Lotus Notes, Domino, Domino Designer

Version 8.0.2

Release Notes
Note: Before using this information and the product it supports, read the information in "Notices" on page 295.
About this release................................................................................................................................. 1

Welcome .................................................................................................................................................. 1
Welcome to IBM Lotus Notes, Domino, and Domino Designer ................................................................. 1
Additional items on Notes and Domino CD-ROMs .................................................................................... 1
Help - usage and availability .................................................................................................................... 8
Release notes - updated information available on-line .............................................................................. 9
Contacting Customer Support ................................................................................................................ 9
New in this release...................................................................................................................................... 10
New features in IBM Lotus Notes and Domino 8.0.2 ................................................................................ 10
Local Composite Applications support ................................................................................................... 11
Backward compatibility .............................................................................................................................. 12
Domino Document Manager 7.0 availability .............................................................................................. 12
Group related Out-of-Office options removed in 8.0.1 ............................................................................ 13
Streaming cluster replication is off by default ........................................................................................... 13
Product compatibility ............................................................................................................................... 13
Using Notes/Domino 8 with BlackBerry servers ....................................................................................... 13

Installation, migration, upgrade, and configuration information ............................................................. 15

Hardware requirements ............................................................................................................................ 15
Notes and Domino 8.0.2 hardware requirements .................................................................................. 15
Domino and DB2 - server requirements .................................................................................................... 15
System i: Server hardware requirements .................................................................................................. 16
Tested Smartcard packages ...................................................................................................................... 17
Software requirements .............................................................................................................................. 20
Notes and Domino 8.0.2 platforms and system requirements ................................................................. 20
Supported LDAP directory servers .......................................................................................................... 29
Lotus Sametime servers and available features ......................................................................................... 29
System i: i5/OS V5R4 Software requirements .......................................................................................... 30
System i: i5/OS V6R1 Software requirements .......................................................................................... 32
System i: IBM HTTP Server plug-in for Domino ....................................................................................... 34
System i and IBM Tivoli License Compliance Manager 2.2 ................................................................. 34
System i: Features not available with Domino 8 ...................................................................................... 35
System z: Domino on z/OS now requires Perl .......................................................................................... 35
System z: DB2 requirements for LS:DO, LCLSX and DECS .................................................................. 36
Domino Web Access system requirements .............................................................................................. 36
DECS: supported platforms and data drivers ............................................................................................ 37
Citrix support statement ............................................................................................................................ 39
Supported languages/locales for Notes on Macintosh ............................................................................ 39
AIX system requirements .......................................................................................................................... 40
Linux system requirements ....................................................................................................................... 41
SELinux is not supported ............................................................................................................................ 44
Linux for System z: 64-bit DB2 requirements ............................................................................................ 44
Linux for System z: GNU debugger needed ............................................................................................. 44
Solaris system requirements ....................................................................................................................... 44
Windows system requirements ................................................................................................................ 45
Web browsers supported ............................................................................................................................ 45
KeyView filter formats supported ............................................................................................................ 46
Debugger requirements for NSD ................................................................................................................ 48
Installation notes ........................................................................................................................................ 49
Products to install and order of installation ............................................................................................... 49
<table>
<thead>
<tr>
<th>Upgrade notes</th>
<th>75</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrading a Notes single user install to multi-user</td>
<td>75</td>
</tr>
<tr>
<td>Archive menu options moved from 'Tools' to 'Actions'</td>
<td>75</td>
</tr>
<tr>
<td>Domino 8 upgrade issue on partitioned server</td>
<td>75</td>
</tr>
<tr>
<td>Mail Letterheads and upgrading from previous releases of Notes</td>
<td>76</td>
</tr>
<tr>
<td>Must extract hotfix installer .exe before running silently</td>
<td>76</td>
</tr>
<tr>
<td>New ICC sub-directory required for Win32</td>
<td>76</td>
</tr>
<tr>
<td>Notes 7.x upgrade to 8.0.x fails on Vista</td>
<td>76</td>
</tr>
<tr>
<td>Notes/Domino 8 upgrade to JDK (Java Development Kit) 1.5</td>
<td>77</td>
</tr>
<tr>
<td>Personal Address Book needs new design upgrade</td>
<td>79</td>
</tr>
<tr>
<td>Prevented from upgrading to W64 kit</td>
<td>79</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Migration notes</th>
<th>73</th>
</tr>
</thead>
<tbody>
<tr>
<td>Migrating Domino 32-bit applications to the 64-bit platform</td>
<td>73</td>
</tr>
</tbody>
</table>

| Windows Vista: Considerations for Notes install /upgrade                   | 50 |
| Single user access to Notes default install directories                  | 51 |
| Notes installation directories                                           | 52 |
| Notes shared network install not supported                                 | 53 |
| Reducing Notes Standard install kit size                                  | 54 |
| Notes Basic configuration cannot be run from Domino directory             | 56 |
| Installation and Notes launch from Linux CD-ROM                           | 56 |
| CD mount issue with RHEL 5 for Notes installs                            | 56 |
| Installing Notes using "su root" on Linux                                | 57 |
| Installing and uninstalling Notes on Mac OS plus - Beta                   | 57 |
| Creating a verbose install log file                                       | 60 |
| UNIX: Running the launchpad.sh application                                | 60 |
| Running Domino 8 server installations on UNIX platforms                   | 60 |
| Do not attempt to install Domino data path under drive disk name          | 61 |
| Running the Domino-Portal Integration Wizard                              | 61 |
| System i: Installing Domino 8 on i5/OS V5R4                               | 63 |
| System i: Remove any Beta versions before installing                      | 63 |
| System i: Japanese system values required for install                     | 64 |
| Cannot install to shared network drive as user in Admin group             | 64 |
| Cannot launch nMinder and sload shortcuts after shared install            | 64 |
| Feature install defaults to shared directory                              | 64 |
| Installing DOLS on Microsoft Windows                                      | 65 |
| Installing Domino on UNIX systems                                        | 65 |
| Installing Notes client data directory to network shared drive            | 66 |
| Installing Notes multi-user as a silent installation                      | 67 |
| Installing NSD as a Windows system service                                 | 68 |

| New mail file template for Domino Web Access                              | 69 |
| Prerequisites for Notes Web Browser application on Linux                  | 69 |
| Replace Design fails in multi-user environment                            | 70 |
| Running the Domino server installer on RedHat platforms                   | 70 |
| Silent install and Notes install manifest “default” setting               | 71 |
| Silent Notes multi-user install/upgrade command line statement            | 71 |
| Subsequent Allclient install and feature selection defaults               | 72 |
| Switch User (fast user switching) and Notes installation                 | 72 |
| System i: EZ Setup option no longer available with V6R1                  | 72 |
| Vista: Multi-user client silent install/upgrade                            | 73 |

| Notes/Domino 8 upgrade to JDK (Java Development Kit) 1.5                 | 77 |
| Personal Address Book needs new design upgrade                            | 79 |
| Prevented from upgrading to W64 kit                                       | 79 |
Known limitations, problems, and workarounds

Limitations

Client issues

Cannot move focus between panes in Preferences via keyboard

Citrix: Select Sound list is blank

Embedded OLE objects created with MS Office 2007
Features not available in "basic" configuration of Notes 8 ........................................ 110
Help Search -- Not all results can be synchronized with Contents .......................... 111
Roaming User - Issues and cleanup functionality .................................................. 111
Windows 64-bit: KeyView filter unavailable for Lotus WordPro ............................ 111
Composite Applications issues ............................................................................... 112
Composite applications only open in Notes client ................................................. 112
Detect component application events in NSF components ................................. 112
Errors occur when adding local components ....................................................... 112
References to obsolete tools appear in Designer documentation ......................... 112
Timing problems occur with page transitions and properties ............................. 113
Wire does not fire in composite application ....................................................... 113
Domino Domain Monitoring issues ..................................................................... 113
DDM Remote Server Console Common Action not working correctly .................. 113
System i: DDM memory probe reports 2x usage for Java agent ............................ 113
Domino Web Access issues .................................................................................. 113
Cannot reuse child windows to open encrypted mail ......................................... 113
Desktop icons do not work for DOLS on Linux clients ........................................ 113
Domino Web Access Lite mode support in mixed environments ....................... 114
Out-of-Office cannot be set offline ...................................................................... 114
Prevent Copy function is not supported in Domino Web Access .......................... 114
Ultralite: Alternate names are not supported ...................................................... 114
Ultralite: Reply/Reply To All/Forward limitations .............................................. 114
Ultralite: Secure mail is not supported ................................................................. 115
Installation issues .................................................................................................. 115
Domino install - bidirectional language display error ........................................... 115
Linux installer displays East Asian license text incorrectly .................................. 115
Redundant icon is left in "Add or Remove Programs" using SURunAs ................... 115
Running server does not shutdown after trial license is expired ......................... 115
Smart Upgrade: Notes program path cannot contain a space ............................. 116
UNIX installer shows incorrect prompt creating uninstaller ............................... 116
Lotus Symphony issues ....................................................................................... 116
Forms are not saved correctly in .PPT format ..................................................... 116
Graphics with text cannot be copied to other applications ................................. 116
Presentation tables cannot be displayed in OpenOffice 2.0 ............................... 116
Save unsupported document type may cause data loss ...................................... 116
Tables in Notes cannot be displayed in Lotus Symphony Presentations .......... 116
User cannot undo if a document is not completely loaded .................................. 117
"Reversing Path Direction" is not supported for animation effect ....................... 117
Mail issues ............................................................................................................ 117
Cannot display Categorized Inbox in Notes ......................................................... 117
Group membership changes effectiveness of Message Recall ............................ 117
Interoperability of built-in view icons .................................................................. 117
Mail quota usage and disk space properties values may differ ......................... 118
Out-of-office and differences between client and server time ............................ 118
Setting Delegation requires specific access levels .............................................. 118
Notes client on Macintosh issues ......................................................................... 119
Known attachment viewing issues on Macintosh ............................................... 119
Some shortcut keys are not supported ................................................................. 119
Policy issues .......................................................................................................... 121
Known problems and workarounds

Calendar and scheduling issues

Activities issues

Server issues

Search issues

Security issues

Web Services issues

Web Services and Arrays

Web Services version compatibilities

Multi-byte characters in WSDL documents

Moving Web service classes to a Java Script library

Consuming SOAPENC faults with multi-refs

Section properties box buttons are inaccessible

Adding large files to an Activity may take a long time

Group membership and Forward a Link problems

Issues when adding several Notes documents to Activities

Notes may crash while publishing large mail to Activities

Application Development issues

Using rcplauncher to launch Notes may affect access to APIs

Browser issues

Notes Web Browser issues

Calendar and scheduling issues

Invitees are not displayed in "bcc:" list

Tentative Accept from Notes states that it was accepted

To Do view does not have "Ctrl-Click here to add a new document"

Client issues

Adding NSL to an existing Notes install removes features

Bookmarks from Startup folder opening only with new tab theme

Close All option closes the sidebar

Do not use Alt+F4 to close Preferences dialog

Drag-and-drop folders and bookmarks to Open menu not functional

Drag-and-drop unopened tabs to Open list not functional

Drag and drop from feed reader to IE browser fails

Duplicate items in Preferences dialog

F1 Help for File -> Preferences not fully implemented

Feed reader content should be per user ID

System i: Summary information for Domain Search not displayed

System z: zFS filesystem limitation

System z: Java heap dump not generated with "classic" JVM

Restrictions for using LTPAtoken 2 for single sign-on

Domino 64-bit: Running DIIOP remote application returns error

Domino for Linux on System z jconsole program limitation

NETBIOS over TCP/IP not supported on Windows 2003 x64

System i: Java heap dump not generated with "classic" JVM

System z: zFS filesystem limitation

Web Services and Arrays

Web Services version compatibilities

Multi-byte characters in WSDL documents

Moving Web service classes to a Java Script library

Consuming SOAPENC faults with multi-refs

Section properties box buttons are inaccessible

Adding large files to an Activity may take a long time

Group membership and Forward a Link problems

Issues when adding several Notes documents to Activities

Notes may crash while publishing large mail to Activities

Application Development issues

Using rcplauncher to launch Notes may affect access to APIs

Browser issues

Notes Web Browser issues

Calendar and scheduling issues

Invitees are not displayed in "bcc:" list

Tentative Accept from Notes states that it was accepted

To Do view does not have "Ctrl-Click here to add a new document"

Client issues

Adding NSL to an existing Notes install removes features

Bookmarks from Startup folder opening only with new tab theme

Close All option closes the sidebar

Do not use Alt+F4 to close Preferences dialog

Drag-and-drop folders and bookmarks to Open menu not functional

Drag-and-drop unopened tabs to Open list not functional

Drag and drop from feed reader to IE browser fails

Duplicate items in Preferences dialog

F1 Help for File -> Preferences not fully implemented

Feed reader content should be per user ID

System i: Summary information for Domain Search not displayed

System z: zFS filesystem limitation

System i: Java heap dump not generated with "classic" JVM

Restrictions for using LTPAtoken 2 for single sign-on

Domino 64-bit: Running DIIOP remote application returns error

Domino for Linux on System z jconsole program limitation

NETBIOS over TCP/IP not supported on Windows 2003 x64

System i: Java heap dump not generated with "classic" JVM

System z: zFS filesystem limitation

Web Services and Arrays

Web Services version compatibilities

Multi-byte characters in WSDL documents

Moving Web service classes to a Java Script library

Consuming SOAPENC faults with multi-refs

Section properties box buttons are inaccessible

Adding large files to an Activity may take a long time

Group membership and Forward a Link problems

Issues when adding several Notes documents to Activities

Notes may crash while publishing large mail to Activities

Application Development issues

Using rcplauncher to launch Notes may affect access to APIs

Browser issues

Notes Web Browser issues

Calendar and scheduling issues

Invitees are not displayed in "bcc:" list

Tentative Accept from Notes states that it was accepted

To Do view does not have "Ctrl-Click here to add a new document"

Client issues

Adding NSL to an existing Notes install removes features

Bookmarks from Startup folder opening only with new tab theme

Close All option closes the sidebar

Do not use Alt+F4 to close Preferences dialog

Drag-and-drop folders and bookmarks to Open menu not functional

Drag-and-drop unopened tabs to Open list not functional

Drag and drop from feed reader to IE browser fails

Duplicate items in Preferences dialog

F1 Help for File -> Preferences not fully implemented

Feed reader content should be per user ID
Feed reader not working if "Program Files" name is translated........................................ 133
Feed reader support for sites requiring authentication...................................................... 133
Feeds date/time display in current locale format .................................................................. 133
GB18030 and other fonts may require parameter file customization ................................. 134
GB18030 character display on Windows XP Notes client .................................................. 134
Install yields error when installing from non-ASCII directory ............................................. 135
Invoking Preferences from Designer .................................................................................. 135
JIS2004 character display on Windows XP Notes client .................................................... 135
Lotus Notes Smart Tag options unavailable in Microsoft Word ........................................... 136
Manually resized preview pane and Show Preview .............................................................. 136
My Widgets: Cannot export a locked widget ....................................................................... 137
My Widgets: Live Text and rendered MIME e-mail ............................................................ 137
My Widgets: Not all Web pages supported for widget creation ........................................... 137
My Widgets: Recognize Live Text in this Document option ................................................ 137
My Widgets: Restricting install of existing widgets types .................................................... 138
My Widgets: Sidebar contribution and Close menu option .................................................. 138
My Widgets: Text with multiple components not recognized .............................................. 139
My Widgets: Toolbar should not appear in standalone Symphony ...................................... 139
My Widgets: View state lost if sidebar collapsed at shutdown ............................................ 139
Notes Help window disappears in some MUI installs ......................................................... 139
Notes message RTVSCAN holding memory ........................................................................ 140
Notes UI display speed on Windows .................................................................................. 140
Open panel font does not match OS font setting ................................................................. 140
Roaming user not fully supported ...................................................................................... 140
Search bar returns to default position at restart ................................................................. 140
Theme does not change after disabling high contrast ........................................................ 140
Toolbar may display incorrect icons after a crash ............................................................... 141
Toolbars can experience display issues in new window theme ........................................... 141
Unexpected feed reader subscription behavior .................................................................. 141
Use Help table of contents to access Help topics on Preferences ....................................... 141
XML files may appear in list of Dynamic Help search results ............................................ 142
"Open" menu displays incorrectly in bi-directional mode ...................................................... 142
Composite Applications issues ......................................................................................... 142
Applications not opened in the correct window ................................................................. 142
DAP configuration settings impact what client displays ...................................................... 142
Keyboard loses focus in composite application .................................................................. 143
Lead Manager Composite Application sample does not install ....................................... 143
Problem encountered wiring components with ?OpenDatabase ........................................ 143
Tab remains when deleting a page in CAE ........................................................................... 143
Contacts issues .................................................................................................................. 144
Moving a recent Contact with a domain in the address ....................................................... 144
Designer issues .................................................................................................................. 144
Preview page with embedded view focus issue .................................................................... 144
Directory issues .................................................................................................................. 144
Change to LDAP searches for the mail attribute ............................................................... 144
Directory Assistance not taking advantage of cluster failover ........................................... 145
Domino Access for MS Outlook issues .............................................................................. 145
DAMO: Known issues ........................................................................................................... 145
Single Logon with DAMO .................................................................................................... 145
Domino Web Access issues

DOLS uninstallation requires restart

Domino Web Access Lite mode does not support secure mail

Inability to reach Sametime server may cause system to hang

Issue starting chats from Mail views

No support for bi-directional display in Firefox

Opening a calendar entry from the sidebar in Lite mode

Passthru HTML is supported only with plain text signature

RSS feeds remain in IE 7 feed reader after logging off

Spell check issue on Linux and UNIX servers

System i: DWA with Sametime chat/awareness requires port 80

Tabs appear incorrectly in bi-directional mode

Ultralite: Default Time Zone behavior

Ultralite: International characters are not displayed correctly

Ultralite: Known issues with Contacts

Ultralite: Mark Unread icon in ghosted invitations has no effect

Ultralite: Time/Date format errors for new users

Unexpected security message appears in Lite mode session

Unread marks do not replicate by default

Using Domino Web Access 8.0 with a Sametime 7.0 server

Installation issues

Ending the Notes installation process before completion

FTP and Notes .keystore file

Incorrect message after installing Notes with missing features

Information and known issues with the new UNIX ISMP installer

Installation path cannot contain certain characters

Installer does not create the registry entries for Notestat

Notes does not support downgrade

Notes features size values if already installed

Notes installation panel may close unexpectedly on SLED 10

Notes processes left open if configuration wizard is cancelled

Notes upgrade does not terminate when Notes is running

Recognizing and stopping a failed network share install process

Rerunning Notes installer to uninstall Lotus Symphony

Shared node install: Do not use option "b" in silent mode

SLED 10: Setting locale for Notes installation

Smart Upgrade Governor information is not refreshed

Some messages do not appear in the Linux install log file

System i: CHKPRDOPT error messages in language environments

System i: Domino installation may fail with signature violation

System i: Installation will fail if WRKDOMSVR command active

System i: Missing Java option not always reported during install

Upgrading Notes 8.0 installs that used a multiuser transform

Vista: Changing the default Notes installation path

Vista: Smart Upgrade succeeded report issue

Instant Messaging issues

IM Vertical Orientation View is not working

Sametime Preference setting - Communities using HTTP settings

Save Chat to HTML file

Save Chat to HTML file
Lotus Symphony issues ................................................................. 160
JAWS: Version 8.0 or higher is needed using Windows ......................... 160
Linux: No "Save as type" option available ........................................ 160
MS Excel file with protected worksheet or workbook will not open ............ 160
ODF file association is overwritten ................................................ 160
Special characters are not supported in file name ................................ 160
Mail issues .................................................................................. 161
Cannot create a mail archive when mail quota is exceeded ....................... 161
Deleting messages may cause conversations to be out of order ............... 161
Documents selected in Mail mini-view will not appear in Preview ............... 161
Errors after restarting Mail Application ........................................... 162
Notes 8 .css overrides some Domino Designer mail properties ................. 162
Notes client on Linux issues .................................................................. 163
Bookmark behaviors with Notes on Linux ........................................ 163
Dragging-and-dropping Notes documents to Desktop folder .................. 163
High Contrast mode is not automatically detected by Notes client ............ 163
System file dialog issues ................................................................... 164
Using "Open in New Window" on Linux ............................................. 164
Programming issues ....................................................................... 164
Deprecating Notes.ini variable DXLI2=0 ....................................... 164
Recompiling Visual Basic programs that use backend COM APIs ............ 165
Redisplay a programmatically modified outline .................................. 165
Security issues ................................................................................ 165
Error: This identity’s keys have never been rolled over ......................... 165
Problems using Entrust certificates on smartcards .............................. 166
Requesting a client certificate causes an error in Windows Vista .............. 166
Server issues .................................................................................. 167
System i: HTTP crash when same port used by IPV 4/IPV6 ................... 168
System i: Database name with extended characters not displayed ............ 168
iNav: CFGDOMSVR with timezone (* sysval) by iNav ......................... 168
Domino 64-bit: Known issues .......................................................... 167
AIX, Linux, Solaris: Domino task crash when JVM receives signal .......... 167
Web Services issues ....................................................................... 169
Fault order in generated method signatures ....................................... 169
Importing WSDL containing xml:lang types ..................................... 169
Importing WSDL <group> references with maxOccurs attribute .......... 169
Java Web service providers may return null data members .................... 170
Java Web service value type classes may not generate into WSDL ......... 170
Web service interface change may not regenerate WSDL ...................... 171
Web services and Agents should have unique names .............................. 171

Documentation updates ................................................................... 173
Notes Client Help ........................................................................... 173
Changes to local database encryption ............................................... 173
Correction: Locking the Notes ID ..................................................... 174
Correction: Synchronizing Notes with Domino Web Access ................ 174
Domino Blog: Use Create -> Hotspot to add links to blog posts ............ 175
Enabling Java applets in Notes - correction ...................................... 175
Errata: Web browsing troubleshooting ............................................. 177
File formats supported for viewing in Lotus Notes .............................. 177
Agents property - usage and examples revised ................................................................. 198
attachVCard method - new Document java method ...................................................... 200
AttachVCard method - new NotesDocument method ...................................................... 200
CalendarFormat @Command - usage enhancement ...................................................... 201
Caution when using CreateFromTemplate with large dbs ........................................... 201
Changes to the "Instant Spell Check" feature ............................................................... 202
Clear method ................................................................................................................. 202
clearProperty method ................................................................................................. 203
Composite Properties renamed Wiring Properties ...................................................... 203
Concurrent Web services require concurrent Web Agents ............................................ 203
ConvertToZone method - usage notes ........................................................................... 204
CreateSession in NotesFactory - syntax revised ......................................................... 204
Description property ................................................................................................... 205
DesignImportOption property ...................................................................................... 205
Designing forms - Changes do not effect existing forms .............................................. 205
Disabling Passthru HTML - revised values .................................................................. 206
DiscoverFolders @Command title parameter and new example ................................ 206
DontSendLocalSecurityUpdates takes effect immediately ........................................... 207
Examples: Accessing the current database and view .................................................... 207
Examples: Clear method - revised .............................................................................. 207
Examples: ClearProperty method - revised ................................................................. 208
Examples: Description property - revised .................................................................... 208
Examples: GetMailInfo method - new examples .......................................................... 209
Examples: GetProperty method - revised ..................................................................... 210
Examples: Isinput property - revised ........................................................................... 210
Examples: Name property - revised ............................................................................ 211
Examples: NameSpace property - revised ................................................................... 212
Examples: NotesProperty class - revised ..................................................................... 212
Examples: Publish method - revised ........................................................................... 213
Examples: Title property - revised ................................................................................ 213
Examples: TypeName property - revised ....................................................................... 214
Examples: Values property - revised ........................................................................... 214
Example: FTDomainSearch - new example ................................................................. 215
Formulas that look for values in columns and views .................................................... 215
GetComponentViewPreference method ......................................................................... 216
getProperty method .................................................................................................... 217
getPropertyBroker method .......................................................................................... 217
getPropertyValue .......................................................................................................... 218
getPropertyValueString method .................................................................................. 218
getAddressString method ............................................................................................. 219
hasProperty method .................................................................................................... 220
InputPropertyBroker property - new Java PropertyBroker property ......................... 220
IsInCompositeApp property ......................................................................................... 221
IsInput property - new .................................................................................................. 222
isTrustedSession in Session - new example .................................................................. 222
isTrustedSession in Session - new Java property .......................................................... 222
IsUsingJavaElement property ...................................................................................... 223
Java versions of LotusScript methods .......................................................................... 224
Java View class - revised methods ............................................................................... 224
Keyboard shortcuts for bi-directional language support .............................................. 225
markAllRead method - java ViewNavigator new method .............................................. 226
markAllUnread method - java ViewNavigator new method ............................................. 226
Memory management for Java objects ........................................................................... 227
Name property .............................................................................................................. 227
Namespace property ...................................................................................................... 227
NotesFactory class - new createTrustedSession method .............................................. 228
NotesProperty class - new Java class ............................................................................ 228
NotesUIFileDocument Print method - syntax parameter revised .................................... 229
NotesUIView Print method - syntax parameter and examples revised ......................... 230
Oracle connectivity with Linux ................................................................................. 232
Prompt method: Clarification of PROMPT_CHOOSEDATABASE .................................. 232
PropertyBroker class - new Java class ......................................................................... 234
Publish method - NotesProperty .................................................................................. 234
Publish method - PropertyBroker ................................................................................ 235
Read-restricted views not appearing in Domino Designer ............................................ 235
RemoveLinkage method - new method ....................................................................... 235
setPropertyValue method ........................................................................................... 236
StampAllMulti method - new method ......................................................................... 236
s.GetPropertyBroker(" com.ibm.compositeapps.samples") has changed ...................... 237
Table of Column Icons - revised .............................................................................. 237
Title property ............................................................................................................... 238
Troubleshooting DAVs - Data Exception error .............................................................. 238
Troubleshooting DAVs - Inserting multiple value dates ............................................. 239
Troubleshooting DAVs - unknown form : Message ................................................... 239
TypeName property .................................................................................................... 239
Updates to Web services Java and LotusScript classes doc ........................................ 240
Using the Message programming model with a web service ...................................... 246
Values property .......................................................................................................... 247
ViewHorizScrollBar @Command - not supported ....................................................... 248
Web Service Consumer PortType class ....................................................................... 248
@AbstractSimple - revised syntax and return value .................................................. 255
@Adjust usage note ..................................................................................................... 257
@GetComponentViewPreference .................................................................................. 258
@InheritedDocumentUniqueID usage - only works in Notes client ............................... 259
@IsEmbeddedInsideWCT and IsEmbeddedInsideWCT method - usage note .............. 259
@IsInCompositeApp .................................................................................................. 259
@Version - Notes 8.0 is version 307, Notes 8.0.1 is version 322 ................................. 260
Domino Web Access Help ............................................................................................ 262
Add a rich text signature to messages .......................................................................... 262
Configuration settings supported in Domino Web Access Lite mode ......................... 262
Create "confidential" contacts or mail groups .............................................................. 263
Delegate access to Contacts ....................................................................................... 263
Displaying remote images in mail ............................................................................. 264
Domino Web Access Lite mode .................................................................................... 264
Errata: Using the To Do list ......................................................................................... 265
iNotes_WA_EnableLiteMode.......................................................................................... 265
iNotes_WA_NoVertLineReplyForward ....................................................................... 265
iNotes_WA_PrintSSApplyTo ......................................................................................... 266
Logging in to Domino Web Access ................................................................. 266
Notes.ini settings supported in Domino Web Access Lite mode ................ 266
Preferences supported in Domino Web Access Lite mode ......................... 267
Setting up Domino Web Access with Sametime - errata .............................. 269
Using message recall in Domino Web Access ............................................. 270

Domino for System i Documentation ............................................................. 271
System i: C and C++ Application requirements .......................................... 271
System i: CFGDOMSVR maximum length of DOM and ORG keywords .... 271
System i: CFG/CHGDOMSVR TIMEZONE and DAYSAVTIME keywords ... 272
System i: Daylight Savings Time changes .................................................... 273
System i: Generating an NSD ................................................................. 273
System i: How to obtain additional spell-check dictionaries ....................... 273
System i: Parallel save capability with BRMS and i5/OS V5R4 ..................... 274
System i: Retrieve Domino Server Attributes API .................................... 274
System i: System Value QLOGOUTPUT .................................................... 283
System i: Use of the forward slash "/" character ........................................ 284
System i: Using iSeries Navigator tasks on the Web .................................. 284
System i: WRKDOMSVR new options - 14, 15, 16 and F23 ...................... 289

Activities Help ............................................................................................. 290
Activities sidebar enhancements .............................................................. 290

Sametime Help .......................................................................................... 292
Sametime Contacts Help ........................................................................... 292
Sametime Show Online Settings ............................................................... 293

Lotus Symphony Help .............................................................................. 293
Symphony keyboard shortcuts corrections and updates .......................... 293

Notices and Trademarks .......................................................................... 295

Notices ....................................................................................................... 295
License agreement .................................................................................... 295
Notices ....................................................................................................... 295
Trademarks ............................................................................................... 297
Welcome

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Offline Services (DOLS), Domino for System i, Domino for System z

Welcome to IBM Lotus Notes, Domino, and Domino Designer
Welcome to the IBM® Lotus® Notes® and IBM Lotus Domino® Server family of software products. Lotus Notes 8.0.2 and Lotus Domino 8.0.2 are the latest releases of the world's leading products for information management, messaging, collaboration and application development.

These Release Notes contain information on the many new features and enhancements included in the Notes and Domino software products. For an overview of the features in this release, see the “About this release” chapter, "New in this release" section, of these release notes. For more detailed information on the features, see the online help for each product, as well as the "Documentation Updates" chapter of these release notes.

Before installing, please review the "Installation, migration, upgrade, and configuration information" chapter of these Release Notes.

To ensure that you have the very latest version of these Lotus Notes and Domino 8.0.2 Release Notes, please visit the following website:


Additional items on Notes and Domino CD-ROMs
In addition to the Notes installation files, there are the following items on the Notes and Domino CDs. Please note that Lotus provides support only for Lotus software in the \APPS directory, and we support it on a best-effort basis. For other, non-Lotus software applications included in the \APPS directory, please refer to the appropriate third-party vendor for support.

Domino Global Workbench
Domino Global WorkBench is a fully integrated component of the Domino Designer development environment. Domino Global WorkBench enables Web application developers to quickly and cost-effectively deliver multilingual Web and intranet applications.

1. Documentation

Please refer to online Help for more detailed information about the specifics of using Domino Global WorkBench 6. Our printable documentation, Guidelines for Developers and Translators, in Adobe Acrobat® PDF format, is available for download, from the Lotus Web site at www.lotus.com/international.
2. **Overview of features**

Please refer to the "What's new in IBM Lotus Notes" topic in Help for information about features that are new in the Notes client.

3. **System Requirements**

The following hardware is recommended:
- A Pentium® or equivalent processor
- A minimum of 32Mb of memory
- Approximately 32Mb of hard disk space to install the software

Operating system:
Windows XP® is required to use this product.

To use the WorkBench:
Domino Designer 6 or above

To translate Domino Global WorkBench glossaries:
Notes 6 client, or above, or
Domino 6 server and Internet Explorer 5.5 or later

To use applications built by Domino Global WorkBench:
Server: Domino 6 or above
Client: Notes 6 or above, or a Web browser (see below)

To install the Language Synchronizer:
Server: Domino Release 5 or above

Browsers:
To work with Web-enabled language applications, a browser must be capable of supporting HTTP language detection, for example Netscape Navigator® 4.0 or later, or Microsoft Internet Explorer® 5.0 or later.

4. **Download and Installation**

To install from the Notes CD:
Open the Apps\DGW folder and run Setup.exe.

To install after downloading from the Web:
You will have one file, DGW800.ZIP. Download this file to a temporary directory on your hard disk. Unpack it then run SETUP.EXE which will begin the installation process.

**Installation issues**
Before installing Domino Global WorkBench, be sure that your Notes program directory is in your path. Add it if necessary. (For example, in Windows 98, edit your C:\AUTOEXEC.BAT file and add C:\LOTUS\NOTES to the PATH= statement.)

If you are installing under Windows NT, 2000 or XP, and the user account being used does not have administrator privileges, you may find that installation terminates prematurely. This is because the install program is refused permission to copy the Microsoft MFC shared DLL, MFC42.DLL, resulting in install terminating before it completes. The solution is to ensure that the user account you use to install Domino Global WorkBench has administrator rights on the NT machine. (For the majority of users this is the case, so the problem does not arise.)
5. **Glossaries**

The design of the Domino Global WorkBench glossary application (DGWGLOSS.NTF) has been enhanced. You can update the design of glossaries created using earlier versions of Domino Global WorkBench by choosing File - Application - Replace Design.

6. **Multilingual applications and browsers**

The default language of a multilingual application will only be observed if:

1. You choose a language for your browser that does not exist in the multilingual application, and
2. No other languages that are used in your multilingual application are present in the language listbox of your Web browser.

7. **Language switching and browsers**

When using Netscape or Internet Explorer to view multilingual applications created with Domino Global WorkBench, you must remove cached files before you can switch languages from the browser's 'Preferences' or 'Internet Options' dialog box. This is primarily relevant to developers, during testing.

**Workarounds**

Netscape: The cache size can be set to zero (0) in the 'Preferences' dialog. Otherwise, the cache must be emptied, again through the 'Preferences' dialog, when switching languages.

Internet Explorer: The cache size reduction in this browser is limited to 1% of the machine's hard-disk size, so it cannot be set to zero (0). The cache may be emptied via the 'Internet Options' dialog, or the option to delete cached files may be set in the 'Advanced' tab of the 'Internet Options' dialog (see below) when the browser is closed. The cached files are then deleted by closing and then reopening the browser.

8. **Synchronization**

The language synchronizer has not changed in this release of Domino Global WorkBench.

**Synchronized applications**

Performance issues have been noted when synchronizing large numbers of new documents ( > 1,000 ) where the applications are located on a server other than that on which the synchronizer server task is running. It is best to locate applications on the same server as the synchronizer server task.

9. **Bi-Directional language support**

Domino Global WorkBench includes bi-directional functionality for the Hebrew and Arabic languages. For details, see the topic "Support for bi-directional languages" in the documentation.
10. **LotusScript compile and Notes documents**

You may encounter problems if you use Domino Global WorkBench to localize Notes documents that contain LotusScript or formulas. This can happen if:

1. The form used by the documents contains some LotusScript and has the "Store form in document" property set (on the Info tab of Designer form infobox). The entire contents of the form are then included with every document created from it, but the LotusScript is not recompiled as part of the build process, even if it has been translated. The original (source application) version of the script will execute in the built application.

2. The documents have hotspots that contain script. This only applies to hotspots in the document content (in other words, added by the author in a rich text field). All hotspots in document content are signed as a security measure. Because Domino Global WorkBench cannot sign these hotspots it cannot translate the associated LotusScript. If the WorkBench encounters LotusScript in a signed hotspot, it issues the following warning:

   **Warning:** A signed hotspot could not be translated. The untranslated data may include scripts and/or formulas.

   The script is then copied to the target application without any changes (in other words, without tagging or translation).

   **Workaround:** LotusScript or formulas associated with signed hotspots must be translated by hand in the Notes 6 client after building is complete.

11. **Editing documents in a projects application**

Documents in a projects application are, by default, not editable. If a document must be edited, then it must be opened and View/Switch Form... selected. The form for the document is then chosen, and the document placed in edit mode.

If a folder document name is edited in the project application, then the names of any project documents for this folder must also be modified to match or unexpected results may occur in the WorkBench.

12. **Keywords and values in help documents**

Sometimes a Notes application may span several applications, with all keywords and values grouped in help documents in one of the applications. Formulas referencing the application with the keywords and values will only continue to work if they contain the correct name of the application file they are calling. When localizing, you can either translate the application name in the calling formulas, in which case you must take care to rename the built application to the translated name, or you can leave the application name untranslated in the calling formulas, in which case the different language versions of the application will have to reside in different directories. The help documents themselves can be processed in the usual way by Domino Global WorkBench.

13. **Project icons in Windows XP**

In Windows XP, the display of project icons on the left frame of the WorkBench can be obscured if you create too many of them (more than about 25). You can alleviate the problem by organizing your projects into folders.
**Language dictionary files**
The language dictionary files are used for spell-checking within Notes. The following language dictionary files are included in a self-extracting file located in the `\APPS\DICTIONARIES` directory. Notes automatically installs certain dictionary files that correspond to your language version of Notes. If you want to use one of the dictionary files listed below and find that it has not been installed automatically by Notes, simply decompress the contents of the `DICTIONARIES.EXE` (`DICTIONARIES.SEA` for Macintosh) self-extracting file on the CD-ROM to a temporary directory on your hard drive and copy the appropriate dictionary file (listed below) into your Notes data directory.

<table>
<thead>
<tr>
<th>Language</th>
<th>Dictionary File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afrikaans*</td>
<td>AFRIKAAN.DIC</td>
</tr>
<tr>
<td>Arabic*</td>
<td>ARABIC.DIC</td>
</tr>
<tr>
<td>Catalan</td>
<td>CATALA.DIC</td>
</tr>
<tr>
<td>Chinese*</td>
<td>CLKCHS.DIC</td>
</tr>
<tr>
<td></td>
<td>CLKCHT.DIC</td>
</tr>
<tr>
<td>Czech*</td>
<td>CZECH.DIC</td>
</tr>
<tr>
<td>Danish</td>
<td>DANSK.DIC</td>
</tr>
<tr>
<td>Dutch</td>
<td>NEDERLND.DIC</td>
</tr>
<tr>
<td>Dutch Belgian</td>
<td></td>
</tr>
<tr>
<td>Dutch Preferred</td>
<td>NEDPLUS.DIC</td>
</tr>
<tr>
<td>English (Australia)</td>
<td>AUS.DIC</td>
</tr>
<tr>
<td>English (Canada)</td>
<td>US.DIC</td>
</tr>
<tr>
<td>English (Caribbean)</td>
<td></td>
</tr>
<tr>
<td>English (Jamaica)</td>
<td></td>
</tr>
<tr>
<td>English (New Zealand)</td>
<td></td>
</tr>
<tr>
<td>English (United States)</td>
<td></td>
</tr>
<tr>
<td>English (Ireland)</td>
<td>UK.DIC</td>
</tr>
<tr>
<td>English (South Africa)</td>
<td></td>
</tr>
<tr>
<td>English (United Kingdom)</td>
<td></td>
</tr>
<tr>
<td>Finnish</td>
<td>SUOMI.DIC</td>
</tr>
<tr>
<td>French (Belgium)</td>
<td>FRANCAIS.DIC</td>
</tr>
<tr>
<td>French (Luxembourg)</td>
<td></td>
</tr>
<tr>
<td>French (Standard)</td>
<td></td>
</tr>
<tr>
<td>French (Switzerland)</td>
<td></td>
</tr>
<tr>
<td>French (Canada)</td>
<td>CANADIEN.DIC</td>
</tr>
<tr>
<td>German (Austria)</td>
<td>DEUTSCH.DIC</td>
</tr>
<tr>
<td>German (Liechtenstein)</td>
<td></td>
</tr>
<tr>
<td>German (Luxembourg)</td>
<td></td>
</tr>
<tr>
<td>German (Standard)</td>
<td></td>
</tr>
<tr>
<td>German (Reform)</td>
<td>DEUTSCH2.DIC</td>
</tr>
<tr>
<td>German (Switzerland)</td>
<td>DSCHWEIZ.DIC</td>
</tr>
<tr>
<td>Language</td>
<td>Dictionary File Name</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Greek*</td>
<td>HELLAS.DIC</td>
</tr>
<tr>
<td>Hebrew*</td>
<td>HEBREW.DIC</td>
</tr>
<tr>
<td>Hungarian*</td>
<td>MAGYAR.DIC</td>
</tr>
<tr>
<td>Icelandic*</td>
<td>ISLENSK.DIC</td>
</tr>
<tr>
<td>Italian (Standard)</td>
<td>ITALIANO.DIC</td>
</tr>
<tr>
<td>Italian (Switzerland)</td>
<td></td>
</tr>
<tr>
<td>Medical (American)</td>
<td></td>
</tr>
<tr>
<td>Medical (British)</td>
<td></td>
</tr>
<tr>
<td>Medical (British IZE)</td>
<td></td>
</tr>
<tr>
<td>Norwegian (Bokmal)</td>
<td>NORBOK.DIC</td>
</tr>
<tr>
<td>Norwegian (Nynorsk)</td>
<td>NORNYN.DIC</td>
</tr>
<tr>
<td>Polish*</td>
<td>POLSKA.DIC</td>
</tr>
<tr>
<td>Portuguese (Brazil)</td>
<td>BRASIL.DIC</td>
</tr>
<tr>
<td>Portuguese (Standard)</td>
<td>PORTUGAL.DIC</td>
</tr>
<tr>
<td>Russian*</td>
<td></td>
</tr>
<tr>
<td>Russian (Io)*</td>
<td>RUSSIAN.DIC</td>
</tr>
<tr>
<td>Spanish</td>
<td></td>
</tr>
<tr>
<td>Spanish (Argentina)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Bolivia)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Chile)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Colombia)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Costa Rica)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Dominican Republic)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Equador)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Guatemala)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Mexico)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Modern Sort)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Panama)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Paraguay)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Peru)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Uruguay)</td>
<td></td>
</tr>
<tr>
<td>Spanish (Venezuela)</td>
<td></td>
</tr>
<tr>
<td>Swedish</td>
<td>SVENSK.DIC</td>
</tr>
<tr>
<td>Thai*</td>
<td>SPELLT.GRA</td>
</tr>
<tr>
<td>Turkish*</td>
<td>TURKIYE.DIC</td>
</tr>
</tbody>
</table>

* is available for Windows platform only.
SwiftFile Mail Assistant 4.0 for IBM Lotus Notes
SwiftFile is an add-on to the Notes client that helps users file their e-mail into folders. SwiftFile learns to predict where the user is likely to file each incoming message. Based on its predictions, SwiftFile adds three shortcut buttons to the top of each message that can be used to quickly file a message into one of the suggested folders. When one of SwiftFile’s predictions is correct, the effort required to file a message is reduced to a single button click.

Installation
SwiftFile can be installed from the Notes CD by running setup.exe in the Apps\SwiftFile directory. After the SwiftFile installer completes, follow the directions in the SwiftFile ReadMe file to enable SwiftFile for your mail application.

International Support
SwiftFile supports all languages supported by Lotus Notes. Multiple languages can be mixed within the same application and even within the same document without adversely affecting SwiftFile’s prediction ability.

System Requirements
Windows XP
32 MB RAM
10 MB free disk space
Lotus Notes client

Free Time Web Service application
The Busy Time Web Service application (BUSYTIMEWS.NSF) allows a Domino Server to provide busy time information about the users in its Domino Directory through a Web Service.

This is a sample application and may change in future releases.

Using this application
This is a sample application and may change in future releases.

Accessing the Web Service
The Domino server now does free/busy time lookup for meeting attendees whose names are Internet e-mail addresses. If an attendee whose name is an Internet e-mail address is in the same Domino Domain as the server, the server obtains the attendee’s free time information from the Free Time application (BUSYTIME.NSF) as usual. If the attendee is not in the local Domino domain, the server sends the lookup request to the Web Service gateway, wsconn. Wsconn then makes a Web service request for the information to the Web service defined by the NOTES.INI variable WSCALCONN_URL. The URL should have the following syntax for a remote Domino server providing the Web service:

http://host/busytimews.nsf/busytimelookup?OpenWebService

To run wsconn at server startup, add wsconn to the NOTES.INI variable ServerTasks. Any Web service client can obtain free time information using this Web service.
Providing the Web Service
To provide the web service on a Domino server:

1. Add a new person document to the Domino directory that includes an HTTP password. No Notes ID is required for this user.

2. Modify the ACL of the database BUSYTIMEWS.NSF to give this user Reader access.

3. Provide this user's name and HTTP password to the manager of the server or Web service client that wants to access the Web service.

Tip: Use a full name without spaces to make the use of this name in URLs easier to manage.

Obtaining the WSDL of the Web Service
To obtain the WSDL (the formal definition of the Web Service, encoded in XML) for this Web Service, use the following URL:

http://host/busytimews.nsf/busytimelookup?WSDL

Securing the Web Service
You can secure the Free Time Web Service by doing one of the following:

- Protect the service using HTTP transport level security. To do this, create a new user in the server's Domino Directory and assign that user an HTTP password. The user does not need a Notes ID. Then set the application ACL for BUSYTIMEWS.NSF to "no access" for Default and "no access" for Anonymous. Set the access for this new user to Reader.

To provide the user name and password when a Domino server accesses this Web service, include the username and password in the URL as follows. Remember that URLs cannot contain spaces.

http://username:password@host/busytimews.nsf/busytimelookup?OpenWebService

- Encrypt the data exchange with the Web service using SSL. You can do this if the server's Web server is configured to support SSL and the URL contains HTTPS rather than HTTP.

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Offline Services (DOLS), Domino for System i, Domino for System z

Help - usage and availability
Following is information about the Help files provided with IBM Lotus Notes and Domino 8:

Lotus Notes Help
Lotus Notes 8 includes an Eclipse-based Help system that lets you display context-sensitive help in a side panel while you work. In addition to help for Lotus Notes, this Help includes sections on Sametime Connect, Activities, Feeds, Composite Application Editor, Portal Template Library and Portal Application Catalog, Google Desktop Search, and IBM Lotus Symphony, all of which might be installed as part of the client installation.

You can access Notes Help in the following ways.

- Click Help --> Help Contents from the menu bar
- For context-sensitive help, press F1 (Ctrl+F1 for Linux users), click Help --> Dynamic Help from the menu bar, or click the “?” in the toolbar or in the top right corner of most dialog boxes

Also see the Documentation Updates section of these release notes.
Domino and Domino Designer Help

Lotus Domino 8 and Lotus Domino Designer 8 includes Help .NSF files for Lotus Domino Administrator (Server) and Lotus Domino Designer Help. The Help .NSF files are installed by default in the HELP directory of your Domino or Notes data directory.

<table>
<thead>
<tr>
<th>Title</th>
<th>Database file name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lotus Domino Designer 8 Help</td>
<td>HELP8_DESIGNER.NSF</td>
<td>Lotus Domino Designer and programming language Help</td>
</tr>
<tr>
<td>Lotus Domino Administrator 8 Help</td>
<td>HELP8_ADMIN.NSF</td>
<td>Lotus Domino server and Lotus Domino Administrator Help</td>
</tr>
</tbody>
</table>

You can access Domino and Domino Designer Help in the following ways:

- Click the link to Help on the Notes, Domino Designer, or Domino Administrator Welcome pages
- Click Help --> Help Topics from the menu bar
- Press F1
- Click the “?” in the top right corner of most dialog boxes
- Click File --> Application --> Open and browse to your local directory or a Domino server
- Visit the Domino and Notes Documentation site at http://www.lotus.com/doc

IBM Lotus Domino and Notes Information Center

Information about the Domino server and Domino Administrator client for the 8.0.2 release can be found in the Domino Administrator Help, which is available in the IBM Lotus Domino and Notes Information Center:


The Information Center also contains the Help for: Lotus Notes Traveler 8.0.1, Lotus Notes 8, and Lotus Domino 8 Administrator.

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), Domino for System i, Domino for System z

Release notes - updated information available on-line

The Release Notes that are available on-line are more up-to-date than the Release Notes that are shipped with the product. This is due to production schedules; after the product ships, updates are sometimes made to the Release Notes and posted on the Lotus Documentation website.

To ensure that you have the very latest version of these Lotus Notes and Domino 8.0.2 Release Notes, please visit the following website:


Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), Domino for System i, Domino for System z

Contacting Customer Support

You may contact Lotus Customer Support on-line at:

http://www.ibm.com/software/lotus/support/
New in this release

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), Domino for System i, Domino for System z

New features in IBM Lotus Notes and Domino 8.0.2
The following list represents an overview of the new features that are available in IBM Lotus Notes and IBM Lotus Domino 8.0.2. For more comprehensive information about new features, please refer to the Documentation Updates chapter of these release notes, and to the IBM Lotus Domino and Notes Information Center at http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/index.jsp.

Client

Client UI
- The choice to use either a Windows selection model, which is currently in the Notes 8.0.2 Standard client, or the classic Notes selection model, has been provided. This replaces Notes 7.x functionality that was lost in previous 8.0.x Java views.

Notes Client on Linux
- The Notes Toolbox / My Widgets and LiveText features have been expanded to include platform support for Linux.

Performance
- The Notes 8.0.2 Standard client has been upgraded to Java 6 SR1 J2SE runtime, which has been shown to improve startup performance.

Domino Access for Microsoft Outlook (DAMO)
- Support for DAMO in a Citrix environment has been introduced
- Support for Outlook 2007 - DAMO now runs on Outlook 2007 SP1
- Support for Windows Vista - DAMO is supported on the Windows Vista OS. See the "Known limitations, problems, and workarounds" section of these release notes for Domino Access for Microsoft Outlook issues.

Domino Web Access
- New ultralite client mode - The newest mode of Domino Web Access is the ultralite mode, called Lotus iNotes ultralite mode. It is designed for use on a mobile device and is initially supported on the Apple iPhone or iPod touch. It provides basic mail and contacts capabilities, along with a day-at-a-glance calendar. For additional information on this new mode see the topic "Domino Web Access ultralite mode” in the IBM Lotus Domino and Notes Information Center at http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/index.jsp.
**Domino Designer**

**Functions and Methods**

- A new function can be used to prevent exporting view data to local files when the Notes database ACL setting "Replicate or copy documents" is set to 'Prevent copying'.
- A new method, `RichTextDocLink.RemoveLinkage`, can be used on a document link or hotspot link to remove the linkage. In the case of a simple doclink, the link is removed. In the case of a hotspot link, this method removes only the linkage, leaving the text intact.

**Domino Server**

**Platform**

- Domino is now supported on Red Hat Enterprise Linux (RHEL) 5.1, 32-bit and 64-bit. For additional information, see "Notes and Domino 8.0.2 platforms and system requirements" in these release notes.

**Proxy**

- NTLMv2 proxy authentication is now supported. There are no special configuration instructions; it can be configured in the same way as any other proxy. Note, however, that the Apache Axis 1.4 runtime used for Domino Web Services does not use the platform URL handler, and will not obey the proxy configuration.

**Domino for i5/OS**

- The variable `TCP_NODELAY` is now set to "on" for the socket connection, by default. This means that the Nagle algorithm is now off by default. The Nagle algorithm, named for its creator John Nagle, is used to automatically concatenate a number of small buffer messages; this process (called "nagling") increases the efficiency of a network application system by decreasing the number of packets that must be sent.

---

**Domino Designer**

**Local Composite Applications support**

Notes now has support for creating and opening non-NSF-based, local composite applications. A user can simply choose File -> Application -> New Composite Application from the menu bar and create a new composite application. These applications are written locally and have the extension `.ca`. They can be edited with the Composite Application Editor (CAE), and used just as portal-based or NSF-based composite applications are used.

**Enabling Local Composite Applications (.ca)**

By default, the UI elements that provide access to the new local composite application support will not be visible. They are filtered out with an Eclipse activity, as they are considered to be an advanced user feature. The CAE is considered a related component to the “New Composite Application” action so, even if you enable these actions, New Composite Application will only be present when CAE is installed as well.
Local composite application support can also be enabled by editing the `plugin_customization.ini` file for Notes. This file is located in the `<INSTALL_DIR>\framework\rcp` directory. Open the `plugin_customization.ini` file and add the following entry:

```
com.ibm.rcp.ca.utils/localCAenabled=true
```

## Backward compatibility

**Domino Server**

**Domino Document Manager 7.0 availability**

Domino Utility Server customers are still entitled to use Domino Document Manager 7.0, as outlined in the Domino License. However, Domino Document Manager 7.0 is only supported in conjunction with Domino Server 7.0.x.

You may still download Document Manager on Passport Advantage on-line, via one of the following e-Assemblies, depending on the language required:

<table>
<thead>
<tr>
<th>Assembly</th>
<th>Assembly Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CR322NA</td>
<td>IBM Lotus Domino Document Manager and Workflow 7.0 for Domino Utility Server 7.0.x  eAssembly English</td>
</tr>
<tr>
<td>CR3CPML</td>
<td>IBM Lotus Domino Document Manager and Workflow for Domino Utility Server 7.0.x  eAssembly (German, Spanish, French, Italian and Brazilian Portuguese)</td>
</tr>
<tr>
<td>CR3CQMNL</td>
<td>IBM Lotus Domino Document Manager and Workflow for Domino Utility Server 7.0.x  eAssembly (Japanese, Korean, Simplified and Traditional Chinese)</td>
</tr>
<tr>
<td>CR3P8ML</td>
<td>IBM Lotus Domino Document Manager for Domino Utility Server 7.0.x eAssembly Nordics (Danish, Finnish, Dutch, Norwegian, Swedish)</td>
</tr>
<tr>
<td>CR3P9ML</td>
<td>IBM Lotus Domino Document Manager for Domino Utility Server 7.0.x eAssembly (Hebrew, Russian, Polish)</td>
</tr>
</tbody>
</table>

You may still order physical media for Domino Document Manager by requesting any of the Domino Utility Server 7.0.x Media Packs; the most recent Media Packs for 7.0.3 are listed here for your convenience:

<table>
<thead>
<tr>
<th>Part number</th>
<th>Long Description</th>
<th>Languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>AH0T4EN</td>
<td>IBM Lotus Domino Utility Server Multi O/S 7.0.3 Media Pack English</td>
<td>English</td>
</tr>
<tr>
<td>AH0U4JA</td>
<td>IBM Lotus Domino Utility Server Multi O/S 7.0.3 Media Pack Japanese</td>
<td>Japanese</td>
</tr>
<tr>
<td>AH0U5ML</td>
<td>IBM Lotus Domino Utility Server Multi O/S 7.0.3 Media Pack (BP,ES,FR)</td>
<td>French, Portuguese, Brazilian, Spanish</td>
</tr>
<tr>
<td>AH0U6ML</td>
<td>IBM Lotus Domino Utility Server Multi O/S 7.0.3 Media Pack (CA,DE,IT)</td>
<td>Catalian, German, Italian</td>
</tr>
<tr>
<td>AH0U7KO</td>
<td>IBM Lotus Domino Utility Server Multi O/S 7.0.3 Media Pack Korean</td>
<td>Korean</td>
</tr>
<tr>
<td>AH0U8TC</td>
<td>IBM Lotus Domino Utility Server Multi O/S 7.0.3 Media Pack Trad Chinese</td>
<td>Chinese, Traditional</td>
</tr>
<tr>
<td>AH0U9SC</td>
<td>IBM Lotus Domino Utility Server Multi O/S 7.0.3 Media Pack Simp Chinese</td>
<td>Chinese, Simplified</td>
</tr>
<tr>
<td>AH0UATH</td>
<td>IBM Lotus Domino Utility Server Multi O/S 7.0.3 Media Pack Thai</td>
<td>Thai</td>
</tr>
</tbody>
</table>
Lotus Notes

**Group related Out-of-Office options removed in 8.0.1**

Out of Office exclusion options related to mail that is sent to or by groups has been removed in Notes 8.0.1 and future versions. For additional information, please see technote 1315515 at:

http://www.ibm.com/support/docview.wss?&uid=swg21315515

Domino Server

**Streaming cluster replication is off by default**

In Domino 8.0.2, streaming cluster replication is turned off by default. For more information, see the following technote:

http://www-1.ibm.com/support/docview.wss?rs=477&uid=swg21306074

**Product compatibility**

Domino Server

**Using Notes/Domino 8 with BlackBerry servers**

Please see the following technote for more information regarding BES (Blackberry Enterprise Server) support for Notes and Domino 8. When using Notes and Domino 8, you will want to make sure you are running a version of the BES that supports it.

http://www-1.ibm.com/support/docview.wss?uid=swg21266138
Installation, migration, upgrade, and configuration information

Hardware requirements

Lotus Notes, Domino Designer, Domino Server, Domino for System i, Domino for System z

Notes and Domino 8.0.2 hardware requirements
For a list of the Lotus Notes and Lotus Domino 8.0.2 hardware requirements for each supported platform, please see the release note titled "Notes and Domino 8.0.2 platforms and system requirements" in the 'Software requirements' section of this chapter.

Domino Server

Domino and DB2 - server requirements
The IBM Lotus Domino 8 Administrator documentation contains the topic "Supported platforms and hardware and software requirements."

Information regarding which releases of IBM DB2 are supported should be replaced with this information:

Server Domino/DB2 Supported DB2 Version:
  - DB2 Enterprise Server Ed 9.1 FP2 - Microsoft Windows 32-bit
  - DB2 Enterprise Server Ed 9.1 interim special build 2a - IBM AIX and Linux (SLES10 & RHEL5) 64-bit
  - DB2 Workgroup Server Ed 9.1 FP2 - Microsoft Windows 32 bit
  - DB2 Workgroup Server Ed 9.1 interim special build 2a - IBM AIX and Linux (SLES10 & RHEL5) 64-bit

Information pertaining to supported configurations should be replaced with this information:

Server Domino/DB2 Configurations:
  - Local configurations - DB2 and Domino installed on the same server
  - Remote configurations, same platform - DB2 and Domino reside on separate servers that are each running the same OS
  - Remote configurations, mixed platform - DB2 resides on an AIX or LINUX server, Domino resides on a Windows server

Note: Domino 64-bit is not a supported Domino and DB2 configuration.
Domino for System i

**System i: Server hardware requirements**

**System i requirements**

- IBM iSeries model 270 or 8xx servers or eServer i5 model 520 and above

  The following models are recommended:
  - iSeries 270, 810, 820, 825, 800-2464 and above
  - eServer i5 520-0901 and above
  - System i 9405-520 Express models and 9406-520 Value models **WITH** accelerator processor feature
  - System i 9407-515, 9406-520, 9406-525 and above

  The following models are NOT supported:
  - iSeries 800-2463
  - eServer i5 520-0900
  - System i 9405-520 Express models and 9406-520 Value models **WITHOUT** accelerator processor feature

**Note:** Although a Domino server can run on any POWER model, the iSeries and System i server models are optimized for client/server applications such as Domino. iSeries 270, 800-2464, 810-2465, and eServer i5 520-0901 and 520-0902 are recommended for Notes-based mail or light applications only. Partial processor models may not be suitable for compute-intensive applications; IBM eServer i5 520-0903 or higher are recommended for CPU-intensive workloads.

See the [System i Performance Capabilities Reference](http://publib.boulder.ibm.com/infocenter/iseries/v5r4/topic/books/sc410607.pdf) for more details on specific models.

See also [Upgrade Planning: i5/OS and OS/400 level mapping](http://www-304.ibm.com/jct01004c/systems/support/i/planning/upgrade/osmapping.html) for details about which releases of i5/OS or OS/400 are supported by each of the System i RISC models.

**Memory requirements**

- 512 MB or more minimum
- 512 MB or more per Domino server

**Disk requirements**

- 2GB of free space minimum.
- 4 or more drives recommended

Use these values as general guidelines for minimum memory and disk space. The requirements for your environment may be different. For more information about sizing System i for Domino, use the IBM Systems Workload Estimator. The Estimator is available at the following Web site:

Lotus Notes, Domino Server

**Tested Smartcard packages**

Smartcard functionality has only been tested under Win32-based operating systems. The following smartcard packages have been tested with this release of Notes/Domino, and indicated packages (*) have caveats listed below. Untested smartcards that include PKCS #11 libraries may work with this release of Notes/Domino. Entries left blank indicate functionality that has not been tested with this release.

<table>
<thead>
<tr>
<th>Smartcard Package</th>
<th>Lock ID with password equivalent on token</th>
<th>Lock ID With Key on Smartcard</th>
<th>Removing token will generate 'F5'-style logout</th>
<th>Use pre-loaded keys and X.509 certificates</th>
<th>Sign with RSA keys on token</th>
<th>Decrypt with RSA keys on the token</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActivClient 5.4</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>ActivClient 5.4 with CAC tokens</td>
<td>no (R/O token)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Aladdin eToken RTE 3.65</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>A-Trust a-sign Client v1.2.2.1 (*)</td>
<td>yes (7.02+)</td>
<td>yes</td>
<td>yes</td>
<td>yes (1536 bits)</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>Belgian eID v2.5.9 (*)</td>
<td>no (R/O token)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Datakey CIP 4.07 (*)</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Estonian eID (*)</td>
<td>no (R/O token)</td>
<td>no (*)</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Eutron CryptoIdentity Cryptokit 3.7.1</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>GemSafe Libraries 4.2.0 SP3 (*)</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
</tr>
<tr>
<td>IBM Embedded Security System with Client Security Software v6.01.0037.00</td>
<td>n/a</td>
<td>n/a</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Rainbow iKey 2032 SDK v4.7.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rainbow CryptoSwift eCommerce Server Accelerator PCI CS400 model 2.2.6a (*)</td>
<td>yes</td>
<td>yes</td>
<td>n/a</td>
<td>n/a</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Secude v5.6 (*)</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

**Smartcard Package Caveats:**

- The technique introduced in 7.0 to "Lock ID With Key on Smartcard" will be used with all tokens that support C_Sign for CKM_RSA_PKCS with input lengths up to k-11 bytes, in accordance with the PKCS#11 specification. New techniques for locking the ID file using a private RSA key on the smartcard were added in later releases for some tokens that do not support the full range of input lengths, and those tokens are marked with (version+) in the relevant columns of the above table. ID files locked with these new techniques can not be used by older versions of Notes/Domino; attempts to do so will result in an "Unsupported ID file version" error.
- Aladdin eToken RTE 3.65 has been tested with this release using eToken PRO USB 64k tokens and eToken NG-FLASH USB tokens.
• The Belgian eID was tested with run-time version 2.5.9, and we highly recommend that customers upgrade to the most recent version of the Belgian eID Run-time software. Users will receive redundant PIN prompts from the PKCS#11 library as well as Notes due to the token failing to set the CKF_PROTECTED_AUTHENTICATION_PATH token flag, but setting "allow_sso = false" in the Belgian eID configuration file beidbase.conf will eliminate the duplicate prompts. However, setting that variable and rebooting with the token in the reader may result in the PKCS#11 library hanging when first attempting to use the smartcard. This problem does not appear to occur when the ID file is locked with a key on the smartcard.

• The DataKey CIP 4.07 software installs multiple PKCS#11 libraries. dkck201.dll uses PKCS#11 v2.01 and has been tested successfully with Notes; dkck232.dll uses PKCS#11 v2.00 and does not work with Notes.

• The Estonian eID was tested with the PKCS#11 library from id-card-installer-0.7.exe (2/14/2006). Using this version of the library, the pre-loaded certificates could be imported into the ID file and used for S/MIME signing and decryption, but smartcard login was nonfunctional. It is possible that a newer version of the smartcard drivers will fix the token limitation that prevented the "Lock ID With Key on Smartcard" action from succeeding.

• The GemSafe Libraries 4.2 SP3 returns CKR_DEVICE_ERROR instead of CKR_TOKEN_NOT_PRESENT from C_GetTokenInfo when no token is in the reader. If Notes fails to automatically activate a workaround for this token bug, it may be necessary to manually set PKCS11_TOKEN_BUGS=128 in the notes.ini file. Due to the occasional failure of this token to report slot events, it may also be necessary to hit F5 and log out of Notes in order to force a PIN prompt when using keys on a smartcard when the ID file is not secured with that same smartcard.

• The Rainbow CryptoSwift eCommerce Server Accelerator fails to report that RSA cryptographic operations are performed in hardware. If you are having difficulty performing cryptographic operations (including importing X.509 certificates or exporting RSA keys) with this device, setting PKCS11_NO_HWCHECK=1 or PKCS11_TOKEN_BUGS=2 in the NOTES.INI file will activate a workaround in Notes/Domino for this problem.

• The Secude token cannot perform cryptographic operations with a number of smart card readers due to the high power demands of that token. Please confirm that your token readers are supported by Secude before deploying this package. If you are having difficulty signing S/MIME messages with a key on these smartcards and are using a supported token reader, setting PKCS11_TOKEN_BUGS=1 in the NOTES.INI file will activate a workaround in Notes that may fix this problem, and upgrading your Secude software may fix this problem.

Caveats and Warnings:

• An entry of "n/a" in the "Use pre-loaded keys and X.509 certificates" column does not necessarily indicate any incompatibility with the smartcard package, but simply means that we did not have a sample pre-loaded token to test against.

• Current versions of the Entrust CA create non-compliant PKCS#11 attributes for certificates and keys. Support for these keys and certs is limited; see "Problems using Entrust certificates on smartcards" in these release notes for more details.

• Read-only tokens, such as many national identity "eID" cards and Common Access Cards, can only be used to lock the ID file through the "Lock ID with Key on Smartcard" action, which was introduced in ND7. The "Enable Smartcard Login" action that was introduced in ND6 requires write access to the token.
The "Lock ID with Key on Smartcard" action will search all slots for the key needed to unlock the Notes ID file. Therefore, if a token is lost or locked out, a new token can be used with the old ID file, as long as the new token contains the exact same certificates and keys with the same key identifier (CKA_ID) attributes. However, if an ID file is smartcard-enabled using the "Enable Smartcard Login" option, then ID File Recovery must be used if the token is lost or locked out in order to revert the ID to a conventional password.

The only way to revert a smartcard-protected ID file to a conventional password is through ID File Recovery. ID File Recovery should be configured for an ID file before the ID file is smartcard-enabled. Recovering a smartcard-protected ID file will revert the ID file to use a password and will restore any keys that were pushed onto the smartcard from the ID file, as long as the recovery information was not changed after the key was pushed down to the smartcard.

Password expiration should be disabled in a user's person record before they smartcard-enable their ID file.

Password checking will result in only a single smartcard being usable with a given ID file, even across multiple computers or platforms. In this scenario, one copy of the ID file should be smartcard-enabled, and then that version of the ID file should be copied to all of the other respective computers. That single smartcard will now be required for all of the copies of the ID file.

Server setup will not function with a smartcard-protected server ID. In order to use a smartcard-protected ID with a server, finish server setup with a password-protected version of the ID file, then add the path to the PKCS #11 library in the server's NOTES.INI (PKCS11_Library=<path to library>), and finally smartcard-enable the server's ID file on a client or using the SECMANipulateSC C-API function.

Single Logon, which synchronizes the Notes and Windows passwords, cannot be used with a smartcard-protected ID file. You must restart Notes after disabling Single Logon before smartcard-enabling an ID file.

Notes uses version 2.01 of the PKCS #11 API to communicate with smartcards and other PKCS#11 devices. PKCS #11 libraries that only implement version 2.0 will not result in an "F5"-style logout when the card is removed from the reader. Updated libraries may be available from the smartcard vendors.

Sample PKCS #11 Library Install Paths:

- c:\WINNT\system32\acpkcs211.dll (ActivClient 5.4)
- c:\WINNT\system32\etpkcs11.dll (Aladdin eToken RTE 3.65)
- c:\WINNT\system32\asignp11.dll (A-Trust v1.2.2.1)
- c:\WINNT\system32\Belgium Identity Card PKCS11.dll (Belgian eID)
- c:\WINNT\system32\dkck201.dll (Datakey CIP 4.07)
- c:\WINNT\system32\opensc:pkcs11.dll (Estonian eID)
- c:\WINNT\system32\sadaptor.dll (Eutron Cryptoidentity CryptoKit 3.7.1)
- c:\Program Files\Gemplus\GemSafe Libraries Admin\BIN\gclib.dll (GemSafe Libraries 4.x)
- c:\Program Files\IBM ThinkVantage\Client Security Solution\csspkcs11.dll (IBM Client Security Software v6.01)
- c:\WINNT\system32\dkck201.dll (Rainbow iKey 2032)
- c:\WINNT\system32\Cryptoki22.dll (Rainbow CryptoSwift eCommerce Sever Accelerator)
- c:\Program Files\Common Files\SECUDE\itsecp11.dll (Secude v5.6)
Software requirements

Lotus Notes, Domino Designer, Domino Server, Domino for System i, Domino for System z

Notes and Domino 8.0.2 platforms and system requirements

The platforms and operating systems listed in the table below are applicable to the Lotus Notes 8.0.2 and Lotus Domino 8.0.2 release, and may not necessarily pertain to other Notes and Domino releases.

For Domino Web Access system requirements, please refer to the release note titled "Domino Web Access system requirements".

For web browsers supported, including Web Mail and the Domino Web Administrator, please refer to the release note titled "Web browsers supported".

Operating system patches, service packs, and other updates are not specified in the tables that follow. For the most recent information regarding updates, see the Lotus Knowledge Base online at http://www-3.ibm.com/software/lotus/support/ or contact your local Lotus Support representative.

Lotus Notes compatibility with Microsoft® Windows Vista™

For Lotus Notes 8.0 installation on a Windows Vista client, it was required that User Account Control (UAC) was turned OFF. That requirement was removed in release 8.0.1. When installing or upgrading Notes 8.0.1 or higher on a Windows Vista client, the UAC security setting should be enabled (UAC ON). For additional information, please see "Notes install/upgrade and directory changes for Vista and XP SP2" in the 'About this release' chapter of these release notes.

Notes Client

<table>
<thead>
<tr>
<th>Platform</th>
<th>Microsoft Windows</th>
<th>Linux (Notes client only)</th>
<th>Macintosh - (Notes client only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported operating system</td>
<td>Microsoft Windows XP Professional; Microsoft Windows XP for Tablet PC; Microsoft</td>
<td>SUSE Linux Enterprise Desktop (SLED) 10 XGL; RedHat</td>
<td>Macintosh OS 10.5.1 (see the &quot;Supported</td>
</tr>
<tr>
<td>versions</td>
<td>Windows Vista: Enterprise, Ultimate and Business Editions; Microsoft Windows Vista</td>
<td>Enterprise Linux (RHEL) 5.1 Desktop - Note: AIGLX</td>
<td>languages/locales for Notes on Macintosh&quot; Release Note for additional information)</td>
</tr>
<tr>
<td></td>
<td>for Tablet PC</td>
<td>and SELinux must be disabled</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(see the &quot;Windows system requirements&quot; Release Note for Service Pack information)</td>
<td>(see the &quot;Linux system requirements&quot; Release Note</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>for Service Pack information)</td>
<td></td>
</tr>
<tr>
<td>Processors supported</td>
<td>Intel Pentium or higher and compatibles, or equivalents</td>
<td>Intel Pentium or higher and compatibles, or</td>
<td>Notes Standard client - Intel</td>
</tr>
<tr>
<td></td>
<td>Windows XP - Pentium 4, 1.2GHz or higher Windows Vista - Pentium 4, 1.2GHz or</td>
<td>equivalents</td>
<td>Notes Basic client - Intel, PPC</td>
</tr>
<tr>
<td></td>
<td>higher</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Notes Client (cont'd)

<table>
<thead>
<tr>
<th>Platform</th>
<th>Microsoft Windows</th>
<th>Linux (Notes client only)</th>
<th>Macintosh (Notes client only)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RAM</strong></td>
<td>Windows XP - 512 MB minimum; 1 GB or more strongly recommended</td>
<td>512 MB minimum; 1 GB or more strongly recommended</td>
<td>512 MB minimum; 1 GB or more strongly recommended</td>
</tr>
<tr>
<td>(Additional memory requirements are subject to your operating system requirements)</td>
<td>Windows Vista - 1 GB minimum; 1.5 GB or more strongly recommended</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Disk space</strong></td>
<td>Install directory (C:) - 900 MB or more recommended</td>
<td>Install directory (/opt) - 1.5 GB minimum</td>
<td>Install directory (/Applications) - 1 GB or more recommended</td>
</tr>
<tr>
<td>(Minimum amounts are the disk space required for installing default files. More space is required if databases are replicated or copied locally)</td>
<td>(see the &quot;Notes installation directories&quot; Release Note for additional information)</td>
<td>(see the &quot;Notes installation directories&quot; Release Note for additional information)</td>
<td>(see the &quot;Notes installation directories&quot; Release Note for additional information)</td>
</tr>
<tr>
<td><strong>Video</strong></td>
<td>Hardware support for OpenGL</td>
<td>128 MB video RAM (with XGL-compatible video driver from hardware OEM for SLED 10)</td>
<td>32 MB video RAM or more recommended</td>
</tr>
<tr>
<td><strong>Monitors supported</strong></td>
<td>Color monitor required; 1024x768 screen resolution minimum</td>
<td>Color monitor required; 1024x768 screen resolution minimum</td>
<td>Color monitor required, 256 colors or greater; 1024x768 screen resolution minimum</td>
</tr>
<tr>
<td><strong>Protocols supported</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NetBIOS over NetBEUI</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>NetBIOS over IP&lt;sup&gt;(2)&lt;/sup&gt;</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>NetBIOS over IPX&lt;sup&gt;(3)&lt;/sup&gt;</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>SPX</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>SPX II</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Yes, IPV4 and IPV6</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>X.PC</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Citrix support information
The Notes Client is supported on Citrix Presentation Server 4.5, on Windows 2003 server, using ICA clients. For additional information, please see the "Citrix support statement" release note in this chapter.
**Domino Administrator Client, Domino Designer**

<table>
<thead>
<tr>
<th>Platform</th>
<th>Microsoft Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported operating system versions</td>
<td>Microsoft Windows XP Professional;</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows Vista: Enterprise, Ultimate</td>
</tr>
<tr>
<td></td>
<td>and Business Editions</td>
</tr>
<tr>
<td></td>
<td>(see the &quot;Windows system requirements&quot; Release Note for</td>
</tr>
<tr>
<td></td>
<td>Service Pack information)</td>
</tr>
<tr>
<td>Processors supported</td>
<td>Intel Pentium or higher and compatibles, or equivalents;</td>
</tr>
<tr>
<td></td>
<td>1.5 GHz or higher recommended</td>
</tr>
<tr>
<td>RAM</td>
<td>Windows XP - 512 MB minimum; 1 GB or more</td>
</tr>
<tr>
<td>(Additional memory requirements are</td>
<td>strongly recommended</td>
</tr>
<tr>
<td>subject to your operating system</td>
<td>Windows Vista - 1 GB minimum; 1.5 GB or more</td>
</tr>
<tr>
<td>requirements)</td>
<td>strongly recommended</td>
</tr>
<tr>
<td>Disk space</td>
<td>Install directory (C: ) - 960 MB minimum</td>
</tr>
<tr>
<td>(The minimum amounts are the disk space</td>
<td></td>
</tr>
<tr>
<td>required for installing default files.</td>
<td></td>
</tr>
<tr>
<td>More disk space is required if</td>
<td></td>
</tr>
<tr>
<td>databases are replicated locally or</td>
<td></td>
</tr>
<tr>
<td>copied locally)</td>
<td></td>
</tr>
<tr>
<td>Monitors supported</td>
<td>Color monitor required</td>
</tr>
</tbody>
</table>

**Protocols supported**

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetBIOS over NetBEUI</td>
<td>No</td>
</tr>
<tr>
<td>NetBIOS over IP(^{(2)})</td>
<td>Yes</td>
</tr>
<tr>
<td>NetBIOS over IPX(^{(3)})</td>
<td>Yes</td>
</tr>
<tr>
<td>SPX</td>
<td>No</td>
</tr>
<tr>
<td>SPX II</td>
<td>No</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Yes, IPV4 and IPV6</td>
</tr>
<tr>
<td>X.PC</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Footnotes**

1 System requirement information is provided for the Notes Standard client configuration only. Notes Basic client configuration system requirement information is the same as for Notes 7.0.x.

2 Only Microsoft TCP/IP is supported.

3 Both Novell NetBIOS and Microsoft NetBIOS over IPX are supported.
## 32-bit Domino Server\(^{(1)}\) - Table 1

<table>
<thead>
<tr>
<th>Platform</th>
<th>Microsoft Windows 2003</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processors supported</td>
<td>Intel Pentium or higher and compatibles (32-bit and 64-bit chips as appropriate), or equivalents</td>
</tr>
<tr>
<td>RAM</td>
<td>512 MB minimum 512 MB or more recommended per CPU</td>
</tr>
<tr>
<td>Disk space</td>
<td>1.5 GB minimum per partition</td>
</tr>
<tr>
<td>Disk swap space</td>
<td>2 times the physical RAM installed</td>
</tr>
<tr>
<td>Monitors supported</td>
<td>Color monitor required</td>
</tr>
<tr>
<td>Protocols supported</td>
<td></td>
</tr>
<tr>
<td>NetBIOS over NETBEUI</td>
<td>No</td>
</tr>
<tr>
<td>NetBIOS over IP(^{(2)})</td>
<td>Yes; No (64-bit)</td>
</tr>
<tr>
<td>NetBIOS over IPX</td>
<td>Yes; No (64-bit)</td>
</tr>
<tr>
<td>SPX(^{(3)})</td>
<td>No</td>
</tr>
<tr>
<td>SPX II</td>
<td>No</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Yes</td>
</tr>
<tr>
<td>TCP/IP IPV6</td>
<td>Yes</td>
</tr>
<tr>
<td>X.PC</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## 32-bit Domino Server (1) - Table 2

<table>
<thead>
<tr>
<th>Platform</th>
<th>IBM AIX</th>
<th>Linux</th>
<th>Sun Solaris</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported operating system versions</td>
<td>IBM AIX 5.3 (4) (64-bit kernel) IBM AIX 6.1 (4) (64-bit kernel) (see the &quot;AIX system requirements&quot; Release Note for Service Pack information)</td>
<td>Novell SUSE Linux Enterprise Server (SLES) 10 x86 (32-bit); Novell SUSE Linux Enterprise Server (SLES) 10 x86_64 (64-bit); Red Hat Enterprise Linux (RHEL) 5.0 and 5.1 (32-bit) <strong>Note:</strong> XGL and SE Linux must be disabled; Red Hat Enterprise Linux (RHEL) 5.0 and 5.1 (64-bit) <strong>Note:</strong> XGL and SE Linux must be disabled (see the &quot;Linux system requirements&quot; Release Note for Service Pack information)</td>
<td>Sun Solaris 10 (4) (64-bit kernel) (see the &quot;Solaris system requirements&quot; Release Note for Service Pack information)</td>
</tr>
<tr>
<td>Processors supported</td>
<td>PowerPC</td>
<td>Intel Pentium or higher and compatibles (32-bit and 64-bit chips as appropriate), or equivalents</td>
<td>UltraSPARC III and higher</td>
</tr>
<tr>
<td>RAM</td>
<td>512 MB minimum; 512 MB or more recommended per CPU</td>
<td>512 MB minimum; 512 MB or more recommended per CPU</td>
<td>512 MB minimum; 512 MB or more recommended per CPU</td>
</tr>
<tr>
<td>Disk space</td>
<td>1.5 GB minimum 1.5 GB or more recommended</td>
<td>1.5 GB minimum 1.5 GB or more recommended</td>
<td>1.5 GB minimum 1.5 GB or more recommended</td>
</tr>
<tr>
<td>Disk swap space</td>
<td>Same amount as physical memory required; recommend 2 times the physical RAM installed</td>
<td>2 times the physical RAM installed recommended</td>
<td>3 times the physical RAM recommended</td>
</tr>
<tr>
<td>Monitors supported</td>
<td>Any standard display (local or remote)</td>
<td>Any standard display (local or remote)</td>
<td>Any standard display (local or remote)</td>
</tr>
</tbody>
</table>
### 32-bit Domino Server - Table 2 (cont'd)

<table>
<thead>
<tr>
<th>Platform</th>
<th>IBM AIX</th>
<th>Linux</th>
<th>Sun Solaris</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocols supported</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NetBIOS</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>NetBIOS over IP[^2]</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>NetBIOS over IPX</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>SPX[^3]</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>SPX II</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>TCP/IP IPV6</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>X.PC</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
# 32-bit Domino Server (1) - Table 3

<table>
<thead>
<tr>
<th>Platform</th>
<th>IBM z/OS</th>
<th>Linux on System z</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported operating system versions</td>
<td>IBM z/OS Version 1, Release 7 or later; IBM z/OSef Version 1, Release 7 or later</td>
<td>Novell SUSE Linux Enterprise Server (SLES) 10 on System z (64-bit); Red Hat Enterprise Linux (RHEL) 5 on System z (64-bit) - Note: XGL and SELinux must be disabled (see the &quot;Linux system requirements&quot; Release Note for service pack information)</td>
</tr>
<tr>
<td>Processors supported</td>
<td>Any that supports your release level of z/OS</td>
<td>Any that supports your release level of Linux on System z</td>
</tr>
<tr>
<td>RAM</td>
<td>1 GB minimum; 2 GB or more recommended</td>
<td>1 GB minimum; 2 GB or more recommended</td>
</tr>
<tr>
<td>Disk space</td>
<td>3 3390-3 volumes minimum</td>
<td>2.5 GB minimum; 2.5 GB or more recommended</td>
</tr>
<tr>
<td>Disk swap space</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Monitors supported</td>
<td>Any standard display (local or remote)</td>
<td>Any standard display (local or remote)</td>
</tr>
<tr>
<td>Protocols supported</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NetBIOS</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>NetBIOS over IP (2)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>NetBIOS over IPX</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>SPX (3)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>SPX II</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>TCP/IP IPV6</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>X.PC</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
### 64-bit Domino Server - Table 1

<table>
<thead>
<tr>
<th>Platform</th>
<th>IBM AIX</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported operating system versions</td>
<td>64-bit IBM AIX 5.3 64-bit IBM AIX 6.1 (see the &quot;AIX system requirements&quot; Release Note for Service Pack information)</td>
<td>Microsoft Windows 2003 Server x64 Edition (see the &quot;Windows system requirements&quot; Release Note for Service Pack information)</td>
</tr>
<tr>
<td>Processors supported</td>
<td>PowerPC</td>
<td>Intel EMT64 or higher and compatibles, or equivalents</td>
</tr>
<tr>
<td>RAM</td>
<td>512 MB minimum; 512 MB or more recommended per CPU</td>
<td>512 MB minimum 512 MB or more recommended per CPU</td>
</tr>
<tr>
<td>Disk space</td>
<td>1.5 GB minimum 1.5 GB or more recommended</td>
<td>1.5 GB minimum per partition</td>
</tr>
<tr>
<td>Disk swap space</td>
<td>Same amount as physical memory required; recommend 2 times the physical RAM installed</td>
<td>2 times the physical RAM installed</td>
</tr>
<tr>
<td>Monitors supported</td>
<td>Any standard display (local or remote)</td>
<td>Color monitor required</td>
</tr>
</tbody>
</table>

#### Protocols supported

<table>
<thead>
<tr>
<th>Protocol</th>
<th>IBM AIX</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetBIOS</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>NetBIOS over IP&lt;sup&gt;(2)&lt;/sup&gt;</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>NetBIOS over IPX</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>SPX&lt;sup&gt;(3)&lt;/sup&gt;</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>SPX II</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>TCP/IP</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>TCP/IP IPV6</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>X.PC</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
### 64-bit Domino Server - Table 2

<table>
<thead>
<tr>
<th>Platform</th>
<th>IBM System i (4), (7)</th>
</tr>
</thead>
</table>
| Supported operating system versions | IBM i5/OS V5R4  
IBM i5/OS V6R1  
(see the "System i: i5/OS V5R4 Software requirements" and "System i: i5/OS V6R1 Software requirements" Release Notes for additional information) |
| Processors supported             | IBM iSeries model 270 or 8xx servers, or eServer i5 model 520 and above  
(see the "System i: Server hardware requirements" Release Notes for additional information) |
| RAM                              | 512 MB minimum; 512 MB or more per Domino server                                      |
| Disk space                       | 2 GB minimum; 4 or more drives recommended                                           |
| Disk swap space                  | N/A                                                                                   |
| Monitors supported               | Any standard display (local or remote)                                               |
| Protocols supported              |                                                                                      |
| NetBIOS                          | No                                                                                   |
| NetBIOS over IP                  | No                                                                                   |
| NetBIOS over IPX                 | No                                                                                   |
| SPX                              | No                                                                                   |
| SPX II                           | No                                                                                   |
| TCP/IP                           | Yes                                                                                   |
| TCP/IP IPV6                      | Yes                                                                                   |
| X.PC                             | No                                                                                   |

### Footnotes

1. If you are running with DB2 as the Domino datastore then you must add additional DB2 install requirements. DB2 9.1 is supported in the current release. NSFDB2 support is not available using Domino for System i. For additional install requirements, please see "Setting up and using Domino and DB2" in the Domino Administrator Help.
2. Only Microsoft TCP/IP is supported.
3. Domino clusters and partitioned server configurations do not support the IPX/SPX protocol. At this time, IBM does not plan to provide IPX/SPX network support for future releases of these features.
4. The 64-bit kernel must be installed and in use on these systems, even though the OS is 32-bit. The use of the 32-bit kernel is no longer supported on these platforms. Please see the OS vendor documentation for questions on enabling/using the 64-bit kernel. (On Solaris, the 64-bit kernel is used by default on supported hardware; this is not the case for AIX).
5. See "Domino 64-bit: Known issues" in these release notes for more information.
7. i5/OS only runs on 64-bit hardware and has been enabled for 64-bit for a long time. i5/OS also provides 128-bit pointer capability. This means that all software that runs on i5/OS, including Domino, is 64-bit capable and typically uses 128-bit pointers.
Domino Server

**Supported LDAP directory servers**
This release of Lotus Domino supports the use of the following LDAP directory servers:

- IBM Tivoli Directory Server 5.2 and 6.0
- Lotus Domino 6.5.x and 7.0.x
- Microsoft Windows Active Directory 2003, except on IBM i5/OS
- Sun Java System Directory Server 5.2, except on i5/OS

Lotus Notes, Domino Server

**Lotus Sametime servers and available features**
You must have a Sametime server to use the Sametime features in IBM Lotus Notes 8.0.2. Notes 8.0.2 Sametime features are supported with the Sametime 8.0 server. The following features are available:

- Text chat
- Rich Text Editor
- Emoticons
- Availability (on-line) status
- File transfers
- Screen captures
- Voice chat
- Video chat
- Telephone conference calls (telephony)
- Multiple communities
- Gateway communities
- Instant meetings
- Geographic location awareness
- Alert me whens
- Privacy lists
- Selective Do Not Disturb
- Announcements

All of the Sametime product documentation, including the IBM Lotus Sametime 8.0 Information Center, and the latest Release Notes, can be accessed from the IBM Lotus Sametime documentation page on Lotus developerWorks at:

www.ibm.com/developerworks/lotus/documentation/sametime
Domino for System i

**System i: i5/OS V5R4 Software requirements**

**Operating System Software**
The following System i i5/OS V5R4 software is required for Lotus Domino 8.0.2:

- IBM i5/OS™ V5R4
- PTF 5722SS1 SI24683 OSP-THREADS-PERFM FASTER THREAD LOCAL STORAGE ACCESS METHOD must be applied. Without the PTF applied the product will install, but virtually all Domino-related functions (WRKDOMSVR, CFGDOMSVR, UPDDOMSVR, and anything that performs a NotesInit API call) will fail with messages that may refer to a missing export from service program QLEAWI.

This PTF is available in V5R4 cumulative PTF package #7 - C6297540

- i5/OS - Host servers, 5722SS1 (option 12)
- TCP/IP Connectivity Utilities for i5/OS, 5722TC1
- IBM Developer Kit for Java, 5722JV1 (*BASE option)
- J2SE 5.0 32 bit, 5722JV1 (option 8, the default JDK used by Domino 8)
  - Java Developer Kit 5.0, 5722JV1 (option 7) may also be used if a Notes.ini variable is specified to override the default.

**Note 1:** Domino 8 defaults to use J2SE 5.0 32 bit (option 8). This is an upgrade from the version used in prior Domino releases.

**Note 2:** While the 5722JV1 option 8 JDK is recommended and the default for Domino 8, you can choose to use 5722JV1 option 7 by specifying JavaUseClassicJVM=1 in the server's Notes.INI file.

**Note 3:** If Option 8 is not installed and JavaUseClassicJVM=1 is not specified in the Notes.ini file, then a JVM load failure will occur when the HTTP task starts.

- i5/OS - Qshell, 5722SS1 (option 30)
- i5/OS - Portable App Solutions Environment, 5722SS1 (option 33)

If you plan to use Web services, you must also install the following software:

- 5722DG1 IBM HTTP Server for i5/OS

If you plan to manage your Domino environment using iSeries Navigator, the graphical user interface for managing System i, you must install the following additional software:

- IBM iSeries Access Base, 5722XW1
- IBM iSeries Access for Windows, 5722XE1

Refer to the release note "Domino administration using iSeries Navigator tasks on the Web" for additional software requirements and information on managing Domino servers from the Web.

Make sure you have the latest PTF levels applied on your system. Refer to the Preventive Service Planning (PSP) Web site for the latest cumulative, group and individual PTFs available for the release:

http://www-912.ibm.com/s_dir/sline003.nsf/sline003home
Domino software
- Lotus Domino 8.0.2 for System i (5733LD8) and options:
  - 5733LD8 *BASE - This is the base option of Domino 8; this option is required.
  - 5733LD8 option 1 - This contains the C API and related files. Installation of the C API is optional. If you want to run any application that uses the C API interfaces, you must install this software.

  **Note:** The C API option is not multi-version capable.

- 5733LD8 option 12 - This is the server option for Domino 8.0.2; this option is required.

After installing the *BASE option and options 1 and 11, the following will be displayed on the DSPSFWRSC panel:

<table>
<thead>
<tr>
<th>Resource ID</th>
<th>Option</th>
<th>Feature Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5733LD8</td>
<td>*BASE</td>
<td>Lotus Domino 8 (5724E62)</td>
</tr>
<tr>
<td>5733LD8</td>
<td>*BASE</td>
<td>Lotus Domino 8 (5724E62)</td>
</tr>
<tr>
<td>5733LD8</td>
<td>1</td>
<td>Lotus Domino 8: C API</td>
</tr>
<tr>
<td>5733LD8</td>
<td>12</td>
<td>Lotus Domino 8: Release 8.0.2</td>
</tr>
<tr>
<td>5733LD8</td>
<td>12</td>
<td>Lotus Domino 8: Release 8.0.2</td>
</tr>
</tbody>
</table>

The Resource ID "5733LD8" is the i5/OS installed licensed program (LICPGM) value and the text ",(5724E62)" that follows the Description is the IBM Lotus Passport Advantage product ID. While both values may be used to refer to the Lotus Domino 8 product, the 5733LD8 LICPGM value is specific to System i and i5/OS.

Additional PTF Requirements
The following V5R4 PTFs are required if you SAVE Domino on a V6R1 system and restore it back onto a V5R4 system.

- PTF 5722SS1 SI27294 JVA-INCORROUT JAVA PROGRAM RESTORE FROM FUTURE RELEASE FAILS
- PTF 5722999 MF40520 LIC-MSCPF3888 *PGM, *SRVPGM AND *MODULE RESTORE FROM FUTURE

Limitations
Refer to the release note "Features not available with Domino 8 for System i" for details regarding features that are not available with Domino 8.0.2 on System i.

C and C++ Application Requirements
Any applications that use the Domino C or C++ API on i5/OS need to be reviewed to make sure they are properly enabled for use with Domino on i5/OS. There are two important considerations. See the Release note "Enable C/C++ Applications for 64-bit support on System i" for more information.
Domino for System i

**System i: i5/OS V6R1 Software requirements**
The following software is required if you choose to run Domino 8.0.2 Server for System i on i5/OS V6R1. Refer also to the resources listed below before installing Domino 8.0.2 on V6R1 or upgrading to V6R1 with Domino already installed.

**Release note:**

**System i: Installing Domino 8.0.2 with i5/OS V6R1** for instructions on Domino installation with V6R1 and program conversion impacts.

**Web page:**

**Support for Lotus Domino and related products on i5/OS V6R1** (http://www.ibm.com/systems/i/software/domino/support/v6r1.html) for the latest information on product support.

**HELP:**

**Installing and Managing Domino 8 for System i** (http://www.ibm.com/developerworks/lotus/documentation/domino/ and also contained with the Domino 8 product CD or Web kit as i400HELP) for detailed information on Domino installation and administration.

- IBM i5/OS™ V6R1
- i5/OS - Host servers, 5761SS1 (option 12)
- TCP/IP Connectivity Utilities for i5/OS, 5761TC1
- IBM Developer Kit for Java, 5761JV1 (*BASE option)
- J2SE 5.0 32 bit, 5761JV1 (option 8, the default JDK used by Domino 8)
  - Java Developer Kit 5.0, 5761JV1 (option 7) may also be used if a Notes.ini variable is specified to override the default.

**Note 1:** Domino 8 defaults to use J2SE 5.0 32 bit (option 8). This is an upgrade from the version used in prior Domino releases.

**Note 2:** While the 5761JV1 option 8 JDK is recommended and the default for Domino 8, you can choose to use 5761JV1 option 7 by specifying JavaUseClassicJVM=1 in the server's Notes.INI file.

**Note 3:** If Option 8 is not installed and JavaUseClassicJVM=1 is not specified in the Notes.ini file, then a JVM load failure will occur when the HTTP task starts.

- i5/OS - Qshell, 5761SS1 (option 30)
- i5/OS - Portable App Solutions Environment, 5761SS1 (option 33)

If you plan to use Web services, you must also install the following software:

- 5761DG1 IBM HTTP Server for i5/OS

If you plan to manage your Domino environment using System i Navigator, the graphical user interface for managing System i, you must install the following additional software:

- IBM System i Access Family (*BASE option), 5761XW1
- IBM System i Access for Windows, 5761XE1
- Latest System i Navigator service pack available (http://www-03.ibm.com/systems/i/software/access/windows/casp.html)
Refer to the release note Domino administration using System i Navigator tasks on the Web for additional software requirements and information on managing Domino servers from the Web.

Make sure you have the latest PTF levels applied on your system. Refer to the Preventive Service Planning (PSP) Web site for the latest cumulative, group and individual PTFs available for the release:

http://www-912.ibm.com/s_dir/sline003.nsf/sline003home

Note: The latest cumulative, group and individual PTFs are not available until V6R1 general availability.

Domino software
- Lotus Domino 8.0.2 for System i (5733LD8) and options:
  - 5733LD8 *BASE - This is the base option of Domino 8; this option is required.
  - 5733LD8 option 1 - This contains the C API and related files. Installation of the C API is optional. If you want to run any application that uses the C API interfaces, you must install this software.
    
    Note: The C API option is not multi-version capable.
  - 5733LD8 option 12 - This is the server option for Domino 8.0.2; this option is required.

After installing the *BASE option and options 1 and 11, the following will be displayed on the DSPSFWRSC panel:

<table>
<thead>
<tr>
<th>Resource ID</th>
<th>Option</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5733LD8</td>
<td>*BASE</td>
<td>5050</td>
<td>Lotus Domino 8 (5724E62)</td>
</tr>
<tr>
<td>5733LD8</td>
<td>*BASE</td>
<td>2924</td>
<td>Lotus Domino 8 (5724E62)</td>
</tr>
<tr>
<td>5733LD8</td>
<td>1</td>
<td>5050</td>
<td>Lotus Domino 8: C API</td>
</tr>
<tr>
<td>5733LD8</td>
<td>12</td>
<td>5050</td>
<td>Lotus Domino 8: Release 8.0.2</td>
</tr>
<tr>
<td>5733LD8</td>
<td>12</td>
<td>2924</td>
<td>Lotus Domino 8: Release 8.0.2</td>
</tr>
</tbody>
</table>

The Resource ID "5733LD8" is the i5/OS installed licensed program (LICPGM) value and the text "(5724E62)" that follows the Description is the IBM Lotus Passport Advantage product ID. While both values may be used to refer to the Lotus Domino 8 product, the 5733LD8 LICPGM value is specific to System i and i5/OS.

Limitations
Refer to the release note "Features not available with Domino 8 for System i" for details regarding features that are not available with Domino 8.0.2 on System i.

C and C++ Application Requirements
Any applications that use the Domino C or C++ API on i5/OS need to be reviewed to make sure they are properly enabled for use with Domino on i5/OS. There are two important considerations. See the Release note "Enable C/C++ Applications for 64-bit support on System i" for more information.
System i: IBM HTTP Server plug-in for Domino

This release note lists the software and PTFs required to use the IBM HTTP Server plug-in with Domino 8.0.x and i5/OS V5R4 or i5/OS V6R1.

**Required software**
The following are the software requirements for the IBM HTTP Server plug-in for Domino:

<table>
<thead>
<tr>
<th></th>
<th>5722SS1 - i5/OS V5R4 with latest PTFs applied</th>
<th>5761SS1 - i5/OS V6R1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HTTP Server</strong></td>
<td>5722DG1 - IBM HTTP Server for i5/OS</td>
<td>5761DG1 - IBM HTTP Server for i5/OS</td>
</tr>
<tr>
<td><strong>HTTP Group PTF</strong></td>
<td>SI99114</td>
<td>n/a</td>
</tr>
<tr>
<td><strong>Individual PTFs</strong></td>
<td>SI19429 - Domino plug-in for HTTP server (powered by Apache). Included in Group PTF</td>
<td>n/a</td>
</tr>
</tbody>
</table>

The latest group and cumulative PTFs should always be applied.

To check the HTTP Server PTF level on V5R4, enter the following on an i5/OS command line:

```
DSPPTF 5722DG1
```

**Note** There may be additional updates to these PTF requirements. For the latest information, see the Web page:

```
http://www.ibm.com/systems/i/software/domino/apachedom/
```

For more information about using the HTTP Server (powered by Apache) to forward HTTP traffic to Domino servers, refer to Chapter 16 Using IBM HTTP Server with Domino in the "Domino 8 for System i Help (Installing and Managing Guide)" at:

```
```

System i and IBM Tivoli License Compliance Manager 2.2

The IBM Tivoli License Compliance Manager, version 2.2 fixpack 2.2.0-TIV-TLCM-FP0001 and PTF 22F0001 provides license management support for i5/OS V5R4. Complete details can be found at the following Web site:

```
http://www-1.ibm.com/support/docview.wss?uid=swg24012719
```
Domino for System i

**System i: Features not available with Domino 8**
The following features are not available with Domino 8.0.x for System i:

- DB2 datastore and related Query View and Domino Access View capabilities
- Integration with and forwarding events to the Tivoli Enterprise console
- Domino-Portal Integration (DPI) Wizard is not available with Domino 8. Refer to the Portal 6.1 InfoCenter (http://infocenters.lotus.com/help5/index.jsp) for information about support in later releases.
- Activities server. To use Activities with Notes 8, the Activities server must be deployed to a supported platform. Refer to the Lotus Connections documentation for more information on Activities server configuration options and deployment.
- The feature **Fault Recovery restart in less than 30 seconds with Full NSD**
- IPV6 support with i5/OS varies depending on the release, as indicated in the table below:

<table>
<thead>
<tr>
<th>Feature</th>
<th>i5/OS V5R4</th>
<th>i5/OS V6R1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domino server configuration (*)</td>
<td>PV4 / IPV6</td>
<td>PV4 &amp; IPV6</td>
</tr>
<tr>
<td>iSeries Navigator and iSeries Navigator Tasks on the Web</td>
<td>PV4 only</td>
<td>PV4 &amp; IPV6</td>
</tr>
<tr>
<td>HTTP (Apache) Plugin</td>
<td>PV4 only</td>
<td>PV4 &amp; IPV6</td>
</tr>
<tr>
<td>FTP</td>
<td>PV4 only</td>
<td>PV4 &amp; IPV6</td>
</tr>
<tr>
<td>Java console</td>
<td>PV4 only</td>
<td>PV4 &amp; IPV6</td>
</tr>
</tbody>
</table>

(*) You can configure a Domino server to communicate using IPV6 using the CFGDOMSVR CL command or configuration wizard (domwzd).

- Domino 8 does not support the batch installation feature using the LODRUN command with physical media. The OS400/INTLENG/BATCH directory files were removed from the CD when the Domino product grew to require a second CD for installation.
- iSeries Cluster Enabled Domino is not available. For more information on System i High Availability (HA); see http://www.ibm.com/eserver/iseries/ha/
- xSP hosting has been removed. If the CFGDOMSVR or CHGDOMSVR commands specify XSP(*YES), the setting is ignored.
- SNMP Agent

Domino for System z

**System z: Domino on z/OS now requires Perl**
Domino on z/OS now requires that Perl is installed on your system. The minimum level of Perl required is version 5.8.7. You can check your Perl version by issuing a "perl -v" command from a USS command line. If you install Perl manually, it is preferable to have it installed in /usr/lpp/perl.
Domino Server, Domino for System z

**System z: DB2 requirements for LS:DO, LCLSX and DECS**
Following are the z/OS Enterprise Integration requirements (LS:DO, DECS, LCLSX).

- DB2 ODBC must use the DB2 for OS/390 and z/OS Recoverable Resource Manager Services attachment facility (RRSAF). The following settings are required:
  1. Enable RRSAF on the db2 side
  2. Specify MVSATTACHTYPE=RRSAF in the subsystem section of the DSNAOINI file.
     - Any Stored Procedure must be defined to use RRSAF.
  3. Specify MULTICONTEXT=1 in the common section of the DSNAOINI file.

- If running DB2 8, install the following PTF:
  DB2 PTF AQ91824

Domino Web Access

**Domino Web Access system requirements**

**Client Hardware Requirements**

- **Recommended for better performance**:
  - Windows -- Pentium IV 1.5 GHz with 512 MB of memory
  - Linux -- Pentium IV 1.5 GHz with 512 MB of memory
  - Macintosh -- G4 1.5 GHz with 512 MB of memory

- **Minimum requirements**:
  - Windows -- Pentium III 800 MHz with 256 MB of memory
  - Linux -- Pentium III 800 MHz with 256 MB of memory
  - Macintosh -- G4 1 GHz 256 MB of memory

**Client Operating Systems and Supported Browsers**

Domino Web Access runs on the following client operating systems:

- Windows XP and Vista using the following browsers:
  - Internet Explorer 6 and 7
  - Mozilla Firefox 2.0.x

- Novell Linux Desktop (NLD) 10 using the following browsers:
  - Mozilla Firefox 2.0.x

- RedHat Enterprise Linux Desktop 5.0 using the following browsers:
  - Mozilla Firefox 2.0.x

- Macintosh OS 10.4.x and 10.5 using the following browsers:
  - Mozilla Firefox 2.0.x -- **Note:** Does not support Domino Off-Line Services (DOLS), local archiving, and Lotus Sametime awareness

- Citrix Presentation Server 4.5 on Windows 2003
  - Clients using the Citrix Presentation Server 4.5 on Windows 2003 server, using ICA. Citrix ICA stands for Citrix® Independent Computing Architecture. It is the "thin" protocol that enables Citrix to separate screen updates and user input processing from the rest of the application’s logic. When using a Citrix ICA client, all application logic executes on the server and only screen updates, mouse movements and keystrokes are transmitted via the Citrix ICA session. **Note:** Does not support Domino Off-Line Services (DOLS).
Browser Support Notes

- Mozilla Firefox is supported by the DWA7 and MAIL8 mail templates only, it is not supported by iNotes6 templates.
- Attempting to access Domino Web Access through unsupported browsers results in the display of an unsupported browser notice. Netscape 4.x users may see hangs and/or crashes when encountering the Domino Web Access unsupported browser page. If you are a Netscape 4.x user and you encounter these problems, you should open your mail file using the WebMail UI directly through the &ui=webmail switch. This is documented in the topic “Switching to WebMail” in the Domino Web Access help.
- Domino Web Access will not work if JavaScript is disabled or if session cookies are disabled.

Server Requirements

See "Notes and Domino 8.0.2 platforms and system requirements" in these Release Notes for a complete list of server operating systems and requirements.

Certified Proxy Servers

- SunOne Portal Server 6.2
- IBM WebSphere Edge Server 2.0.2 efix 49
- Tivoli Access Manager 6.0

Adobe Acrobat

Adobe Acrobat Reader, Version 4.0 or higher to print calendars.

DECS: supported platforms and data drivers

Supported IBM Lotus Connector data driver versions for Domino Enterprise Connection Services (DECS) are listed below. IBM Lotus Enterprise Integrator (LEI) data driver information continues to be supplied in the LEI readme.txt file at http://www.ibm.com/developerworks/lotus/documentation/lei.

DECS/LEI with 32-bit Domino server

DECS and LEI are supported with 32-bit versions of Domino on the following platforms:

- Windows 2003 32-bit
- Windows 2003 64-bit
- AIX 5.3 64-bit
- Solaris 10
- RedHat Linux Enterprise Server 5.0 32-bit
- RedHat Linux Enterprise Server 5.0 64-bit
- SUSE Linux Enterprise Server 10 (SLES10) 32-bit
- SUSE Linux Enterprise Server 10 (SLES10) 64-bit

DECS/LEI with 64-bit Domino server

DECS and LEI are supported with 64-bit versions of Domino on the following platforms.

- Windows 2003 64-bit

DECS only

- z/OS 1.7
- Linux for System z - RedHat Enterprise Linux (RHEL) Server 5 on System z 64-bit
- Linux for System z - SUSE Linux Enterprise Server (SLES) 10 on System z 64-bit
DECS/LEI on System i

- i5/OS V5R4
- i5/OS V6R1 (*)

* - Before installing or running Domino DECS or LEI 8.0.1 on i5/OS V6R1, please refer to the "Support for Lotus Domino and related products on i5/OS V6R1" Web page for information at support details at http://www.ibm.com/systems/i/software/domino/support/v6r1.html.

Connector data drivers

Supported Lotus Connector data driver versions relative to the above bit specifications, are listed below.

**Note:** DataDirect ODBC drivers can be used with the Lotus Connector for ODBC. These include the DataDirect Sybase, Oracle, Informix, DB2, and SQL Server ODBC wire protocols. LEI and DECS support the supplied Lotus-branded DataDirect ODBC driver. LEI and DECS recommend using the Lotus-branded DataDirect ODBC Wire Protocol drivers.

**Windows 2003 Server and Server Enterprise Edition**

- Oracle 9i and 10g
- DB2 v8.2.2, 9.1 and DB2 Universal Database for iSeries (System i)
- Sybase 15
- MS SQL Server 2000 and 2005
- DataDirect ODBC 5.2

**AIX 5.3**

- Oracle 9i and 10g
- DB2 v8.2.2, 9.1 (must be aix power 4 or higher for DB2 9.1) and DB2 Universal Database for iSeries (System i)
- Sybase 15
- DataDirect ODBC 5.2

**Solaris 10**

- Oracle 9i and 10g
- DB2 v8.2.2, 9.1 and DB2 Universal Database for iSeries (System i)
- Sybase 15
- DataDirect ODBC 5.2

**RedHat Linux Enterprise Server 5**

- Oracle 9i and 10g
- DB2 v8.2.2, 9.1 and DB2 Universal Database for iSeries (System i)
- DataDirect ODBC 5.2

**Novell SuSE Linux Enterprise Server (SLES) 10**

- Oracle 9i and 10g
- DB2 v8.2.2, 9.1 and DB2 Universal Database for iSeries (System i)
- DataDirect ODBC 5.2

**System i, i5/OS V5R4 and V6R1**

- DataDirect ODBC 5.2 (32-bit version)
- DB2 Universal Database for iSeries (System i)
Lotus Notes

Citrix support statement
The Notes Client (Basic Configuration), and Domino Web Access, are supported on Citrix Presentation Server 4.5 on Windows 2003 server, using ICA\(^1\) clients.

\(^1\)Citrix ICA stands for Citrix® Independent Computing Architecture. It is the "thin" protocol that enables Citrix to separate screen updates and user input processing from the rest of the application's logic. When using a Citrix ICA client, all application logic executes on the server and only screen updates, mouse movements and keystrokes are transmitted via the Citrix ICA session.

Lotus Notes

Supported languages/locales for Notes on Macintosh
Following are the supported languages/locales for Notes 8.0.2 on Macintosh:

<table>
<thead>
<tr>
<th>Language</th>
<th>Translated?</th>
<th>Basic Support by Locale (Country/Region)</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>No</td>
<td>Australia, Belgium, Canada, Hong Kong S.A.R., China, India, Ireland, Ireland (pre-Euro), New Zealand, Philippines, Republic of South Africa, Singapore, United Kingdom, United States</td>
</tr>
<tr>
<td>French</td>
<td>Yes</td>
<td>Belgium, Canada, France, Luxembourg, Switzerland</td>
</tr>
<tr>
<td>German</td>
<td>Yes</td>
<td>Austria, Germany, Luxembourg, Switzerland</td>
</tr>
<tr>
<td>Italian</td>
<td>No</td>
<td>Italy, Switzerland</td>
</tr>
<tr>
<td>Japanese</td>
<td>Yes</td>
<td>Japan</td>
</tr>
<tr>
<td>Language</td>
<td>Translated?</td>
<td>Basic Support by Locale (Country/Region)</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Portuguese (Brazilian)</td>
<td>No</td>
<td>Brazil</td>
</tr>
<tr>
<td>Spanish</td>
<td>No</td>
<td>Argentina, Bolivia, Chile, Colombia, Costa Rica, Dominican Republic, Ecuador, El Salvador, Guatemala, Honduras, Mexico, Nicaragua, Panama, Paraguay, Peru, Puerto Rico, Spain, United States, Uruguay, Venezuela</td>
</tr>
<tr>
<td>Danish</td>
<td>No</td>
<td>Denmark</td>
</tr>
<tr>
<td>Dutch</td>
<td>No</td>
<td>Belgium, Netherlands</td>
</tr>
<tr>
<td>Norwegian-Bokmal</td>
<td>No</td>
<td>Norway</td>
</tr>
<tr>
<td>Portuguese</td>
<td>No</td>
<td>Portugal</td>
</tr>
<tr>
<td>Swedish</td>
<td>No</td>
<td>Sweden</td>
</tr>
</tbody>
</table>

**Domino Server**

**AIX system requirements**

The following AIX patch levels are required for Domino 8.x:

**32-bit Domino Server - AIX 5.3**

ML05 or higher

xlC.rte 8.0.0.5 or higher

**32-bit Domino Server - AIX 6.1**

Service Pack 1

APAR IZ10223

APAR IZ09961

APAR IZ10284

APAR IZ08022
IBM Lotus Notes, Domino, Domino Designer 8.0.2

64-bit Domino Server - AIX 5.3
ML05 or higher
xicr.rete 8.0.0.5 or higher

64-bit Domino Server - AIX 6.1
Service Pack 1
APAR IZ10223
APAR IZ09961
APAR IZ10284
APAR IZ08022

Lotus Notes, Domino Server

Linux system requirements

Notes client
Before installing Notes 8.0.x on a Linux client, you must install a Mozilla GTK2 Web browser. The client requires a Mozilla 1.8-based application (Firefox/XULRunner/Seamonkey) and will not support the earlier beta requirement of Mozilla 1.7.12.

For Notes 8.0.x, it is recommended that the latest updates for SLED 10 are installed. At a minimum, the latest versions of the following subsystems are required:

```
metacity
compiz
xgl
```

The following packages are required for client feature support on xSeries (32/64-bit OS) SLED 10:

```
alsa-32bit-1.0.11-32.2
atk-32bit-1.10.3-15.2
audiofile-32bit-0.2.6-17.2
cairo-32bit-1.0.2-27.4
compat-libstdc++-5.0.7-22.2
cups-libs-32bit-1.1.23-40.6
dbus-1-32bit-0.60-33.2
dbus-1-glib-32bit-0.60-33.2
esound-32bit-0.2.36-19.4
expat-32bit-2.0.0-13.2
fontconfig-32bit-2.3.94-18.5
freetype2-32bit-2.1.10-18.5
gconf2-32bit-2.12.1-27.2
glib-32bit-1.2.10-609.2
glib2-32bit-2.8.5-21.2
glibc-32bit-2.4-31.2
glitz-32bit-0.4.4-21.2
 gnome-vfs2-32bit-2.12.2-58.10
gtk-32bit-1.2.10-907.2
hal-32bit-0.5.6-33.10
libart_lgpl-32bit-2.3.17-17.2
libbonobo-32bit-2.10.1-24.4
libc-1-0.1-28.4
libgnome-32bit-2.12.0.1-26.6
libgnomecanvas-32bit-2.12.0-19.2
libgnomeprint-32bit-2.12.1-20.6
libgnomeprintui-32bit-2.12.1-20.2
```
The following packages are required for client feature support on xSeries (32/64-bit OS) RHEL 5 Desktop. 

Note: If there is no comparable patch available for RHEL, there is no need to apply one.

alsa-lib-1.0.12-3.el5
atk-1.12.2-1.fc6
audiofile-0.2.6-5
audit-libs-1.3.1-1.el5
avahi-0.6.16-1.el5
avahi-glib-0.6.16-1.el5
cairo-1.2.4-1.fc6
compat-libstdc++-33-3.2.3-61
cups-libs-1.2.4-11.5.el5
dbus-1.0.0-6.el5
dbus-glib-0.70-5
e2fsprogs-libs-1.39-8.el5
eel2-2.16.1-1.el5
esound-0.2.36-3
expat-1.95.8-8.2.1
fontconfig-2.4.1-6.el5
gail-1.9.2-1.fc6
gamin-0.1.7-8.el5
GConf2-2.14.0-9.el5
glib2-2.12.3-2.fc6
glibc-2.5-12
gnome-desktop-2.16.0-1.fc6
gnome-keyring-0.6.0-1.fc6
gnome-menus-2.16.0-2.fc6
gnome-vfs2-2.16.2-4.el5
gnutls-1.4.1-2
gtk2-2.10.4-16.el5
krb5-libs-1.5-17
libart_lgpl-2.3.17-4
libbonobo-2.16.0-1.fc6
libbonoboui-2.16.0-1.fc6
libcap-1.10-26
libgcc-4.1.1-52.el5
libgcrypt-1.2.3-1
libglade2-2.6.0-2
libgnome-2.16.0-6.el5
libgnomecanvas-2.14.0-4.1
libgnomeprint22-2.12.1-9.el5
libgnomeprintui22-2.12.1-6
libgnomeui-2.16.0-5.el5
libgpg-error-1.4-2
libICE-1.0.1-2.1
libjpeg-6b-37
libpng-1.2.10-7
libselinux-1.33.4-2.el5
libsepol-1.15.2-1.el5
libSM-1.0.1-3.1
libstdc++-4.1.1-52.el5
libX11-1.0.3-8.el5
libXau-1.0.1-3.1
libXcursor-1.1.7-1.1
libXdmcpr-1.0.1-2.1
libXext-1.0.1-2.1
libXfixes-4.0.1-2.1
libXft-2.1.10-1.1
libX11-1.0.1-3.1
libXinerama-1.0.1-2.1
libxml2-2.6.26-21.2
libXrender-0.9.1-3.1
libXt-1.0.2-3.1.fc6
openssl-0.9.8b-8.3.el5
ORBit2-2.14.3-4.el5
pam-0.99.6.2-3.14.el5
pango-1.14.9-3.el5
popt-1.10.2-37.el5
startup-notification-0.8-4.1
zlib-1.2.3-3

domino server
the following packages are required for server support on xSeries (32/64-bit) /System z (64-bit) SLES 10 (equivalent required for RHEL 5 - which may mean additional RPMs including compatible RPMs)*:
glibc-32bit-2.4-31.2
libgcc-4.1.0-28.4
libstdc++-4.1.0-28.4

in addition, due to Java, the following packages are required for the server (some may not be needed on System z (64-bit))*:
alsa-32bit-1.0.11-32.2
atk-32bit-1.10.3-15.2
cairo-32bit-1.0.2-27.4
compat-libstdc++-5.0.7-22.2
expat-32bit-2.0.0-13.2
fontconfig-32bit-2.3.94-18.5
freetype2-32bit-2.1.10-18.5
glib-32bit-1.2.10-609.2
glib2-32bit-2.8.5-21.2
glibc-32bit-2.4-31.2
glitz-32bit-0.4.4-21.2
gtk-32bit-1.2.10-907.2
libgcc-4.1.0-28.4
libpng-32bit-1.2.8-19.2
pango-32bit-1.10.2-23.2
resmgr-32bit-0.9.8_SVNr75-18.4
unixODBC-32bit-2.2.11-21.4
xorg-x11-libs-32bit-6.9.0-50.14
zlib-32bit-1.2.3-15.2

* These names are from the library dependency lists on a SLES 10 64bit xSeries system, which is why some of the RPMs say "32bit" in their name. The names may change slightly if you are running any other version of Linux, but the "gist" remains the same: you need the given package (such as libstdc++) and the given level (4.1.0). Sometimes a higher level is OK, but other times you need the given level or a compatible level (C++ is an example where you need the given level or compatible RPM, like compat-libstdc++-5). For example, on RHEL 5 you need compat-libstdc++-33 and compat-libstdc++-296 to get the correct C++ level of libraries for both Java and Domino. If there is no comparable patch available for RHEL, for example, then you should be ok with not applying the patch/package.

Lotus Notes, Domino Server

**SELinux is not supported**

SELinux is not supported for this release of Domino. Since RHEL5 enables SELinux by default, you will need to disable it; failure to do so will result in operational issues with both the client and server.

Domino for System z

**Linux for System z: 64-bit DB2 requirements**

If using LS:DO, LC LSX, or DECS with Domino on Red Hat Enterprise Linux (RHEL) 5, on System z (64-bit), the following two packages need to be installed:

- compat-libstdc++-33-3.2.3-61.s390x.rpm
- libXp-1.0.0-8.s390x.rpm

Domino for System z

**Linux for System z: GNU debugger needed**

When using RedHat Enterprise Linux (RHEL) 5 on System z (64-bit), in order to collect stack information, the GNU debugger (gdb) needs to be installed. It should be installed under the directory /usr/bin. Ensure the Domino server ID has permission to execute /usr/bin/gdb.


Domino Server

**Solaris system requirements**

The following Solaris patch level is required for Domino 8.0.x:

**Solaris 10**

March 2006 patch cluster or higher
Lotus Notes, Domino Designer, Domino Server

**Windows system requirements**
Lotus Notes 8.0.2 and Lotus Domino 8.0.2 are initially supported on Windows platforms listed in the "Notes Domino 8.0.2 platforms and system requirements" release note with the application of the Service Packs listed below. Although individual operating system patches and Service Packs are not certified, IBM/Lotus realizes that there are later service packs that may become publicly available after testing, and acknowledges that these more recent updates may fix additional problems. You may wish to apply these newer service packs as they become available.

You can obtain and install the following patches from Microsoft Corporation or download them from Microsoft's Web site:
http://www.microsoft.com/downloads

**Notes Client, Domino Designer, and Domino Administrator Clients:**
- Windows XP Professional: Service Pack 2

**32-bit Domino Server**

**64-bit Domino Server**
- Windows 2003 Server x64 Edition: Service Pack 2 (64-bit)

Lotus Notes, Domino Server

**Web browsers supported**
The following are the Web browsers supported, by application:

<table>
<thead>
<tr>
<th>Application</th>
<th>Browsers supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes Client¹</td>
<td>- Microsoft Internet Explorer 6.x, 7.x (Windows platforms only)</td>
</tr>
<tr>
<td></td>
<td>- Mozilla Firefox 1.5.x, 2.0 on Windows XP Professional</td>
</tr>
<tr>
<td></td>
<td>- Mozilla Firefox 1.5.x, 2.0 on RHEL 5 Desktop</td>
</tr>
<tr>
<td></td>
<td>- Mozilla 1.8 on SLED 10 XGL²</td>
</tr>
<tr>
<td>Web Mail and Web-enabled templates</td>
<td>- Microsoft Internet Explorer 6.x, 7.x (Windows platforms only)</td>
</tr>
<tr>
<td></td>
<td>- Mozilla Firefox 1.5.x, 2.0 (All supported platforms)</td>
</tr>
<tr>
<td>Domino Web Administrator</td>
<td>- Microsoft Internet Explorer 6.x, 7.x (Windows platforms only)</td>
</tr>
<tr>
<td></td>
<td>- Mozilla Firefox 1.4.x , 1.5.x, 2.0 (All supported platforms)</td>
</tr>
<tr>
<td>Domino Web Access</td>
<td>- Microsoft Internet Explorer 6.x, 7.x (Windows platforms only)</td>
</tr>
<tr>
<td></td>
<td>- Mozilla Firefox 1.5.x, 2.0 (All supported platforms)</td>
</tr>
</tbody>
</table>

¹ Not applicable to Domino Designer.
² See "Linux system requirements" in these release notes for more information.
Lotus Notes, Domino Server, Domino for System i, Domino for System z

**KeyView filter formats supported**
The Domino 8.0.2 server and Notes 8.0.2 client are using version 10.4.0.0 of the KeyView filters.

**Note:** Indexing of .zip files is not supported by Notes and Domino.

**Note:** Domino for System i and Domino for System z are using version 9.2.0.12 of the KeyView filters. Attachment types noted in bold text in the tables below are not supported for version 9.2.0.12 of the KeyView filters.

### Word Processing Formats:

<table>
<thead>
<tr>
<th>Attachment Type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI (TXT)</td>
<td></td>
</tr>
<tr>
<td>ASCII (TXT)</td>
<td></td>
</tr>
<tr>
<td>HTML (HTM)</td>
<td>3.4</td>
</tr>
<tr>
<td>IBM DCA/RFT (Revisable Form Text) DC</td>
<td>SC23-0758-1</td>
</tr>
<tr>
<td>Rich Text Format / Wordpad (RTF)</td>
<td>1 through 1.7</td>
</tr>
<tr>
<td>Unicode (TXT)</td>
<td>3.4, .UNI and .TXT</td>
</tr>
<tr>
<td>Adobe Maker Interchange Format (MIF)</td>
<td>5, 5.5, 6, 7</td>
</tr>
<tr>
<td>Applix Words (AW)</td>
<td>3.11, 4, 4.1, 4.2, 4.3, 4.4</td>
</tr>
<tr>
<td>Display Write (IP)</td>
<td>4</td>
</tr>
<tr>
<td>Folio Flat File (FFF)</td>
<td>3.1</td>
</tr>
<tr>
<td>Fujitsu Oasys (OA2)</td>
<td>7</td>
</tr>
<tr>
<td>JustSystems Ichitaro (JTD)</td>
<td>8 through 2005</td>
</tr>
<tr>
<td>Lotus AMI Pro (SAM)</td>
<td>2, 3</td>
</tr>
<tr>
<td>Lotus Word Pro</td>
<td>96, 97, Millennium Edition R9 (Windows x86 Only)</td>
</tr>
<tr>
<td>Oasis Open Document Format (ODT)</td>
<td>2</td>
</tr>
<tr>
<td>Microsoft Word for PC (DOC)</td>
<td>4, 5, 5.5, 6</td>
</tr>
<tr>
<td>Microsoft Word for Windows (DOC)</td>
<td>1 through 2003</td>
</tr>
<tr>
<td>Microsoft Word for Macintosh (DOC)</td>
<td>4 through 2004</td>
</tr>
<tr>
<td>Microsoft Word 2007 (DOTX, DOTM)</td>
<td></td>
</tr>
<tr>
<td>Microsoft Works (WPS)</td>
<td>2 through 2000</td>
</tr>
<tr>
<td>Microsoft Windows Write (WRI)</td>
<td>1, 2, 3</td>
</tr>
<tr>
<td>WordPerfect for Windows V5 (WO)</td>
<td>5, 5.1</td>
</tr>
<tr>
<td>Word Perfect for Windows V6 or Higher (WPD)</td>
<td>6, 7, 8, 10, 11, 12, x3</td>
</tr>
<tr>
<td>Word Perfect for Macintosh</td>
<td>1.02, 2, 2.1, 2.2, 3, 3.1</td>
</tr>
<tr>
<td>Word Perfect for Linux</td>
<td>6.0, 8.1</td>
</tr>
<tr>
<td>XyWrite (XY4)</td>
<td>4.12</td>
</tr>
</tbody>
</table>
### Spreadsheet Formats:

<table>
<thead>
<tr>
<th>Attachment Type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applix Spreadsheets</td>
<td>4.2, 4.3, 4.4</td>
</tr>
<tr>
<td>Comma Separated Values (CSV)</td>
<td>No specific version</td>
</tr>
<tr>
<td>Corel Quattro Pro (QPW, WB3)</td>
<td>5, 6, 7, 8</td>
</tr>
<tr>
<td>Lotus 123 for Smartsuite (123)</td>
<td>96, 97, Millennium Edition R9</td>
</tr>
<tr>
<td>Lotus 1-2-3 (WK4)</td>
<td>2, 3, 4, 5</td>
</tr>
<tr>
<td>Lotus 1-2-3 Charts (123)</td>
<td>2, 3, 4, 5</td>
</tr>
<tr>
<td>Oasis Open Document Format (ODS)</td>
<td>2</td>
</tr>
<tr>
<td>Microsoft Excel for Windows (XLS)</td>
<td>2.2 through 2003</td>
</tr>
<tr>
<td>Microsoft Excel for Macintosh (XLS)</td>
<td>98, 2001 v.X, 2004</td>
</tr>
<tr>
<td>Microsoft Excel Charts (XLS)</td>
<td>2, 3, 4, 5, 6, 7</td>
</tr>
<tr>
<td>Microsoft Works Spread Sheet (S30, S40)</td>
<td>2, 3, 4</td>
</tr>
</tbody>
</table>

### Presentation Formats:

<table>
<thead>
<tr>
<th>Attachment type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applix Presents (AG)</td>
<td>4.0, 4.2, 4.3, 4.4</td>
</tr>
<tr>
<td>Corel Presentations (SHW)</td>
<td>6, 7, 8, 9, 10, 11, 12, X3</td>
</tr>
<tr>
<td>Lotus Freelance Graphics for Windows (PRE)</td>
<td>2, 96, 97, 98, Millennium Edition R9</td>
</tr>
<tr>
<td>Lotus Freelance Graphics 2 (PRE)</td>
<td>2</td>
</tr>
<tr>
<td>Oasis Open Document Format (ODP)</td>
<td>2</td>
</tr>
<tr>
<td>Microsoft PowerPoint 2007 (PPTX, PPTM, POTX, POTM, PPSX, PPSM)</td>
<td>98</td>
</tr>
<tr>
<td>Microsoft PowerPoint for PC (PPT)</td>
<td>4</td>
</tr>
<tr>
<td>Microsoft PowerPoint for Macintosh (PPT)</td>
<td>98</td>
</tr>
<tr>
<td>Microsoft Project (MPP) (Extracts metadata only)</td>
<td>98, 2000, 2002</td>
</tr>
</tbody>
</table>

### Display Formats:

<table>
<thead>
<tr>
<th>Attachment type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Portable Document Format (PDF)</td>
<td>1.1 to 1.7</td>
</tr>
</tbody>
</table>
**Graphics Formats (Filter SDK):**

<table>
<thead>
<tr>
<th>Attachment type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD Drawing Format (DWG)</td>
<td>R13, R14, 2000 (R15), 2004 (R18), 2007 (R21)</td>
</tr>
<tr>
<td>(Standalone: Does not extract metadata)</td>
<td></td>
</tr>
<tr>
<td>AutoCAD Drawing Format (DXF)</td>
<td>R13, R14, 2000 (R15), 2004 (R18), 2007 (R21)</td>
</tr>
<tr>
<td>(Standalone: Does not extract metadata)</td>
<td></td>
</tr>
<tr>
<td>Computer Graphics Metafile (CGM)</td>
<td>No specific version</td>
</tr>
<tr>
<td>(Embedded)</td>
<td></td>
</tr>
<tr>
<td>Enhanced Metafile (EMF) (Embedded and Standalone)</td>
<td>No specific version</td>
</tr>
<tr>
<td>Lotus Pic (Pic) (Standalone)</td>
<td>No specific version</td>
</tr>
<tr>
<td>Microsoft Visio (Extracts metadata only)</td>
<td>5, 2000, 2002, 2003</td>
</tr>
<tr>
<td>Tagged Image File (TIFF)</td>
<td>through 6.0</td>
</tr>
<tr>
<td>(Standalone: Extracts metadata only)</td>
<td></td>
</tr>
<tr>
<td>Windows Meta File (WMF) (Embedded and Standalone)</td>
<td>3</td>
</tr>
</tbody>
</table>

**Multimedia Formats:**

<table>
<thead>
<tr>
<th>Attachment type</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPEG - 1 Audio Layer 3 (MP3)</td>
<td>ID3 Versions 1 and 2</td>
</tr>
<tr>
<td>(Extracts Meta Data : Summary Information Only)</td>
<td></td>
</tr>
</tbody>
</table>

**Container Formats:**

<table>
<thead>
<tr>
<th>Attachment type</th>
<th>Version</th>
</tr>
</thead>
</table>

**Binary Formats:**

Nothing Supported in the Filter SDK.

---

**Lotus Notes, Domino Server**

**Debugger requirements for NSD**

Notes and Domino on operating systems other than Windows and IBM I (iSeries) use native debuggers or other utilities to collect callstack information for relevant processes. These debuggers/utilities must be installed on the operating system prior to NSD running. Failure to do so will result in NSD being unable to collect adequate information to resolve problems. The following table lists the requirements:

<table>
<thead>
<tr>
<th>Platform</th>
<th>AIX</th>
<th>Solaris</th>
<th>Linux</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debugger or utility required</td>
<td>prostack (^1) (preferred) or dbx (slower than prostack)</td>
<td>pstack</td>
<td>gdb (^2)</td>
</tr>
</tbody>
</table>

---

\(^1\) For AIX 5.3 the required version of prostack can be downloaded here: http://www.ibm.com/support/docview.wss?rs=0&uid=isc1iy95868

\(^2\) For information about specific versions of gdb for Linux operating systems refer to IBM Support Technote 1200676
Installation notes

Lotus Notes, Domino Designer, Domino Server

Products to install and order of installation
The following information lists servers and products to install for using Lotus Notes 8.

Servers to install

1. IBM Lotus Domino server.

2. (Optional) IBM DB2 running with a Domino 8 server. Required if you want to create and use DB2 enabled Notes databases.

3. (Optional) IBM Lotus Sametime server. Required if you want awareness and chat in the Notes client.
   
   Note: If you have a version 7.5.1 Sametime server, you must install it to a Domino 7.x server. The Domino 8 installation kit includes a Domino 7.x server for this purpose. Administrators must "point" their Notes clients to the Sametime 7.5.1 server that is running on the Domino 7.x server, in order to use the Instant Messaging and availability (online) status features in Notes.

4. (Optional) Lotus Connections server. Required if you want to use Activities from within the Lotus Notes client. For information, see the Lotus Connections documentation.

5. (Optional) IBM WebSphere Portal server. Required if you want to use composite applications that contain portlets.
   
   (Optional configuration) To use the Portal administrative user interface on the Portal server to administer both Domino and WebSphere Portal, configure Domino and Portal server federated administration. For information, see the topics "Running the Domino-Portal integration wizard" and "Configuring Domino and Portal Server federated administration".
   
   For more information, see the WebSphere Portal Information Center at: http://publib.boulder.ibm.com/infocenter/wpdoc/v6r0/topic/com.ibm.wp.ent.doc/wpf/pui_intro601.html

6. (Optional) WebSphere Portal composite application support for Lotus Notes (install on the WebSphere Portal server). Required if you want to work with composite applications that contain portlets or edit portlets using the Composite Application Editor.

Clients to install

1. Lotus Notes. This provides Mail, Calendar, Contacts, and options including IBM Lotus Symphony, Composite Application Editor, and Activities.
   
   Note: For Windows users, if Notes version 6.5.x or 7.x is detected on the client, the installation program will upgrade it to Notes 8.
   
   Note: For Linux users, upgrade from Notes version 7.x is not supported. Linux users should uninstall their existing Notes version and then install Notes. Upgrade from 8.0 to 8.0.1 is supported.

2. (Optional) Domino Administrator and Domino Designer.
   
   For Windows single user installation, the Domino Administrator client and Domino Designer client can optionally be installed or upgraded during Notes install.
Lotus Notes

Windows Vista: Considerations for Notes install/upgrade

For Lotus Notes 8.0 installation on a Windows Vista client, it was required that User Account Control (UAC) was turned OFF. That requirement has been removed in release 8.0.1 and later. When installing or upgrading to Notes 8.0.x on a Windows Vista client, the UAC setting should be enabled (UAC ON) in the following situations:

- Lotus Notes 8.0.x single or multi-user install on Windows Vista on which no Lotus Notes installation exists currently
- Lotus Notes 8.0.x upgrade from an existing Lotus Notes 8.0 install on Windows XP

Listed below are two options for enabling the UAC setting on the Windows Vista client. You can also reference http://www.netsquirrel.com/msconfig/msconfig_vista.html.

Note: When installing or uninstalling Notes with UAC ON, you must be working as an administrative user. Also note that installation directories are described in the "Notes installation directories" release note as well as the platform-specific installation topics in the Domino Administrator help information center at http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/index.jsp.

Note: When installing Notes multi-user on a Windows Vista client with UAC on you must manually set 4 registry key values in the MSI transform file (MST) and call that transform from the Notes multi-user silent install command line or else you will not be able to run Notes after install. See the release note "Make required transform for silent multi-user install on Windows" for details on how to create this transform.

Setting UAC ON -- Option 1

1. Click Start > Run and type MSCONFIG in the Run field to start the Microsoft Configuration Utility.
   
   Note: The Run menu may not visible by default. The Run command is in Programs Accessories. You can also find it by placing your cursor on the task bar, right-click, and choose > Properties > Start Menu > Classic Start menu.

   Alternatively you can click on the Vista Start icon in the bottom left corner of your screen and then type MSCONFIG in the search box to locate and start the utility.

2. If prompted for your administrator user name and password, or if so logged in, if prompted to continue respond as needed to continue.

3. Click the Tools tab.

4. Scroll down and click Enable UAC.

   Note: The Tools tab is a new addition to MSCONFIG in Windows Vista. The Enable UAC and Disable UAC options modify the Registry so that UAC will be either enabled or disabled upon your next client startup. Note that MSCONFIG requires that you have UAC authorization to run it and that Registry changes cannot be made without elevated privileges.

5. Click the OK or Launch button.

6. A command window will appear. When the command is finished running, close the window.

7. Close MSCONFIG and restart the computer to enable new the UAC setting.
Setting UAC ON -- Option 2

1. Click Start > Control panel to open the Windows Vista Control Panel.
2. Click User Accounts.
3. Click Turn User Account Control on or off.
4. Check the box next to Use User Account Control (UAC) to help protect your computer.
5. Click OK and restart the computer to enable the UAC setting.

Upgrading from Notes 8.0 to 8.0.1 with UAC ON

While you can upgrade a Notes 8.0 installation that was installed with UAC turned OFF to a Notes 8.0.x installation with UAC turned ON, you may encounter unexpected behavior such as the following:

- After upgrade, some desktop shortcuts such as Notes 8 and the Symphony editors may only be visible and accessible to an administrative user. This can occur if you installed Notes 8.0 with UAC OFF, turned UAC ON, and then upgraded to Notes 8.0.1 with UAC ON.
- After upgrade in a single user environment, uninstalling Notes 8.0.x may not remove the Notes 8 and Symphony desktop shortcuts. This can occur if you installed Notes 8.0 single user with either UAC ON or UAC OFF and then upgraded to Notes 8.0.1 with UAC ON.
- After upgrade in a single user environment, duplicates of the Symphony and Notes 8 desktop icons may appear. This can occur if you installed Notes 8.0 single user (as an administrator) with UAC OFF and then upgraded to Notes 8.0.x with UAC ON.

Upgrading from single user to multi-user

The Notes installation program does not support automatic Notes upgrade from single user to multi-user within the same release or from one release to another, although it is possible. To upgrade from single user to multi-user, see the “Upgrading a Notes single user install to multi-user” release note.

Lotus Notes

Single user access to Notes default install directories

If you install Notes as a single user install to the default directory (C:\Program Files\IBM\Lotus\Notes) or any subdirectory of C:\Program Files, you must then run Notes as an administrative user. In seeking to accommodate Windows Vista and Windows XP SP2 security with respect to this directory, programs installed to the Program Files directory require administrative privileges to run. This is a departure in behavior from earlier versions of Notes. To avoid this complication, do not install Notes to the C:\Program Files directory.

The suggested single user Notes installation directory is C:\IBM\Lotus\Notes.
Lotus Notes

**Notes installation directories**

The default and suggested Windows Vista and XP single user directories for Notes install are as below:

- C:\Program Files\IBM\Lotus\Notes -- Notes product and binary files installation directory
- C:\Program Files\IBM\Lotus\Notes\data -- Notes single user data files installation directory
- C:\Program Files\IBM\Lotus\Notes\data\workspace -- Notes single user workspace directory
- C:\Program Files\IBM\Lotus\Note\framework -- Recommended Notes Java code installation directory

The default and suggested Windows XP multi-user directories for Notes install for are as below:

- C:\Program Files\IBM\Lotus\Notes -- Notes multi-user default binary files installation directory
- C:\Documents and Settings\<user>\Local Settings\Application Data\Lotus\Notes\data -- Notes data files installation directory for each user
- C:\Documents and Settings\<user>\Local Settings\Application Data\Lotus\Notes\Data\workspace -- Notes workspace directory for each user
- C:\Program Files\IBM\Lotus\Notes\framework -- Notes Java code installation directory
- C:\Documents and Settings\All Users\Local Settings\Application Data\Lotus\Notes\Data -- Shared data directory

The default and suggested Windows Vista multi-user directories for Notes install are as below:

- C:\Program Files\IBM\Lotus\Notes -- Notes multi-user default binary files installation directory
- C:\ProgramData\Lotus\Notes\data -- Notes multi-user shared resources and templates installation directory
- C:\Users\<user name>\AppData\Local\Lotus\Notes\data -- Notes multi-user default data installation directory
- C:\Users\<user name>\AppData\Local\Lotus\Notes\data\workspace -- Notes multi-user workspace directory for each user
- C:\Program Files\IBM\Lotus\Notes\framework -- Notes Java code installation directory

Note: On a Windows system in which an existing Notes installation is detected (6.5.x, 7.x, or 8.x), default installation directories are as below:

- Notes product and binary files installation directory -- Directory where the existing Notes install binaries exist, for example C:\Lotus\Notes
- Notes data files installation directory -- Directory where the existing Notes data files exist, for example C:\Lotus\Notes\data
- Notes Java code installation directory -- Subdirectory \framework of the Notes installation directory, for example C:\Lotus\Notes\framework
On a **Linux** system, default directories for Notes install are as below:

- `/opt/ibm/lotus/notes` -- Notes product and binary files installation directory
- `/root/lotus/notes/data` -- Notes data files installation directory
- `/root/lotus/notes/data/workspace` -- Notes workspace directory
- `/opt/ibm/lotus/notes/framework` -- Notes Java code installation directory
- `/etc/lotus/notes/data` -- Shared data directory
- `~/lotus/notes/data` -- Notes data files directory for each user
- `~/lotus/notes/data/workspace` -- Notes workspace directory for each user

On a **Macintosh** system, default directories for Notes install are as below:

Note: Installation of Notes 8 on Mac OS X is expected to be available with Notes 8.5. The draft information presented here is preliminary and relative to the beta version of this functionality available within the Notes 8.0.1 time frame.

- `/Applications/Note.app` -- Notes product and binary files installation directory
- `/Applications/Note.app/Contents/MacOS` -- Notes Java code installation directory
- `~/Library/Application Support/Lotus Notes Data/Expeditor` -- Notes workspace directory
- `/Applications/Note.app/Contents/Resources/<current locale>.lproj/Data` -- Shared data directory
  
  For English locale, the data folder is `/Applications/Note.app/Contents/Resources/English.lproj/Data`.

- `~/Library/Application Support/Lotus Notes Data` -- data files directory for each user

On a **Macintosh** system, default directories for Notes 8.0 and 8.0.1 basic configuration install are as below:

- `/Applications/Note.app` -- Notes product and binary files installation directory
- `/Applications/Note.app/Contents/Resources/<current locale>.lproj/Data` -- Shared data directory

  For English locale, the data folder is `/Applications/Note.app/Contents/Resources/English.lproj/Data`.

- `~/Library/Application Support/Lotus Notes Data` -- data files directory for each user

---

**Lotus Notes**

**Notes shared network install not supported**

Shared network installation is not supported for Lotus Notes standard configuration.

Note that installing Notes from a network drive is supported for both the standard and basic configurations.
Reducing Notes Standard install kit size

The Notes 8.x Standard client contains features which increase the size of the install kits when compared to the Notes 8.x Basic install kits and previous releases. Some customer's infrastructures are not capable of efficiently handling distribution of the larger install kits and require a method by which they can reduce the size of the kit and still leverage the increased capabilities of the Notes 8.x Standard client.

If you are not using Lotus Symphony, Sametime, or the Composite Application Editor in your user population you can reduce the size of the Notes 8.x Standard client install kit using the procedure described in this release note. Reductions to the size of the Notes 8.x Standard install kit are listed in the table below.

<table>
<thead>
<tr>
<th>Feature Name</th>
<th>Size reduction (approximate)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lotus Symphony</td>
<td>78 megabytes</td>
</tr>
<tr>
<td>Sametime</td>
<td>4 megabytes</td>
</tr>
<tr>
<td>Composite Application Editor</td>
<td>4 megabytes</td>
</tr>
</tbody>
</table>

You can remove the following supplied features from the Notes 8.x Standard install kit:

- Lotus Symphony (represented as `<installfeature default="false" description="%Editors.description" id="Editors"...`)
- Sametime (represented as `<installfeature default="true" description="%Sametime.description" id="SametimeUI"...`)
- Composite Application Editor ( represented as `<installfeature default="false" description="%CAE.description" id="CAE"...`)

Other features listed in the Notes 8.x Standard install kit are required and should not be removed using this method. Do not remove any other features from the kit.

Note: Installfeatures are optional features of a Notes 8.x Standard install kit that may be selected by the user for installation. These features are defined in the install manifest file (deploy\install.xml). The implementation of these features is done in Java; the code resides in the zipped Eclipse update site directory updateSite.zip in the main install kit directory. It is possible to remove user selectable features from the updateSite.zip file and from the install manifest (deploy\install.xml) to reduce the size of the updateSite.zip file. As noted, this can reduce the size of the Notes 8.x Standard install kit.

To remove any of the three features listed above from the Notes 8.x Standard Install kit, do the following:

1. Copy the Notes 8.x Standard install kit to a local drive to a new directory. Include all subdirectories, (for example."C:\NotesInstallKit").
2. In the locally copied kit, rename updateSize.zip to a backup name such as UpdateSiteSave.zip.
3. Uncompress the backup file to a new directory, preserving the directory structure.
The contents of the directory should include the features and plugins subdirectories and site.xml as seen in the following graphic:

To remove only these specific InstallFeatures from the expanded update site directory, refer to the following table:

<table>
<thead>
<tr>
<th>InstallFeature</th>
<th>Wildcard files to remove</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lotus Symphony</td>
<td>plugins\com.ibm.productivity.tools.*</td>
</tr>
<tr>
<td></td>
<td>features\com.ibm.productivity.tools.*</td>
</tr>
<tr>
<td>Sametime</td>
<td>features\com.ibm.notes.sametime.installed.feature_*</td>
</tr>
<tr>
<td></td>
<td>plugins\com.ibm.notes.sametime.installed_*</td>
</tr>
<tr>
<td>Composite Application Editor</td>
<td>features\com.ibm.rcp.aaf.feature_*</td>
</tr>
<tr>
<td></td>
<td>plugins\com.ibm.rcp.aaf.*</td>
</tr>
<tr>
<td></td>
<td>plugins\com.ibm.rcp.aaf_*</td>
</tr>
<tr>
<td></td>
<td>features\com.ibm.notes.toolbox.ca.adapter.feature_*</td>
</tr>
</tbody>
</table>

4. Using the wildcard syntax remove the files from the expanded update site directory.
5. Create a new "updateSite.zip" file by zipping the expanded update site directory making sure to include all subdirectories. You must preserve the existing directory structures.
   Note: The resulting .zip file must include "site.xml" at the root of the updateSite.zip and must not include a directory at the top level.
6. Copy the deploy\install.xml file to a backup file such as installsave.xml.
7. Using a text editor, (i.e. Notepad, Wordpad), open "deploy\install.xml".
   Locate the ID of the feature you removed in step 4 above by searching for the feature ID listed below:

<table>
<thead>
<tr>
<th>Feature Name</th>
<th>Feature ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lotus Symphony...</td>
<td>Editors -- expressed in the installfeature statement as id=&quot;Editors&quot;</td>
</tr>
<tr>
<td>Composite Application Editor</td>
<td>CAE -- expressed in the installfeature statement as id=&quot;CAE&quot;</td>
</tr>
<tr>
<td>Sametime</td>
<td>SametimeUI -- expressed in the installfeature statement as id=&quot;SametimeUI&quot;</td>
</tr>
</tbody>
</table>
8. From the point in the file where the feature ID was found, look backward in the file for the start of the feature definition which starts with "<installfeature ...".
9. Insert a blank line on the line BEFORE the line that starts with "<installfeature ...".
10. Type "<!-- <enter>" on the blank line (omit the quotes -- <enter> means press the "Enter" key to end the line).
11. Insert a blank line at the end of the feature definition -- on the line AFTER "</installfeature>".
12. Type "--> <enter>" on the blank line (omit the quotes -- <enter> means press the "enter" key to end the line).
13. Save the file.

The updated Notes install kit should now be ready to deploy. Perform a test installation to be sure that the kit functions correctly. If it does not, recheck that you have followed the steps in this procedure.

Lotus Notes

Notes Basic configuration cannot be run from Domino directory
For users who choose to use the "old-style" Notes Basic configuration, instead of the Notes 8 Standard configuration which is Eclipse-based, be aware that starting Notes Basic configuration (nlnotes.exe) from the Domino program directory is not supported.

For example, if you have installed the Notes Basic configuration to the C:\Lotus\Domino directory, you cannot run nlnotes.exe from that directory. To avoid this complication, consider installing and running the Notes Basic configuration in the default directory, for example C:\Program Files\IBM\Lotus\Notes.

For more information about Notes installation directories, see the platform-specific Notes installation instructions in the Domino 8 Administrator information center, and the "Notes installation directories" release note.

Lotus Notes

Installation and Notes launch from Linux CD-ROM
When installing or upgrading to Notes 8 from a CD-ROM, after successfully installing you must open a UNIX shell and navigate to the installed Notes program, typically /opt/ibm/lotus/notes. Start Notes from the shell. Because of browser considerations, the Start Notes option, found at the end the Notes installation program for other platforms, is not available when installing Notes from CD-ROM on a Linux platform.

Lotus Notes

CD mount issue with RHEL 5 for Notes installs
When installing Notes from CD onto an RHEL 5 Linux client, you must mount the CD drive using exec as a gconf mount option. Once so mounted, you can insert the Notes installation CD into the drive and run the installer by typing ./setup.sh. By default, RHEL 5 does not allow the execute permission on a mounted CD drive.

To properly mount the RHEL 5 client drive, use the following command:

gconftool-2 /system/storage/default_options/iso9660/mount_options -s "[exec]" -t list --list-type=string
Optionally, you can mount the drive using the following command to mount the drive using your UID settings:

```
gconf-tool-2 /system/storage/default_options/iso9660/mount_options -s "[exec,uid=]" -t list --list-type=string
```

After installation is complete, change back to the default permissions as below.

```
gconf-tool-2 /system/storage/default_options/iso9660/mount_options -s "[]" -t list --list-type=string
```

Lotus Notes

**Installing Notes using "su root" on Linux**

To install Notes in graphical mode on the SLED 10 platform, you may need to log into the desktop as root, rather than run change to the root user using "su root". The procedure to use "su root" and then install Notes is as below:

1. Launch a terminal window as a non-root user.
2. Type `xhost +`.
3. Open a terminal window.
4. Type `su root`.
5. Enter the root password.
6. Execute the Lotus Notes 8 install instructions.

Lotus Notes

**Installing and uninstalling Notes on Mac OS plus - Beta**

Notes installation on Macintosh OS X is expected to be available with Notes 8.5. This information is relative to the beta version of this functionality available within the Notes 8.0.1 time frame. Note that this content is also present in the Domino 8.0.1 Administrator Help information center at http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/index.jsp.

**Considerations before installing**

Some considerations for the beta capabilities of Notes install on Macintosh, available in the Notes 8.0.1 time frame, are listed below:

- The install media kit for Notes install on a Macintosh OS X client consists of the following items:
  - Notes installation Meta-package (.mpkg)
  - Uninstaller application
- Notes installation is supported for the Macintosh OS X 10.5.1 client. Macintosh OS X 10.4 is not supported.
- 1GB or more of memory is recommended. See the "Software requirements" section of the release notes for details.
- The installation program will detect and upgrade an existing Notes 7.x or 8.x installation to 8.5.
- Notes multi-user install is supported; Notes single user install is not supported.
- The IBM Lotus Symphony tools are not currently available.
- Activities, My Widgets, and Composite Application Editor sidebar features are not available.
- Notes install customization is not currently available.
- Notes is currently available in US English only.
- The ability to customize Notes installation is not available.
  - Default installation directories are preselected and not editable.
  - All default and available Notes features are installed, the install manifest and update site contents are not editable.
- Embedded browser support is not available.
- Notes standard configuration client for Mac beta in Notes 8.5 supports the Intel Processor. The Notes basic configuration client for Mac beta in Notes 8.5 supports the PowerPC Processor and Intel Processor.
- The Notes basic client and Notes standard client are both available in this beta release.
- Silent install, Smart Upgrade, and multi-volume install are not available.
- Roaming user in the Notes standard configuration is not available.
- Users must have administrator-level privileges to install.

**Installing Notes on Macintosh OS X**
Notes installation on Apple Macintosh OS X is expected to be available with Notes 8.5. The draft information presented here is preliminary, and relative to the beta version of this functionality, are available within the Notes 8.0.1 time frame.

1. Obtain the Notes installation media kit.
2. Locate and run the installation executable.
3. Read the Welcome screen and click Continue.
4. Read and accept the license agreement terms and click Continue.
5. Accept the default install directory and click Continue.
6. Accept the default features to install and click Continue.
7. Read the preview screen and click Install.
8. If prompted, enter your administrative user name and password and click OK.
   The installation process may take several minutes.
9. Read the installation summary screen and click Finish to exit the installation wizard.
10. Start Notes by double clicking the new Notes.app icon in /Applications directory.
11. Respond to Notes setup prompts as they appear.

**Uninstalling Notes from a Macintosh OS client**
You can uninstall Notes by dragging Notes.app from /Applications to the trash. This preserves user data.
Note: You can also uninstall Notes using the uninstaller application supplied with the Notes install media. This preserves user data.
Note: You can also uninstall Notes by dragging the following items to the Macintosh OS trash bin:

- Notes.app
- ~/Library/Application Support/Lotus Notes Data folder ("~" = user's home directory)
- ~/Library/Preferences/Notes Preferences

To reinstall after uninstalling, you may also need to delete the following items prior to reinstalling Notes:

- /Library/Receipts/Lotus Notes Installer.pkg
- /Library/Receipts/xpdcoreinstaller.pkg

Installing Notes basic configuration on Macintosh OS X

Notes installation on Apple Macintosh OS X is expected to be available with Notes 8.5. The draft information presented here is preliminary and relative to the beta available in the Notes 8.0.1 timeframe.

1. Obtain the Notes installation media kit.
2. Locate and run the installation executable.
3. Read the Welcome screen and click Continue.
4. Read and accept the license agreement terms and click Continue.
5. Accept the default install directory and click Continue.
6. Read the preview screen and click Install.
7. If prompted, enter your administrative user name and password and click OK.
   - The installation process may take several minutes.
8. Click Finish to exit the installation wizard.
9. Start Notes by double clicking the new Notes.app icon in /Applications directory.
10. Respond to Notes setup prompts as they appear.

Uninstalling Notes basic configuration from a Macintosh OS client

You can uninstall the Notes basic configuration by dragging Notes.app from /Applications to the trash. This preserves user data.

You can also uninstall Notes by dragging the following items to the Macintosh OS trash bin:

- /Applications/Notes.app
- ~/Library/Application Support/Lotus Notes Data folder ("~" = user's home directory)
- ~/Library/Preferences/Notes Preferences
- /Library/Receipts/Lotus Notes Installer.pkg
Lotus Notes

Creating a verbose install log file

When you install Lotus Notes 8 on a Windows or Linux client, the system creates an install log file in the `<installdir>\framework\installer_logs` directory. On Windows, it also creates a LotusInstall.log file in the My Documents directory. These install log files are helpful but if you are reporting a problem with your installation, a verbose log file will contain more of the information that support needs to help resolve your problem.

Note: For information about attaching your verbose log file to a problem report and sending that problem report to Notes 8 support, see the "Reporting Notes 8 issues and problems" release note.

If reporting issues against the Windows version Notes 8 installation program, you should include a verbose install log file with your problem report. To create a verbose install log file, do either of the following:

- Run the Notes install SETP.EXE from the command line in the verbose mode and specify a log file name. For example, start the installer using the following command line:
  
  `setup /v"/lv* c:\temp\install.log"

- Set a registry value to always generate an MSI log file for each Notes 8 install and uninstall. To do so, create a registry entry
  
  HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\Installer with
  String Value Logging=voiceswarmup. This will create an MSI log file in your
  `<temp>` directory with the file extension ".log" for all MSI (Windows) installations.

Domino Server

UNIX: Running the launchpad.sh application

The Domino 8 UNIX CDs now include an application called "launchpad.sh". This application allows users to launch a browser, and launch the "Install" script from within the browser. It also allows users to read some documentation in Adobe PDF format.

The launchpad.sh application can be started only from the shell window; it will not run by simply clicking on its icon in the file browser. In addition, the path to the "xterm" application should be in the PATH environmental variable, otherwise it displays "xterm not found" in the shell window.

Domino Server

Running Domino 8 server installations on UNIX platforms

Running the silent server script install on Linux

To create a response file for automating the Domino installation, complete these steps:

1. Create a local copy of the UNIX template `unix_response.dat`.

2. Modify the copy so that it contains your server's specific program and data directory paths, user and group names and any other applicable install options.

3. Use the following command to apply the modified response file and run the silent install:

   `./install -silent -options file.dat`
Running a server install on Linux

<table>
<thead>
<tr>
<th>Enter this command</th>
<th>Type of install</th>
</tr>
</thead>
<tbody>
<tr>
<td>./install</td>
<td>Runs the server install on UNIX and displays a user interface during the install.</td>
</tr>
<tr>
<td>./install -console</td>
<td>Runs the server install on UNIX without a user interface. This install runs on a console.</td>
</tr>
</tbody>
</table>

Domino Server

**Do not attempt to install Domino data path under drive disk name**

Do not attempt to install the Domino data path under only a drive disk name, on the Windows platform. For example, do not specify an installation data path of "D:" or "C:".

Domino Server

**Running the Domino-Portal Integration Wizard**

Use the Domino-Portal Integration (DPI) Wizard to configure a WebSphere Portal server to work with your Domino-based infrastructure. You can use the DPI Wizard with the Domino 7.0 server, or more recent servers. The DPI Wizard eliminates many of the manual Domino and WebSphere Portal configuration steps required to run the Domino and Extended Products Portlets, Common Mail and Common Calendar.

**Note** The DPI Wizard is supported on all of the platforms that support Portal. For information, see the Portal 6.1 Information Center [http://infocenters.lotus.com/help5/index.jsp](http://infocenters.lotus.com/help5/index.jsp)

**Prerequisites**

The DPI Wizard requires that both the Domino server and WebSphere Portal server be installed and set up.

- WebSphere Portal server 6.0 with security enabled, configured with Domino LDAP, not clustered, and with no support for IBM Tivoli Access Manager or Computer Associates eTrust(R) SiteMinder(R).
- Domino LDAP server, configured as the LDAP server for WebSphere Portal 6.0, running Domino release 7.0 or more recent, with the LDAP and HTTP/HTTPS services enabled. The wizard communicates over HTTP, but specifying an HTTPS port as well allows for a secure transmission of the DTPA token that the wizard copies.
- If security is enabled manually on the WebSphere Portal server 6.0, instead of enabling security with the Advanced Configuration Wizard on the WebSphere Portal server, you will need to restart the WebSphere Portal Administration server before you run the DPI Wizard. To prevent having to manually restart the WebSphere Portal Administration server, be sure to enable security in the Advanced Configuration Wizard prior to running the DPI Wizard.
- All servers must be behind the same Internet security firewall, in the same Internet domain, and if they are Domino servers, in the same Domino domain.
- To run the DPI Wizard, you must be listed as an Administrator in the Server document in the Domino Directory (NAMES.NSF) on the Lotus Domino LDAP server.

**Caution** If you already have a Web SSO configuration on your Domino servers, be sure to read the “Consideration for existing SSO environments” section prior to running the wizard.
**Considerations for existing Web SSO environments**

The wizard creates a fresh Web SSO environment for all of the IBM Lotus Domino servers in your Domino domain that you choose to configure.

If your installation of Lotus Domino is new, or if your existing Lotus Domino and Lotus Sametime servers have no Web SSO documents in their Domino Directory applications (NAMES.NSF files), no further action is needed and you are ready to run the wizard.

If you do have one or more existing Web SSO documents, refer to the following checklist to evaluate whether your site is ready to run the wizard. There is a technote available on the IBM Support Web site providing instructions for dealing with the existing documents. The technote is:

Title: Domino-Portal Integration Wizard unable to create a working Web Single Sign-On environment
Doc #:1256149

- If you have an existing Web SSO document in your Domino Directory (NAMES.NSF), check to see whether it has the name LtpaToken. If all Web SSO documents in your domain have other names, no further action is needed and you are ready to run the wizard. The wizard creates a document with this exact name and will not affect your existing documents with other names.

- If the document is called LtpaToken, check to see whether there are any copies of it on other Lotus Domino servers in your Lotus Domino domain that have different content (for example, with different servers listed in the document). The Web SSO document should always be created by replication so that its content is identical on all Lotus Domino servers. If you have documents with differing content, you need to correct the configuration before you can run the wizard. For instructions, see the technote.

- If the document is called LtpaToken and has the same content on all servers, check to see whether it was created by the Lotus Sametime server. A document created by the Sametime server before Web SSO is configured in Lotus Domino cannot be used with the wizard. You need to correct this configuration. For instructions, see the technote.

- If the document is called LtpaToken, has the same content on all servers, and was not created by Lotus Sametime, check to see whether it was created by a Lotus Domino administrator other than the one who will run the wizard. You need to correct this configuration; for instructions, see the technote.

- If the document meets all the conditions above, but you do not plan to configure all of the Lotus Domino servers currently listed in it, you need to correct this configuration to list only the servers you plan to use with the wizard. For instructions, see the technote.

- Otherwise, your environment is probably ready for the wizard; see the technote if you have concerns.

**Running the Domino-Portal Integration Wizard**

Complete these steps to run the Domino-Portal Integration Wizard.

1. Move the following files from the Domino Directory to the WebSphere Portal server, directory path `<PortalServerHome>/config/wizard`:
   - DPIWizard.jar
   - dpiwiz.bat for Microsoft Windows platforms
2. From the WebSphere Portal server, enter this command:
   - For Microsoft Windows platforms, enter

   You can review the log file `dpitasks.log` generated during the configuration. `Dpitasks.log` contains the history of the wizard run. If the DPI Wizard fails, use the View Log button to review the content of the log file. Log files are stored on the Portal server at `<PortalServerHome>/log`.

   When the wizard completes, the log files are zipped into a file with this naming convention: `DPIDebug_yyyymmdd_hhmm.zip`, which can be found at `<PortalServerHome>/config/wizard`. You can review this file if necessary.
Domino for System i

**System i: Installing Domino 8 on i5/OS V5R4**

Remove any Domino 8 Beta software and configured servers prior to installing Domino 8 for System i. Refer also to *Installing and Managing Domino 8 for System i* (HELP) at the following URL, and contained on the product CD, for more detailed information on Domino installation and administration.


Before installing the Domino 8 on i5/OS, verify the following:

- If installing on i5/OS V5R4, PTF 5722SS1 SI24683 OSP-THREADS-PERFM FASTER THREAD LOCAL STORAGE ACCESS METHOD must be applied. Without the PTF applied the product will install, but virtually all Domino-related functions (WRKDOMSVR, CFGDOMSVR, UPDDOMSVR, and anything that performs a NotesInit API call) will fail with messages that may refer to a missing export from service program QLEAWI.

- You have a user profile with the required authorities to install and configure Domino. For more information about required authorities, see "Authorities authorities required to install and configure Domino" in the Domino 8 for System i help.

- You have installed the required hardware and software. For more information, see the Release Note "System i software requirements."

- Your operating system is IBM i5/OS V5R4 or later. If your operating system is prior to V5R4 level, you must upgrade it before installing Domino 8. If your operating system is at V6R1, see the release note "System i: Installing Domino 8.0.1 with i5/OS V6R1."

- Any previous beta or pre-release versions of Domino 8 servers have been removed using CFGDOMSVR SERVER(server-name) OPTION(*REMOVE) and the software has been removed using DLTLICPGM LICPGM(5733LD8).

- TCP/IP is set up and active on your system. For more information about setting up TCP/IP, see the IBM eServer iSeries Information Center at the following Web address:

http://www.ibm.com/eserver/iseries/infocenter

**Domino for System i**

**System i: Remove any Beta versions before installing**

Before installing Domino 8 software, you must remove any beta or pre-release versions. To remove the beta or pre-release version, make sure that all Domino servers are stopped and no users are running any Domino CL commands (i.e., WRKDOMSVR). Delete any Domino servers configured with beta software using the command:

```
CFGDOMSVR SERVER(<server-name>) OPTION(*REMOVE)
```

Enter the following command to remove any beta or pre-release versions of Domino 8:

```
DLTLICPGM LICPGM(5733LD8)
```
Domino for System i

**System i: Japanese system values required for install**

IBM recommends setting the following system values before installing Lotus Domino for i5/OS on a System i Japanese edition (Language Feature 2962). Specifically, please verify that the system value for QCCSID is 5035 (the default system value for QCCSID is 65535).

<table>
<thead>
<tr>
<th>System Value</th>
<th>Description</th>
<th>Recommended Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>QCCSID</td>
<td>Coded character set identifier</td>
<td>5035</td>
</tr>
<tr>
<td>QCCHRID</td>
<td>Graphic character set and code page</td>
<td>1172 1027</td>
</tr>
<tr>
<td>QCNTRYID</td>
<td>Country or region identifier</td>
<td>JP</td>
</tr>
<tr>
<td>QCURSYM</td>
<td>Currency symbol</td>
<td>Yen Mark</td>
</tr>
<tr>
<td>QDATFMT</td>
<td>Date format</td>
<td>YMD</td>
</tr>
<tr>
<td>QDATSEP</td>
<td>Date separator</td>
<td>1 (/)</td>
</tr>
<tr>
<td>QKBDTYPE</td>
<td>Keyboard language character set</td>
<td>JKB</td>
</tr>
<tr>
<td>QLANGID</td>
<td>Language identifier</td>
<td>JPN</td>
</tr>
<tr>
<td>QTIMSEP</td>
<td>Time separator</td>
<td>1 (:)</td>
</tr>
</tbody>
</table>

**Lotus Notes**

**Cannot install to shared network drive as user in Admin group**

For Windows Vista with UAC on only, logging into Vista as a user in the Admin group and attempting to execute a general install or a shared install, you will be unable to change the program path or data path to a shared network drive.

**Lotus Notes**

**Cannot launch nMinder and sload shortcuts after shared install**

After a shared installation, the nMinder and sload shortcuts cannot be launched. Users need to manually make the shortcuts point to the correct location of their Notes.INI file. Right-click on "Shortcuts", choose 'Properties', and append `-sa"=<Data Path>\notes.ini" to the 'Target' field.

**Lotus Notes**

**Feature install defaults to shared directory**

In a multi-user installation, installing a feature using the Eclipse update manager (File -> Application -> Install menu sequence in Notes) places that feature in the (Notes install directory )\framework\shared\eclipse directory. For example, if you log in as a non-administrative user, and install a third party feature using the File -> Application -> Install procedure, that feature is installed to (Notes install_dir)framework\shared\eclipse directory and available to all users in that multi-user installation.

All features, when installed by a non-administrative user in a Notes multi-user install, whether they originated in the Notes install kit or are third party features installed from the Eclipse update manager, are installed to the (Notes install_dir)framework\shared\eclipse directory by default. This default can be overridden for a particular third party feature by the feature's application developer using a colocation-affinity attribute.
If the platform is only ever used by a single user with a single workspace, then the target site for a feature is less important, since all features will always be available. In the multi-user configuration, the target install site is much more important, since some features should be shared among all users of the platform, while others should be private to specific users.

To limit the ability of a specific user to install feature W into their user site, the deployer could specify a colocation-affinity attribute with the ID “com.ibm.rcp.site.anchor.shared.feature”. The resultant site for a deployer would still be the shared site, chosen now not because it is the default, but because the colocation-affinity selects that site. A user attempting to install the feature would have the feature installation fail, since the site specified by the colocation-affinity is not accessible.


Domino Offline Services (DOLS)

**Installing DOLS on Microsoft Windows**

When Domino Off-Line Services (DOLS) is installed on Windows, if the selected installation location is read-only, the user will be re-prompted until a location entered has both read and write access.

**Workaround**

Make sure you install DOLS to a directory for which you have read/write privileges.

For more information on setting privileges see Microsoft's technote at the following URL:
http://support.microsoft.com/kb/326549

For more information on UAC see Microsoft's technote at the following URL:

Domino Server

**Installing Domino on UNIX systems**

The IBM Lotus Domino 8 Administrator documentation contains the topic "Installing Domino on UNIX systems." The topic in the documentation contains an error in Step 2.

**Incorrect information**

2. As the root user, run the install program ./install which is on the installation CD.

**Correct information**

2. As the root user, run the install program ./install from the unpacked install kit.
Lotus Notes, Domino Designer

Installing Notes client data directory to network shared drive

In Lotus Notes 8.0.1, a change was made that prevents the client from being installed such that the Notes data directory is stored on a mapped network drive. To resolve this issue, a MSI transform file must be used to change the default behavior of the installer. To create the transform, you must have either InstallShield Tuner for Lotus Notes or Orca.

InstallShield Tuner for Lotus Notes can be installed from the IBM Lotus Notes install CD or downloaded from the Passport Advantage website:

Orca can be downloaded from Microsoft’s website: http://support.microsoft.com/kb/255905

Using either program, load the Lotus Notes msi file (Lotus Notes 8.0.1.msi). Navigate to the LockPermissions table and click on the entry in the table for the DATADIR. Right click on this entry and click "Delete". Save the transform.

<table>
<thead>
<tr>
<th>Table</th>
<th>LockObject</th>
<th>Table</th>
<th>Do...</th>
<th>User</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control</td>
<td>COREINSTALLDIR</td>
<td>CreateFolder</td>
<td>Everyone</td>
<td>260435454</td>
<td></td>
</tr>
<tr>
<td>ControlCondition</td>
<td>DATADIR</td>
<td>CreateFolder</td>
<td>Everyone</td>
<td>260435454</td>
<td></td>
</tr>
<tr>
<td>ControlEvent</td>
<td>notes.ini</td>
<td>File</td>
<td>Everyone</td>
<td>260435454</td>
<td></td>
</tr>
<tr>
<td>CreateFolder</td>
<td>F1906_formats.ini</td>
<td>File</td>
<td>Everyone</td>
<td>260435454</td>
<td></td>
</tr>
<tr>
<td>CustomAction</td>
<td>KeyView.ini</td>
<td>File</td>
<td>Everyone</td>
<td>268135454</td>
<td></td>
</tr>
</tbody>
</table>
Use the transform as part of the install kit by including it on the command line or editing the setup.ini.

To prevent users from having to manually enter the transform on the command line, you can edit the setup.ini file that is part of the IBM Lotus Notes install kit.

Edit the following line in the [Startup] section to invoke the transform automatically using the correct path and name for your transform file.

[Startup]
CmdLine=/v"TRANSFORMS=path_to_mst_file"

See the Domino Administrator Help infocenter (http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/index.jsp) for this release for information about how to use a transform from the install command line.

Lotus Notes

**Installing Notes multi-user as a silent installation**

To perform a silent multi-user Notes install or upgrade you must configure the install transform file setting for multi-user, or else the Notes silent install command line will perform a Notes single user install or upgrade only. Also note that you must include the modified transform file name in the silent install or upgrade command line.

For instructions on installing Notes multi-user silently, see the "Using installation options with the transform file" topic in the Domino 8.0.1 Administrator help infocenter at http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/index.jsp. Instructions reside in the "Performing a Notes multi-user silent install" subtopic.
Installing NSD as a Windows system service

The Lotus Notes and Domino system diagnostics program, NSD, requires administrator level authority to successfully collect a complete set of system information in the event of a panic or crash. To meet this requirement on systems using a limited user account, or an account that is subject to restricted access, NSD can be installed as a Windows (Win32) system service. When installed as a Win32 service, NSD will execute under the system account at a higher privilege level than the user account. NSD is not installed as a service by default at this time, and the Notes and Domino product installers do not support installing NSD as a service. Instead, the NSD service must be installed, started, stopped or uninstalled using NSD command line options.

Windows Vista: Because of the enhanced security features introduced in Windows Vista, NSD must be installed as a system service in order to function properly on any account.

Steps for installing and starting the NSD service:

1. Open a Windows console window
2. Change the directory to the Notes client program or data directory, whichever contains notes.ini
3. Enter the following command to install the service:
   
   nsd -svcinst

4. Enter the following command to start the service:
   
   nsd -svcstart

5. Enter the following command to check the status of the service:
   
   nsd -svcreport

   If the install worked, this should show a status of "Running", similar to this:

   INFO: [(pid) mm/dd/yy hh:mm:ss x M]: Service status (Service report status):
     dwServiceType:
     dwCurrentState:            Running
     dwControlsAccepted:
     dwServiceSpecificExitCode: 00000000
     dwCheckPoint: 00000000
     dwWaitHint: 00000000

Steps for stopping and uninstalling the NSD service:

1. Open a Windows console window
2. Change the directory to the Notes client program or data directory, whichever contains notes.ini
3. Enter the following command to stop the service:
   
   nsd -svcstop

4. Enter the following command to uninstall the service:
   
   nsd -svcuninst

5. Enter the following command to check the status of the service:
   
   nsd -svcreport

   If the uninstall worked, this should result in a message indicating that the service is not installed, similar to this:

   ERROR: [(pid) mm/dd/yy hh:mm:ss x M]: Service status: OpenService failed: error code: 00000424: "The specified service does not exist as an installed service."

Domino Web Access

New mail file template for Domino Web Access
The mail template for Domino Web Access is MAIL8.NTF (Mail (R8)). When registering users, choose the Domino Web Access mail system, and the MAIL8.NTF mail template. This template contains mail template support for the IBM Lotus Domino Web Access client and the Lotus Notes client.

Previous beta releases included a DWA8.NTF template. This template is no longer shipped with Domino.

Lotus Notes

Prerequisites for Notes Web Browser application on Linux
Prerequisite for Mozilla Firefox or Mozilla Runtime Environment on Linux
To use Lotus Notes on Linux, you must first have the Mozilla browser installed. Select from the following:

- Mozilla Firefox 1.5.x.x (GTK2 build)
- Mozilla SeaMonkey 1.0.x.x (GTK2 build)
- Mozilla Runtime Environment (xulrunner) 1.8.0.x (GTK2 build)

Install the Mozilla browser or xulrunner with a compliant version from your installation media. Visit the Linux update site or the Mozilla Web site (http://www.mozilla.org) to download and install these programs.

Verifying the Mozilla environment on a Linux system
Before launching Lotus Notes, follow these steps to verify you meet the prerequisites for Linux:

SUSE Linux Enterprise Desktop 10

The default installed xulrunner1.8.0.1 can be used. The path is /usr/lib/xulrunner1.8.0.1. The default installed Firefox 1.5.0.4 cannot be used.

You can find the prerequisite packages on your SLED 10 Service pack CDs or from the Linux update site.

Red Hat Enterprise Linux 4.0 WS with GTK support - Update 4

The default installed Firefox can be used. The path is /usr/lib/firefox1.5.0.3.

Install Firefox or xulrunner from the Linux update site or the Mozilla Web site (http://www.mozilla.org).
Red Hat Enterprise Linux 5.0 WS with GTK support

The default installed Firefox 1.5.0.9 can be used. The path is /usr/lib/firefox1.5.0.9.

You can find it on your Red Hat Enterprise Linux 5.0 CDs, from the Linux update site, or the Mozilla Web site (http://www.mozilla.org).

Follow these steps to verify which Mozilla application is installed on your Linux system:

Mozilla Runtime Environment (xulrunner)
1. Open a terminal and enter rpm -qa | grep xulrunner to query installed packages.
2. If you see returns like mozilla-xulrunner-1.8.0.x-xx, the Mozilla Runtime Environment (xulrunner) is installed.

Mozilla Firefox
1. Open a terminal and enter rpm -qa | grep mozilla-firefox to query installed packages.
2. If you see returns like mozilla-firefox-1.5.xx-xx, Mozilla Firefox is installed.

Mozilla SeaMonkey (Mozilla Browser Suite)
1. Open a terminal and enter rpm -qa | grep mozilla-seamonkey to query installed packages.
2. If you see returns like mozilla-seamonkey-xx-xx, a compliant Mozilla SeaMonkey is installed.

Lotus Notes, Domino Server

Replace Design fails in multi-user environment
Non-administrative users working in a Notes multi-user environment cannot successfully run "Replace Design" (File - Application - Replace Design) on their Personal Address Book/Contacts NAMES.NSF, or their Mail database, using the Notes 8 template, after installing or upgrading to Notes 8.0.1.

The workaround is for the administrative user who performed the 8.0.1 install or upgrade to perform the Replace Design task for each of the users who will be working in the installation's shared directory. To do this in Windows Vista with UAC turned on, Notes must be run "as administrator", which will allow the Replace Design feature to work properly. For related information about directories, see the "Windows Vista: Considerations for Notes install" and "Notes installation directories" release notes. These topics are also present in the Domino 8 Administrator information center available with this 8.0.1 beta release at http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/index.jsp.

Domino Server

Running the Domino server installer on RedHat platforms
To successfully install the Domino server in graphical mode on supported RedHat platforms, install the following RPM:
libXp-1.0.0-8.i386.rpm (or later)

If you are using the 64-bit version of RedHat, also install:
libXp-1.0.0-8.x86_64.rpm (or later)

64-bit version of RedHat only
You must install the following 32-bit library on your 64-bit RedHat server to run the Domino server installer in graphical mode:
libXmu
To check the rpms you have installed, run:
/bin/rpm -q -a

If you want to select local setup during installation, or select manual setup during installation and then manually launch the Domino server setup in graphical mode, you will also need to install compat-libstdc++-33-3.2.3-61.i386.rpm, in order to get the Domino server setup GUI. Please see the "Linux system requirements" for full package requirements for Domino on Linux.

Lotus Notes

Silent install and Notes install manifest "default" setting
The Notes 8.0 silent installation program did not use the Notes install manifest (Notes install media kit's install.xml file) "default" setting when determining which "installfeature"s to install. This silent install behavior has been changed in 8.0.1 and later, as below:

Notes clean install (Install Notes 8.0.1 and greater on a system on which a Notes installation does not currently exist):

- If the "SELECTINSTALLFEATURES" property is specified on the command line, use that property to determine which installfeatures (in the install.xml file) should be installed.
- If "SELECTINSTALLFEATURES" is not specified on command line, use the "default" setting of each installfeature (in the install manifest) to determine if a feature should be installed. In this situation, the only installfeatures that will be installed if "default" is set to "true" are those where the "show" attribute is also set to "true" -- these are the installfeatures that would have appeared in the feature install panel.

Notes upgrade install (Install Notes 8.0.1 and greater on a system in which an upgradeable version of Notes currently exists):

Note: This maintains current (Notes 8.0) "SELECTINSTALLFEATURES" behavior.

- If the "SELECTINSTALLFEATURES" property is specified on the command line, use that property to determine which installfeatures should be installed or upgraded. If an installfeature is already installed and is not specified in "SELECTINSTALLFEATURES", remove the feature.
- If "SELECTINSTALLFEATURES" is not specified on the command line, "installfeature"s that are already installed and are not specified on the command line will be uninstalled.

Lotus Notes

Silent Notes multi-user install/upgrade command line statement
Prior to Notes 8.0.2 a transform was required for silently installing or upgrading a multi-user Notes install on Windows. A new command line option has been added in 8.0.2 and 8.5 to remove that requirement.

To perform a Notes silent multi-user install or upgrade on Windows, use the "SETMULTIUSER=1" command line statement. An example is shown below:

msiexec /i "Lotus Notes 8.0.2.msi" SETMULTIUSER=1 /qb

Note: There is no such switch for the Linux or Mac OS platforms as multi-user is the only possible Notes installation method; there is no single user Notes install option on those platforms.
Lotus Notes

Subsequent Allclient install and feature selection defaults

When you install the Notes Allclient kit and select to install the Domino Administrator client and/or the Domino Designer client, and later re-run the Allclient installer (Modify option), the installed Designer and Administrator client sub-features are not reflected in the feature panel. You must re-select the Designer and Administrator subfeatures to reinstall, or they will be removed. The installed Notes subfeatures are selected by default.

Lotus Notes

Switch User (fast user switching) and Notes installation

The Windows XP operating system introduced the notion of "Use Fast User Switching" to change credentials but not fully log out and exit all running applications. If these settings are enabled, the system security policy is also altered to provide a more streamlined experience for users.

When installing Notes on XP or Vista, the "Switch User" action must not be used to change users before an installation. The install user should fully log off any other users before performing an installation. Leaving other users running on the system may cause permission issues, and could result in an incompletely configured installation.

Domino Server, Domino for System i

System i: EZ Setup option no longer available with V6R1

With i5/OS V6R1, the option to "Install and Configure Domino" from System i Navigator (also referred to as EZ Setup) is no longer available. The option remains visible on the V6R1 System i Navigator interface, but no actions are taken if selected. It will be removed fully in the next release of the operating system.

Use the alternative interfaces to install and configure Domino on i5/OS V6R1:

Installation

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>setup.exe</td>
<td>the ISMP-based installation wizard</td>
</tr>
<tr>
<td>LODRUN</td>
<td>using physical CDs</td>
</tr>
<tr>
<td>RSTLICPGM</td>
<td>using save files</td>
</tr>
</tbody>
</table>

Configuration

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>domwzd</td>
<td>Configuration setup wizard</td>
</tr>
<tr>
<td>CFGDOMSVR</td>
<td>CL command</td>
</tr>
</tbody>
</table>

Note: You can launch the Configuration setup wizard from System i Navigator as follows:

1. Open System i Navigator.
2. Select the system where Domino is installed.
3. Expand "Network -> Servers"
4. Select 'Domino'
5. Right-click on "Domino -> New -> New Domino Server"
Lotus Notes

**Vista: Multi-user client silent install/upgrade**

For Windows Vista with UAC on only, while creating a transform to silently install or upgrade a multi-user client, please make the following changes:

- Change the "ApplicationUsers" property from "OnlyCurrentUser" to "AllUsers". The case is significant; "AllUsers" must be lower-case, except for the letters "A" and "U".

- In the Registry Section "HKEY_LOCAL_MACHINE | SOFTWARE | Lotus | Notes":
  - Double-click the "DataPath" registry key. Delete "[DATADIR]" from the edit box (so the edit box is empty). Click OK.
  - Double-click the "MultiUser" registry key. Change "0" to "1" in the edit box. Click OK.

- In the Registry Section "HKEY_LOCAL_MACHINE | SOFTWARE | Lotus | Notes | 8.0":
  - Double-click the "DataPath" registry key. Delete "[REGDATAPATHPROPERTY]" from the edit box (so the edit box is empty). Click OK.
  - Double-click the "MultiUser" registry key. Change "0" to "1" in the edit box. Click OK.

**Migration notes**

**Domino Server**

**Migrating Domino 32-bit applications to the 64-bit platform**

While both the Domino 64-bit and Domino 32-bit platforms are based on the same code base, and thus maintain the same API and reliability, all Domino applications - including third-party applications - need to be compiled and linked on 64-bit platforms in order to run successfully in the Domino 64-bit environment. Domino 32-bit applications cannot be run in the Domino 64-bit environment, as they are not binary-compatible. However, Domino databases can be copied across 32-bit and 64-bit servers.

The effort to port an application from 32-bit to 64-bit might range from trivial to very difficult, depending on how the applications were written and maintained. Even well-written, highly portable applications may have subtle issues, which are mentioned below. The intent of this document, however, is not to provide all the porting guidelines that need to be followed for moving an application from 32-bit to 64-bit. You should refer to the appropriate platform documentation for more in-depth and detailed descriptions on these issues.

**Supported platforms/environments**

<table>
<thead>
<tr>
<th>Platform</th>
<th>AIX 5.3 - 64-Bit Kernel in Use</th>
<th>Microsoft Windows 2003 Server - 64-Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Operating System Versions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AIX</td>
<td>ML5</td>
<td>Latest SP &amp; Patches</td>
</tr>
<tr>
<td>xltC.rte 8.0</td>
<td>xltC.rte 8.0</td>
<td></td>
</tr>
<tr>
<td>bos.perf.libperfstat 5.3.0.10</td>
<td>IBM Visual Age C/C++ 8.0 Aug 2006 PTF</td>
<td>Microsoft (R) C/C++ Optimizing Compiler Version 14.00.40310.41 for AMD64 Copyright (C) Microsoft Corporation. All rights reserved. Intel® C++ Compiler for Windows version 9.1</td>
</tr>
</tbody>
</table>
Compiler flags/debuggers
Please refer to the appropriate platform compiler flags text file, for example w64_cmp.txt for Windows, in the SDK for compiler and link flags used when compiling Domino code on native 64-bit platforms. Lotus uses dbx on AIX 64 and Microsoft Visual Studio 2005 on Windows 64 for debugging Domino applications.

32-bit to 64-bit changes
There are three different popular data models on 64-bit platforms - LP64, LLP64, and ILP64. Windows x64 platforms use the LLP64 data model. Since Domino is a cross-platform application, Lotus uses LLP64 on Windows x64 and other UNIX 64-bit platforms. Only *pointer* and *long* are 64-bits, while *LONG* is still maintained as 32-bit, even though native *long* is 64-bit on UNIX 64-bit platforms. Users should use *LONG* to be consistent across Domino platforms.

Lessons learned during Domino 64-bit development
During the migration of Domino from 32-bit to 64-bit native, we have observed the following general coding issues which are not portable. If you would like to maintain the common code, you should take care of these issues.

- Do not use native data type *long* as this is 32-bit on 32-bit and 64-bit on 64-bit systems. Use LONG or ULONG, which are 32-bit both on 32-bit and 64-bit Domino platforms.
- Domino handles are 32-bit on Domino 32-bit and 64-bit platforms. However, Windows handles are 64-bit on 64-bit Windows. Use DHANDLE instead of system HANDLE, which is 32-bit on all 32-bit and 64-bit platforms. Use HANDLE only when you need to use the Windows API, but all Domino API calls should be passed with DHANDLE.
- Since *pointer*, *int* and *long* are no longer the same size on 64-bit systems, problems may arise depending on how the variables are assigned and used within an application.
  - Do not use *int* and *long* interchangeably, because of the possible truncation of significant digits.
  - Do not use *int* to store *pointer*. This works on 32-bit systems, but fails on 64-bit systems because a 32-bit integer cannot hold a 64-bit pointer. If you need to store a pointer, use something like *size_t* instead of *int*.
  - Do not use *pointer* to store an integer.
- Numeric constants are another issue. Hexadecimal constants are commonly used as masks or specific bit values. A hexadecimal constant without a suffix is defined as an unsigned *int* if it will fit into 32-bits, and if the high-order bit is turned on. For example, the constant 0xFFFFFFF is a signed *long*. On a 32-bit system, this sets all the bits, but on a 64-bit system, only the lower-order 32-bits are set, resulting in the value of 0x00000000FFFFFF. If you want to turn all the bits on, a portable way to do this is to define a signed *long* constant with a value of -1. This turns all the bits on. On a 32-bit system, the constant 0x80000000 is used to turn on or mask the most significant bit. This is not portable - use shift logic.
- Do not use *int* and *size_t* interchangeably. On 32-bit systems, this would work, but on 64-bit systems, *size_t* is 64-bit. To make an application portable, always use *size_t*.
- Be aware that formatting strings are another source of problems during porting.
Upgrade notes

Lotus Notes

Upgrading a Notes single user install to multi-user

The Notes installation program cannot upgrade an existing Notes single user installation to a later version Notes multi-user installation. However, you can use a manual process, involving uninstall and reinstall, to accomplish this goal. The steps below describe how to upgrade a user from single to multi-user and also move that user’s data directory and other content from their old to new install. Again, the Notes installer does not support this, and will cancel the multi-user install when it detects the existing single user install.

To upgrade a single user install to a higher version multi-user install, do the following:

1. Log in as an administrative user or user with elevated privileges.
2. Back up the user’s data directory (by default located below the Notes install directory, for example C:\Program Files\IBM\Lotus\Notes\data).
3. Back up the user’s NOTES.INI file (be default located in the Notes install directory, for example C:\Program Files\IBM\Lotus\Notes).
4. Back up any third party binaries installed in the Notes binary directory (optional if there are no binaries or if it would be easier to reinstall them).
5. Uninstall Lotus Notes, for example Notes 8.0, using the Notes uninstall procedure.
6. Install Lotus Notes, for example Notes 8.0.1, and when prompted choose a multi-user install.
   - Note: The Notes.msi.w32.prod install media kit supports multi-user.
   - Note: The multi-user install creates a shared data directory under, by default, C:\ProgramData, which contains database templates and other shared data files. This directory is read only for non-administrative users.
7. Run Lotus Notes as the current (administrative) user and respond to all setup prompts.
8. Merge the old NOTES.INI from the backup with the newly installed NOTES.INI to preserve preferences and activate any third party code.
9. Merge the old data directory from the backup with the newly installed data directory. The merge will depend on the versions of the Notes single-user install and multi-user install.
10. Exit Notes and log in as a non-administrative user.
11. Start Notes.

Lotus Notes

Archive menu options moved from 'Tools' to 'Actions'

The "Archive" menu options have been moved in Notes 8 from the top level ‘Tools’ menu to the ‘Actions’ menu.

Domino Server

Domino 8 upgrade issue on partitioned server

When you upgrade to Domino 8 on existing partitioned servers, Domino as a Windows service is not added. The workaround is comprised of these steps:

1. Uninstall the partitioned server.
2. Reinstall the Domino 8 partition server to the same Domino Program path and Domino Data paths as you used in the previous install.
Lotus Notes

Mail Letterheads and upgrading from previous releases of Notes

In Lotus Notes 8, the Mail Memo (and Reply) forms have a new 'look and feel'. There are also a number of new and redesigned letterheads. In the next release, there will be more redesigned letterheads and some new ones as well.

There are a few caveats pertaining to letterheads:

1. Your old letterhead graphic is still part of the template; it will still display in the redesigned forms. The old letterhead design is wider than the new designs, however, and the picture may appear truncated in the Memo header. The only workaround at this time is to choose a different letterhead via Preferences.

2. If you save Preferences for any reason and had previously chosen a letterhead that is not included on the redesigned list above, the letterhead image that displays in the Memo form will change to the "Envelope" image. You will not be able to use your previously-chosen letterhead until a future release, and then only if it is on the list of those to be redesigned.

3. If you choose to use one of the new letterheads, if the recipient of your e-mail is still using a mail template from a previous release, the letterhead area will appear blank.

Lotus Notes

Must extract hotfix installer .exe before running silently

When running a hotfix install silently, you must first extract the hotfix installer before running it. For example, the following two commands can only be run successfully if you've first extracted hotfix.exe.

```
hotfix.exe /S /V"/qn"
hotfix.exe /S /V"/qb+
```

Lotus Notes, Domino Server

New ICC sub-directory required for Win32

A new FIPS 140-2 certified cryptographic library has been added to Notes/Domino as of release 8.0.1 on Win32. Any C API programs that run against their own copy of nlnotes.dll, instead of the Notes/Domino install directory, will need a copy of the ICC directory, as well as nlnotes.dll. This library is under consideration for inclusion on other platforms in future releases.

Lotus Notes

Notes 7.x upgrade to 8.0.x fails on Vista

In instances where Notes 7.x was installed on a Vista client, which is an unsupported configuration, upgrade to Notes 8.0.x is not supported with UAC ON.

When you first start Notes 7.x on Vista, the Notes configuration information is written to C:\Users\<admin>\AppData\Local\VirtualStore\Program files\Lotus\Notes, but the install data directory is not. The installation directory cannot be changed for the Notes 8.0.x upgrade, hence the problem. If UAC was OFF when Notes 7.x was installed, you can upgrade to Notes 8.0.x with UAC OFF; not with UAC ON.
Notes/Domino 8 upgrade to JDK (Java Development Kit) 1.5

IMPORTANT: The JavaCompilerTarget=1.5 INI setting is required to take advantage of new language features in JDK 1.5, but may reduce the backwards compatibility of agents.

Syntax:  JavaCompilerTarget=1.5

Example: JavaCompilerTarget=1.5

Description:

This release note refers to the Notes/Domino 8 upgrade to JDK (Java Development Kit) 1.5. This upgrade enhances the Java language with new features, described below. (Note: In the following text, we refer to JDK 1.5, which is also known as JDK 1.5.0 and JDK 5.0.)

By default, Notes/Domino 8 utilizes JDK 1.5 to compile and run agents, but it limits language features to maintain backwards compatibility through JDK 1.2.

Developers who wish to use JDK 1.5-specific features within their agents must override the default behavior. To override the default behavior, developers must specify the JavaCompilerTarget=1.5 INI setting. It is important to note that enabling 1.5-specific language features via this setting prevents compiled agents from running on Notes/Domino installations prior to 8.0 (and, more generally, JVMs prior to 1.5), regardless of whether the new language features are actually used in the agent's code. Enabling the JDK 1.5 language features via this INI setting therefore introduces the possibility of having an agent recompiled, replicated to a non-JDK-1.5 server, and then fail to run. Additionally, problems can arise editing and saving agents compiled with JavaCompilerTarget=1.5 in Notes/Domino installations without the INI.

It is suggested that organizations use a consistent setting across machines. Developers who will not be using JDK 1.5-specific language features are encouraged to keep the default Notes/Domino behavior as it will maximize backward compatibility.

<table>
<thead>
<tr>
<th>INI Setting</th>
<th>Effects on Notes/Domino Agents</th>
</tr>
</thead>
</table>
| No INI Setting (default)    | • Notes/Domino will compile agents using the following compiler flags: javac -source 1.3 -target 1.2  
  • Agents will run on JREs from 1.2.x onward  
  • The user loses the ability to compile with JDK 5.0 functionality (cannot create or edit any Java agent that uses JDK 5.0 features)  
  • The user keeps backward compatibility (any agent that is created or edited during the session can still be still run on Domino 6.0 or later) | |
| JavaCompilerTarget=1.5      | • Notes/Domino will compile agents using javac -source 1.5 -target 1.5  
  • Compiled agents can only be run with JDK 5.0 (Notes/Domino 8.0 and later).  
  • The user gains JDK 5.0 functionality with any agent created or edited during that session (such agents will run with new JDK 5.0 features)  
  • The user loses backward compatibility with any agent created or edited during that session (such agents will not run on a server with any earlier Domino version, even if they don't use any 5.0 features) |
JDK 1.5 Language Features that Require "JavaCompilerTarget=1.5":

The following JDK 1.5 agents will require the JavaCompilerTarget=1.5 INI setting to compile and run:

<table>
<thead>
<tr>
<th>New Java 5 Language Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generics</td>
</tr>
<tr>
<td>• Allows a type or method to operate on objects of various types while providing compile-time type safety.</td>
</tr>
<tr>
<td>Enhanced for Loops</td>
</tr>
<tr>
<td>• Facilitates iterating over collections and arrays.</td>
</tr>
<tr>
<td>Autoboxing/Unboxing</td>
</tr>
<tr>
<td>• Facilitates conversion between primitive types (such as int) and wrapper types (such as Integer).</td>
</tr>
<tr>
<td>Typesafe Enums</td>
</tr>
<tr>
<td>• Allows creation of enumerated types with arbitrary methods and fields.</td>
</tr>
<tr>
<td>Varargs</td>
</tr>
<tr>
<td>• Simplifies invoking methods that accept variable-length argument lists.</td>
</tr>
<tr>
<td>Static Import</td>
</tr>
<tr>
<td>• Lets you avoid qualifying static members with class names.</td>
</tr>
<tr>
<td>Annotations (Metadata)</td>
</tr>
<tr>
<td>• Allows tools to generate boilerplate code from annotations in the source code.</td>
</tr>
</tbody>
</table>

Additional References:

- New Language Features in JDK 1.5
  http://java.sun.com/j2se/1.5.0/docs/guide/language/index.html
  http://java.sun.com/j2se/1.5.0/docs/relnotes/features.html

- Compatibility Notes Between JDK 1.5 and JDK 1.42
  http://java.sun.com/javase/technologies/compatibility.jsp

- More information on the use of -source and -target with JDKs
  http://java.sun.com/j2se/1.5.0/docs/tooldocs/windows/javac.html

Applies to: Notes/Domino 8.0
Default: JavaCompilerTarget=
UI equivalent: None
Lotus Notes, Domino Server

**Personal Address Book needs new design upgrade**

If you are upgrading to Notes/Domino 8 from a previous version, you must replace the design of your Personal Address Book with the Domino 8 `pernames.ntf` template. This allows a Notes/Domino 8 user to take full advantage of new features in this area, notably "Edit Locations".

Domino Server

**Prevented from upgrading to W64 kit**

Upgrading from an existing W64 kit installation using a W32 kit is not supported. If you mistakenly do so, when you attempt to install the W64 kit to correct this, you will be presented with the error message below:

```
W32 bit version of Domino is currently installed. Upgrading to 64 bit Domino is not supported. Please uninstall the W32 bit Domino version first.
```

and you will be prevented from installing the 64-bit Windows kit. To make it possible to install the W64 kit, you will first need to remove the registry key under `HKEY_LOCAL_MACHINE\Software\Wow6432Node\Lotus\Domino`.

Domino Server

**Rebuild system views in the Domino Directory after upgrading**

There are several views in the Domino Directory (`NAMES.NSF`) which use the Unicode standard collation, and which must be rebuilt immediately after upgrading to Domino 8. The IBM Lotus Domino server knows the collation versions, and automatically rebuilds the view indexes when the server needs to use them.

When the Domino server starts, it needs to access two important views, `$Users` and `$ServerAccess`. The server stops and waits for these views to rebuild. If the Domino Directory is a large file, rebuilding the two views requires a substantial amount of time. After upgrading to Domino 8, during the first server restart the server may stop while waiting for the views to rebuild. During this time, the server console will display initial information regarding the Domino server.

This process has been tested using a Domino Directory containing 17,000 users. Rebuilding (reindexing) the views required approximately 40 minutes during the initial server restart after upgrade. This test was performed on the platforms listed below. Note that the time requirements varied slightly by platform.

- Microsoft Windows 2003 server
- IBM AIX
- Linux
- i5/OS

If you upgrade to Domino 8 and your Domino Directory contains 10,000 users or more, plan ahead for view updating. You can use the UPDALL program to update the index offline, and then place it on the server. On Microsoft Windows platforms, enter this command

```
nupdall -r names.nsf
```

For more information about using the UPDALL program, see the Domino Administrator 8 documentation.
Domino Server

**Rebuilding of the database design collections**

To correct a potential defect, a one time rebuild of the design collection for each database will occur when either the design task or the index task is run on the database. If view events are being logged (LOG_VIEW_EVENTS=1), messages related to this activity may be observed on the console, and in log.nsf. For example:

```
Informational, rebuild view needed - collection object was deleted (reading C:\server\e.nsf default design note Title:"
Informational, rebuilding view - no container or index (reading C:\server\e.nsf default design note Title:"
Informational, rebuilding view - user specified REBUILD (reading C:\server\e.nsf default design note Title:"
```

where the Title is ".

Databases will still be accessible while this rebuild is happening, but noticeable resource contention may be seen. It may be advantageous to run the index updater against your databases with the server down, where possible.

Lotus Notes

**Setup message still displays after multi-user upgrade from 7.0.2**

After upgrading a configured Notes 7.0.2 multi-user client to Notes 8 or Notes 8.0.1, launching Notes will still display the prompt to set up Notes.

Domino Server, Domino for System i

**System i: Autonomy Keyview filter upgrade**

Domino 8 for System i has been upgraded with version 9.2.0.12 of Autonomy's Keyview filter. System i does not support the viewer. Refer to the release note "File formats supported" for details on the type of documents supported with version 9.2.0.12 of Autonomy's Keyview Filter.

These file types are not supported for System i:

- Lotus Word Pro (LWP)

Domino Server, Domino for System i

**System i: Enable C/C++ Applications for 64-bit support**

ENABLE Applications for 64-bit support on System i

A future release of Domino for System i is being evaluated to provide 64-bit pointer and teraspace support. This release note describes what you need to do to enable your Domino C and C++ applications to run with Domino 64-bit and teraspace support on System i.

**C and C++ Application Requirements**

Any applications that use the Domino C or C++ API on i5/OS need to be reviewed to make sure they are properly enabled for use with Domino on i5/OS. If your application is not properly enabled, it may not be supported in a multi-version environment and may encounter run-time problems when Domino is changed to use 64-bit pointers. There are two important considerations:
- **Bind to QNOTES/LIBNOTES**
  Some applications incorrectly specify a library of `*LIBL` when binding to the LIBNOTES service program. This can result in incorrect operation in a multi-versioned Domino environment. Applications must specify library QNOTES when binding to the LIBNOTES service program in order to function correctly in a multi-versioned environment.

- **Enable for Teraspace**
  When 64-bit support for Domino becomes available, Domino for i5/OS will also change to use the i5/OS 64-bit pointer and teraspace support. To ensure proper operation, applications using the Domino C or C++ API must be teraspace-enabled. This can be accomplished by recompiling the application with the teraspace compiler option specified. This is expected to provide significant improvement in Domino i5/OS performance when 64-bit support is introduced.

For more details, see the following documents:

**Considerations when developing Domino C and C++ API applications for i5/OS:**

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21238494

**Domino 7 for i5/OS Application Development Guide (Chapter 2 - Application Development Considerations)**


For information on Domino 64-bit plans, see this document:


---

**Domino for System i**

**System i: Obsolete SametimeApplets directory**

The directory and contents of `<notes data>/domino/SametimeApplets` is obsolete, and is no longer shipped with the Domino product.

On System i, the SAMETIMEAPPLETS directory is not created in the server's data directory when a new server is configured. However, the directory remains, and is not deleted during the upgrade process (UPDDOMSVR CL command). Customers may elect to remove the obsolete directory SametimeApplets from their existing server's data directory (`<notes data>/domino/SametimeApplets`).

---

**Domino Web Access, Domino for System i**

**System i: Sametime customization saved on upgrade**

The Domino server's data directory `<data dir>/domino/html/sametime/stlinks` was added in releases 6.0.5/6.5.4, and also exists in Domino 7.x and 8.x, but did not exist in 6.5.3 and prior releases. This directory contains files that enable Sametime integration with Domino Web Access (DWA), and files in this directory may be customized to support tunneling.

When a Domino server is upgraded, any files in the existing `<data dir>/domino/html/sametime/stlinks` directory are copied to a backup directory called `<data dir>/domino/html/sametime/stlinks/stlinks.sav` in order to save any potential customized settings.
The server upgrade process occurs:

- during install for servers that are not multi-version capable (Domino 6.0.2 and earlier)
- after install when the UPDDOMSVR command is run for a multi-version capable server (Domino 6.0.3/6.5.0 and later)

Files will only be copied to the stlinks.sav subdirectory during upgrade if the stlinks.sav directory is empty or does not exist (that is, if an install/upgrade occurs more than once for the same server, the copy of the files to stlinks.sav will only occur during the first install/upgrade).

If you make additional customizations to the files in stlinks, be sure to either copy the new customizations to stlinks.sav or remove all files from stlinks.sav so that a subsequent install/upgrade will copy the latest files to the backup directory.

**Domino Server**

**Upgrade to Domino 8 sets 1K console logging limit**

Upgrading the Domino server to Domino 8 sets the console logging limit to 1K. The new default setting of 1K was introduced to improve product serviceability. Console logging is enabled with a 1K limit without user intervention or notification. This will not occur if you already have an entry in the NOTES.INI file to enable, disable or change the console logging size.

To change the default console logging limit to a value other than 1K, use one of the commands listed below:

- Use one of these Notes.ini settings
  ```
  console_log_enabled=n
  console_log_max_kbytes=desired size
  ```
  For information about the Notes.ini settings, see the topic “NOTES.INI Settings” in the Domino 8 Administrator Help documentation.

- After stopping the console log, issue this server command
  ```
  start consolelog
  ```

**Upgrading a DB2-enabled Domino server**

If you have enabled your Domino servers to communicate with DB2, and you have DB2 enabled Notes databases, you cannot upgrade directly from Domino 7.x to Domino 8. You must first convert your DB2 enabled Notes databases to Notes NSF databases. If you do not convert your databases, you will be unable to access your data. Complete these steps:

1. Create NSF database replicas of the DB2-enabled Notes databases. Use the Create Replica tool in the Domino Administrator. Be sure to create the replica on a Domino server configured with NSF as the default datastore.
2. Disable the Domino 7.x server.
3. Upgrade to Domino 8.
4. Run the server enablement tool to allow the Domino and DB2 server to communicate.
5. Convert the NSF database replicas back to DB2-enabled Notes databases.
After a DB2-enabled Domino server has been upgraded from 7.x to 8.0, it cannot be downgraded back to a 7.x version.

When upgrading a DB2-enabled Domino server from 7.x to 8.0, DB2 Universal Database must be upgraded to version 9.1.0.

Mixed Domino and DB2 versions are not supported, for example, Domino 7.x and DB2 9.1.0 are not supported together. Domino 8.0 and DB2 8.2.2 are not supported together.

**Domino Server**

**Upgrading mail files with the mail conversion utility**

The IBM Lotus Upgrading to Domino documentation is being replaced by IBM Lotus Notes and Domino 8 Deployment Guide that contains all upgrade information in one book.

**Upgrading mail files with the mail conversion utility**

When you upgrade users’ mail files to the Notes 8 mail template or to the Domino Web Access template, you can upgrade one file at a time or use the mail conversion utility to automate upgrading the design. Be sure that you have already upgraded the Domino server that hosts the mail files and the Notes clients that access those files, or users will not be able to use the features in the new design. Upgrade mail files at a time when users won’t be accessing them — for example, early mornings or over a weekend. Notify users that their mail files will be unavailable during the upgrade.

You can also use the mail conversion utility to convert a mail design from one language to another language and to migrate from Microsoft Exchange. For more information about using the mail conversion utility for Microsoft Exchange migration, see the topic Migrating from Microsoft Exchange using the mail conversion utility.

**To use the mail conversion utility**

**Note** Before using the mail conversion utility, make sure that all clients are upgraded to Lotus Notes 8.

1. If users have customized their mail files, instruct them to back up these customizations. For example, users can make a copy of their mail file that includes only the database design. This allows users to apply changes they made to their Notes 7 mail file to the new Notes 8 mail template, if necessary.

2. Start the Domino server on which you want to customize mail files.

3. Shut down the router. Enter:

   ```
   tell router quit
   ```

   and press ENTER to prevent Domino from routing mail to the mail files while they are being upgraded. Mail is stored in MAIL.BOX while you upgrade the mail files. After you upgrade the mail files and load the router task again, the router processes and delivers the mail in MAIL.BOX.
4. Load the mail conversion utility. Type

```
load convert [arguments]
```

and press ENTER.

The mail conversion utility command uses arguments to specify options. It has the form:

```
load convert  -? /? -a -c -d -e -f -g -h -i -l -m -n -o -proxy -r -s -u -w -x mailfilepath existingtemplatename newtemplatefilename
```

- **Mailfilepath** specifies which mail file or files to upgrade.
- **Existingtemplatename** specifies a certain mail file design to upgrade (for example, only mail files using Notes 8 design). This property is found in the Template Name field on the Database Properties - Design tab.
- **Newtemplatefilename** specifies the template with which to upgrade the mail files.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a Admin Name</td>
<td>Enables sending mail to the administrator when the convert tool completes.</td>
</tr>
<tr>
<td>-c</td>
<td>Converts categories to folders.</td>
</tr>
<tr>
<td>-d</td>
<td>Do not convert categories to folders.</td>
</tr>
<tr>
<td>-e or -e-</td>
<td>Enables or disables NSF support for IMAP. Converts the file or files for IMAP use in Notes 8.</td>
</tr>
<tr>
<td>-f &lt;file name&gt;</td>
<td>Reads the list of databases to process from a text file.</td>
</tr>
<tr>
<td>-g &quot;Language Name&quot;</td>
<td>Replaces the mail file design with user's preferred language.</td>
</tr>
<tr>
<td>-h</td>
<td>Adds the IMAP specific items to optimize fetches.</td>
</tr>
<tr>
<td>-i</td>
<td>Converts categories to folders, even if there are more than 200 categories.</td>
</tr>
<tr>
<td>-l &lt;file name&gt;</td>
<td>Generates a list of mail files by reading people's mail files from the Domino Directory. Writes the list to a text file.</td>
</tr>
<tr>
<td>-m</td>
<td>Enables or disables folder references which are needed for IMAP. Converts the file or files for IMAP use in Notes 8.</td>
</tr>
<tr>
<td>-n</td>
<td>Shows the databases that match the file name and template name criteria, without actually updating anything.</td>
</tr>
<tr>
<td>-o</td>
<td>Removes IMAP-specific items.</td>
</tr>
<tr>
<td>-proxy</td>
<td>Enables a display status and error messages in a console window.</td>
</tr>
<tr>
<td>-r</td>
<td>Enables recursive search of databases. Converts mail files in subdirectories of the specified directory.</td>
</tr>
<tr>
<td>-s</td>
<td>Ignores the preserve flag for folders when replacing the design but always preserve them.</td>
</tr>
<tr>
<td>-u</td>
<td>Enables the upgrade of folders to the same design as the $inbox design.</td>
</tr>
<tr>
<td>-w &lt;dir path&gt;</td>
<td>Enables fix up of names in Notes in all mail files on the server to allow for Microsoft Exchange Mail Migration.</td>
</tr>
<tr>
<td>-x</td>
<td>Enables exclusive design element keys: &lt;NAME&gt;&lt;CLASS&gt;&lt;LANGUAGE&gt;</td>
</tr>
<tr>
<td>-? /?</td>
<td>Displays help information. Displays command line help.</td>
</tr>
</tbody>
</table>
5. When you have finished upgrading mail files to the Notes 8 template on this server, load the router. Enter:

   load router

   and press ENTER.

6. Notify users that you upgraded their mail files to the Notes8 design.

Mail conversion utility tasks

You can use the mail conversion utility to upgrade one or more mail databases. The following table describes the tasks that the mail conversion utility can perform.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrading a single mail database</td>
<td>This example finds the mail database USER.NSF in the \MAIL subdirectory of the Notes data directory. The mail conversion utility replaces the current mail template -- regardless of which template the mail file uses -- with MAIL8.NTF, the Notes 8 mail template.</td>
</tr>
<tr>
<td></td>
<td>load convert mail\user.nsf * mail8.ntf</td>
</tr>
<tr>
<td>Upgrading all mail databases in a directory</td>
<td>This example finds all databases located in the \MAIL subdirectory of the Notes data directory that use StdR6Mail, the Notes 6 mail template, and replaces their design template with MAIL8.NTF, the Notes 8 mail template.</td>
</tr>
<tr>
<td></td>
<td>load convert mail*.nsf StdR6Mail mail8.ntf</td>
</tr>
<tr>
<td>Upgrading all mail databases in a directory and in its subdirectories</td>
<td>This example finds all databases located in the \MAIL subdirectory and all subdirectories of the \MAIL directory (for example, C:NOTES\DATA\MAIL\GROUP1, C:NOTES\DATA\MAIL\GROUP2, and C:NOTES\DATA\MAIL\GROUP3) and upgrades them to the Notes 8 mail template, MAIL8.NTF.</td>
</tr>
<tr>
<td></td>
<td>load convert -r mail*.nsf * mail8.ntf</td>
</tr>
<tr>
<td>Upgrading all mail databases listed in a text file</td>
<td>You can create a text file listing databases you want to upgrade and use it with the mail conversion utility to upgrade only those databases. For example, you can create the text file MAILLIST.TXT to list all the mail databases you want to upgrade and save it in the directory C:TEMP. This example finds all databases listed in MAILLIST.TXT, determines whether the databases use a design template name that matches Mail*, (mail6.ntf for example), and replaces the designs of the matching databases with MAIL8.NTF), the Notes 8 mail template.</td>
</tr>
<tr>
<td></td>
<td>load convert -f c:temp\maillist.txt mail*.ntf mail8.ntf</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Creating a text file that lists all mail databases in a directory | You can use the mail conversion utility to create a text file that lists all primary mail databases on the server (it does not list replica mail databases). This example creates a text file, MAILLIST.TXT, in the C:\TEMP directory. MAILLIST.TXT contains a list of primary mail databases on the server but excludes replica mail databases. After you create the text file using this option, you can use the file to upgrade the mail databases listed in it. See “Upgrading all mail databases listed in a text file” in this table.  

`load convert -l c:\temp\maillist.txt`

| Converting mail files for use with IMAP in Notes 5 | If you use a Notes 5 mail file with IMAP, run the mail conversion utility to enable IMAP-specific features in the mail file. This example reads the mail database USER.NSF in the \MAIL subdirectory of the Notes data directory for use with IMAP.  

`load convert -m mail\user.nsf`

| Converting mail files for use with IMAP in Notes 6 | If you use a Notes 6 mail file with IMAP, run the mail conversion utility to enable IMAP-specific features in the mail file. This example reads the mail database USER.NSF in the \MAIL subdirectory of the Notes data directory for use with IMAP.  

`load convert -e mail\user.nsf`

| Upgrading custom folder design | You can use the mail conversion utility to upgrade custom folder design to the Inbox design. This example upgrades the custom folder design of all mail databases in the \Mail subdirectory of the Notes data directory to the Inbox design.  

`load convert -u mail\*`

| Upgrading folder design of folders without the Preserve bit | The -s argument ignores any folder or view with the Preserve bit deselected. This bit corresponds to the "Do not allow refresh/replace to modify" option in the design properties. System folders and other design elements from the original template used to create the mail file do not have this bit set, even if the database is set to inherit from design. System folders, such as the Inbox, are not updated if you run the mail conversion utility with the -s argument. This affects mail files being upgraded to Lotus Notes 6 because required script libraries have been removed and action buttons have been upgraded.  

`load convert -s mail\*`

| Changing the English mail design to a German mail design |  

`load convert -g"German" TestMail.nsf * mail8_en_de.ntf`

| Upgrade all previous users’ mail designs listed in the file maillist.txt to Domino 8 mail design |  

`load convert -u -f maillist.txt * mail8.ntf`
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performs address fixup for all Microsoft Exchange migrated mail databases in &lt;dir path&gt; and its subdirectories</td>
<td><code>load convert -w &lt;db path&gt;</code></td>
</tr>
<tr>
<td>Performs address fixup on the given Exchange migrated mail database.</td>
<td><code>load convert -w &lt;mail db path&gt;</code></td>
</tr>
<tr>
<td>Generates a text list containing all Exchange migrated mail databases from the primary mail directory, excluding replicas. This feature is of lesser-importance than address fixup but it is necessary in the event that the subsequent option is required.</td>
<td><code>load convert -w -l &lt;text list path&gt;</code></td>
</tr>
<tr>
<td>Performs address fix-up on all Exchange-migrated mail databases listed in the given text list file. Provides flexibility in allowing the administrator to manage the databases that need address fix-up.</td>
<td><code>load convert -w -f &lt;text list file&gt;</code></td>
</tr>
</tbody>
</table>

**Note**  When you use a wildcard character, such as an asterisk (*), to specify which files to upgrade to the Notes 8 mail template, be sure that all databases in the directory (and, if specified, subdirectories) are mail files. When you use a wildcard character, Lotus Domino replaces the design of all databases specified by the wildcard character with the specified template, such as the Notes 8 mail template. If you replace the design of a non-mail database with the Notes 8 mail template by mistake, you can use the mail conversion utility to restore the original design and then specify the correct template.

**Domino Designer, Domino Server**

**XML4j.jar not needed when upgrading to Domino 8.x**

When upgrading from Domino 6.x to Domino 8.x, you do not need the following files:

- *LotusXSL.cab*
- *LotusXSL.jar*
- *XML4j.cab*
- *XML4j.jar*

You can remove the files; they are located in the `notes\notes\domino\java` directory.
Configuration notes

Lotus Notes

Enabling Notes single sign-on for Windows
When you install Notes you can optionally choose the "Client Single Logon Feature" Notes option. After installation is complete, you must restart the client machine in order for single logon to take effect. After client machine restart, when you restart Notes, a Notes Single Logon Password Synchronization panel appears. Click Yes and, as prompted, enter your Notes password and click OK. A Change Password panel then appears prompting you to enter the new password and re-enter the new password for confirmation. In both password entry fields, enter your Windows system password and then click OK. The single logon feature will now be fully operational.

Note that if you want to disable the Notes single login feature, click File -> Security -> User Security and disable the "Login to Notes using your operating system login" setting in the "Your Login and Password Settings" area of the Security panel. After disabling single sign-on, use your Windows password to log in to Notes.

Lotus Notes

Updating Notes features in 8.0.1
Because Windows directory privileges have been modified for Notes in release 8.0.1 to accommodate security improvements made for Windows Vista and Windows XP SP2, you may experience changes from how feature installation and update behaved in Notes 8.0.

For example, when you install or update features using the "File -> Application -> Install" menu sequence, you will now need administrator privileges if you are updating features installed in the Notes\framework directory. However, you will not need administrator privileges if you are working in Notes 8.0.1 and are installing new features, or updating features installed to the workspace\applications directory.

Lotus Notes, Domino Designer, Domino Server

Signing Eclipse plug-ins
Once you have created and signed new Eclipse features and plug-ins, you can control the response to untrusted content during feature install and update using either Domino or Eclipse settings. Domino policies override Eclipse preferences set in the plugin_customization.ini file.

For information about Domino policy settings specific to signed plug-ins, see the Domino 8 Administrator help topic "Creating a security policy settings document".

For information about signing custom and third party features and plug-ins, and controlling preferences using the plugin_customization.ini file, see the Domino 8 Administrator help or Installation Guide topic "Signing custom or third-party Eclipse plug-ins for install and update".

Domino Server

CA key rollover not recommended in large organizations
In Domino 8, administrators can assign a new set of public and private keys to a Domino certificate authority (CA), which are used to certify the keys of OUs, users and servers in that organization. The process of assigning new keys is known as key roll over, and is documented in the Domino Administration Help topic "Certificate authority key rollover."

The CA key rollover feature has not been tested in Domino customer deployments, so its use is currently not recommended in these environments. Organizations that want to become familiar with the feature are encouraged to use the feature to roll over the keys of a test CA, and then test users in their environment.
Constraining the file system cache on 64-bit Windows

The file system cache on 64-bit versions of Windows will, by default, attempt to use the majority of system memory, and may thus cause issues for applications running on the platform. This is due in part to the fact that the "default" setting for the file system cache moved from 1GB on 32-bit Windows to 1TB on 64-bit Windows.

To address this issue (as well as possible for an application), Lotus has implemented code within Domino which calls the Microsoft API `SetSystemFileCacheSize()`, in order to set a maximum size. By default, Domino will set this maximum size to 30% of the physical memory on the system. A user can change this setting by setting the notes.ini variable `MEM_FSCachePercentMem` to a percent number, to indicate the percent of memory.

For example, setting `MEM_FSCachePercentMem=40` in the notes.ini will cause Domino to set the maximum file system cache size to 40% of the physical memory on the system. Note that the lowest number presently supported is 10%, and the highest number is 95%; numbers outside these limits will be set to the default of 30%.

Key notes

1. This setting is system-wide and affects all processes on the system, as it affects the file system cache for the machine.
2. This setting must be set identically within each Domino partition on a system. Since it is a global setting, if one partition is 70 and another 30, then the setting of one will get overridden by the other when the second partition is launched.
3. This is not an optimal solution as it requires the user to "determine" the best value for the file system cache for their system/load, however, it is the only solution which is presently supported by Microsoft. IBM is actively working with Microsoft to see if a "better" solution can be found to this issue.
4. In order to make this change in the file system cache setting, the user must have the `SE_INCREASE_QUOTA_NAME` privilege, otherwise the setting of the cache will fail.
5. This API requires 64-bit Windows 2003/XP to be at SR2/SP2 or higher, otherwise the API will not be available. 64-bit Windows Vista and 64-bit Windows 2008 both have this API initially.

We now ship with Domino a tool called "cacheset.exe" which is used to affect these changes for 32 Bit Domino (64 Bit Domino calls the API directly), and which is available to see what the present system settings are for both 32- and 64-bit Domino. This binary is located in the same location as all of the Notes/Domino binaries. This is a 64-bit binary program (since the API requires 64-bit in order to set values greater than 4GB), and is thus invalid to run on 32-bit versions of Windows. On 64-bit Windows systems, running this application with no options (or incorrect flags, or -h, or -?) will result in a help/usage message printing to the command prompt.
Domino Server

**Domino for AIX configuration**

It is recommended that `/etc/security/limits` be modified for each Domino Server Partition user ID (domsrv in this example) to the following values:

```markdown
domsrvr:
  fsize = -1
  core = -1
  data = -1
  rss = -1
  stack = -1
  nofiles = -1
```

Make these be "unlimited" for the user ID and Domino Server programs.

Domino Server, Domino for System z

**Domino for Linux on System z configuration**

A detailed reference for the planning, installation, and configuration of Domino for Linux on System z can be found in the following Redbook:

http://www.redbooks.ibm.com/abstracts/sg247021.html

While written for an earlier Domino release, the planning considerations and task descriptions still apply to this release.

**Increasing the per-process filehandle limit**

By default, the Linux kernel limits the number of file descriptors that any one process can open; the default is 1024. This limit includes socket file descriptors that are opened during basic client/server communications, therefore is too restrictive for the Domino process. Do not assume that having fewer than 1024 databases (or files) in the Domino data directory is an indicator of the maximum number of open file descriptors that Domino will require. In order to scale above "tens" of client connections, this default must be overridden by the Linux administrator.

The mechanism for overriding the default varies depending on how the Domino server is started. There are 2 basic scenarios:

1. **Domino is started from a login session**

   For this case, the default must be overridden by modifying the file `/etc/security/limits.conf` AND insuring it is respected by the login. Edit `/etc/security/limits.conf` using root and add or modify the lines:

   ```
domsrvr soft nofile 20000
domsrvr hard nofile 49152
```

   where "domsrvr" is an example of the user id that will run the Domino server. Specify the UNIX user name in the first column that is the owner of the notesdata directory specified during Domino installation. If more than one Domino partition exists on the same Linux for System z platform, repeat these lines for each user id. The "soft" value specifies the new default file descriptor limit (ulimit -n), and the "hard" value specifies the maximum file descriptor limit that may be set by the user.

   In order for these limits to be respected following logon, ensure the following line is in the appropriate `pam.d` login file:

   ```
   session required pam_limits.so
   ```

90
For example, if ssh login is used, this line must appear in /etc/pam.d/sshd
If telnet is used, this line must appear in /etc/pam.d/login
If rlogin is used, this line must appear in /etc/pam.d/rlogin

The user id must login after the above changes are made and saved.

2. Domino is automatically started through /etc/init.d

The redbook "IBM Lotus Domino 6.5 for Linux on zSeries Implementation" discusses this procedure in detail (Chapter 9, Section "Automating Domino startup and shutdown"). It is worth noting, however, that /etc/security/limits.conf settings are NOT respected when Domino is automatically started by a /etc/init.d script. Therefore, a line such as the following MUST appear in the "start" section of such a script:

```bash
ulimit -n 20000
```

**Warning:** Always make /etc/security/limits.conf change (1. above) in addition to modification of the "start" script. Otherwise, on the occasion that Domino is started from a login session, the file descriptor limit will be inadequate.

**Kernel values modified by Domino**

In addition to the above, other Linux kernel value changes are needed for large scale Domino environments. Unlike the per-process filehandle limit, which must be modified before logon of the Domino user id, these values can be modified by Domino itself. At startup, a program named "tunekrnl" runs with root authority and sets these values in the /proc filesystem. Once set, these /proc values will not change until Linux is (re)booted, at which time they revert to their default values. The exception to this is "mapped_base", which is a process-local setting made at each Domino startup. The "tunekrnl" log of /proc filesystem changes tends to vary from many (following a Linux boot) to few (subsequent Domino startups). The kernel values modified by "tunekrnl" are:

<table>
<thead>
<tr>
<th>kernel parameter</th>
<th>default value</th>
<th>tunekrnl value</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/proc/sys/fs/file-max</td>
<td>(as low as 8192)</td>
<td>131072</td>
<td>maximum number of system-wide file descriptors</td>
</tr>
<tr>
<td>/proc/sys/kernel/sem</td>
<td>250 32000 32 128</td>
<td>250 256000 32 1024</td>
<td>shared semaphore allocation sizes and limits</td>
</tr>
<tr>
<td>/proc/sys/kernel/shmmax</td>
<td>32 M</td>
<td>256 M</td>
<td>maximum shared-memory segment size</td>
</tr>
<tr>
<td>/proc/sys/net/ipv4/tcp_fin_timeout</td>
<td>60</td>
<td>15</td>
<td>retransmission timer for a FIN (socket close) in seconds</td>
</tr>
<tr>
<td>/proc/sys/net/ipv4/tcp_max_syn_backlog</td>
<td>1024</td>
<td>16384</td>
<td>maximum value of the listen() connection backlog</td>
</tr>
<tr>
<td>/proc/sys/net/ipv4/tcp_tw_reuse</td>
<td>0</td>
<td>1</td>
<td>1 enables &quot;time-wait assassination&quot; allowing for rapid re-use of sockets</td>
</tr>
<tr>
<td>/proc/sys/net/ipv4/ip_local_port_range</td>
<td>32768 61000</td>
<td>1024 65535</td>
<td>increases the range of port values available for connect()</td>
</tr>
<tr>
<td>/proc/&lt;pid&gt;/mapped_base</td>
<td>1 Gigabyte</td>
<td>16 Megabytes</td>
<td>&quot;floor&quot; address value above which memory allocations may occur on SLES</td>
</tr>
</tbody>
</table>
Note: Mapped_base is only changed where/when needed based on the OS version.

**Swap configuration for Linux on System z**

64-bit native environments, such as SLES9 (64-bit), should be configured with more than 2 Gigabytes of real memory rather than dedicating the memory resource to XPRAM. In these environments, Linux swap should still be configured, however routine swapping is not expected and using disk for the swap region is acceptable.

**Domino Server**

**Domino for Linux on x86 configuration**

The following configuration notes apply to Domino for Linux x86 processors:

**Increasing the per-process filehandle limit**

By default, the Linux kernel limits the number of file descriptors that any one process can open; the default is 1024. This limit includes socket file descriptors that are opened during basic client/server communications, therefore is too restrictive for the Domino process. Do not assume that having fewer than 1024 databases (or files) in the Domino data directory is an indicator of the maximum number of open file descriptors that Domino will require. In order to scale above "tens" of client connections, this default must be overridden by the Linux administrator.

The mechanism for overriding the default varies depending on how the Domino server is started. There are 2 basic scenarios:

1. **Domino is started from a login session**

   For this case, the default must be overridden by modifying the file `/etc/security/limits.conf` AND insuring it is respected by the login. Edit `/etc/security/limits.conf` using root and add or modify the lines:

   ```
   domsrvr soft nofile 20000
   domsrvr hard nofile 49152
   ```

   where "domsrvr" is an example of the user id that will run the Domino server. Specify the UNIX user name in the first column that is the owner of the notesdata directory specified during Domino installation. If more than one Domino partition exists on the same Linux x86 platform, repeat these lines for each user id. The "soft" value specifies the new default file descriptor limit (ulimit -n), and the "hard" value specifies the maximum file descriptor limit that may be set by the user.

   In order for these limits to be respected following logon, insure the following line is in the appropriate `pam.d` login file:

   ```
   session required pam_limits.so
   ```

   For example, if `ssh` login is used, this line must appear in `/etc/pam.d/sshd`

   If `telnet` is used, this line must appear in `/etc/pam.d/login`

   If `rlogin` is used, this line must appear in `/etc/pam.d/rlogin`

   The user id must login after the above changes are made and saved.
2. Domino is automatically started through /etc/init.d

Starting a Domino server automatically when Linux is booted is typically accomplished by executing a script which resides in the /etc/init.d directory (in a "runlevel"). It is worth noting, however, that /etc/security/limits.conf settings are NOT respected when Domino is automatically started by a /etc/init.d script. Therefore, a line such as the following MUST appear in the "start" section of such a script:

```
ulimit -n 20000
```

**Warning:** Always make /etc/security/limits.conf change (1. above) in addition to modification of the "start" script. Otherwise, on the occasion that Domino is started from a login session, the file descriptor limit will be inadequate.

### Kernel values modified by Domino

In addition to the above, other Linux kernel value changes are needed for large scale Domino environments. Unlike the per-process filehandle limit, which must be modified before logon of the Domino user id, these values can be modified by Domino itself. At startup, a program named "tunekrnl" runs with root authority and sets these values in the /proc filesystem. Once set, these /proc values will not change until Linux is (re)booted, at which time they revert to their default values. The exception to this is "mapped_base", which is a process-local setting made at each Domino startup. The "tunekrnl" log of /proc filesystem changes tends to vary from many (following a Linux boot) to few (subsequent Domino startups). The kernel values modified by "tunekrnl" are:

<table>
<thead>
<tr>
<th>kernel parameter</th>
<th>default value</th>
<th>tunekrnl value</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/proc/sys/fs/file-max</td>
<td>(as low as 8192)</td>
<td>131072</td>
<td>maximum number of system-wide file descriptors</td>
</tr>
<tr>
<td>/proc/sys/kernel/sem</td>
<td>250 32000 32 128</td>
<td>250 256000 32 1024</td>
<td>shared semaphore allocation sizes and limits</td>
</tr>
<tr>
<td>/proc/sys/kernel/shmmax</td>
<td>32 M</td>
<td>256 M</td>
<td>maximum shared-memory segment size</td>
</tr>
<tr>
<td>/proc/sys/net/ipv4/tcp_fin_timeout</td>
<td>60</td>
<td>15</td>
<td>retransmission timer for a FIN (socket close) in seconds</td>
</tr>
<tr>
<td>/proc/sys/net/ipv4/tcp_max_syn_backlog</td>
<td>1024</td>
<td>16384</td>
<td>maximum value of the listen() connection backlog</td>
</tr>
<tr>
<td>/proc/sys/net/ipv4/tcp_twReuse</td>
<td>0</td>
<td>1</td>
<td>1 enables &quot;time-wait assassination&quot; allowing for rapid re-use of sockets</td>
</tr>
<tr>
<td>/proc/sys/net/ipv4/ip_local_port_range</td>
<td>32768 61000</td>
<td>1024 65535</td>
<td>increases the range of port values available for connect()</td>
</tr>
<tr>
<td>/proc/&lt;pid&gt;/mapped_base</td>
<td>1 Gigabyte</td>
<td>16 Megabytes</td>
<td>&quot;floor&quot; address value above which memory allocations may occur on SLES</td>
</tr>
</tbody>
</table>

Note: Mapped_base is only changed where/when needed based on the OS version.
Domino Server

**Domino memory pre-allocation configuration**

As of Domino 7, there is now code in Domino which, when enabled, will instruct Domino to pre-allocate shared memory at startup, thus preventing the possibility of the server "crashing" with an error of the type "Error attaching to shared memory" or "Error on mapping memory" during extended Domino server operation. This is due to the fact that at Domino startup, Lotus will immediately allocate/map in the maximum amount of useable shared memory, and never again create any more shared memory, thus preventing the possibility of a later process allocating shared memory that other processes cannot map into their address space. The downside of this is that Lotus will always automatically use up this amount of virtual memory for shared memory, and thus will be capped on available local memory based on the addressable memory available to Domino on the operating system.

For example, with this code enabled, on Windows, 32-bit Domino will pre-allocate 1.5 GB of shared memory (default setting for Constrained Shared memory, changeable via **ConstrainedSHMSizeMB** Notes.INI setting) and with an addressable memory of 2 GB (default value for Windows to match default setting of OS, changeable via **MEM_AddressableMemSizeMB** Notes.INI setting and OS configuration), that only leaves 512MB for local memory. The upside is that running out of memory either in shared or local will not crash the server (or should not), whereas the inability to map shared memory always will.

This new code is off by default, and must be enabled by setting **MEM_EnablePreAlloc=1** in Notes.INI.

In order for this new code to work, Lotus had to enable the sub-allocation of shared memory when pre-allocation is turned on (this can be manually enabled if desired and do not wish to pre-allocate by setting **MEM_EnableSubAlloc=1** in Notes.INI; Sub-allocation is only on by default on AIX). With sub-allocation, Lotus creates shared memory as large "segments" and then sub-allocate memory pools out of them. For example, on Windows the size for a "segment" is ~200MB (default setting for sub-allocate Shared Memory segment size, changeable via **MEM_SHMSubAllocSize** Notes.INI setting) and Lotus will then create memory allocations out of it based on a shared dpool size of 4MB (default setting on Windows, changeable via **SHARED_DPOOLSIZE** Notes.INI setting). This does limit the maximum single allocation size to the size of a "segment" - in this case ~200MB - but internally Domino makes no memory requests of this size, nor should any API program; an allocation request over this size will fail.

There are also some changes/additions to memory variables which are set in the Notes.INI file:

1. As stated previously, the variable **MEM_EnableSubAlloc=1** will enable sub-allocation of shared memory.

2. As stated previously, the variable **MEM_SHMSubAllocSize=VALUE** can be used to override the default setting for the size of a sub-allocated "segment" of shared memory (where VALUE is in bytes, and the default varies by platform).

3. As stated previously, the variable **MEM_EnablePreAlloc=1** will enable pre-allocation of shared memory and will also enable sub-allocation as well. (Setting this variable enables **ConstrainedSHM** and **MEM_AddressableMem** as well).

4. The variable **ConstrainedSHM=1** will now enable the constraining of shared memory only - it will not directly inhibit "addressable" memory as before but will enable **MEM_AddressableMem**.

5. The variable **ConstrainedSHMSizeMB=VALUE** can still be used to override the default setting for constrained shared memory (where VALUE is in megabytes, and the default varies by platform).

6. The variable **MEM_AddressableMem=1** will enable code to limit the amount of memory seen as "addressable". Without this setting, there is still a default limit in place of 4GB, and with the setting enabled, more realistic values are used.
7. The variable $\text{MEM\_AddressableMemSizeMB=VALUE}$ can be used to override the default setting for the amount of memory Domino will see as "addressable" memory (where VALUE is in megabytes, and the default varies by platform).

8. There is now a variable on UNIX to enable using "mmap" for shared memory - $\text{MEM\_EnableMmap=1}$. This is on by default on Solaris only, and is not presently supported on any other platform.

9. There is now a variable to specify the location for where Domino will place "mmap" shared memory files - $\text{MEM\_Mmap\_Location=FOO}$ where FOO is the absolute path to the new location. This variable is only valid for platforms running with "mmap" shared memory.

Domino Web Access

**DWA: Configuring the new Sametime buddy list**

To configure the new Sametime buddy list:

**On the DWA server**

- Turn on Java servlet support
  1. Open server doc and go to [Internet Protocols...] -> [Domino Web Engine]
  2. Select "Domino Servlet Manager" in the "Java servlet support" field.

- Create a file named servlets.properties and put it in the server's data directory
- Add the following content to the servlets.properties file:
  
  ```
  servlet.DWABuddyList.code=com.lotus.dwa.stbuddy.DWABuddyList
  ```

- Be sure to restart the server after finishing the settings above
On the Sametime server
- Add the IP address of the DWA server to a setting document in stconfig.nsf on the Sametime server
  1. Open stconfig.nsf on the Sametime server
  2. Open "By Form" view and open the document called "CommunityConnectivity"

3. Enter the IP address of the DWA server to "Community Trusted IPs" field

4. Restart the Sametime server
Domino Server

Error message displays setting up partitioned server
When you set up a partitioned server with the nserver command, an error message window with "You must specify a valid data directory" will pop up. This pop-up, however, should be a Windows partition selection option.

Workaround
Directly load the Notes.INI parameter, for example, C:\Lotus\Domino\nserver.exe = C:\Lotus\Domino\data2\notes.ini

Domino Server

NAB does not contain cross certificates for authentication
Although cross certificates are created when you set up your first server, the Name and Address Book (NAB) does not contain cross certificates capable of authenticating you when you set up an additional server.

Workaround
1. Manually copy the names.nsf/admin4.nsf/server.id/ file and the cross certifier locally to the newly-installed server.
2. Set up the additional server again.

Lotus Notes, Domino Server

Running Java "programs" using the Java API for Domino
In order to run a Java "program" or "application" local (as opposed to using "remote" java via NCSO.jar and running the DIIOP server task), which uses the Java API for Domino, you must:

1. Use the Java version which ships with Domino. Only the version which ships with the given version of Domino is supported; there are various reasons for this. First, Lotus only tests with their version of Java, and does no testing with any other version. Second, Lotus has made "modifications" to files within the version of Java (JVM) they ship, such as changes to security policies, or adding additional jar files, which would not be present in another version of Java.

2. On UNIX, you must invoke the Lotus version of Java via the symbolic link (default location is /opt/ibm/lotus/bin/java). On UNIX, any binary which is run is actually invoked via a startup script. For example, /opt/ibm/lotus/bin/java is a symbolic link to tools/startup, which is in turn a symbolic link to /opt/ibm/lotus/notes/latest/PLATFORM/startup. When invoked in this method, it runs the Lotus startup script, which sets up the environment needed to operate (such as LANG and LIBPATH), and then invokes the binary for which the initial symbol link was named (in this case, java).

Failure to follow these rules will result in an unsupported environment; running outside of these rules is unsupported.
Domino Server

**Server Fast Restart**

When a Domino outage occurs due to a crash, Fault Recovery typically runs NSD on the crashed instance, and then launches a new instance once completed. The Server Fast Restart feature allows a new Domino instance to start directly, while NSD diagnostics are still being run in the background on the crashed Domino server instance. When diagnostics are completed the initial Domino server instance resources are automatically recycled. In the current release, Server Fast Restart is only available on AIX and Solaris versions of the Domino server.

**How does Server Fast Restart work?**

All files and connections in use by the initial Domino instance are closed but processes and shared memory remain active until NSD diagnostics are completed. The new instance will be started by a Server Fast Restart process called `faultmon`.

When the initial Domino instance fails, it will send a message to a monitoring program called `faultmon`. `faultmon` receives the message over a named pipe, and restarts Domino. `faultmon` has two options for restarting the new Domino instance; the default option is to start the new Domino instance in the background, while the second option allows the user to specify a script to start the new Domino instance.

When Server Fast Restart is enabled, the resources necessary for each Domino instance are kept separate and unique by the use of a key.

**How to configure Server Fast Restart**

Server Fast Restart is an extension of Fault Recovery:


2. To enable Server Fast Restart in the current release the following must be added to the Notes.INI file:

   ```
   SERVER_FAST_RESTART=1
   Debug_DisableOSFileLocks=1
   ```

3. (Optional) To enable a script to start the new Domino instance, add the following to the Notes.INI file:

   ```
   SERVER_FAST_RESTART_SCRIPT=<absolute path to script including script name>
   ```

   The following is an example script or a restart script:

   ```
   #!/usr/bin/csh -f
   setenv DISPLAY rome:0.0
   /usr/dt/bin/dtterm -e /opt/domino8/lotus/bin/server &
   ```

   Note, the example above requires that xwindows is installed and running. The contents and functionality of the restart shell script are your responsibility. Make sure that your shell script can run independent of the feature to ensure it works. Also make sure that the file permissions allow script execution. Don't wait for a server failure to find out your script does not run.

4. Start Domino as normal; `faultmon` will be started automatically.
Observations and known behaviors:

1. When a new server is started with Fast Restart enabled the server will report the instance key being used:

   [180300:00006-00515] 06/26/2007 14:29:41  Server Fast Restart is ENABLED, instance key is FD3CE800

2. At any time the "show server" command can be issued to review the server’s current instance key:

   [180300:00006-00515] Server Fast Restart: Enabled instance key FD3CE800

3. When using NSD with Server Fast Restart with Domino, it is necessary to use the -key option to specify which instance to collect information about.
   
   a. To run NSD to collect data with an example key of FD9AA800, from the Domino data directory:

   /opt/domino8/lotus/bin/nsd -key FD9AA800

   b. To run NSD to terminate Domino with an example key of FD9AA800, from the Domino data directory

   /opt/domino8/lotus/bin/nsd -kill -key FD9AA800

   c. If the Domino instance fails, the fault recovery code will automatically start nsd with the instance key to collect instance specific data. Once nsd has completed data collection, nsd will use the -kill option to terminate the faulted instance.

   d. In future releases, it maybe possible to run NSD without the -key option to collect data on the current instance.

4. Currently, Server Fast Restart does not work with a server ID with a password.

5. To ensure enough headroom, and to maintain satisfactory performance during a Fast Restart of the new Domino instance while NSD is collecting data, it is recommended to have additional physical memory available. Specifically, if the Domino instance uses up to 4 GB of physical memory, it is recommended to reserve additional memory in the range of 2 - 4 GB for the Fast Restart feature. For an 8 partition system using currently 32 GB of physical memory an additional 4 GB are recommended.

6. Server Fast Restart does not work with the Java Console. RTOA6Y7QXU

7. The Notes.INI setting Debug_DisableOSFileLocks=1 has had limited testing.

8. faultmon output is logged to the IBM_TECHNICAL_SUPPORT directory in a file called faultmon.log.
SSL Cryptographic Accelerators

Starting with Notes/Domino 7, the SECManipulateSC API function can be used to push the server’s RSA keypair from an SSL keyring file onto a cryptographic token that supports PKCS#11. This will cause all private key operations involving the server key to be performed upon the token. This cryptographic token can be a traditional smartcard (which will result in terrible performance issues) or an SSL cryptographic accelerator that provides a PKCS#11 interface.

The only cryptographic accelerator that has been tested is the Rainbow CryptoSwift eCommerce Server Accelerator PCI CS400 model 2.2.6a, using the PKCS#11 DLL installed to c:\WINNT\system32\Cryptoki22.dll with the PKCS11_NO_HWCHECK=1 NOTES.INI variable set.

In the current release, the server’s ID file must be smartcard-enabled in order for the PushKyrKey operation to succeed.

Here is some pseudocode to demonstrate the use of SECManipulateSC. As always, real code should check for and handle errors.

```c
error = SECManipulateSC (SC_manip_GetVersion, _ NULLSCMCTX, 
                       NULL, 
                       &Version, 
                       NULL); 

/* SC_manip_PushKyrKey was added in Version 5 of this interface. If Version is 
not at least 5, then that operation will fail. */

/* Initialize the PKCS#11 context. */
SCMCTX Context = NULLSCMCTX;
error = SECManipulateSC (SC_manip_InitializeContext, 
                       &Context, 
                       NULL, NULL, NULL); 

/* Set up the server's ID file */
error = SECManipulateSC (SC_manip_EnterIDFile, 
                       &Context, 
                       NULL, 
                       &dwIDLen, 
                       ServerIDPath); 

/* Unlock the smartcard */
error = SECManipulateSC (SC_manip_EnterPIN, 
                       &Context, 
                       NULL, 
                       &dwPINLen, 
                       PIN); 

/* Note -- SC_manip_EnterPIN will use an external authentication path if it 
exists. If the token doesn't support a protected authentication path, 
SC_manip_EnterPIN will use the supplied PIN if one exists or generate a prompt 
if a NULL or zero-length PIN was used. */
```
/* Smartcard-enable the server's ID file */
error = SECManipulateSC(SC_manip_SCEnableID,
&Context,
NULL,
&dwPwdLen,
ServerIDPwd);

/* Push the keyring private key to the token */
if (Version >= 5)
error = SECManipulateSC(SC_manip_PushKyrKey,
&Context,
NULL,
&dwKyrLen,
KyrPath);

/* Alternately, starting in 7.02 and the current release, push the keyring private key and the corresponding X.509 certificate to the token */
if (Version >= 8)
error = SECManipulateSC(SC_manip_PushKyrKeyAndCert,
&Context,
NULL,
&dwKyrLen,
KyrPath);

/* Clean up */
SECManipulateSC(SC_manip_TerminateContext,
&Context,
NULL, NULL, NULL);

Domino for System i

System i: Choose the format of HTTP log files
HTTP log files are written in EBCDIC format by default on the System i platform. You can change the format of these files to ASCII by setting the following in the NOTES.INI file. The setting will take effect the next time the server starts or when HTTP starts again (for example, "tell http quit" then "load http").

HTTPLogFormatAscii=1

If HTTPLogFormatAscii is not present in the NOTES.INI file or if the setting is HTTPLogFormatAscii=0, then the HTTP log files will revert to their default EBCDIC format.
Domino for System i

**System i: JVM property settings on a per Domino server basis**

A property in the NOTES.INI file can be used to specify JVM Properties for the Domino server. This property, JavaUserOptionsFile, specifies a text file which contains the properties to add to the JVM. This text file can be either ASCII or EBCDIC and have up to 256 properties specified. Each entry must be in the form of "property=value" and be on a separate line.

Any property that can be set with the -D Java option is valid. Domino already provides a way of adjusting the stack sizes, etc.

If Domino specifies a property, and that property is also specified in the JavaUserOptionsFile, the JavaUserOptionsFile value is used. For example, if Domino specifies the property "Foo=1", and the JavaUserOptionsFile specifies "Foo=2", the JVM is created with "Foo=2".

Note There are currently 2 exceptions to this: java.class.path and java.library.path. Domino will link the values specified in the JavaUserOptionsFile to what Domino is already setting for these two properties.

Multiple Domino servers can share the same options file.

One use of this feature is easier enablement of Java applications that have native methods. In order for the System.load() or System.loadLibrary() to find the service program, that service program must be in the current path. In this case, the administrator would have to know what directories the Domino for iSeries code uses. With this change, the administrator can set the JavaUserOptionsFile in the NOTES.INI and in the referenced file specify "java.library.path=/QSYS.LIB/PGMAPP.LIB" where PGMAPP.LIB is the library containing the service program loaded by the java application.

For example:

In the server's NOTES.INI the following line is added:

```
JavaUserOptionsFile=/PGMApp/JvmOptions.properties
```

The file "/PGMApp/JvmOptions.properties" could have the following:

```
java.library.path=/QSYS.LIB/PGMAPP.LIB
java.class.path=/PGMApp/bin/PGMApp.jar
PGMApp.debug=0
PGMApp.serverName=Server1
```

Domino Server

**Virtualization and Domino**

To maximize a given hardware resource, it is possible to virtualize Domino using a variety of technologies. Briefly outlined in this release note are the technologies available for virtualization which can support Domino instances. The basic support concept is that if the technology virtualizes an operating system supported by Domino, then Domino is supported. Domino supports operating systems and is not limited to how the operating system is configured. The three virtualization technologies outline are Sun Solaris 10 Zones, IBM Dynamic Logical Partitioning (LPAR), and VMware ESX Server 2.5.x and 3.x
Sun Solaris 10 Zones
Sun Microsystems has provided virtualization documentation in a paper titled "IBM Lotus Domino in Solaris 10 Zones" by Eric Sosman. The document outlines how to setup and run Domino with a Solaris Zone:


IBM Dynamic Logical Partitioning (LPAR)
IBM has provided virtualization documentation on a variety of IBM platforms.

iSeries
Coexistence of Multiple Lotus Domino Releases in an LPAR Environment on the IBM eServer iSeries Server, SG24-6593-00
Redbooks, published 31 March 2003

PSeries
The following Redpaper provides insight into how IBM used pSeries LPARs to consolidate IBM Global Services servers worldwide:

IBM eServer pSeries 690 and Lotus Domino Mail Server Consolidation An IBM Global Services Case Study, REDP-3654-00
Redpapers, published 14 March 2003, Rating: ★★★★★ (based on 2 reviews)

VMware ESX Server
The official support policy for VMware ESX Server is published on the IBM web site http://www-1.ibm.com/support/docview.wss?rs=203&uid=swg21106182
IBM and VMware are currently working on a whitepaper that should be available in the last quarter of 2007.

Uninstallation information

Lotus Notes
Windows Vista: Silent uninstall must have UAC turned off
To silently uninstall Notes on a Windows Vista system, you must turn off Vista's UAC (User Account Control) capabilities. If not, uninstall will not be successful, and you may see the following error message:
Lotus Notes

Cleaning a previous Notes 8 installation from the client

If you experience a problem installing Lotus Notes on a system on which a previous beta has been installed, or if you exited out of the Notes installation process prior to its completion, review the troubleshooting suggestions provided below. Uninstall instructions are provided in the release notes supplied with each beta. If, after uninstalling your Lotus Notes beta or partial release, you continue to experience problems installing Lotus Notes, use the manual cleanup instruction provided below.

System on which a Notes 8.0 Beta 3 or later, or 8.0.1 Beta or partial Notes 8x version was installed:

If after uninstalling a Notes 8.0 Beta 3 or later or 8.0.1 Beta or partial Notes 8x install, you experience an issue re-installing, some troubleshooting suggestions are provided below.

Cleanup instructions for Windows -- Notes 8.0 Beta 3 or later or 8.0.1 Beta or partial Notes 8x install:

1. Delete the Lotus Notes <install path>\framework folder.
2. Delete the following two registry keys, if they exist, using the Start > Programs > Run > regedit command sequence:
   - HKEY_LOCAL_MACHINE\SOFTWARE\Lotus\Notes
   - HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Lotus\Expeditor
   Note: If the only folder inside HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Lotus is Expeditor, delete the Lotus folder.
3. If Notes appears in your Add/Remove Program panel, run the Windows installer cleanup utility located at http://support.microsoft.com/default.aspx?scid=kb;en-us;290301.

Cleanup instructions for Linux -- Notes 8.0 Beta 3 or later or 8.0.1 Beta, or partial Notes 8x install:

As root user:
1. Remove <install path>/install.log (and any other log files left over in that directory).
2. Remove <install path>/framework.
3. Remove /root/InstallShield (unless you have installed other programs on your system with InstallShield).
5. Remove /root/install.log if present.
6. Remove /root/install.xml if present.
7. Remove /etc/lotus/notes if present.

As non-root user:
1. Remove /home/<user name>/lotus.
2. Remove /home/<user name>/InternalProvisioning.log.
3. Remove the contents of /tmp owned by <user name>.
System on which a Notes 8.0 Beta 2 or earlier beta was installed:

If after uninstalling a Beta 2 or earlier beta version of Notes 8.0, you experience an issue installing this version, some troubleshooting suggestions are provided below.

Cleanup instructions for Windows -- Notes 8.0 Beta 2 or earlier:

1. Delete the Notes 8.0 Beta <install path>/framework folder.

2. Remove C:\Program Files\Common Files\InstallShield\Universal\ibm\notes8.
   Note: Subsequent installation may fail if you uninstalled the Notes 8.0 Beta, but temporary files were left in Program Files\Common Files\InstallShield\Universal\ibm\notes8. Symptoms are a relatively quick install, or a "null" error in the installation panels. To prevent this problem, be sure to uninstall Lotus Notes 8 and manually remove any files left in Program Files\Common Files\InstallShield\ibm\notes8.

3. Remove the user workspace located in Documents and Settings\<user name>\IBM\RCP\<timestamp> if present.
   Note: If multiple workspace folders are present, delete the most-recently created folder. You can determine which folder was created most recently by clicking View > Details.

4. Delete the following two registry keys, if they exist, using the Start > Programs > Run > regedit command sequence:
   HKEY_LOCAL_MACHINE\SOFTWARE\Lotus\Notes
   HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Lotus\Expeditor
   Note: If the only folder inside HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Lotus is Expeditor, delete the Lotus folder.

Cleanup instructions for Linux -- Notes 8.0 Beta 2 or earlier:

1. Remove the <install path>/framework folder.

2. Remove /home/<user name>/InstallShield unless you have installed other programs on your system with Macrovision InstallShield.

3. Remove /home/<user name>/IBM.

4. Remove /home/<user name>/install.log if present.

5. Remove the contents of /tmp that are owned by <user name>.

6. Remove /home/<user name>/install.xml if present.

7. Remove /home/<user name>/tmp_notes_args.properties if present.

8. Remove /home/<user name>/notes.

9. Update the following hidden files:
   Note: To view these hidden files in File Browser, click View > Show Hidden Files and scroll down the list until you find them.
   
   • Remove /home/<user name>/notesrc.
   • Restore /home/<user name>/profile by removing Notes references from any variables.
   • Restore /home/<user name>/bash_profile by removing Notes references from any variables.
Lotus Notes

**Cannot uninstall Notes on Linux using application browser**
You cannot uninstall Notes from a Linux client using the right-click menu in the Application Browser. For example:

1. Click Computer\More Applications.
2. Right-click "Lotus Notes 8" in New Applications.
3. Click Uninstall.

Instead use the Notes uninstall instructions in the Domino 8 Administrator help at http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/index.jsp.

Lotus Notes

**Ending the Notes uninstall process before completion**
If you end the Notes uninstall program prematurely, you may be prompted to navigate though various error messages, then be prompted to restart your system. After restart, rollback begins. When rollback is complete, some files and empty folders may remain in your installation directory. To avoid this complication, be sure to let the uninstall program run to completion.

Lotus Notes

**Need to remove "Multi-user Cleanup Service" along with client**
For Windows Vista only, after uninstalling a multi-user client, the "Multi-user Cleanup Service" in the Services dialog will only be stopped, not removed. Re-boot the OS; the "Multi-user Cleanup Service" still remains in the Services dialog.

Lotus Notes

**Notes uninstall must be done by same user type as install**
A non-administrative user cannot successfully uninstall a Notes installation that was installed by an administrative user. If an administrative user installs Notes, only an administrative user can correctly uninstall Notes.

Lotus Notes

**Repair utility for Notes features and shortcuts**
For Notes shortcuts, including the Lotus Symphony productivity tools, and for installed features resident in the `<install_dir>\framework` folder, "Repair" is not available using 'Add or Remove Programs' on the Windows control panel. Repair is only available when you re-run setup.exe using the same version of the Notes install media kit that is already installed. However, Repair will not have an effect for provisionable items, such as files resident in the `<install_dir>\framework` folder.

If you run Repair, and then encounter problems uninstalling or reinstalling Lotus Notes, see the "Cleaning a previous Notes 8 installation from your client" release note for related information.

Note that this change is specific to Notes standard configuration. If you have installed a Notes basic configuration, Repair continues to be available using Add or Remove Programs on the Windows control panel.
Lotus Notes

Single logon service still running after uninstall
If you have installed Notes using the "Lotus Notes Single Logon" option you may receive an error message if you uninstall. The message may state that files or services cannot be updated while the system is running. After completing the uninstall and rebooting the client, check the system services. You will likely find that the "Lotus Notes Single Logon" service is still running.

You should stop the service manually, using the Service Control Manager control panel applet, and then proceed with the Notes install.

Lotus Notes

Uninstall information not present in MSI log file
Uninstalling Lotus Notes 8 uninstall from a Windows client does not add uninstall information to the <install_dir>/framework/installer_logs file. However, uninstall information is added to the C:\Documents and settings\<username>\My Documents\LotusInstall.log file.

Domino Server

Uninstalling a Domino 8 server on UNIX
The IBM Lotus Domino 8 uninstaller has a wizard-type interface similar to the Domino server installer.

To invoke the uninstaller in graphic mode, set the environmental variable DISPLAY to "invoke" or use the command line option -console

Invoking the Domino Uninstaller
To uninstall the Domino server on any UNIX platform, log on as the root user, and then from any directory other than the Domino program directory, run

<Domino Program Directory>_uninst/uninstaller.bin

The default value for <Domino Program Directory> is /opt/ibm/lotus/notes/latest/<arch>

Examples of invoking Domino uninstaller where Domino is installed in the default location /opt/ibm/lotus
IBM AIX platform

/opt/ibm/lotus/notes/latest/ibmpow/_uninst/uninstaller.bin

Linux platform

/opt/ibm/lotus/notes/latest/linux/_uninst/uninstaller.bin

SUN Solaris platform

/opt/ibm/lotus/notes/latest/sunspa/_uninst/uninstaller.bin

If the graphic user interface is not available, run the Domino uninstaller in the console mode by invoking the uninstaller with the "-console" option. For example, on IBM AIX:

/opt/ibm/lotus/notes/latest/ibmpow/_uninst/uninstaller.bin -console

Note The uninstaller leaves several files, logs and links in the Domino program and data directories. These files should be cleaned up manually if necessary.
Lotus Notes

**Uninstalling if Notes path contains more than one space**
On Linux, the Notes 8 uninstall program will not run if the installation path contains a space. If you find yourself in this situation, see the "Uninstalling Notes" topic in the Domino 8 Administrator Help at http://publib.boulder.ibm.com/infocenter/domhelp/v8r0/index.jsp and the "Cleaning a previous Notes 8 installation from the client" release note.

To further clarify, the following conditions caveat this issue:

- If you have one space in the directory path (for example, ibm<space>lotus), you can install and uninstall Notes 8.
- If you have two spaces in the directory preceding the "/" (for example, ibm<space><space>/), you cannot install Notes 8.
- If you have more than one space in the middle of the directory name (for example, ibm<space><space>lotus), you can install Notes 8 but cannot uninstall Notes 8.

Lotus Notes

**Windows Vista: Uninstalling a multi-user installation**
After uninstalling a multi-user installation on Microsoft Windows Vista, when logged on as Administrator, the application does not fully shutdown. There is a process left behind called ntmulti.exe. To remove this process, open the task manager, find the process in the list and kill it.
Known limitations, problems, and workarounds

Limitations

Client issues

Lotus Notes

**Cannot move focus between panes in Preferences via keyboard**
In the Preferences dialog, focus cannot be moved between the navigation (left) and preferences (right) panes via the keyboard [Tab] key. Use the mouse to move focus between panes in the dialog.

Lotus Notes

**Citrix: Select Sound list is blank**
Using a Citrix client, in any Mail or Calendar dialog box where the user sets an alarm, the list of sounds will be blank. The affected dialog boxes are:

- Follow Up - Add or Edit Flag
- Mail Preferences: Follow Up panel
- Calendar Preferences: Alarms panel

There is no known workaround at this time.

Lotus Notes

**Embedded OLE objects created with MS Office 2007**
Microsoft has changed their default file format in Office 2007. As a result, OLE objects created with Microsoft Office 2007 cannot be launched by any client that is using a version of Microsoft Office older than Office 2007. The error you receive is: “The object's application or class is not available”.

**Workaround**
An Office 2007 object may be saved in a format compatible with Office 97-2003, and then embedded into Notes.
Lotus Notes

Features not available in "basic" configuration of Notes 8

A "basic" configuration of Notes 8 is available for cases in which the client machine's memory or specification is insufficient to run the standard configuration. As in previous releases of Notes, clients running this basic configuration can access only applications that reside on Domino servers, and provides only 3.x-compatible features for Sametime.

The following Notes 8 features are not available when you install the basic configuration:

User Interface

- Access to the Notes Getting Started Page using Help -> Getting Started Page from the main menu.
- Sidebar to provide access and mini-views of Sametime Instant Contacts, Feed Reader, Calendar and Activities
- Consolidated user preferences
- Choice of preview pane location, below list or beside list.
- "Open" button to open applications.
- Ability to set how Window tabs display in user preferences.
- Embedded Web browser, with the option to set default to your chosen browser.
- Easier methods to find and work with Location documents.
- New user interface for Help that lets you keep the Help pane open as you work.

Mail

- Mail quota and utilization data displayed in navigator.
- Improved choices for "Reply to All," "Include History," and "Include Attachments."
- Thread layout display when applying to a mail thread.
- The ability to right-click operations for an entire mail thread, such as deleting a thread or moving a thread to a folder.
- The ability to perform operations for an entire mail thread, such as deleting a thread, or moving a thread to a folder.
- Within the Inbox, the ability to see all related messages in a thread.
- Improvements to type-ahead feature.

Contacts

- Recent Contacts view that shows users with whom you have recently interacted, such as e-mail correspondence or chats.

Search

- New centralized search interface for queries and results (Domain Search, Find People, Find Application, Web/Intranet Searches available as search scopes).
- New Search capability for Help that searches across all "books" in the help system, such as Lotus Notes Help and Activities Help.
- Optional Desktop Search that can be launched by right-clicking Live names, and is also available in the Search scope drop-down menu.
Composite applications

- Composite applications that make it convenient for a user to access a collections of components (applications) to address a business need for a particular group of users.

Other

- The Home Page includes buttons for the IBM Lotus Symphony productivity tools (Documents, Spreadsheets, Presentations), however, these tools are not included with the basic configuration of Notes, and the buttons are not active. To use these tools, you must install the standard configuration.

- Ability to view collaboration history with another user, such as e-mail correspondence, saved chat transcripts, or shared documents.

Lotus Notes

Help Search -- Not all results can be synchronized with Contents

In Lotus Notes Help, when you use Help Search, and click on a topic in the search results, usually you can see where in the Help Table of Contents that topic falls by clicking either the Refresh / Show Current Topic or Show in Table of Contents icon. If nothing happens when you click one of these icons, the topic is an advanced topic that intentionally does not appear in the table of contents.

Lotus Notes

Roaming User - Issues and cleanup functionality

The "Cleanup" functionality, which is dependent upon Roaming User*, does not work in the Notes 8 standard configuration. Files which are created during the user's session are not deleted by the cleanup process. This prevents the User from re-launching Notes properly in the next user session.

* Please note that Roaming User is not supported in Notes 8, in its standard configuration. See separate Release Note for additional information.

Workarounds:

Use the Notes 8 basic configuration for users who rely upon the automatic cleanup functionality.

Domino Server

Windows 64-bit: KeyView filter unavailable for Lotus WordPro

The Lotus WordPro (LWP) file type cannot be filtered by the Verity KeyView filters on Windows 64-bit running with 64-bit Domino.
Composite Applications issues

Lotus Notes, Domino Designer

Composite applications only open in Notes client
A composite application can only be opened in the Notes client. In that case, the CA.XML that defines the application is read and any additional features are then provisioned.

When a composite application is opened in the Domino Designer client, the CA.XML is NOT read, and provisioning does not occur.

Lotus Notes, Domino Designer

Detect component application events in NSF components
In a composite application, you may sometimes want your application to publish properties when composite-application events occur. If you create custom components in Eclipse, they can respond to many types of events and, in particular, you can write code to trigger when the component becomes visible. This is handy in cases where you have multiple components on tabs, and you would like some other component to display information about data that comes from whichever tab is in the foreground -- if you click a different tab, the supporting information in the other component should change.

The NSF component plugin does not directly support this ability. However, a workaround is possible using a NotesTimer event that triggers periodically, to check which view or document has focus, by testing the value of NotesUIWorkspace.CurrentView and/or NotesUIWorkspace.CurrentDocument. This event code can be either in a view or form, or in a separate page or form displayed alongside the "target" view or form, in a frameset. The timer page would be in a very small frame, to save screen space. This approach is demonstrated in the Sales Lead sample, which can be downloaded from the Lotus developerWorks sandbox, and which you can read about at http://www.ibm.com/developerworks/lotus/library/notes8-lead-manager/.

Alternatively, you can create a custom component in Eclipse to trap any event you like, have it publish a property that you can wire to an action in the NSF application, and this action can publish a requested property. This approach will not, unfortunately, work with the "visibility" events, since we don't have any way as yet to display two components on the same tab, and the Java component can't appear in a frameset.

Neither approach is an example of loose coupling, but is the best solution at this time.

Domino Designer

Errors occur when adding local components
Errors may occur when adding local components (for example, Lotus Productivity Editors) to composite applications from the Composite Application Editor Component Palette. This occurs because not all local components are currently supported.

Domino Designer

References to obsolete tools appear in Designer documentation
While using the Domino Designer Help, you may find references to the "WSDL" and "NSFCOMPGEN" tools appear in the documentation and in Search lists. These tools are obsolete and any references to them should be ignored.
Domino Designer
**Timing problems occur with page transitions and properties**
Timing problems occur with page transitions in combination with publishing properties on `onPageOpen` using multiple pages. Abnormal page switching may occur when you fire multiple properties on multiple pages.

Domino Designer
**Wire does not fire in composite application**
While creating a composite application, for example, that has two views which are tabbed, a component wire may not fire. To be more specific, by changing which view/tab is on top, the next selection in the main view on the left will not fire the component wire. There is no workaround.

**Domino Domain Monitoring issues**

Lotus Notes
**DDM Remote Server Console Common Action not working correctly**
The Domino Domain Monitoring Common Action Remote Server Console does not enter the correct server name in the Server textbox of the Remote Server Console dialog box.

Domino for System i
**System i: DDM memory probe reports 2x usage for Java agent**
Due to platform differences, a Java agent on System i will be reported as using about 2x the CPU as on other platforms.

**Domino Web Access issues**

Domino Web Access
**Cannot reuse child windows to open encrypted mail**
In Domino Web Access, you cannot reuse a child window to open encrypted mail, even if you set the Basic user preference “Reuse child windows”.

Domino Web Access
**Desktop icons do not work for DOLS on Linux clients**
The Domino Offline Support desktop icons do not work on Linux. To open DOLS, from Domino Web Access, click **Online** to open a DOLS subscription.
Domino Web Access

**Domino Web Access Lite mode support in mixed environments**
Domino Web Access Lite mode is supported on a Domino 8.0.x server only, and the client's mail file must be based on the 8.0.x mail8 mail template. In mixed environments, if the client's mail file is based on version 8.0.x, the option for Lite mode may appear on the login screen, but if the user's mail file resides on a pre-8.0.x server, the Full mode launches instead of the Lite mode.

Domino Web Access

**Out-of-Office cannot be set offline**
If you go offline with Domino Web Access, the Out-of-Office preference is available. However, this preference cannot be set offline, or from a local archive. You must be online to enable it.

Lotus Notes, Domino Web Access

**Prevent Copy function is not supported in Domino Web Access**
Domino Web Access does not support the Notes mail delivery option "prevent copying." This delivery option in Notes mail is used to prevent recipients from copying with the clipboard, forwarding, replying with history, and printing a message.

Note that even if this option is used to send mail to other Notes users, it is merely a deterrent to copying, as recipients can use other means to copy the message.

Domino Web Access

**Ultralite: Alternate names are not supported**
In this release, Lotus iNotes Ultralite mode does not support Alternate Names.

Domino Web Access

**Ultralite: Reply/Reply To All/Forward limitations**
In Lotus iNotes ultralite mode:

- Reply and Reply To All without History are not available in the read document action bar. What a user must do is select Reply or Reply To All (which will include the prior e-mail history), and delete the history if needed before sending the message.
- Reply and Reply To All actions will always convert the prior message history to plain text, as Ultralite mode only supports compose/edit scenes in plain text.
- Reply/Reply To All actions will always remove attachments. The Forward action will always include attachments.
Ultralite: Secure mail is not supported

For this release, Lotus iNotes ultralite mode does not officially support writing or reading encrypted messages.

However, a user might be able to successfully read encrypted messages with ultralite mode if they have a Notes ID imported into their mail file through DWA preferences, and their Notes and Internet passwords are in sync.

If a user does not have their notes.id imported into their mail file, encrypted messages will appear as empty messages with no content.

If a user has their notes.id imported into the mail file and their passwords are out of sync, they may receive a password prompt for their notes.id. Entering the password may or may not work depending on the server configuration. An Illegal Arguments exception is possible.

Installation issues

Domino Server

Domino install - bidirectional language display error
When you install an IBM Lotus Domino 8 server for bidirectional locales, the bidirectional text in the InstallShield Wizard window erroneously displays as a question mark.

Domino Server

Linux installer displays East Asian license text incorrectly
If you install a Domino server in an East Asian language locale, on a Linux platform, the East Asian license text will display incorrectly when you navigate to the license acceptance panel.

Lotus Notes

Redundant icon is left in "Add or Remove Programs" using SURunAs
A redundant icon is left in the "Add or Remove Programs" list when Smart Upgrade RunAs is run by a non-Administrator with installation privileges.

Domino Server

Running server does not shutdown after trial license is expired
If your trial license is not expired, you can launch the trial server, and see a warning that shows the trial license remaining days. If your trial license is expired, you cannot launch the trial server, and will see a warning that the trial license is expired.

If, however, you launch the trial server before your trial license is expired, and let the server continue running, the running server will not automatically be shutdown, even though the trial license has expired.
Lotus Notes

**Smart Upgrade: Notes program path cannot contain a space**
Smart Upgrade will display the error "File does not exist" at the end of the installation process if the Notes program path contains a space anywhere in the pathname.

**DOMINO Server**

**UNIX installer shows incorrect prompt creating uninstaller**
When you install a partition server in console mode on a UNIX platform, the installer should not prompt creating uninstaller... after the installation progress bar reaches 100%.

Lotus Symphony issues

**Lotus Notes**

**Forms are not saved correctly in .PPT format**
If a Lotus Symphony Presentation document that contains forms is saved as a Microsoft PowerPoint (.PPT) file, and then re-opened by PowerPoint, the forms in that document will be shown as blank rectangular frames.

**Lotus Notes**

**Graphics with text cannot be copied to other applications**
In the SpreadSheet or Presentation tool, inserting a graphic and inputting text into it, and then copying the graphic to another tool, or to Lotus Notes, the text inside the graphic may be lost.

**Lotus Notes**

**Presentation tables cannot be displayed in OpenOffice 2.0**
A presentation table cannot be displayed by OpenOffice 2.0 if the file has previously been opened and saved by Lotus Symphony Presentations.

**Lotus Notes**

**Save unsupported document type may cause data loss**
Unsupported document types can be opened by altering their extensions, but this can cause data loss when the file is saved back. For example, changing a .HTML file into a .SXW file and opening it may result in the document content being lost when subsequently saving the file.

**Lotus Notes**

**Tables in Notes cannot be copied to Lotus Symphony Presentations**
Selecting and copying a table in Notes, then pasting it into the Lotus Symphony Presentation tool, will cause only the table text to remain.
Lotus Notes

**User cannot Undo if a document is not completely loaded**

The "Undo" command does not work when a document is still loading (for example, if the page number in the status bar keeps on increasing), until that loading is finished.

Lotus Notes

"**Reversing Path Direction" is not supported for animation effect**

"Reversing Path Direction" is an attribute for the 'Motion Paths' animation effects in Microsoft PowerPoint. This attribute is not supported in Lotus Symphony Presentations; there will be no animation effect if this attribute is set to 'True'.

---

**Mail issues**

Lotus Notes

**Cannot display Categorized Inbox in Notes**

If a mail template has the 'Pick Inbox Style' agent run, it will create an Inbox with some default categorized views. If you then replace the design of your mail application while a column is sorted, after the replacing the design, it will not create categorized views, and may have other column display problems.

Lotus Notes, Domino Server

**Group membership changes effectiveness of Message Recall**

When recalling a message sent to a group, recall requests will be sent to the current members of the group. It is possible that the message will not be recalled from all of the original recipients if those users are no longer members of the group.

Lotus Notes

**Interoperability of built-in view icons**

The Notes 8 client includes several additional built-in view icons. These icons are used in the version 8.0 Inbox, and other Mail and Calendar views. Most of the new icons have the same meanings as old icons, but a new look.

There is an interoperability issue with the version 8.0 mail file that makes it display version 7.x -style icons, or no icons, in mail views and folders when used in a mixed-version environment. This occurs when the mail file is accessed on a server that has a different version of Notes code than the client. Specifically:

- If the server is version 8.0 and the client is version 7.x (or earlier), some icons are not displayed at all, including the "high importance" indicator.
- If the server is version 7.x (or earlier) and the client is version 8.0, the 7.x-style icons are displayed instead of the new graphics.

The incompatibility occurs because the view index calculated by the server includes icon numbers based on the server's version, not the client's.
Any version 8.0 mail file accessed locally will display the appropriate icons for the client version you are using.
Any version 7.x mail file will always display 7.x-style graphics, because it doesn't know about the new icons.

The updated icons were added and given new numbers, rather than replacing the old icons with the same meanings. This was done to avoid affecting custom applications that use the old icons.

**Recommendations**

- Either use local mail files, or do not update mail files to 8.0 before you upgrade clients to 8.0.
- Update servers before clients (this is the recommended sequence for all upgrades).

**Lotus Notes**

**Mail quota usage and disk space properties values may differ**

For users with mail quotas, the mail size displayed in the mail navigator and Quota Information dialog box may differ from the disk space value displayed in the Application Properties box for the mail application. This depends on the quota method the mail server uses to determine the quota value. **By file size** or **By space used**. If the latter method is used, then differences between the mail quota usage and disk space values displayed in the client may occur in rare cases involving very large (multi-GB) files.

**Lotus Notes**

**Out-of-office and differences between client and server time**

When using the out-of-office feature in your mail file, it is important that the time on a user's client clock is close to the time on the mail server's clock, since some of out-of-office processing is done on the client, and some is done on the server.

For example, when using the out-of-office service, if the user manually disables out-of-office before this is scheduled to end, it is the time from the user's client that gets written to the out-of-office profile. The service (running on server) uses this time in its decisions as to whether or not it should run against incoming mail documents. If the server's clock is significantly behind the client's, the service will continue to run (even though the user has disabled it) until the server's clock hits the specified time.

**Lotus Notes**

**Setting Delegation requires specific access levels**

In order to create Delegation successfully, a user needs to have at least Editor access and "Owner" access to the mail database for which they are trying to create delegation. This "Owner" setting is found in the menu item 'Preferences -> Mail -> Basics'.
Notes client on Macintosh issues

Lotus Notes

**Known attachment viewing issues on Macintosh**

View attachment is not fully supported on Macintosh; known file formats that can not be viewed in Notes include:


Lotus Notes

**Some shortcut keys are not supported**

The following hotkeys are unsupported:

1. Home and End keys are not supported in the Address bar
2. Command+Down Arrow and Command+Up Arrow do not move items one row down/up in the dialog list field
3. Command+J does not allow the text properties infobox to open the paragraph alignment tab
4. Command+F9 does not open the Delete confirmation dialog
5. Option+F9 does not refresh the view
6. Escape does not close the Workspace tab
7. Command+End and Command+Home do not work
8. Option+Up, Option+Down, Option+Left, and Option+Right do not work
9. Pressing the F2 key does not enlarge the selected text
10. Accelerator keys "N" and "D" do not work on the Print Preview dialog
11. The Command+Z hotkey may not restore deleted characters in the 'Search for' field of the Search view
12. Command+A does not select the content in the formula field when creating a view or a folder
13. The "N" and "D" keys do not work in the 'Print Preview' dialog.
14. The "Esc" key on 'Open dialog' does not close the dialog, but displays the database list instead.
15. In some dialog boxes, choosing Command+?, or the Help button on the keyboard, results in no Help page displayed.
16. The Address bar does not support the keyboard "Home" key or "End" key.
17. You cannot use the 'Tab' key or arrow keys to move through an infobox.
18. In a rich text field, the Up and Down keys cannot be used to select a value in the Text Properties infobox.
19. Clicking Command +?, or the Help button, will not display a help page in the properties infobox.
20. Windows will not switch normally when pressing keyboard shortcuts ⌘+x.
21. Pressing the Enter key will not cause the database list on the server to appear in the Replace Database Design dialog.
22. The "backward delete" key does not work on the Mail, Calendar and Contacts view. On iMac, you can use the Delete key instead; on MacBook, you can use "Fn"+"backward delete" keys instead.
23. Command+F5 only works if your focus is on Mail, Calendar or Contacts view, otherwise it does not work. On Mac OS, Command+F5 is used to enable/disable voiceover by default. You can go to the menu "Lotus Notes -> Security -> Lock Display" to lock out Notes.
24. Some shortcut keys will not work while focus is on Mail, Calendar, or Contacts view; these include Command+W, Command+L, Command+G, Tab, and Shift+Tab.
25. Command+O will not work at times.
26. The ALT key does not work on Macintosh. The number menu prompted by ALT key does not work on Macintosh.
27. Infobox shortcuts do not work.
28. You can use Command+mouse-click, but not control+mouse-click to select multiple documents on Macintosh. But you can also use Shift+mouse-click to select multiple documents. But operating the selected multiple documents works incorrectly sometimes:
   - If you select many documents using Command+mouse-click and perform an action, it only acts on the last document selected.
   - If you select many documents using Shift+mouse-click, then perform an action, it will execute on all documents selected.
29. Option+B does not open the Open list.
30. Ctrl+F2 does not switch focus to the top menu on the Notes client (basic configuration).
31. Command+4, Command+3, and Command+2 can open, make thin, and close the sidebar in Mail, Calendar and Contacts view, but will not work in other views.
32. Some items cannot be navigated to by pressing Tab key.
   - Pressing the Tab key will not allow you to navigate to the "Prompt to replicate when Notes shuts down" item on the Replication Schedule dialog
   - Tab key does not work on Blocked Senders List
   - Tab key does not work among color pickers
   - The drop-down list cannot be navigated to by pressing the Tab key
   - In the Calendar Preferences UI, users are unable to navigate to the "Cancel!" button by tabbing directly to it
   - UI controls on some Instant Messaging dialogs cannot be navigated to by pressing the Tab key
   - The Date Picker in the Summary field of the meeting page will not get focus when using the Tab key
   - The Tab key does not work in the "Edit Formula" dialog
   - The Tab key does not work on Preferences dialog
33. If you have Sametime logged on, there will be only one name pasted when you copy/paste an invitation list to the "To:" field

34. The "Debugging Dashboard" dialog, opened via Command+0, cannot be closed

35. If you copy text via Command+C in the search bar, in the Mail, Calendar, or Contacts view, then you switch views and paste text into the search bar via Command+V, the text cannot be pasted. You can click on one document in the view, then Command+V will work.

Policy issues

Lotus Notes

Dialing rules not locking down via Desktop policies
The following dial up fields on the location document are not under policy control:

- Country code
- Area code
- Phone number

Lotus Notes

How-to-apply settings not applied to some Desktop settings
The following User Preferences fields on the Notes client Basic tab are not under "How to apply" control via Desktop policies:

- Enable Java Script error dialog
- Show in-line MIME images as attachments
- When text language is unspecified, use the forms
- Invoke Notes on vCard files
- Enable persistent breakpoints in LotusScript debugger
- Do not prompt when forwarding a document with edited attachments

Lotus Notes

Replication box not consuming configured values via policies
The Schedule - Replication schedule dialog box on the Replicator page will not lock down when the replication tab on a Desktop policy is configured to "Set and prevent changes". Configured Replication schedule fields will not be consumed on the client.
Search issues

Lotus Notes, Domino Server

PDF search fails with bidirectional language option
If a search string contains English and either Hebrew or Arabic words, the search fails, even after enabling the PDF bidirectional search option:

1. Enable the PDF bidirectional Search option.
2. Edit the file Formats.ini in the Notes Program directory as follows:
   
   
   [Formats]
   200=lpdf
   
   [pdf_flags]
   pdf_direction=LPDF_LTR (or LPDF_RTL, or LPDF_AUTO)
   
3. Create a Notes application index containing attached files.
4. Include English and Hebrew or Arabic in the same search string; the search fails.

Domino Server, Domino for System i

System i: Summary information for Domain Search not displayed
Domain Search Results for File Systems are not displaying the Summary information for PDF File Types. On System i (i5/OS), the name of the PDF files is displayed instead of the Summary information.

Security issues

Domino Server

Restrictions for using LTPAtoken2 for single sign-on
The Domino Administration Help topic 'Creating a Web SSO configuration document' describes how to choose the LTPA token format when configuring single sign-on (SSO) on Domino. For this release of Domino, please note the following:

- You cannot use LTPAtoken2 if your configuration includes any of the following products or features: Sametime, Quickplace, Domino Web Access, WebSphere Portal, Domino IIOP, Domino Java back-end classes, Domino versions other than Release 8.

- You cannot choose to use both LTPAtoken and LTPAtoken2 if your configuration includes WebSphere Portal.
Server issues

Domino Designer, Domino Server

**Domino 64-bit: Running DIIOP remote application returns error**

Running a DIIOP remote application against a 64-bit Domino server installation returns exception errors such as 'Exception in thread "Thread-1" java.lang.OutOfMemoryError'.

The DIIOP task is able to run on a 64-bit Domino server, but all clients using NCSO.jar to that server may not be able to successfully create a session to that server.

Domino for System z

**Domino for Linux on System z jconsole program limitation**

The following is a list of Domino Console restrictions for Domino on Linux for System z:

1. The `jconsole` command may be run from a Linux for System z system by setting the DISPLAY environment variable to point to a workstation running the XWindows server.

Domino Server

**NETBIOS over TCP/IP not supported on Windows 2003 x64**

NETBIOS over TCP/IP does not work on Microsoft Windows 2003 x64 Edition (64-bit) servers. If you enable a Domino NETBIOS port, the server will crash.

Domino Server, Domino for System i

**System i: Java heap dump not generated with "classic" JVM**

If you choose to use the non-default "classic" JVM using the Notes.INI value `JavaUseClassicJVM=1`, note that a heap dump (.phd file in the server's data directory) will not be generated if the JVM encounters an out of memory condition. The heap dump will be generated if you use the default JVM, J9.

See the "System i: Software requirements" release note for more information.

Domino for System z

**System z: zFS filesystem limitation**

On System z, Lotus does not recommend using the z/FS aggregate dynamic GROW feature for Domino file systems. z/FS is based on a UNIX file system software product that can take minutes (15 minutes in some cases) to grow a z/FS file system in an aggregate. During the time the z/FS aggregate is grown, all file systems within an aggregate are quiesced, in order to format the expanded part of the file system. This quiesce would be detrimental to Domino, as all disk I/O and client responses would cease during the aggregate GROW process.

Lotus also recommends that you continue to monitor the console log for the message "Warning: cannot merge full text index a/notes/data/mtdata/mtstore.ft due to insufficient disk space" and manually grow z/FS files systems as needed during off-peak hours.
Web Services issues

Domino Server

Consuming SOAPENC faults with multi-refs
Java Web service consumer script library methods are unable to fully deserialize thrown provider faults that employ SOAPENC multi-ref's. An empty fault is returned instead. This may be addressed in a future release.

Domino Designer

Moving Web service classes to a Java script library
Domino Designer 8 or later Web service PortType and/or value type classes may now reside in script libraries, either in their entirety or as supertypes in a class hierarchy, however, some restrictions apply when using Java script libraries.

First, the properties dialog droplist for specifying the Web service PortType class currently only displays the names of classes explicitly defined in the Web service design element, so the choice of PortType class must be made and the Web service then saved, before attempting to move the named PortType class into a Java script library. This applies to all Web service implementations, whether imported from an external WSDL document or written from scratch.

For example, one might:

1. Open a new Web service design element in Designer, and select "Java" as the programming language
2. Use the "Import WSDL" button to import an external WSDL document (which automatically initializes the "PortType class" option in the properties dialog)
3. Use the "New Class" button to add one "Untitled" class to the Web service (just a placeholder for step 13. below)
4. Name and save the Java Web service design element
5. Open a new Java script library design element, and reopen the Web service created in steps 1. through 3.
6. Select a Web service value type (i.e. non-PortType) class imported from step 2 (if any)
7. Select an "Untitled" class in the Java script library and replace its definition with the selected Web service class
8. Add another "Untitled" new class to the Java script library
9. Repeat steps 6. through 8., until all value type classes have been copied over to the Java script library (in reverse order of dependency)
10. Lastly, repeat steps 6. through 8. for the specified Web service "PortType" class itself
11. Select the "Compile Java code with debugging information" option on the Java script library properties dialog, and then name and save the Java script library
12. Use the Web service "Edit Project" button to add the script library to the Web service, by changing the left-hand "Browse" option in the resulting dialog to "Shared Java libraries", and then move the newly-named Java script library to the right-hand list of "Current Web Service Files"
13. Select all the individual classes in the "Current Web Service Files" list that were copied to the script library, and delete them from the project (leaving the "Untitled" class in place to satisfy Designer's Java browser)
14. Press "OK" and return to the Web service programmers pane
15. Save the Web service

In the above example, an entire imported Web service has been moved to a Java script library. The "PortType class" entry in the Web service design element properties panel will become blank, however, the service is still valid. Further changes to the contents of the script library, e.g. adding a new method to the previously-designated PortType class (which would then make WSDL regeneration desirable), may not actually trigger WSDL regeneration unless some property panel option is also changed (e.g. the option to "Include operation name in SOAP action").

To move value type classes only, step 10. above can be omitted.

Note, too, that Step 11. is recommended in order to emit the actual PortType method argument names into a generated WSDL document, or to prevent inadvertently triggering WSDL document regeneration when the Web service design element itself is next saved.

Domino Designer

Multi-byte characters in WSDL documents
WSDL documents are Unicode-based XML documents and, as such, may contain characters which are multi-byte in local operating system character sets. Because of file system dependencies, importing WSDL into a Java Web service or Java script library may not succeed for WSDL documents containing such characters.

Domino Designer, Domino Server

Web Service version compatibilities
Web services created using Domino Designer 7.x will run on a Domino 8 or above server with original Domino 7.x behaviors, except for obvious bug fixes. However, the reverse is not supported, for example, a Domino 7.x server cannot support Web services implemented or generated using Domino Designer 8 or above, due to Domino Designer 8 modifications and improvements to mappings between WSDL/XML Schema and Java or LotusScript language constructs.

Accordingly, invoking a Designer 8 Web service or requesting its WSDL document will, if hosted on a Domino 7.x server, return one of the following HTML messages:

"This version of the Web Service design is not supported on this server" -- from a Java Web service

or:

"Error 500"
"HTTP Web Server: Lotus Notes Exception - Unknown LotusScript Error." -- from a LotusScript Web service

Further, opening a Designer 7.x Web service using Designer 8 or above will display the following warning:

"The selected Web service has less-advanced features than are supported by this version of Designer. If changes regenerate the WSDL interface, then less-advanced Domino Web Service runtime environments will no longer execute this service",
Similarly, Domino 7.x Web services saved using Designer 8 will only lose their Domino and Designer 7.x compatibility if the changes saved using Designer 8 or above cause regeneration of the WSDL interface. Making changes using Designer 8 or above that regenerate the WSDL interface for a Domino 7.x Web Service will require confirmation in a dialog box, since the Web service will be permanently upgraded for Domino 8 or above, and will no longer be compatible with Domino 7.x.

Finally, opening a Designer 8 or above Web service using Designer 7.x will display the following warning:

"This Web service has been previously saved in a newer version of Designer. This version of Designer being used will not be able to save the Web service."

Domino Designer, Domino Server

Web Services and Arrays

By default, the WSDL representations generated by Domino Designer 8.x for arrays in a LotusScript or Java Web service implementation are of the following forms:

- XML "literal" form for Web service design elements that have rpc/literal, document/literal, or wrapped SOAP message formats:

```xml
<complexType name="xxxArray">
  <sequence>
    <element name="elem" minOccurs="0" maxOccurs="unbounded"
           type="[array element type]"/>
  </sequence>
</complexType>
```

- the SOAP-encoded ("SOAPENC") form for Web service design elements that have the rpc/encoded SOAP message format:

```xml
<complexType name="ArrayOfxxx">
  <complexContent>
    <restriction base="soapenc:Array">
      <attribute ref="soapenc:arrayType" wsdl:arrayType="[array
element type]"/>
    </restriction>
  </complexContent>
</complexType>
```

In addition, the XML "literal" form is also generated from Java Web service implementations for what are commonly known as Java Bean "indexed" properties in a Java Web service value type.

During WSDL importing, XML "literal" arrays are always supported, regardless of SOAP message format. However, Domino Designer 8 no longer imports WSDL descriptions using SOAP-encoded ("SOAPENC") arrays together with "literal" SOAP message formats (i.e. rpc/literal, document/literal, or wrapped).
The remainder of this Release Note is specific to LotusScript Web services.

**Empty Arrays**
Empty arrays in a SOAP request or response (i.e. literal array elements that are completely absent, or elements with a SOAPENC "arrayType" attribute, but no array content children) are now supported in Domino 8 LotusScript Web services by passing *uninitialized* dynamic arrays to the Domino 8.x provider or consumer.

This is a change in behavior from Domino 7.x Web service providers (which still either trigger runtime SOAP faults, or receive arrays of length 1) to increase interoperability and to allow for identifying empty arrays. This change suggests that the receiving Domino 8.x consumer or provider should be implemented to handle LotusScript ErrUninitDynArray errors, in order to detect an empty array as part of normal program array handling.

**Fixed-Size and Dynamic Arrays**
Fixed arrays are supported only when they are used within a Type declaration. For example:

```livescript
Type MyType
    myArray(2,2) As Long ' fixed-size array
End Type
```

Dynamic arrays are supported only when used within a Class declaration: For example:

```livescript
Class MyClass
    myArray() As Long ' dynamic array
End Class
```

Using arrays in other constructs may cause unpredictable results, including causing server stability problems (see SPR# TCAR6HPUH6).

**Multidimensional Arrays**
Serialization of multidimensional SOAP-encoded arrays are not currently supported. Such a serialization results in a single-dimension SOAP array containing all of the LotusScript array's elements, but with an incorrect array-size value in the "arrayType" attribute. (see SPR# TCAR6HPT4L)

Support for deserialization of multidimensional SOAP-encoded arrays was added with the 7.0.1 release. There are, however, some limitations:

- Multidimensional arrays are not supported when the array is a member of a LotusScript "Type" statement, or when the elements in the array are defined with a LotusScript "Type" statement. For such cases, it is suggested that a "Class" construct be used instead.
- So-called "jagged" arrays are not supported. An multi-dimensional array is considered to be "jagged" when sub-arrays within a given dimension are of varying lengths. For example:

```xml
<soapenc:Array xmlns:soapenc="http://schemas.xmlsoap.org/soap/encoding/"
    arrayType="xsd:int[][2]"
>
    <item>
        <item>100</item>
    </item>
    <item>
        <item>200</item>
        <item>300</item>
    </item>
</soapenc:Array>
```
- The optional "asize" component of the SOAP "arrayType" syntax is not recognized. The length of deserialized arrays will be based solely on the actual number of array elements present in the SOAP message. For example, for an array with the arrayType attribute of "xsd:string[10]", but with 5 or 15 actual items, the length of the array would be 5 or 15 respectively, not 10.

- The SOAP attributes "position" and "offset", for sparse and partially transmitted arrays, are not supported.

Domino Designer

**XML schema mechanisms "include" and "import" are not supported**
The XML schema mechanisms "include" and "import" are not supported. That is, any XML schema defined in an imported WSDL document must not refer to any external XML schema documents.

**Known problems and workarounds**

**Accessibility issues**

Lotus Notes

**Recent searches cannot be displayed in Large Font mode**
If your system is set to High-Contrast/Larger Font Mode accessibility setting, the title "Recent Searches" for the Recent Searches navigator cannot be displayed completely.

Lotus Notes

**Section properties box buttons are inaccessible**
If you open a Properties box for a section to change the section's title, buttons display that let you accept or discard changes you make to the title, but the buttons are not keyboard accessible. As a workaround, you can press 'Tab' to accept the title changes and move to the next properties field or press 'Esc' to discard the title changes.
Activities issues

Lotus Notes

**Adding large files to an Activity may take a long time**

Adding a large file from the file system, or an e-mail with a large file attachment, may take a long period of time, depending on the file size. The method of adding the file can be by either the drag-and-drop action, by the Add to Activity dialog, or by uploading a file using the Add -> File menu item.

An extremely large file, 10 megabytes or more, may take as much as 15 minutes or more to add. If the file size exceeds the server's file size limits, which are set by the server administrator, a dialog will eventually pop-up stating the file was not added due to its size.

To cancel the addition of the file, open the Progress window (by clicking on the Progress Bar icon in the lower right of the status bar), and click on the red box (Cancel Operation icon) in the Show column that is associated with the action.

Lotus Notes

**Group membership and Forward a Link problems**

Users who are included in activity membership by means of belonging to a Group may encounter problems using the "Forward a Link" action.

On the Windows XP platform, the e-mail may not launch properly for a user who is a member of a group. An "Error processing command line arguments" dialog may appear.

On the Vista and Linux platforms, the e-mail may launch, but the names of group members of the activity will not correctly appear in the "To:" section of the e-mail. Instead "null" will appear for each group member name.

The workaround for this problem is to manually add the individual names in the e-mail "To:" section and, in the case of WinXP, manually create an e-mail, and drag-and-drop the activity entry into the e-mail, which will create a link to that entry in the e-mail body.

Lotus Notes

**Issues when adding several Notes documents to Activities**

By default there is a limit of 25 documents that a user can drag-and-drop to the Activities sidebar at one time, set by the ENV_WMCSELECTION_MAXDOCUMENTS variable in the Notes.INI file. Occasionally during this operation a user may receive a message stating "An error occurred while performing drop" which could be due to the amount of documents or content being brought over.

If this is the case the aforementioned .INI variable can be decreased to a smaller number to help alleviate the problem.

Lotus Notes

**Notes may crash while publishing large mail to Activities**

While publishing a large notes document to Activities, Notes may sometimes crash. The crash is usually seen for documents greater than 100 MB. If this crash is seen, the ABORT_IPC_STREAMING_LIMIT variable can be added to the Notes.INI file, with a value less than the size of the document that is causing this crash. The size specified for this variable should be in bytes.
Application Development issues

Domino Designer

**Using rcplauncher to launch Notes may affect access to APIs**
If you launch the Notes standard client using the command line `<Notes Install dir>rameworkcpcplauncher -config notes`, components like feed reader and widgets, which leverage notes.jar, are unable to execute any Notes API that requires authenticated access. This is the expected way for third parties to do application development using the Eclipse IDE.

**Workaround**
Set `ENABLE_EARLY_AUTHENTICATION=0` before launching in this mode.

Browser issues

Lotus Notes

**Notes Web Browser issues**
The following are known issues with the managed browser view in the Notes Web Browser application:

- When using Notes on Linux, if the browser control shows the error dialog "The document contains no data" and denies the navigation, complete the following steps:
  1. Close your application.
  2. Open a terminal window.
  4. Find and delete the file `cookies.txt` and any additional `cookies*.txt` files.
  5. Open your application.

Note that all your persisted cookies will be lost.

Calendar and scheduling issues

Lotus Notes

**Invitees are not displayed in "bcc:" list**
When choosing the calendar Meeting option, and clicking the address book to add invitee names to the "bcc:" field, the chosen names are not displayed.

Note that the invitees are added to the Meeting notice, they are just not displayed in the attendee list when creating the Meeting invitation.

Lotus Notes

**Tentative Accept from Notes states that it was accepted**
The static text on a tentatively-accepted meeting invitation incorrectly displays as "Accepted".
**Lotus Notes**

To Do view does not have "Ctrl-Click here to add a new document"

The To Do application no longer displays the link "Ctrl-Click here to add a new document" in the Notes client, as Ctrl-Click now selects documents. Use the **New** button to add documents.

---

**Client issues**

**Lotus Notes**

Adding NSL to an existing Notes install removes features

Adding the Notes Single Logon service (NSL) to an existing 8.0 or 8.0.1 install using the following command removes other installed components:

```
setup.exe /s /v"ADDLOCAL=ClientSingleLogon /qb+"
```

For Notes 8.0, when you restart Notes, the Sametime Java Plug-in is removed, as are any additional features, such as Activities, Composite Application Editor and/or IBM Lotus Symphony.

When performing an **UPGRADE** or a **MODIFY** install using Silent Install, it is necessary to use the "SELECTINSTALLFEATURES" property to specify install features that are defined in the install manifest on the command line. If you did an initial installation specifying particular features in the "SELECTINSTALLFEATURES" property and you do not specify them on the command line when doing an upgrade or modify install, they will be removed.

**Lotus Notes**

**Bookmarks from Startup folder opening only with new tab theme**

Using documents from the same application as bookmarks placed in the More Bookmarks > Startup folder, Notes 8 displays these bookmarks using the new tab window theme. For example, if you click File > Preferences > Windows and Themes and choose any of the three window management options, when you restart Notes, the bookmarks in the More Bookmarks > Startup folder will open in their own tab regardless of your window management selection.

**Lotus Notes**

**Close All option closes the sidebar**

The Lotus Notes 8 File menu item or toolbar action "Close all" closes the sidebar. If the sidebar is closed, you can redisplay it by clicking View > Sidebar, and selecting Open or Thin from the resultant list.
Lotus Notes

**Do not use Alt+F4 to close Preferences dialog**
In some cases, Alt+F4 may not close the Preferences dialog correctly. The dialog may remain open and become unstable. Instead, use the OK, Cancel, or Close buttons to close the dialog.

Lotus Notes

**Drag-and-drop folders and bookmarks to Open menu not functional**
Notes does not enable drag-and-drop of bookmarks from the docked Open list to folders such as Applications and Favorites. You also cannot drag-and-drop child folders onto the docked Open list.

As a workaround, you can undock the Open list and then drag-and-drop bookmark and/or child folders onto the Open list.

Lotus Notes

**Drag-and-drop unopened tabs to Open list not functional**
Notes does not enable drag-and-drop of unopened tabs to the Open list. As a workaround, you can click on the tab to open it, which also opens a view. You can then drag-and-drop the tab to the Open list.

Lotus Notes

**Drag and drop from feed reader to IE browser fails**
Some links may not drag properly from the feed reader into the internal Web browser when Internet Explorer is set as the Notes internal browser.

Lotus Notes

**Duplicate items in Preferences dialog**
When the Preferences dialog is opened, there may be duplicate items in the navigation (left) pane. Close and reopen the dialog, or exit and restart Notes to correctly display the Preferences navigation pane.

Lotus Notes

**F1 Help for File -> Preferences not fully implemented**
At this time, only a few Preference dialogs bring up a Help topic when you press F1 (focus must be in the dialog when F1 is pressed). To find comprehensive Help for preferences, click Help -> Help Contents from the main menu, and either use Help Search or look in the All Topics list.

Lotus Notes

**Feed reader content should be per user ID**
In this release, Notes feed reader subscriptions are captured on a per-workstation basis, rather than on a per-user-ID basis. Thus, for a multi-user installation, each user on a given workstation will see all of the feeds subscribed to by all of that workstation's Notes users, regardless of their log-in ID.
Lotus Notes

Feed reader not working if "Program Files" name is translated
In some instances, the Notes Feeds functionality is not operational when Notes is installed to a Program Files folder whose name has been translated. For example, for the Brazilian Portuguese native language on Windows, the default installation path is C:\Arquivos de programas\IBM\Lotus\Notes. Using this path, Feeds will not work, and no data will appear in the Feeds sidebar. As a workaround, install Lotus Notes 8 to C:\Program Files\IBM\Lotus\Notes.

Lotus Notes

Feed reader support for sites requiring authentication
The Lotus Notes 8 feed reader supports sites that require authentication. When you attempt to subscribe to a feed that requires authentication, and receive an authentication or other security-related error message, you can create an account in Notes (using the procedure below) and then retry the feed subscription.

1. Obtain the URL for the feed to which you would like to subscribe.
2. Open Lotus Notes 8 and click File -> Preferences -> Accounts.
3. Click New Account.
4. In the Account Name field, type a descriptive name of your choice.
5. In the Description field, type a brief description of the feed to which you want to subscribe.
6. In the Type field, chose HTTP / HTTPS.
7. In the Server field, paste in the URL of the feed to which you want to subscribe, for example https://w3.webahead.ibm.com/w3ki/display/wplcidc/Home.
8. Click OK.

For related information about Lotus Notes 8 accounts, see the Notes 8 Help; choose Help -> Help contents -> Lotus Notes -> Setting Preferences -> Account Preferences.

Lotus Notes

Feeds date/time display in current locale format
The Notes Feed reader displays the current date and time using the Notes client's current locale setting, rather than a display format specified using the File > Preferences > Regional Settings options.

As a workaround, you can edit the installed NOTES.INI file to include the following statement, where "DE" is the language in which you want to see the user interface, including the Feeds date and time, displayed:

UserInterface=DE
**Lotus Notes**

**GB18030 and other fonts may require parameter file customization**

For some non-English text fonts, including Chinese Locale and GB18030, an additional statement in the Notes notes_plugin_customization.ini file may be needed for proper font display. Specifically, the parameter com.ibm.rcp.ui/UI_FONT_FACE=FontFace is locale-specific and font-specific.

When using the com.ibm.rcp.ui/UI_FONT_FACE parameter in the com.ibm.notes.branding_VersionNumber/notes_plugin_customization.ini file, the GB18030 fonts display incorrectly. You can correct this display problem by adding a statement to the notes_plugin_customization.ini file before or after installing or upgrading to Notes 8x. The additional statement is as below:

```
com.ibm.rcp.ui/UI_FONT_FACE=SimSun-1803
```

**Lotus Notes**

**GB18030 character display on Windows XP Notes client**

Simplified Chinese (GB18030) characters may not display properly in Notes running on Windows XP unless you do the following:

To enable GB18030 support on a Windows XP, do the following:

1. Install the language support for Simplified Chinese on any non-Simplified Chinese version of Windows.
2. Click Start > Control Panel > Regional and Language Options.
3. On the Languages tab, check the "Install files for East Asian languages" check box.
4. Install the GB18030 support package from http://go.microsoft.com/fwlink/?LinkId=26235.

To enable GB18030 font linking, do the following:

1. Click Start > Run.
2. In the "Run" text box, type regedt32 to open the registry.
3. Navigate to [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\FontLink\SystemLink].
4. Double-click on the "Tahoma" key in the right panel.
5. Add "SimSun18030.ttc,SimSun-18030", in a new line, in the edit box.
6. Double-click on the "Arial" key in the right panel.
7. Add "SimSun18030.ttc,SimSun-18030", in a new line, in the edit box.
8. Click OK to restart the computer.

Font linking provides the ability to render non-Latin characters when the font set by the application does not support those particular characters. It is suitable when an application cannot use a single font to render all the required characters.

**Note:** If you use the Registry Editor incorrectly, you can cause serious problems that may require you to reinstall your operating system. Use the Registry Editor at your own risk.
To enable the GB18030 dialog font, do the following:
1. Right click in the desktop and click Properties.
2. Click the Appearance tab on the Display Properties dialog.
3. Click Advanced.
4. Select Message Box in the "Item" menu on the Advance Appearance dialog, then select "SimSun-18030" in the "Font" menu.
5. Click OK on the Advanced Appearance dialog.

Changing the CSS user interface font in the notes_plugin_customization.ini file
A Notes user can override the CSS user interface font by adding the following statement to the com.ibm.notes.branding/notes_plugin_customization.ini file.

```
com.ibm.rcp.ui/UI_FONT_FACE
```

For example, to set the Lotus Notes user interface font to "SimSun-18030" instead of using the CSS font, add the following line to the com.ibm.notes.branding/notes_plugin_customization.ini file.

```
com.ibm.rcp.ui/UI_FONT_FACE=SimSun-1803
```

Lotus Notes
Install yields error when installing from non-ASCII directory
Installing Notes from a non-ASCII-named directory yields errors during install. Install Notes from a directory that adheres to ASCII naming conventions.

Lotus Notes, Domino Designer
Invoking Preferences from Designer
Choosing "File -> Preferences" from the Designer client will switch focus to the Notes client. There may be duplicate and/or extra preferences shown in the navigation pane. Close the Preferences dialog, and open directly from the Notes client.

Lotus Notes
JIS2004 character display on Windows XP Notes client
Certain JIS2004 characters may not display properly in Notes running on a Windows XP client. If the user has MS PGothic and MS Mincho fonts installed, the characters should render correctly. To ensure that Japanese JIS2004 characters display properly, do the following:

To enable JIS2004 support on Windows, do the following:
1. Install the language support for Japanese on any non-Japanese version of Windows.
2. Click Start > Control Panel > Regional and Language Options.
3. On the Languages tab, check the "Install files for East Asian languages" check box.
4. Install the JIS2004 support package from http://support.microsoft.com/kb/jp927489/
To enable JIS2004 font linking, do the following:
1. Click Start > Run.
2. In the "Run" text box, type regedt32 to open the registry.
3. Navigate to [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\FontLink\SystemLink].
4. Double-click on the "Tahoma" key in the right panel.
5. Add "msgoth04.ttc,MS PGothic", in a new line, in the edit box.
6. Double-click on the "Arial" key in the right panel.
7. Add "msgoth04.ttc,MS PGothic", in a new line, in the edit box.
8. Click OK to restart the computer.

Font linking provides the ability to render non-Latin characters when the font set by the application does not support those particular characters. It is suitable when an application cannot use a single font to render all the required characters.

Note: If you use the Registry Editor incorrectly, you can cause serious problems that may require you to reinstall your operating system. Use the Registry Editor at your own risk.

To enable the JIS2004 dialog font, do the following:
1. Right click in the desktop and click Properties.
2. Click the Appearance tab on the Display Properties dialog.
3. Click Advanced.
4. Select Message Box in the "Item" menu on the Advance Appearance dialog, then select "MS PGothic" in the "Font" menu.
5. Click OK on the Advanced Appearance dialog.

Lotus Notes
Lotus Notes Smart Tag options unavailable in Microsoft Word
If you are unable to access the Lotus Notes Smart Tags options in Microsoft Word, please execute the following steps:
1. Close Lotus Notes
2. Go to the DOS directory prompt where your Lotus Notes program files are kept (for example, c:\program files\ibm\lotus\notes)
3. Enter the following command "regsvr32 smarttags.dll" and press ENTER
4. A message will then be displayed: "DllRegisterServer in Smarttags.dll succeeded."

Lotus Notes
Manually resized preview pane and Show Preview
If you manually expand the Notes preview pane, the Show action button does not reflect the change. For example, if the preview pane option is off, and you manually increase the preview pane size, when you click the Show action button the current selection remains at Hide Preview.
Lotus Notes

**My Widgets: Cannot export a locked widget**

Exporting a locked widget that contributes to the sidebar produces an error, as seen in the following scenario:

1. Using the Widgets preferences panel, specify a server name and catalog name and click Apply.
2. In the 'categories to install' list, select a category that contains a widget that contributes to the sidebar and click OK.
3. When the widget appears in the My Widgets panel, right click on the widget and select "Email to . . ."

An error message appears stating that the action failed.

Lotus Notes

**My Widgets: Live Text and rendered MIME e-mail**

In Notes 8.0.1 there is a known issue with how the Notes embedded browser renders MIME e-mail. Live Text is not available for e-mail rendered using the embedded browser. As a workaround, you can disable e-mail rendering with the embedded browser using the Notes.INI file setting below:

```
BrowserRenderDisable=1
```

Lotus Notes

**My Widgets: Not all Web pages supported for widget creation**

The Notes My Widgets feature does not currently support creation of a Web-based widget from every existing Web page. Certain Web pages are known to fail during the widget creation process, primarily those requiring form-based authentication. This can be due to differences and complexities in how Java scripting is done in the target Web page or Web page form, especially in the search fields.

Lotus Notes

**My Widgets: Recognize Live Text in this Document option**

There are two aspects of the Recognize All Text in this Document menu option that may be confusing to Notes users.

The Recognize All Text in this Document menu option is visible but disabled in the Tools menu while active in a Notes view. Ideally the menu option would not be visible at all, as it is never an option while active in a Notes view.

The Recognize All Text in this Document menu option is visible and enabled for all users while active in a Notes document, even if that user has not been permitted, based on either policy or preference settings, to use My Widgets functionality, or if that user has no Live Text instances in the active Notes document. Ideally, a user who is not enabled to use My Widgets functionality, or a user who has no Live Text instances in their active Notes document, would not see this menu option as enabled.
Lotus Notes

**My Widgets: Restricting install of existing widgets types**
Changing the Widgets policy to restrict installation of widget types and/or extension points that a user has already installed or configured yields an error message at Notes startup. Consider the following scenario:

1. Install Notes with no policy restrictions on the types of widgets that can be installed.
2. A user adds a Google Gadget to their My Widgets sidebar panel and creates an action for it.
3. The administrator creates a policy for the user, restricting them from installing a Google Gadget and the extension point "org.eclipse.ui.popupMenus" and the policy gets applied to the client.

Each time the user starts Notes they will receive an error message because they have a Google Gadget widget and pop-up menu installed, but their policy indicates they cannot install those item types. Note that the widget and pop-up will not be useable.

Lotus Notes

**My Widgets: Sidebar contribution and Close menu option**
The following two scenarios affect the Close menu option behavior for widget sidebar contributions.

**Changing a widget from non-managed to managed (upgrade):**

1. Create a widget that contributes to the sidebar.
2. Publish the widget to the catalog.
3. Subscribe to the category that you put the widget in and update from the catalog (Replicate catalog and Update widget menu option).

This upgrades the widget from non-managed to managed.

The Close menu option is available for the widget. However, the Close menu option should not be available for managed widgets that contribute to the sidebar. When you click on Close in this scenario, an error message appears stating that the action is not enabled.

**Changing a widget from managed to non-managed (downgrade):**

1. Using the Widgets preference panel, enter a server name and catalog name and click Apply.
2. From the categories to install list, select a category that contains a widget that contributes to the sidebar and click OK.
3. When the widget that contributes to the sidebar appears in the My Widgets panel, go to the Widgets preferences panel, set the server name to "" and click OK.

This downgrades all managed widgets to non-managed.

The Close menu option is not available for the widgets. However the Close menu option should be available for non-managed widgets that contribute to the sidebar. The user will not be able to close the sidebar contribution. As a workaround, the user can right-click on the widget in the My Widgets sidebar panel, select Component Properties, and then de-select "Contribute to sidebar on startup".
Lotus Notes

**My Widgets: Text with multiple components not recognized**
The Notes My Widgets feature is supplied with several advanced Live Text recognizers, including names, addresses, and organizations. Many names are recognized, but known limitations exist.

Names or Notes addresses with three components, or with dashes, may not be recognized. Additionally, uncommon names, or those with non-ASCII characters, may not be found, therefore, these will not appear as Live Text in the active Notes document.

Addresses are currently focused on United States-formatted addresses. Even those, however, cover the most common cases. When in question, the advanced recognizer errs on the side of not underlining. Note that this is separate from the recognizers you can create using Java regular expressions. You can supplement the advanced recognizer with your own regular expression-based recognizer.

Lotus Notes

**My Widgets: Toolbar should not appear in standalone Symphony**
If you start one of the Lotus Symphony applications outside of Notes, the My Widgets toolbar buttons can be displayed using a "View -> Toolbar -> Widgets" or "Tools -> Widgets" menu sequence. Because My Widgets requires that Notes be running, if you select one of the My Widgets toolbar buttons, you will receive a Notes initialization error. The My Widgets toolbar buttons should not be available unless Notes is running.

Lotus Notes

**My Widgets: View state lost if sidebar collapsed at shutdown**
If you have a widget in a Notes sidebar panel, and never expand that sidebar panel (or the entire sidebar) after launching Notes, if you exit and restart Notes, when you expand the sidebar panel for the widget, the opened widget view may be blank. You can close the view using the Close action in the widget sidebar panel and then reopen a new instance in order to resolve the issue.

Lotus Notes

**Notes Help window disappears in some MUI installs**
For some MUI language installs, opening Notes dynamic Help before opening Notes F1 Help can cause the F1 Help window to disappear.

For example, this display issue can occur in the following scenario:

1. Start Notes.
2. Open the Home tab.
3. Press F1 to open Dynamic Help (the tab at the right side of Notes window).
4. Click File -> Application -> Properties to open the Properties window.
5. Press F1 button to open NSF help.

There are two available workarounds;

Click the “?” button on the upper right side of Properties window to open the F1 help.

Or

Skip step #3 above (dynamic Help) and the issue will not occur.
Lotus Notes

**Notes message RTVSCAN holding memory**
When working in Notes, if you receive an error message stating that the "0x115 - RTVSCAN is operational and may be holding memory" message, exit Notes, restart the client system, and restart Notes.

**Notes UI display speed on Windows**
The Notes user interface may intermittently display very slowly on Windows installations based on an anti-aliasing issue. You can solve this display problem by adding the following two statements to the installed `<install_dir>\Notes\framework\rcp\plugin_customization.ini` file:

```
com.ibm.rcp.ui/DISABLE_ANTIALIAS=true
com.ibm.rcp.ui/DISABLE_ANTIALIAS_FONT=true
```

**Open panel font does not match OS font setting**
When Lotus Expeditor is installed, the text font of the Notes client Open panel options, and the Open panel title itself, are not displayed relative to the operating system’s font setting. The Open panel fonts and Open panel title should be changed with the OS font settings, but are not.

**Windows**: There are two workarounds to resolve this display problem; switch to high contrast mode, or choose "File -> Preferences -> Windows and Theme" and then choose "Operating System Theme".

**Linux**: Resize the font when Notes is active.

**Roaming user not fully supported**
Roaming user is not supported in Lotus Notes 8. Roaming user in the Lotus Notes 8 Basic configuration remains available. This feature is available in Lotus Notes 8 with limitations. For example, it has not been enhanced to roam new files created for Lotus Notes 8 and certain configuration issues may occur if mixing multiple versions of Lotus Notes and O/S platforms.

**Search bar returns to default position at restart**
Even after repositioning, the Search function always returns to its original toolbar position after restarting Notes 8.

**Theme does not change after disabling high contrast**
If you enable the high contrast theme using the UI sequence Control Panel > Accessibility options > Display tab, enable the "Use High Contrast" checkbox, and apply the settings, then later return to the Display tab and disable the "Use High Contrast" checkbox, the visual theme does not change to the default Notes 8 theme. Colors and fonts change because they using the default native.css. However, the theme remains still set to the "Operating System" theme in the Windows and Themes preference panel. To resolve this theme display issue, restart the Notes client after disabling the "Use High Contrast" setting.
Lotus Notes

**Toolbar may display incorrect icons after a crash**
This issue occurs only rarely, but if Notes crashes, the toolbars may sometimes display an icon that says "No". This is due to a consistency check being run on the bookmarks. Shutting down and re-launching Notes will resolve this issue.

Lotus Notes

**Toolbars can experience display issues in new window theme**
The toolbars can experience redraw issues when using the Notes client in the new window theme - this can be enabled using File - Preferences - Windows & Themes, and selecting "Launch each document in its own window".

For example, when reading a message, the new window is smaller, so if you have enabled additional toolbars there will not be enough room to display the toolbars completely, and overflow buttons will be used. At times these overflow buttons do not display correctly in the new window mode, and sometimes some of the toolbar sections do not display correctly (they may get cutoff). Resize the new window to be a little larger, and the toolbars and overflow buttons will redisplay correctly.

**Note**: This tends to happen more when using your display in 1024x768 mode.

Lotus Notes

**Unexpected feed reader subscription behavior**
The Lotus Notes 8 feed reader does not allow you to subscribe to feeds that force a URL redirect. However, if you open a browser and enter the feed URL, record the actual destination URL, and use that destination URL in your feed subscription, the feed subscription will be successful.

For example, the following feed may fail if a redirect is required:


In this instance, if you put the above address into a Web browser address bar, the URL resolves to the following, which you can then use to subscribe to the feed using the Notes 8 feed reader.

http://feeds.reedbusiness.co.uk/9d63ef1e-138d-422d-b543-2db74210f87a/CW360/The%20latest%20E-Business.xml

Of related note, when you first enter the URL (http://www.computerweekly.com/Feeds/RSS.aspx?cat=135), the address is converted correctly, but you may receive an error message stating that the XML page cannot be displayed. If this happens, click "Go" again to resolve the URL, and display the expected XML page.

Lotus Notes

**Use Help table of contents to access Help topics on Preferences**
Context help for Preferences is not in place; to access Help topics on Preferences, choose Help -> Help Contents -> Lotus Notes -> Setting Preferences.
Lotus Notes

**XML files may appear in list of Dynamic Help search results**
If you are upgrading from a beta release of Notes, you may see XML files included in the list of search results returned in the Dynamic Help section of the Help view. To prevent this, do the following steps:

1. Exit Notes.
2. Delete the folders in `<notes install>/data/workspace/.config`. Leave any files (`args.properties`, `config.ini`, `rcpinstall.properties`) in place.
3. Restart Notes.

Lotus Notes

"Open" menu displays incorrectly in bi-directional mode
In some locales, such as Hebrew or Arabic, the Notes bi-directional option does not properly display the Open submenu; the Open submenu is not flipped from the left to the right side of the user interface. Also, with this setting, the Open menu will overlap other Notes submenus. This behavior is apparent when you do the following:

1. Start Notes in a Hebrew or Arabic locale.
2. Click File > Preferences > Regional Setting > Bidirectional.
3. Click Right in the Menu direction field.
4. Click Right to Left in the Global text direction field.
5. Click OK and restart Notes.

Composite Applications issues

Lotus Notes, Domino Designer

**Applications not opened in the correct window**
Applications are not opened in the correct window when the Composite Application Editor has focus. This occurs when opening another database/composite application from the client while the Composite Application Editor is open.

**Workaround**
Whenever a new application is opened while the Composite Application Editor is open, click on any application in the main window to make it active.

Domino Designer

**DAP configuration settings impact what client displays**
DAP (Domino Application Portlet) configuration settings (via browser/server), can impact the way applications display on the Notes client.

**Workaround**
When entering the Configuration user interface for DAP, go to the Rich Client Configuration page and make sure the following preferences are set as follows:

```
com.ibm.rcp.fastView false
com.ibm.rcp.fixed true
com.ibm.rcp.visible true
```
Domino Designer

**Keyboard loses focus in composite application**
Composite applications that have multiple components wired together may see problems with components maintaining focus, as well as related navigation with the user's keyboard. The component that owns the action steals focus away from the component it is wired to, and if you try to navigate with the keyboard you may not be able to do this. The issue does not occur for all composite applications.

**Workaround**
You may need to navigate to certain components of a composite application using a mouse if the wiring of the application components causes this problem.

Lotus Notes

**Lead Manager Composite Application sample does not install**
The installation of the Customer Interests and Lead Manager Composite Application samples, which are provided along with the Notes 8.0.1 installation, may fail if they are installed in a particular sequence. Install the Customer Interests sample first and confirm it works. Next, try to install the Lead Manager sample. While installing the Lead Manager sample, at times you might encounter the following error:

This is because the /Zetabank cross-certificate, which needs to be added while accessing the site.xml file of the Lead Manager Update Site, clashes with an existing /Zetabank cross Certificate in the user's Personal Address Book. This entry in the Address Book was added while working with the Customer Interests sample.

Deleting the /Zetabank certificate from the address book will solve this problem, and the Lead Manager sample will be allowed to install.

Domino Designer

**Problem encountered wiring components with ?OpenDatabase**
In Composite Application Editor, you encounter problems wiring components with the ?OpenDatabase command.

**Workaround**
Do not manually enter the URL with ?OpenDatabase. Use the Component Picker in the Composite Application Editor to select the URL.

Domino Designer

**Tab remains when deleting a page in CAE**
When deleting a page in the Composite Application Editor with a child page, the tab at the top still remains. There is no workaround.
Contacts issues

Lotus Notes

Moving a recent Contact with a domain in the address
Two issues arise if a the user clicks "Move to My Contacts" on a recent contact which has a domain in the mailing address, as in "Jane Dough/Acme@ACME_US":

1. The canonical-ized name will appear in the Move to My Contacts dialog box, as in "CN=Jayne Dough/O=Acme@ACME_US".

2. The recent contact is not removed from the Recent Contacts view. If this situation occurs, just press the DEL key to remove it from the view.

Designer issues

Lotus Notes, Domino Designer

Preview page with embedded view focus issue
In Domino Designer, create a page, and insert an embedded view; doing a "Design -> Preview in Notes" of this page results in the following behavior:

- The initial focus is on the Embedded View object (you can see the embedded view is outlined, indicating focus)
- The expected behavior is that the initial focus should be inside the embedded view (on the first document in the view)

Workaround
Set focus by mouse-clicking in the embedded view, or by pressing the Space bar.

Directory issues

Domino Server

Change to LDAP searches for the mail attribute
Beginning in release 8.0.1, by default, the LDAP service searches for the mail attribute value only in the Internet Address and Short Name fields in a Person document. Because only a view search is required to find these values, this change was made to avoid doing unnecessary full-text searches to look for the value elsewhere. If the LDAP service is not returning values for the mail attribute because the value is not stored in the Internet Address or Short Names fields, use the Notes.ini setting LDAPMailSearchMailAddress=1 to enable full-text searching to find them.

For information on how the LDAP service searches for the mail attribute value, see the topic "How the LDAP service forms a value for the mail attribute" in the Domino Administrator Help.
Domino Server

**Directory Assistance not taking advantage of cluster failover**
A configuration-only directory that points to a remote primary via Directory Assistance will not use cluster failover if the remote primary server becomes unavailable. Consider the following scenario:

Server A has a config-only directory and, using Directory Assistance, points to a remote primary directory on Server B. Server B is part of a cluster with servers C and D. If Server B were to become unavailable one might expect cluster failover to occur and have Server C or D take Server B’s place as the remote primary for Server A. This failover does not take place and results in Server A being without a remote primary until Server B becomes available again. A workaround would be to specify additional replicas of the remote primary in the Directory Assistance document.

Domino Access for MS Outlook issues

**DAMO: Known issues**
Following is a list of known DAMO issues for this release of Notes and Domino:

- When exiting Outlook 2003 on Windows Vista, DAMO will consistently create a diagnostic file (NSD)
- Rules are not working if you are using the Friendly Name of an SMTP address
- Dismissed Calendar reminders sometimes reappear on subsequent days
- When a meeting Chair sends an update to a Notes invitee, the invitee receives a Reschedule notice, rather than an Update notice.
- Portable Network Format (PNG) graphics are not supported
- A user who registers with extended characters in their name is unable to create a profile

**Single Logon with DAMO**
In order for a DAMO user to be able to change their password using Ctrl+Alt+Del, which activates the Windows "Change Password" button, it is necessary to have the Notes Single Logon Service installed. In order to install this service, it is necessary to install the Notes client and enable the Notes Single Logon Service. The user will supply a Notes ID when configuring the Notes client, and this will be the ID that is updated when the user changes their password.

When DAMO is installed and the DAMO profile created, the user must supply the path to the Notes ID configured with the Notes client. In this process, the user will be asked if the Notes ID file should be copied to the Domino Access for Outlook data directory for this user. Unless this is also the intended location for the Notes client, the choice should be to NOT copy the ID file. DAMO will 'share' the Notes ID with the Notes client; it will prompt for a password when the Outlook client is launched, and it will use the Notes ID supplied when the DAMO profile was created.

The Notes Single Logon Service can only be installed with the Notes client. If the Notes client is uninstalled, the Notes Single Logon Service is also uninstalled.
The Notes ID shared by the Notes and DAMO client may be located anywhere on the local system, for example, C:\Notes\mhowell.id.

DAMO 8.0.2 no longer installs the Notes Single Logon Service itself because of unresolvable conflicts with supporting DAMO in the Vista environment. The primary mechanism for changing both Windows and Notes passwords is through the use of Control+Alt+Delete. Other prompts will not ensure that all passwords are changed.

**Domino Web Access issues**

**Domino Web Access**

**DOLS uninstallation requires restart**

When you uninstall Domino Off-Line Services (DOLS) on Microsoft Windows Vista Ultimate, the DOLS uninstaller cannot remove the DOLS directory \c:\Program File\Lotus iNotes automatically.

**Workaround**

Restart the system, then manually remove the Lotus iNotes directory.

**Domino Web Access**

**Domino Web Access Lite mode does not support secure mail**

For this release, the Lite mode of Domino Web Access does not support secure mail. This means that even if you have set one or both of the Mail Security options “Sign mail that you send” or “Encrypt mail that you send,” the preference will not be supported when sending mail from Lite mode.

If you try to send a signed or encrypted message, or if you attempt to respond to a message that was signed or encrypted, you will receive the message “Domino Web Access Lite mode is designed for quick access and does not support sending secure mail...”, and you will be given the option of opening Domino Web Access Full mode, from which you can send encrypted and signed mail.

**Workaround**

When prompted, open the Full mode of Domino Web Access and send signed or encrypted mail from there.

**Domino Web Access**

**Inability to reach Sametime server may cause system to hang**

If the Sametime server is not running when you try to log in to instant messaging, the process may hang.

**Workaround**

Add the following to the end of your URL so that if Domino Web Access hangs trying to access Sametime, you can still get into your mail:

&im=0
Domino Web Access

**Issue starting chats from Mail views**
You cannot use the right-click menu to start a chat from any of the Mail views, such as the Inbox or All documents.

*Workaround*
Click the awareness icon to start chat.

---

Domino Web Access

**No support for bi-directional display in Firefox**
The Firefox browser does not support a bi-directional display.

---

Domino Web Access

**Opening a calendar entry from the sidebar in Lite mode**
In Domino Web Access Lite mode, if you open a sidebar Calendar entry while you are in the Drafts view, the entry opens in Edit mode. This means that the form opens, rather than the saved Calendar entry.

*Workaround*
Open sidebar calendar entries from views other than Drafts view, such as from the Inbox.

---

Domino Web Access

**Passthru HTML is supported only with plain text signature**
HTML passthru is supported only with a plain text signature.

*Workaround*
Optionally the signature can be set to Rich Text, which allows images, colors, and other text attributes to be entered directly into the signature field.

---

Domino Web Access

**RSS feeds remain in IE 7 feed reader after logging off**
In Microsoft Internet Explorer (IE) 7, RSS feeds continue to display the subject line in the feed reader after users log off and clear the cache. This is a Feed Reader limitation in IE 7. Microsoft's Feed Reader caching feature cannot be disabled in the Feed Properties.

*Workaround*
Administrators can disable IE 7 Feed Detection using policies through Microsoft Group Policy, or disable the RSS feature in IBM Lotus Domino Web Access.

---

Domino Web Access

**Spell check issue on Linux and UNIX servers**
If you are using Domino Web Access on a Linux or UNIX server, the first time a user runs spell check, no result is produced.

*Workaround*
In the spell checker, click Done, and then run spell check again.
IBM Lotus Notes, Domino, Domino Designer 8.0.2
Release Notes

Domino Web Access, Domino for System i

**System i: DWA with Sametime chat/awareness requires port 80**
Sametime chat and awareness do not work with Domino Web Access when the HTTP server is configured to use a port other than 80.

**Workaround**
Configure the HTTP server to listen on port 80.

Domino Web Access

**Tabs appear incorrectly in bi-directional mode**
When viewing Domino Web Access using bi-directional mode, tabs in the One Week or Two Week calendar views may display incorrectly. This problem occurs when a calendar entry that has a long subject line causes the horizontal scroll bar to display.

**Workaround**
Resize the browser window.

Domino Web Access

**Ultralite: Default Time Zone behavior**
Lotus iNotes ultralite mode does not respect the Time Zone of the client device by default (iPhone or iPod Touch). Instead, it respects the Time Zone of the Domino server on which the mail database resides. To set a specific desired Time Zone to be used by the ultralite mode, please specify a custom Time Zone setting in the Domino Web Access user preference settings.

Domino Web Access

**Ultralite: International characters are not displayed correctly**
When UTF-8 encoding is disabled in the Domino server configuration, international characters cannot be displayed correctly in some Ultralite document fields. Please enable UTF-8 encoding in the the Domino server configuration to correct this problem.

Domino Web Access

**Ultralite: Known issues with Contacts**
Known issues with Contacts in Lotus iNotes Ultralite mode:

- The "Contact Save" action does not auto-update the Full Name field, causing a name validation failure on mail send. As a workaround, edit the contact entry in DWA full mode and save.
- A message to a group which has personal contacts created in full mode cannot be sent. Instead, edit the group in full DWA, and replace the personal contact name values with the actual intended e-mail addresses.
- Unable to change default e-mail address in Ultralite from Work1 address. To work around this issue, go to DWA full mode, edit the contact record, and change the default e-mail address there.
Domino Web Access

**Ultralite: Mark Unread icon in ghosted invitations has no effect**
If you open a ghosted (unaccepted) calendar invitation in your Lotus iNotes ultralite mode Day-At-A-Glance view, the "Mark Unread" icon appears in the upper right-hand corner. If you click it, you are returned to the Day-At-A-Glance view without any apparent change to the document.

**Workaround**
Go to the invitation instance in your inbox and click the unread icon there; it will mark the document unread.

Domino Web Access

**Ultralite: Time/Date format errors for new users**
In some cases, the time or date format may appear incorrectly in an Ultralite mail message or calendar event. To correct this, enter DWA Full mode and save user preferences once; this should correct the problem.

Domino Web Access

**Unexpected security message appears in Lite mode session**
In Domino Web Access Lite mode, when using Microsoft Internet Explorer and HTTPS, you will get an unexpected security message when you close or send a message. The security message "This page contains both secure and nonsecure items. Do you want to display the nonsecure items?" appears only once per session, and the expected action does complete successfully without any loss of data or functionality.

**Workaround**
When the security message displays, click either Yes or No to dismiss the information box.

Domino Web Access

**Unread marks do not replicate by default**
By default, the mail8.ntf template does not replicate unread marks. If your mail file is replicated to other servers, or if you use Domino Web Access both online and offline and you want the unread marks to be synchronized, use the following steps to set the Unread Mark Option to "All servers."

1. Open the user’s mail file on the Notes client.
2. Click File > Application > Properties.
3. Click the Advanced tab.
4. Under Unread Mark Options/Replicate Unread Marks, select All servers.
5. Close the properties box.
Domino Web Access

Using Domino Web Access 8.0 with a Sametime 7.0 server
If you are using a Sametime 7.0 server with Domino Web Access 8.0, follow the steps below to use Instant Messaging correctly.

If you use only one browser, use the following settings in the Domino Web Access server Configuration Settings document:
2. Under Instant Messaging, select the Loading \stlinks from Domino application server option as follows:
   - **Disable** -- If the only browser you will use is Microsoft Internet Explorer. This allows Domino Web Access to load all stlinks files from the Sametime server.
   - **Enable** -- If the only browser you will use is Mozilla Firefox. This allows Domino Web Access to load all stlinks files from the Domino Web Access server.

In a mixed browser environment where you might use either browser, copy the stlinks directory from the Sametime server and replace the one on the Domino Web Access server. You may want to change the name of the stlinks directory on the Domino Web Access server for backup so that you can use the directory when you upgrade the Sametime server in the future. You can choose either Enable or Disable for the Loading \stlinks from Domino application server in this case.

Installation issues

Lotus Notes

Ending the Notes installation process before completion
Once you click "Install" on the Notes installation panel, allow the installation to complete. Do not terminate the process before Notes installation is complete. Ending the Notes installation process prematurely can leave files in an unstable state, and may also leave empty folders and miscellaneous files on your system.

If you experience problems installing Notes x after exiting out of Notes installation prior to its completion, see the release note and help topic entitled "Cleaning a previous Notes 8 installation from the client".

Lotus Notes

FTP and Notes .keystore file
Because the Notes .keystore file(s) begins with a period, some FTP utilities do not recognize the file. Since the supplied .keystore file is bundled with the Notes install media kit, this is ordinarily not a problem. However, if you must obtain the .keystore file using FTP, do the following:

1. In an FTP client window, change to the source directory in which the .keystore file resides.
2. Type `ls -al` and the .keystore file becomes visible.
3. Type `get .keystore` to FTP the .keystore file from its source to the target directory on your client system.
Lotus Notes

**Incorrect message after installing Notes with missing features**

If you remove certain features from the Notes install media's update site (updateSite.zip\features), for example com.ibm.rcp.feedreader.feature and com.ibm.rcp.propertybroker.feature, Notes will not fully install. In this situation you should receive an error message stating that a partial installation and setup has occurred, and to check the installation log file for additional information. The actual message indicates that you have installed successfully. Because partial installation is not supported, you will have problems running Notes and will need to uninstall, correct the problem, and reinstall.

The installation log file can be found in the `<installdir>ramework\installer_logs\directory`. You can also review the provisioning log at `<workspace>\logs\provisioning.log`.

Uninstall and cleanup procedures are described in the "Uninstall information" section of these release notes.

Domino Server

**Information and known issues with the new UNIX ISMP installer**

The new ISMP installer requires that you log on as the root user in order to perform the install. The following known issues occur when using the UNIX ISMP installer:

- There are three modes of installation with the new ISMP installer. Graphical interface in interactive mode -- use this method to synchronously monitor the installation processing and results. If the target console has no graphical interface, or if one is not desired, you can use console or silent installation.

  When launching the install in graphical mode where the graphical interface is unavailable, the installer will exit display a message indicating that the installer is unable to run in graphical mode, and to try running the installer with -console or the -silent option.

  To run the installation in graphical mode, enter: 
  `. /install`
  To run the installation in console mode, enter: 
  `. /install -console`
  To run the installation in silent mode, enter: 
  `. /install -silent -options <path to unix_response.dat>`

  The new ISMP installations can also be uninstalled in both graphical and console modes from the /opt/ibm/lotus/notes/latest/<platform>/_uninst directory.

  To run the uninstall in graphical mode, enter: 
  `. /uninstaller.bin`
  To run the uninstall in console mode, enter: 
  `. /uninstaller.bin -console`

- When installing on a system with low disk space, a message may display indicating that there may not be enough temporary disk space, and to try using `-is:tempdir`, in order to use a temporary directory on a partition with more disk space.

  To run the installation specifying the temporary directory, enter: 
  `. /setupPlatform.bin -is:tempdir "<directory>"`
  where `<directory>` is the name of a directory on a partition with more available disk space.
The new installer validates the group name such that the user must belong to the group being specified. If you successfully installed with specific user and group names in previous Domino versions, it does not necessarily mean that the previously supplied group name will now be valid.

If you provide user and group names, and the following message appears: “Group <group name> is not a valid group for user <user name>...,” either (1) add the user to the group you are supplying or (2) as that user, type the "id" command and choose a valid group that the user already belongs to.

Existing script.dat files from previous Domino versions cannot be used with the new ISMP installer. Modify a local copy of the file sample unix_response.dat provided with the install kits. More options are now available than in the previous installation's script.dat file. Take note of the following information:

- If you select a Setup Type other than CustomServer, do not modify any of the Feature sections, for example, the "License" feature. Use these feature options to customize your installation when using a Setup Type of CustomServer.
- Do not attempt to record a response file at this time. The installation will hang and the response file will be incomplete. Use the file sample unix_response.dat provided with the install kits.

**Lotus Notes**

**Installation path cannot contain certain characters**
The Notes installation path, and Notes application file names, cannot contain certain special characters. Along with non-ASCII characters, the following characters are not supported:

; ! # $ ` , ' = ^ @

Other unsupported characters include the following:

\ : * ? " < > and | (pipe)

The above may exist currently in a Notes 6.5.x or 7.x installation path, but if upgrading that installation to Notes 8, upgrade will fail as these characters are not currently supported by Notes 8 and Lotus Expeditor. Additionally, on Linux, the Notes installation path cannot contain a space character. The uninstall utility will not run if the installation path contains one or more spaces.

**Lotus Notes**

**Installer does not create the registry entries for Notestat**
The Domino Server installer for Domino 8 does not create the registry entries for Notestat. Without this entry, Domino statistics cannot be monitored using Windows Performance Monitor (Perfmon).

As a workaround, run the Notesreg.bat file with the Domino executable directory as a parameter, for example, notesreg.bat c:\domino. You can find notesreg.bat in the executable directory.

**Lotus Notes**

**Notes does not support downgrade**
Notes downgrade is not supported in Lotus Notes 8x. The term downgrade refers to installing an older version when a newer version is currently installed.
Lotus Notes, Domino Designer

**Notes features size values if already installed**
The Notes client feature installation panel correctly displays required size values for Notes features, specifically the Notes client, Domino Designer, and Domino Administrator, that are already installed. If these features are already installed, their required size values display as "0" on the feature installation panel, as they should. The size values of Java-based features, such as the Composite Applications Editor and Lotus Symphony productivity tools, that are already installed should also display as "0", but currently do not.

Lotus Notes

**Notes installation panel may close unexpectedly on SLED 10**
When installing or uninstalling Notes on a SLED 10 Linux client, an error message may appear during or at the end of the installation or uninstallation process as below:

```
The application "Gnome-main-menu" has quit unexpectedly. You can inform ... or you can restart the application right now.
```

If this error appears, click the Close option on the error message panel and you will be prompted to choose either Reload or Don't Reload from a second panel. If you click "Reload" the main menu will be redisplayed. If you click "Don't Reload" the main Menu will not be redisplayed.

Lotus Notes

**Notes processes left open if configuration wizard is cancelled**
If you cancel out of the Notes client configuration wizard, some Notes processes may not close properly. To ensure that all Notes processes terminate, open a command window and change to the Notes program directory (for example, Program Files\IBM\Lotus\Notes), and type the following:

```
nsd -kill
```

Lotus Notes

**Notes upgrade does not terminate when Notes is running**
If you complete Notes installation and, while active in Notes, re-run the installation program, you are informed that the file is in use. You are given the options to retry, ignore or exit. In fact, the program should terminate, as you cannot successfully run the Notes installation program while active in Notes. If you choose the Ignore option, the program will continue with unexpected results.

Lotus Notes

**Recognizing and stopping a failed network share install process**
When installing Notes from a network share, if the network is disabled during the Notes installation process, installation will stop. Installation will not roll back, which is as designed, however when installing on a Linux client no error message appears to indicate that the network has been disabled and that Notes 8 installation has stopped. If the network becomes available, installation will continue.

To close the installation window and end the installation process, you must end the installation process manually. If you end the installation process, you may have a partial install and should run the uninstall program before attempting another install. Uninstall and manual cleanup instructions are available in these release notes.
Lotus Notes

**Rerunning Notes installer to uninstall Lotus Symphony**

Rerunning the Notes installer in order to uninstall the Lotus Symphony editors feature is not supported on the Linux platform.

When re-running the Notes installer on Linux with the objective of uninstalling the Lotus Symphony feature, the install program will stop running prior to completion. For example, ordinarily after the Lotus Notes client is installed, you can re-run the installer to selectively uninstall one of the optional features, such as the Composite Applications Editor, Lotus Symphony editors, and Activities, by re-running the installer and deselecting the feature that you want to uninstall. However, for the Lotus Symphony feature on Linux, the installer will stop responding when the uninstall process begins. In this situation, if the installer stops responding, you must manually stop the installer process and then run the Notes uninstall program to uninstall Notes. Once you have uninstalled Notes, re-run the Notes installer but do not select to install the Lotus Symphony feature.

**Workaround**

To avoid the issue described above, and avoid the need to perform a Notes uninstall and reinstall, turn off the Java JIT compiler prior to performing the task. To disable the JIT and uninstall just the Lotus Symphony editors feature from the existing Notes install, do the following:

1. Locate and edit the `jvm.properties` file located in the JVM plug-in directory (`<install_dir>/rcp/eclipse/plug-ins`).

2. Open the `jvm.properties` file for edit.

3. Locate the following line in the file:

   ```
   vmarg.Xjit=-Xjit:<JIT setting>
   ```

4. Change that line to be as below:

   ```
   vmarg.Xjit=-Xint
   ```

You can now rerun the Notes installer, deselect the Lotus Symphony editors feature, and the installer will successfully uninstall the Lotus Symphony editors feature while leaving the rest of the installed Notes application as-is.

Lotus Notes, Domino Designer

**Shared node install: Do not use option "b" in silent mode**

if you use the progress bar option "b" (/qb and /qb+) when doing a silent shared installation, the message: "1904 nsixbe registration warning" appears at the end of the installation, and during subsequent uninstallation. You can click "OK" to ignore these warning messages, and the installation/uninstallation will finish successfully.

These warning dialogs do not happen when using "/qn+" and "/qn" for shared node install.
Lotus Notes

**SLED 10: Setting locale for Notes installation**

When installing and running Notes on a non-English SUSE Linux Enterprise Desktop (SLED) 10 client, you must set the locale using a specific procedure, or the Notes install screens will not recognize your locale. Set the locale using the Control Center in order to see the correct language screen text during Notes install.

If you set the locale using Control Center, the installer picks up the language correctly and displays the screen text correctly during Notes installation. If the locale is set using the “Language during login” page, the Notes installer will not recognize your locale, and will instead display the screen text in English during Notes installation.

For example, if the Control Center language is set to zh_TW but the Login language is JA, the Notes installer will use the zh_TW locale setting.

For additional information, the Lotus Expeditor team includes the following in their release notes:

SLED10 contains several system environment variables, one of which, LC_CTYPE, takes highest precedence by Java™ when determining the execution locale and character classifications. When setting SUSE Linux Enterprise Desktop 10 to execute in non-English environments, such as Spanish, through the log-in panel, the contents of LC_CTYPE are not updated, but other locale related variables such as GDM_LANG and LANG are updated. To update the value of LC_CTYPE, the administrator should use the YaST2 Language Selection tool as follows:

1. After logging in as root, click Computer > Control Center.
2. In the left panel, under Groups, click System.
3. In the updated right panel, click Language.
4. Choose the appropriate Primary language for the system.
5. Determine if you want to have the system use an English (US) keyboard layout and click Accept.

**Note:** If multiple languages will be used on the same system, it may be more appropriate to not set the LC_CTYPE variable at all, and not use the YaST2 Language Selection tool, as LC_CTYPE will inherit the value of LANG or LC_ALL. Also, it is important to note, if YaST is adapting the keyboard layout to English (US), you might need to unset LC_CTYPE in a command prompt and manually execute the installation script (setuplinux.sh) for the installation to occur in a non-English language.

Lotus Notes, Domino Server

**Smart Upgrade Governor information is not refreshed**

If you move from Enable to Disable for the Smart Upgrade Governor, the dynamic configuration information is not refreshed. After restarting the server, the correct information can be shown.

Lotus Notes

**Some messages do not appear in the Linux install log file**

Some messages do not appear in the install log file when running Notes install or uninstall on a Linux client. However, if you run Notes in console mode, these messages are displayed. The types of messages being referred to are those described at the following Web address:

http://support.installshield.com/kb/view.asp?articleid=Q111480

These types of messages are shown only when Lotus Notes 8 installation or uninstallation is run in console mode.
System i: CHKPRDOPT error messages in language environments
Domino 8 for System i is only provided as an English (2924) language feature. To deploy Domino in a language other than English, you must first install the English version of Domino, and then install the Language Pack.

If you install Domino 8 on a system where English (2924) is not the primary language installed, error messages will result from the CHKPRDOPT command as follows:

```
CHKPRDOPT PRDID(5733LD8)
Product 5733LD8 release V8R0M0 option *BASE load 2924 correctly installed.
Language *N not installed.
Product 5733LD8 release V8R0M0 option *BASE load 5050 correctly installed.
Errors found by CHKPRDOPT.
```

Similar messages may also result during the LODRUN or RSTLICPGM commands and are also normal. These conditions are normal and do not affect the ability to configure or run Domino servers.

System i: Domino installation may fail with signature violation
When installing Domino 8 for System i, the installation may fail with the following error message (check the job log for the job that issued the RSTLICPGM command):

```
Object has a signature that is no longer valid.
```

This is likely the result of installing Domino to a system that has the more stringent levels of object signature validation enabled for restore operations.

The policy to be used for object signature verification during a restore operation (for example, product installation) is controlled by the QVFYOBJRST system value, which has a default value of 3.

When installing Domino 8 for System i, the system value QVFYOBJRST must be set to a value of 3 or lower prior to installing Domino.

After installation of Domino has completed, the system value may be changed back to a more restrictive setting.

An example of changing the system value QVFYOBJRST is provided below:

```
CHGSYSVAL SYSVAL(QVFYOBJRST) VALUE('1')
```

System i: Installation will fail if WRKDOMSVR command active
Installing Domino 8 on System i will fail if a WRKDOMSVR CL command is being run in another session. If this occurs, an error message in the job log indicates that the QGNNINDS object cannot be allocated. Verify that there are no interactive jobs running the WRKDOMSVR command, and that all Domino servers are ended, when you perform the installation.
Domino Server, Domino for System i

**System i: Missing Java option not always reported during install**

Installing Domino on a V5R4 system when the required Java option (5722JV1 option 8 J2SE 5.0 32 bit) is not installed should result in a warning message in the installation job log.

Cause . . . . . : Domino 8 requires J2SE 5.0 (5722JV1 option 8) unless JavaUseClassicJVM=1 is specified in the server NOTES.INI file, then JDK 5 (5722JV1 option 7) is required. Recovery . . . : In order to satisfy the software pre-requisites for the Domino product install product 5722JV1 option 7 or 8.

In some cases, the missing Java option is not correctly detected and the message is not sent. The Domino installation will proceed successfully, however, the missing Java option will be reported again when the Domino server is started and the JVM attempts to load.

Refer to the Software Requirements section of these Release Notes, or to the Installation Guide for more information about Java software requirements and options.

---

**Lotus Notes**

**Upgrading Notes 8.0 installs that used a multiuser transform**

If Notes 8.0 was installed using a multiuser transform file, the Notes 8.0 icons and links may remain in the user's private desktop after an upgrade. If these icons need to be public for all users, it is recommended that they be manually moved to the public desktop so they are visible to all users.

---

**Lotus Notes**

**Vista: Changing the default Notes installation path**

When installing Notes on a Vista client on which Notes has previously been uninstalled, you may be unable to specify a non-default Notes installation directory. If this happens, and you want to install Notes to a non-default directory, delete the registry key HKEY_LOCAL_MACHINE\Software\Lotus\Notes and start the Notes install process again.

---

**Lotus Notes**

**Vista: Smart Upgrade succeeded report issue**

When upgrading from Notes 7.0.3 or earlier versions to Notes 8.0.1 using Smart Upgrade on Vista, you will be unable to get a "Smart Upgrade succeeded" report.

**Workaround**

Create an Agent that will update the 'Status' field on Failed Reports which contain the text "upgrade does not match" in the error message. When the Agent runs, the Status field is updated to "Succeeded", and the report will now display in the By Status\Succeeded view.
Steps for Creating Agent

- Select Document Selection in the Objects pane window
- Click the Add condition button.
- Set Condition to "Multiple Words".
- Set Search for documents containing to "any of the terms below".
- Enter upgrade does not match in the first text field and click Add.
- Select Action in the Object Pane window.
- Click Add Action.
- Set Action to 'Modify field'.
- Set Modify to 'Replacing'.
- Set The value in field to "FinalStatus".
- Set With the new value to "Succeeded".
- Click the Replace button.
- Save the Agent.

Instant Messaging issues

Lotus Notes

IM Vertical Orientation View is not working
The Instant Messaging/Lotus Sametime icon does not display in the bottom row of the client if the user changes the "Vertical orientation" setting to "Bottom" in the Names section, as outlined in the following example:

1. Install and launch the Notes client
2. Open "Mail" and select a view from the Views folder in the Navigator
3. Select "View -> Design" to open Domino Designer
4. Select the "Name" column and right-click to open Column Properties
5. In the advanced format tab from the Column Properties dialog, set the Row Height to 3 for the View property
6. The Sametime icon does not display in the Mail view
Lotus Notes

**Sametime Preference setting - Communities using HTTP settings**

When setting up integrated Sametime within Notes, in the Preferences/Sametime/Server Communities menu item, there is an option for "Use my Internet Explorer HTTP Settings". If you select this, and your Internet Explorer is set up to use a Proxy, Sametime will actually attempt to directly connect instead of using that Proxy for the initial connection. If this fails, then it uses the proxy.

Due to the fact that the browser-settings connection is an HTTP tunneling connection, and is quite inefficient, (and because often the browser is set not to use a proxy), it was decided that Sametime clients would try a plain socket connection first. If it fails for some reason, for example if the client is blocked from opening a socket to the server like when using a firewall, then it will connect through the proxy. This was done for reasons of efficiency, and not to load the network itself more than necessary. It has been this way since the first versions of Sametime.

Lotus Notes

**Save Chat to HTML file**

When the Sametime Chat History preference is set to "save to mail file", chats are saved in the Chat History view of the mail file. If the mail server or the network goes down when you exit your chat, you will receive a prompt to save your chat to a local file instead. The format of the saved chat is in HTML. The prompt:

![Chat history save error dialog](image)

Note that the text outlined in red above is variable, and describes the actual error.

Selecting "Yes" will bring up a standard File -> Save dialog, which allows the user to save the HTML version of their chat transcript into a file anywhere on the machine. The File -> Save dialog will default to the Notes data directory. In order to view chats saved from this prompt, use any application that can read HTML files.

Please note that this prompt may be changed in a future release.
Lotus Symphony issues

Lotus Notes
**JAWS: Version 8.0 or higher is needed using Windows**
For JAWS users on a Windows machine, JAWS 8.0 or higher is required for Lotus Symphony productivity tools.

Lotus Notes
**Linux: No "Save as type" option available**
There is no "Save as type" combobox in the 'Save as' dialog for Lotus Symphony productivity tools running on the SUSE platform. File extensions need be set specifically to save a file as a certain type.

Lotus Notes
**MS Excel file with protected worksheet or workbook will not open**
Attempting to opening a Microsoft Excel file in Lotus Symphony productivity tools may display a dialog asking the user to remove the password in the file.

**Workaround**
Before starting, you should know the password(s) for worksheets or workbooks that have been protected. The password can be removed by following the steps below.

1. Open the Excel file with Microsoft Excel.
2. Select "Unprotect worksheet" or "Unprotect workbook" from the "Tool -> Protection" menu.
3. Remove all protections, and save the file.
4. Lotus Symphony productivity tools will now open the Excel file.

Lotus Notes
**ODF file association is overwritten**
The following file extension associations that are defined by the OpenDocument standard are overwritten on Windows platforms when you install Notes 8: .odt, .ott, .ods, .ots, .odp, and .otp. If you want to change the association, please consult your system administrator. The following gives one possible way to change the association of certain file extensions:

1. In the Windows Explorer, right-click on a file with the extension whose association you want to change, and click "Open With"
2. In the "Open With" dialog, click the program that you want to use to open the file, or click "Browse" to choose the program on a disk
3. Select the check box "Always use the selected program to open this kind of file"

Lotus Notes
**Special characters are not supported in file name**
Use of special characters, like "*" and "#" in a file name is not supported, and should be avoided. Unpredictable results, including opening the wrong file and overwriting other files, may occur.

Avoid using special characters when saving a document. If a file name contains special characters, rename it before opening it.
Mail issues

Lotus Notes

**Cannot create a mail archive when mail quota is exceeded**
If a user's mail quota is exceeded, the user cannot create a mail archive. The user should first delete mail messages and empty trash to go below the mail quota, and then create a mail archive.

Lotus Notes

**Deleting messages may cause conversations to be out of order**
In Notes 8, you can view an entire e-mail conversation by selecting a member document and opening an in-line conversation subview in Inbox or All Documents. In the subview, messages are organized by the hierarchy of how they arrived. For example, all replies are shown under the message to which they are replies, and indented.

If you delete a message which has replies to it, the hierarchy of the conversation may appear broken. For example, assume there are two replies to the first e-mail (the 'root'), and each of these replies has more replies. If you delete the first of the two replies, the second one moves up, and the "children" of the first reply appear below the "children" of the second.

What you started with:

first e-mail (root)
  reply 1 (← this one is deleted)
  reply -to-reply 1
  reply 2
  reply -to-reply 2

What now appears:

first e-mail (root)
  reply 2
  reply -to-reply 2
  reply -to-reply 1

Also, if you delete the root message in a conversation, only the first reply and any children will appear in the conversation. Note that if you have Soft Delete enabled, you can fix both of these issues by restoring the deleted message(s) from the Trash folder.

Lotus Notes

**Documents selected in Mail mini-view will not appear in Preview**
Selecting an item in the Mail mini-view (beneath the Navigator pane) will not display the contents of that document in the Notes client.
Lotus Notes

**Errors after restarting Mail Application**

Occasionally, the error below will occur after the Mail application is closed and restarted.

![Multiple Errors have Occurred](image)

**Notes 8 .css overrides some Domino Designer mail properties**

Lotus Notes 8 mail users can customize views and columns using Domino Designer to edit view and column properties. However, some of these properties are controlled by the .css file (theme), thus some view and column property customization is overridden by .css. Changing the following view and column properties with Domino Designer will not affect their appearance in Lotus Notes 8 mail.

**View Style property**

- Body - Image
- Body - Repeat
- Grid - Style
- Grid - Color
- Header - Style
- Header - Color
- Header - Height
- Rows - Spacing
- Rows - Don't show empty categories
- Rows - Colorize view icons
- Rows - Unread color
- Rows - Unread bold
- Rows - Unread Transparent
- Rows - Column total text
- Other - Show selection margin
- Other - Hide selection margin border
- Margin - Top/Left/Bottom/Right
- Margin - Below header
- Margin - Color
Notes client on Linux issues

Lotus Notes

**Bookmark behaviors with Notes on Linux**
With Notes running on a Linux client, using the Windows and Theme preference "Open each document in its own window" can cause bookmarked windows to intermittently hide behind the Notes main window. This is particularly noticeable when you close all Notes tabs and when you first start Notes.

Also, when you start Notes, click Open (which displays a bookmark list), and then minimize Notes, the bookmark list may still be visible.

Lotus Notes

**Dragging-and-dropping Notes documents to Desktop folder**
When using Notes on Linux SLED 10 only, dragging-and-dropping a Notes document from Notes to an unopened desktop folder will result in the document being dropped on the desktop as a document link, instead of into the folder itself.

The workaround is to open the folder first, then drop the document into it. This is a limitation of the software.

Lotus Notes

**High Contrast mode is not automatically detected by Notes client**
If a user selects a High Contrast theme in the System Control Center, the Notes client does not automatically detect and use the high contrast resolution when running on SLED10.

To use the Notes client on Linux with high contrast, first select the high contrast theme in the System Control Center. Then, from the Notes client, select File -> Preferences -> Windows and Themes. Select 'Operating System Theme' in the Theme drop-down list. Click Apply, OK. Exit and then restart the Notes client.
Lotus Notes

**System file dialog issues**
Following are the system file dialog issues using the Linux client:

1. When detaching multiple files, users are prompted to select a target folder. If the user inputs a folder name first in the input box, for example "/", then uses the mouse to double-click another folder, for example "/home/acme/temp", the result will be "/". Thus, the files will be detached to a different folder than the user expected. This is an issue with the system dialog.

2. File type cannot be changed to the selected file type in the Import File dialog box. File type will still be "ASCII Text" after selecting an item in the file list.

Lotus Notes

**Using "Open in New Window" on Linux**
When using the Window Management theme "Launch each document in its own window", some functional problems may be encountered in certain circumstances. If these issues are encountered and cause an impact, switching to one of the other window modes is recommended.

1. If a document has already been opened in a new window, opening it a second time may appear to not work. In this case locate the window in the system tray to restore it.

2. In some cases it is not possible to close a Window using the ESC key; in this case use one of the other options such as "File - Close".

3. In some circumstances, a new window may be opened behind the main window; in this case it may be located and brought to the front from the system tray.

4. In rare circumstances when closing the client a JVM error maybe reported; should this continue to be a problem, it is recommended to switch to one of the other window modes.

5. If closing the Notes document window by pressing the ESC key, or by clicking the "Save and close" button on the Action bar, the top menu of the main window will be missing. Click in the content view or document to restore the correct menus.

6. Notes hangs after trying to close the main window, when a new mail message window is open.

Programming issues

Lotus Notes, Domino Designer, Domino Server

**Deprecating Notes.ini variable DXLI2=0**
The Notes.ini variable DXLI2=0 is being deprecated beginning with Notes 8.0.1. This variable was designed for customers to revert to the old DXL importer, in case items did not work with the current DXL importer. The old DXL importer existed in the xml\dxli directory which, moving forward, will be deleted; the new importer exists in the xml\dxli2 directory.
Lotus Notes, Domino Server

Recompiling Visual Basic programs that use backend COM APIs
Starting with Notes/Domino 6.0.3/6.5, some Microsoft Visual Basic language applications built using the Notes 5.x COM interfaces for backend classes would not run properly without recompiling, using the 6.0.3/6.5 domobj type library. This was fixed for Notes/Domino versions 6.5.3 and 6.0.5, however, the fix necessitates that applications still compiled with the 6.0.3/6.5 domobj type library (or later, if prior to 6.5.3 or 6.0.5) be recompiled for 6.5.3, 6.0.5 or later. Thereafter, and with subsequent Notes/Domino releases, recompilation should not be necessary.

Domino Designer

Redisplay a programmatically modified outline
The NotesUIWorkspace.OutlineReload method does not redisplay an outline whose design has been modified programmatically, as stated in the 'OutlineReload method' help topic:

This method can be used to to redisplay a modified outline after you have edited its design programmatically using the NotesOutline class.

To redisplay such an outline, close and reopen the application displaying the outline.

Security issues

Domino Server

Error: This identity's keys have never been rolled over . . .
While in the process of doing a CA Rollover, the following dialog appears:
When [Yes] is clicked, the following (incorrect) message will appear:

![IBM Domino Administrator](image)

This message may be ignored. The workaround is to create any Cross Certificates which are needed using "Tools -> Certification -> Rollover Cross Certificates", after the CA Rollover has been done. This is a known issue, and is expected to be fixed in a future release.

Lotus Notes

**Problems using Entrust certificates on smartcards**

When using pre-loaded certificates and keys stored on smartcards, Notes/Domino follows the "PKCS#11: Conformance Profile Specification" for RSA Asymmetric Client Signing, which specifies a set of attributes that must be in the keys and certificates, and a set of functionality that must be supported by the smartcard and smartcard software. In particular:

"A unique non-null CKA_ID value exists and has proper associations for all keys and certificates."

Some certificate authorities, including a number of Entrust CAs, may generate certificates and keys that contain a null (zero-length) CKA_ID attribute. This bug has been reported to Entrust, where it is being tracked as "SR 1-44960142". Future releases of these Entrust CAs may fix this problem.

Attempting to import these certificates with Notes clients before 7.0.1 will result in an "Illegal null parameter passed to security function" error.

A workaround has been added to 7.0.1 and 8.0 to find, import, and use these non-compliant certificates and keys, with several caveats:

- The first import attempt will only find and import compliant certificates and keys. Subsequent imports will find and import non-compliant certificates of this type, if any private RSA keys with a null CKA_ID attribute were noticed during the first import attempt.
- The ID file must be smartcard-enabled; the mode of operation added in 7.0 to allow certificates to be imported and used without first smartcard-enabling the ID file cannot be used with these certificates and keys.
- The "Lock ID with Key on Smartcard" functionality is not available when using these non-compliant certificates and keys.
- These non-compliant certificates must be imported in order to be used; the new functionality added to 7.0.2 and this release to allow use of certs without first performing an "Import Internet Certificate from a Smartcard" action is not supported.

Lotus Notes, Domino Server

**Requesting a client certificate causes an error in Windows Vista**

Requesting a new client certificate brings down a form to Microsoft Internet Explorer containing Visual Basic code that calls out to a browser local DLL (xenroll.dll) that is no longer supported on the Windows Vista platform. Instead, the new API in CertEnroll.dll must be used.
Server issues

Domino Server

AIX, Linux, Solaris: Domino task crash when JVM receives signal

On AIX, Linux, or Solaris, when the JVM loaded by a Lotus Domino server receives a signal, a crash similar to the following may occur on Router, SMTP, or HTTP tasks:

```plaintext
nanosleep (elafd0f0, elafd0e0)
OSRunExternalScript (120, 40, elafd8e0, fe44eff4, 1, fe711754)
OSFaultCleanupExt (fa800000, le4c00, 0, 1, 14a5, le4c00)
OSFaultCleanup (0, 0, 0, fc668850, 1dfe8c, 2bc00)
fatal_error (6, 33, 0, 14a5, fa800000, 1)
signdlr (6, elafec18, elafe960, fc668640, 0, 0)
call_user_handler (6, elafec18, elafe960, 0, 0, 0)
sigacthandler (6, elafec18, elafe960, feabc000, 81010100, ff00) called from
signal_handler with signal 6 (SIGABRT) ---
_lwp_kill (6, 6, elafed58, 0, 1, elafe5d4)
abort (0, elafed8, 0, fffffff8, 0, elafee11)
__lcCosFabort6Fi_v (1, f5939002, elaff668, f596d4f8, f5969bd2, ff00)
__lcMreport_error6Fipkci11E_v (elaff678, f59c6ab4, f5938d88, f5944df7,
f5938e70, f5944d9b)
__lcHvm_exit6Fi_v (81, 5000, 0, cb45a4, 34, 0)
JVM_Halt (81, elaff69c, cb4398, elaff590, elaff568, 1)
```

Workaround

The Notes.INI parameter JavaUseReducedSignals=1 enables the use of reduced signal handling when starting the JVM through HTTP or Amgr on UNIX. This prevents a crash when the JVM on Solaris receives a HUP or INT signal.

This Notes.INI parameter has been enabled on all UNIX platforms, so that this ability is consistent.

Domino Server

Domino 64-bit: Known issues

Interoperability with other IBM products

The Domino 64-bit platform is not intended to inter-operate with the following Lotus extended products:

- Lotus Sametime
- Lotus QuickPlace
- Lotus WorkFlow
- Lotus Enterprise Integrator

Known issues

C/C++ applications that were developed on the Domino 32-bit platform need to be ported to 64-bit applications and built against the 64-bit C/C++ API Toolkits for Domino on the appropriate platform, as there is no binary compatibility between 32-bit applications and 64-bit applications. Note that the C++ toolkit is not available in this beta release (see below).

- The following Domino components are not functional in this beta release:
  - KeyView
  - Domino Off-line Services (DOLS) and Domino Web Access (DWA) in offline mode for AIX (Note: DWA online mode should be functional on AIX)
  - C++ API toolkit
  - DB2 as a Domino database store
• Running a DIIOP remote application against a 64-bit Domino server installation returns exception errors such as ‘Exception in thread “Thread-1” java.lang.OutOfMemoryError’.
• The DIIOP task is able to run on a 64-bit Domino server, but not all clients using NCSO.jar to that server may be able to successfully create a session with that server.
• If you are upgrading an existing 32-bit Domino server to the 64-bit platform, you must run updall on all databases.
• The 64-bit Windows installation will show 100% done before the process has finished. The installation will continue to take some time after the system indicates completion. This is a known issue and is being addressed.
• The Tivoli Enterprise Console (TEC) server is not certified to run on 64-bit platforms.

Domino for System i

iNav: CFGDOMSVR with timezone (*SYSVAL) by iNav
A problem occurs when a Domino server has been setup from iNav, and you want to specify *SYSVAL in the TIMEZONE field. When the command is submitted, the process finishes without errors but, if you search the label named “Timezone”, this will have a value of 0 (zero) - this means that the process did not get assigned the correct system value.

To solve this issue, Lotus recommends that when you set up a Domino server using the Domino Wizard from iNav, you choose any Timezone value except *SYSVAL, and you will submit the command to be processed.

Domino for System i

System i: Database name with extended characters not displayed
With i5/OS V5R4 and the HTTP (powered by Apache™) Domino plug-in based on WebSphere 6.0.2.3 (PTF SI19429), the following error is displayed on the Web browser when attempting to load a URL that contains a Domino database name with double-byte or other characters that are not a-z and 0-9 (for example, 剪除.nsf, Å.nsf or Ë.nsf).

HTTP Web Server: Unknown Command Exception
[/%E5%88%A0%E9%99%A4.nsf/(/All)?OpenView]

The same URL/Domino database name is successfully served using Domino HTTP via Domino Web Access.

This issue also occurs with the i5/OS V6R1 plugin.

Domino for System i

System i: HTTP crash when same port used by IPV 4/IPV6
The HTTP task of a server that is configured to use IPV6 will crash if the HTTP port is already in use by another server that is configured to use IPV4.

Workaround
In the Domino Directory, specify the host name(s) with an IPV4 or IPV6 address, and then enable "Bind to host name."

When you start a Domino server that was configured to use all of the available IPV4 addresses on the system (*SYSTEM) and then try to start a Domino server which is configured to use also IPV6, the server with IPV6 will crash. This happens because both try to use the 1352 port and the Domino server with IPV6 also tries to bind to the IPV4 address ports.
You must solve this issue by correctly assigning and binding specific IPv4 or IPv6 addresses to each Domino server.

Install PTF MF42024 for 5722999 V5R4M0 to avoid the Domino server crash, but you will still get "the requested TCP/IP port is in use on this system", which is correct - you must assign IP addresses correctly as mentioned above.

This applies to any other port in the same circumstances, for example on port 80 for HTTP, etc.

Web Services issues

Domino Designer
Fault order in generated method signatures
When importing a WSDL document prior to Domino 8.0.1, the order of the WS_FAULT arguments generated into LotusScript Web service method signatures was indeterminate. Starting in Domino 8.0.1, their order now conforms to the corresponding order of <fault> elements for each operation in the associated WSDL document portType. This can have an adverse effect on existing code having dependencies on the generated signatures if the WSDL document were to be re-imported in 8.0.1 or later.

Domino Designer
Importing WSDL containing xml:lang types
Element "type" attributes with a value of "xml:lang" in WSDL schema definitions are rejected during WSDL import for lack of a mapping to an implementation type. This may be addressed in a future release.

Domino Designer
Importing WSDL <group> references with maxOccurs attribute
Importing WSDL into a Designer Web service when the WSDL document contains an XML <group> reference with a maxOccurs attribute will fail with the following message:

"An error occurred while importing the WSDL file: The specified WSDL file is not suitable for source code generation. Please review the contents of the file."

An example WSDL fragment that will trigger this error is:

```xml
<xsd:complexType name="AnotherType">
  <xsd:sequence>
    <xsd:group ref="tns:AnotherGroup" maxOccurs="unbounded"/>
  </xsd:sequence>
</xsd:complexType>
```

Currently the only known workaround is to remove the "maxOccurs" attribute from the <group> reference element.
Java Web service providers may return null data members.

There is a known problem in Lotus Domino 7.0.3, 8.0, and 8.0.1 where some Java Web service providers may now return class member values as null SOAP response elements. This occurs only if the WSDL document for the Java Web service design element was generated by Lotus Domino Designer, and only for Java class members whose names begin with a lower-case character followed by an upper-case character, for example, "eField".

The workaround for this problem is to rename such class members in the Java Web service provider design element either to have an upper-case first character or a lower-case second character ("EFieId" or "efield"), and then to regenerate the WSDL document by saving the design element.

This problem is expected to be addressed in a future release.

Java Web service value type classes may not generate into WSDL

For a Java Web service, Designer 8 and above will not generate WSDL <types> entries for subclasses of value types that are themselves explicit in the service interface. For example, given the following Web service design:

```java
public class BaseValueType {
    // properties not shown
}

public class ValueSubType extends BaseValueType {
    // properties not shown.
}

public class PortType {
    public BaseValueType echoValueType( BaseValueType inp) {
        // implementation not shown
    }
}
```

... the Designer-generated WSDL contract will contain an XML complexType for the "BaseValueType" class only, even though "ValueSubType" can legitimately be echoed by the "echoValueType" method shown here.

As a workaround, use Designer to generate the WSDL document anyway, then edit it outside Designer to include the missing "ValueSubType" complexType, and reimport the WSDL document for detailed implementation.
Web service interface change may not regenerate WSDL

Modifying a parameter or return type in a LotusScript Web service PortType method may not always regenerate the associated WSDL document, if the change is between some arbitrary data type and its holder class.

For example, changing the following LotusScript Web service PortType class method:

```livescript
Function echoString( arg As String ) As String
  '...
  End Function
```

...to:

```livescript
Function echoString( arg As STRING_HOLDER ) As String
  '...
  End Function
```

is not detected by Designer as a change to the WSDL interface, even though it introduces a second return value for the method, and should cause the WSDL document to be regenerated.

To work around this issue, change some known WSDL-regenerating property of the Web service at the same time, for example change an argument name, or toggle the "Include operation name in SOAP action" checkbox on the "Advanced" tab of the Web services properties dialog.

Web services and Agents should have unique names

Web services and Agents should have unique names, otherwise it is possible that the agent would be invoked via the ?OpenWebService URL, instead of the intended Web service.
Documentation updates

Notes Client Help

Lotus Notes

Changes to local database encryption
Beginning in Notes 8.0, users who use local database encryption are either required or encouraged to use the "Strong" encryption level.

If users choose File - Security - User Security - Notes Data, and "Simple" or "Medium" is the default encryption level for local databases, users can continue to use that level of encryption on new databases and replicas they create. However, these users are encouraged to switch to "Strong" encryption instead. If the default encryption level is "Strong" or no encryption, users can use only "Strong" encryption when creating new databases and replicas.

If a database has "Simple" or "Medium" encryption enabled, its encryption level can be changed to any of the three levels. If a database has "Strong" encryption enabled or no encryption enabled, only "Strong" encryption can be specified for it.

The Help topic on this feature is out-of-date and should instead be replaced with the following text.

Restricting access to local databases
When you enable encryption for a local database to which you have Manager access, IBM® Lotus® Notes® encrypts the database using your public key from your User ID. You are the only one who can then decrypt the database because you have the corresponding private key in your User ID. Nobody else's User ID can open the database.

Note If you use a disk compression utility, databases using medium or strong encryption will not use significantly less disk space.

To change the default encryption settings for new local databases or replicas
You can set Notes to leave new local databases or replicas unencrypted when you create them. You can also change the default encryption setting.

2. Click Notes Data > Databases.
3. To turn off encryption for new local databases, select "Do not locally encrypt."
   Or
   Change the encryption setting, under "Locally encrypt using..." by choosing one of the following options:
   - "Simple encryption." You can still use a different level when you create local databases and replicas.
- "Medium encryption." You can still use a different level when you create local databases and replicas.
- "Strong encryption" (recommended). Once this is selected, you can use only Strong encryption for new local databases and replicas from here on in.

To encrypt existing local databases
1. Open the local database.
2. Click File > Application > Properties.
3. Click the "Database Basics" tab, and then click the "Encryption Settings" button.
4. Select "Locally encrypt this database using" and select an encryption level. Strong is recommended and may be the only encryption level available.
5. (Optional) By default, your User ID is listed as the only User ID that can open the database when encrypted. If you would rather give a different person access to the database, click "For," then choose an address book and person from the "Select name" dialog box.

**Caution** If you choose a different user to have access to the database, you will lose your access to the database.

**Note** You may need to compact the database in order to fully remove the previous encryption settings.

Lotus Notes

**Correction: Locking the Notes ID**
In the topic "Locking the Notes ID" (in the Notes client standard configuration), there is a change in the section titled "To unlock your ID."

The following text:

Click File > Security > Unlock ID.
Macintosh OS X users: Notes > Security > Unlock ID"

has been replaced with:

"You will be prompted to log in to Lotus Notes in order to access your Lotus Notes applications."

Lotus Notes, Domino Web Access

**Correction: Synchronizing Notes with Domino Web Access**
The Notes help topic about synchronizing Domino Web Access contacts and journal entries with your Notes entries is incorrect. Use the information provided here instead.

**Synchronizing with Domino Web Access**
If you also use the IBM(R) Lotus(R) Domino(TM) Web Access client to access your mail and other Notes(R) applications on the Web, you can synchronize your Notes Contacts with your Domino Web Access Contacts list, and your Notes Personal Journal with your Domino Web Access To Do items.

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronize your Personal Journal with To Do items</td>
<td>From any of the Notes Mail views, click Actions &gt; Domino Web Access &gt; Synchronize Journal.</td>
</tr>
<tr>
<td>Task</td>
<td>Steps</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Synchronize your Contacts lists</td>
<td>1. Enable the Contacts preference <strong>Enable &quot;Synchronize Contacts&quot; on the Replicator.</strong>&lt;br&gt;2. From the Replication page, enable <strong>Synchronize Contacts</strong>, if it is not already enabled, and then click <strong>Start Now</strong>.</td>
</tr>
<tr>
<td>Open the synchronized copy of your</td>
<td>From any of the Notes Mail views, click <strong>Actions &gt; Domino Web Access &gt; Open Mail File Copy of Contacts</strong>.</td>
</tr>
<tr>
<td>Contacts, stored in your mail file</td>
<td></td>
</tr>
</tbody>
</table>

**Lotus Notes**

**Domino Blog: Use Create -> Hotspot to add links to blog posts**

In Lotus Notes 8.0.1, the Domino Blog application now uses the standard Lotus Notes 'Hotspot' functionality for embedding clickable Web links in rich text fields. This is accomplished by the following steps:

1. In the Body field of the Blog application 'New Post' form, select the text that will be turned into a clickable link.
2. From the top-level menu select "Create -> Hotspot -> Link Hotspot".
3. In the dialog that is presented, add the URL to the 'URL' field and click the 'X' on the top right corner to close the dialog.

The result is that the selected text is now a clickable link that will open the target URL in the browser that is set in the Notes Preferences. The link text will now appear in blue. When rendered in the Blog web client, these links will open in the same page by default.

**Note:** In earlier releases, links were added by using pulldown menus in the Blog application 'New Post' form. As of release 8.0.1, this has been replaced by the standard Lotus Notes 'Hotspot' functionality.

---

**Lotus Notes**

**Enabling Java applets in Notes - correction**

In the topic "Enabling Java applets in Notes, the menu path to java applet security settings and to open user preferences was incorrect. Use the information provided here instead.

**Enabling Java applets in Notes**

IBM Lotus Notes lets you run Java applets -- simple programs added to many Web pages to create interesting effects. To run a Java applet, the Web page's server must access your system, which can present a security problem. You can give access to Java applets on a server-by-server basis. This method of access control works well in a corporate intranet where you want to give open access to internal servers while limiting access to external servers.

**Notes**

- Java applet security settings in the Execution Control List (**File > Security > User Security > What Others Do**) do not apply when you are using Notes with Microsoft Internet Explorer.
- The defaults set in the Execution Control List's **Java applet security** section allow all servers to run Java applets in Notes. However, regardless of what settings you choose here, Notes does not permit any server access to any of your system resources (files, environment variables, password files, and so on).
To enable Java applets to run in Notes
1. From the menu, click File > Preferences > Basic Notes Client Configuration.
2. Under Additional Options select Enable Java applets.

To give access on a server-by-server basis
To provide greater control on a server-by-server basis if you’re using the Notes browser, perform these steps:
1. From the menu, click File > Locations > Manage Locations.
2. Click your current location and then click Edit.
3. Click the Advanced tab, then click the Java Applet Security tab:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Trusted hosts</strong></td>
<td>Enter the IP addresses or domain names of hosts (servers) that you trust to load Java applets on your workstation. For example, enter <a href="http://www.ibm.com">www.ibm.com</a>. You can specify wildcards such as 123.45.678.* or *.ibm.com.</td>
</tr>
<tr>
<td><strong>Caution:</strong></td>
<td>If you leave this field blank, the network access you specify in the “Network access for untrusted hosts” is in effect for all hosts.</td>
</tr>
</tbody>
</table>
| **Network access for trusted hosts** | Specify the level of network access for the hosts you named in the Trusted hosts field.  
  - **Disable Java** means the trusted host cannot run applets on your system.  
  - **No access allowed** means the trusted host can run an applet on your system, but cannot make network HTTP connections on any other host.  
  - **Allow access to any originating host** means that the applet can make network HTTP connections only on trusted hosts.  
  - **Allow access to any host** means the applet can make network HTTP connections on any host. |
| **Network access for untrusted hosts** | Specify the level of access for hosts not named in the Trusted hosts field.  
  - **Disable Java** means untrusted hosts cannot run applets on your system.  
  - **No access allowed** means untrusted hosts can run applets but cannot make network HTTP connections on any host.  
  - **Allow access to any originating host** means that the applet can make network HTTP connections only on the host where the applet was retrieved. |
Field | Description
--- | ---
Trust HTTP Proxy | Use this field only if you have specified that Java applets should run through a proxy. Click **Yes** if you can't run an applet because your local machine is not able to resolve the host name.

Lotus Notes

**Errata: Web browsing troubleshooting**
In the topic Web browsing troubleshooting, the menu path in the answer to the question "Why aren't Java applets running in Notes?" should be **Tools > Show Java Debug Console**.

Lotus Notes

**File formats supported for viewing in Lotus Notes**
Documents created with Office 2007 applications can only be viewed by Notes if they were explicitly saved using the older Office 98-2003 document formats.

Documents saved in the native/default Office 2007 file format cannot be viewed by Notes. Notes cannot view, nor can Notes import, files with the extension `.docx`, `.pptx`, and `.xlsx`.

Lotus Notes

**Getting Started - View mail conversations**
The Getting Started topic section "View mail conversations" is incorrect. Please use the information here instead:

**View mail conversations**
You can view your messages as mail conversations, which means that each message is grouped with all of its replies. To switch between seeing a simple list of messages or mail conversations, click the Action menu option **Show > Individual Messages** or **Show > Conversations**.

Lotus Notes

**Google Desktop Search setup description update**
The description: "5. Unzip GoogleDesktopEnterprise.zip and then run GoogleDesktopSetup.msi" is inaccurate. The download is an .EXE file, not a ZIP file.

The user steps in the following description are no longer required:

6. Once installation completes, open the Notes client and enable indexing of local Notes repositories as follows:

   a. Choose **Actions > Google Desktop for Notes**.
   b. In the dialog box, select **Enable indexing of local Lotus Notes databases**.
   c. Include any local databases by clicking the Add button.
   d. To index discussion documents from discussion and teamroom templates, select the **Index discussion documents** option.
**Lotus Notes**

**Inline spell checking available on text fields**

You can use spell checking on the text you are entering in Notes-style text fields (including Rich Text and Rich Text Lite fields), if the application designer has enabled in-line spell check for that field.

To check spelling on a field, locate the cursor in the field, and then click **Tools > Instant Spell Check**. Each time you move to a new text field, you must enable this feature; it does not remain on permanently for all fields.

**Lotus Notes**

**Keyboard shortcuts corrections and updates**

**General keyboard shortcuts**

- Alt+Down arrow does not open the Select Name dialog box from drop-down control in name fields.
- Alt+Minus key (−) opens a Size menu for pane borders. Press the s key to activate the menu, move the Up or Down arrow to select the border to move, and then press the Left, Right, Up, or Down arrow to move the selected border.
- Ctrl+F opens the Find dialog box from views.
- F6 cycles through all panes in the open perspective.

**Navigation keyboard shortcuts**

Home and End can be used to go to the first or last document in a view, respectively.

**Mail and Calendar keyboard shortcuts**

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+Down arrow</td>
<td>Open date picker, time picker, and time zone picker in new calendar entry form</td>
</tr>
<tr>
<td>Alt+Up arrow</td>
<td>Close date picker, time picker, and time zone picker in new calendar entry form and save new selection</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Move through embedded date picker</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Edit document</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Create new mail message</td>
</tr>
<tr>
<td>Ctrl+Page Down</td>
<td>Move to next day, week, or month in calendar view</td>
</tr>
<tr>
<td>Ctrl+Page Down</td>
<td>Move to selected month and day of following year in embedded date picker</td>
</tr>
<tr>
<td>Ctrl+Page Up</td>
<td>Move to previous day, week, or month in calendar view</td>
</tr>
<tr>
<td>Ctrl+Page Up</td>
<td>Move to selected month and day of previous year in embedded date picker</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save current document</td>
</tr>
<tr>
<td>Delete</td>
<td>Move mail message to trash; permanently delete calendar entry</td>
</tr>
<tr>
<td>Enter</td>
<td>Close date picker, time picker, and time zone picker, activate selection in new calendar entry, and save new selection</td>
</tr>
<tr>
<td>Enter</td>
<td>Close document and open next document</td>
</tr>
<tr>
<td>Enter</td>
<td>Open selected document or view</td>
</tr>
<tr>
<td>Shortcut</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enter</td>
<td>Create a new calendar entry in the calendar view, type the subject, and press Esc to save entry</td>
</tr>
<tr>
<td>Esc</td>
<td>Close date picker, time picker, and time zone picker in new calendar entry without changing selection</td>
</tr>
<tr>
<td>Esc</td>
<td>Exit embedded date picker</td>
</tr>
<tr>
<td>Esc or Ctrl+W</td>
<td>Close current document</td>
</tr>
<tr>
<td>F3</td>
<td>Move to next selected document</td>
</tr>
<tr>
<td>F4</td>
<td>Move to next unread document in a view</td>
</tr>
<tr>
<td>F6</td>
<td>Move to next pane or frame</td>
</tr>
<tr>
<td>Focus cursor next to group name in To, cc, or bcc field, then press F9</td>
<td>Displays each member of group</td>
</tr>
<tr>
<td>F9</td>
<td>Refresh mail or calendar views</td>
</tr>
<tr>
<td>Home</td>
<td>Move to current day in embedded date picker</td>
</tr>
<tr>
<td>Insert</td>
<td>Toggle between marking document read or unread mark (basic Notes only)</td>
</tr>
<tr>
<td>Page Down</td>
<td>Move to next month in embedded date picker</td>
</tr>
<tr>
<td>Page Up</td>
<td>Move to previous month in embedded date picker</td>
</tr>
<tr>
<td>Shift+Backspace</td>
<td>Select previous document in view (basic Notes only)</td>
</tr>
<tr>
<td>Shift+Ctrl+C</td>
<td>Display instant messaging contact list (basic Notes only)</td>
</tr>
<tr>
<td>Shift+Ctrl+Enter</td>
<td>Send new (rather than draft) mail message and open new mail message in edit mode</td>
</tr>
<tr>
<td>Shift+Delete</td>
<td>Move mail message to trash (basic Notes only)</td>
</tr>
<tr>
<td>Shift+Esc</td>
<td>Close and save current document (except for mail messages)</td>
</tr>
<tr>
<td>Shift+Esc</td>
<td>Send and close mail message</td>
</tr>
<tr>
<td>Shift+F3</td>
<td>Move to previous selected document</td>
</tr>
<tr>
<td>Shift+F4</td>
<td>Move to previous unread document</td>
</tr>
<tr>
<td>Shift+F6</td>
<td>Move to previous pane or frame</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>In a view, moves to the previous control in the Tab order. In a read-only document, moves to the previous unread document.</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Give focus to embedded date picker (basic Notes only)</td>
</tr>
<tr>
<td>Tab</td>
<td>In a view, moves to the next control in the Tab order. In a read-only document, moves to the next unread document.</td>
</tr>
</tbody>
</table>

**Keyboard shortcuts in German Help**

Some keyboard shortcuts in German Help are inaccurate; for example, Ctrl+B is listed as the shortcut for applying bold formatting, but for German the shortcut for bold is Ctrl+F.
Lotus Notes

**New Preference on document selection in views**
Notes 8.0 changed the document selection model in views to be consistent with the model the operating system uses. If you prefer to return to the document selection model used in Notes 7 and earlier, choose File > Preferences > Basic Notes Client Configuration, and under Additional Options, select Use Lotus Notes selection model (not system selection).

Lotus Notes

**New View > Show > Information Bar command**
The command View > Show > Information Bar lets you hide or display the information bar that is displayed at the top of mail views.

Lotus Notes

**No context help for policies and settings document in Notes**
Context-sensitive (F1) help is not available when creating a new settings document, for example using the Policies > Settings view of a server-based Notes application such as NAMES.NSF, while working in Lotus Notes 8 standard configuration. This help is available in the Domino 8 Administrator help. The correct context-sensitive F1 help continues to appear when working in Lotus Notes 8 basic configuration. In general, context-sensitive F1 help is not available for areas in the Lotus Notes 8 standard configuration where topics in the Domino 8 Administrator help or Domino Designer help are accessed.

Lotus Notes

**No context help for programmer pane in Notes client**
When creating a button that is a hotspot, a programmer's pane opens in the Notes client. There is no context-sensitive help (F1, or clicking the Help button) in this pane.

For help with Designer commands or formulas, or for more information about creating a button, see the IBM Lotus Domino Designer 8 Help. To download or view Lotus Domino Designer 8 Help, go to Lotus Documentation on the Web.

Lotus Notes

**Open in new window**
To open a document in a new window, you can right-click a document from any of these locations and select "Open in New Window"

- A document that is open in a window tab
- A document in a list in any Lotus Notes view
- A document bookmarked in the Open list

This option is available whether or not you have set a Window Management preference (File > Preferences > Windows and Themes) to open each document in its own window.

**Note:** You cannot open a view that you have bookmarked in a new window; only specific documents.
Lotus Notes, Domino Designer, Domino Server

Prevent the export of view data
You can prevent view data from being exported by setting a database property. When this property is enabled, if focus is in the application view, the Export option is not available from the File menu.

1. Open the application.
2. Click File > Application > Properties.
3. Click the Advanced tab.
4. Check "Disable export of view data."

Lotus Notes

Quota indicator display in mail navigator
For users who have their mail on Domino servers where mail quotas are enforced, a new horizontal bar displays near the top of the mail navigator, indicating the amount of disk space used for mail. To get more information about their mail quota, users can hover over the indicator or choose Tools > Quota Information. The quota indicator displays only in the Notes Standard client.

Lotus Notes

Recent contacts view
In your contacts, the Recent Contacts view contains a list of contacts with whom you have interacted in the recent past. The names in this view change so that the list reflects your recent activity, such as e-mail or chats. However, recent contacts are not stored automatically in your contacts file (usually names.nsf), nor do they automatically display in the My Contacts view.

Add a recent contact to your contacts file
1. From your Contacts, click Recent Contacts in the navigation pane.
2. Select one or more recent contacts.
3. Click Move to My Contacts.
4. In the dialog that displays, duplicate names that already have an entry in your contacts are listed in the bottom text pane. Check any contacts whose entries you want to update.
5. Click OK to add new and update selected names.

Delete a recent contact
When you delete a recent contact, the contact is moved to the Trash view. Names in the Trash view are automatically deleted permanently after a period of days (the default is 48) determined by a Contacts Preference (File > Preferences > Contacts).
1. From your Contacts, click Recent Contacts in the navigation pane.
2. Select one or more recent contacts.
3. Click Delete (trash can icon).

Lotus Notes

Replication - Correction to "Make Available Offline" menu
Use the "Make Available Offline" dialog box to simplify the creation of an offline copy (replica) of a Lotus Notes 8 application. The Lotus Notes Help incorrectly gives the menu command to access this dialog as File -> Make Available Offline. The correct command is File -> Application -> Make Available Offline. (This command is disabled when the focus is in a local replica, or in a server-based application for which you already have a local replica).
Lotus Notes

Saving and displaying conference call information
You can save conference call information that you use frequently as a calendar preference, and then display the information in the location field of meeting invitations you create.

To save conference call information, open your calendar, click More > Preferences above the calendar, and type the information under Conference Call Information. Then, when you create a new meeting invitation, you can select or clear the Include conference call information in the Location option below the Location field on an invitation-by-invitation basis.

Lotus Notes

Scheduling an IBM Lotus Sametime Unyte online meeting
Sametime Unyte users can set up a Sametime Unyte meeting from an IBM Lotus Notes meeting invitation. To do so, open a new meeting invitation from your calendar, click Online Meeting, and select the IBM Lotus Sametime Unyte option. Then specify the required information for the online meeting.

You can make Sametime Unyte meetings your default online meeting type. To do so, go to your calendar, click More > Preferences above the calendar, click Scheduling, click Sametime Unyte, select Make Sametime Unyte the default meeting type for online meetings, and specify the required meeting settings.

Lotus Notes

Searching the Web from Notes
The topic "Searching for information on the Internet" contains incorrect procedures for opening a search engine from within Notes and adding a search engine to the Search menu.

Performing the following steps actually submits your search term to a Web search engine and returns the search results:

1. From the "Search scope" drop-down list in the toolbar, click Yahoo! Search or Google Web Search.
2. Enter the term or terms to search for in the box and click the Search button.

Note: The above procedure applies only to the standard configuration on Lotus Notes. If you are using the basic configuration, the Search drop-down list does not include Web search engines.

In this release, you cannot add a search engine to the Search menu (drop-down list), in either the basic or standard configuration.

Lotus Notes

Search: Web query syntax is minus sign instead of NOT
The Notes Help topic "Refining a Search query using operators" needs to be updated to include the - (minus sign) as an operator meaning NOT in Web-style query syntax. (The word NOT is an operator only in Notes query syntax).
Lotus Notes

Setting regional calendar preferences
In the Notes Standard client, you can use the File > Preferences > Calendar and To Do > Regional Settings preferences to perform new tasks in this release. The following information needs to be added to step 3 of the "Changing regional calendar preferences" Help topic:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show a secondary, non-Gregorian calendar alongside the primary calendar</td>
<td>Select Hebrew, Hijri, or Japanese six day in the Secondary calendar field. To hide the secondary calendar, select None.</td>
</tr>
<tr>
<td>Show an additional time zone</td>
<td>Select Display an additional time zone, specify a time zone label, and then select a time zone. Tip Specify a short or blank label to minimize truncation of text in the time slot column.</td>
</tr>
<tr>
<td>Change the method used to calculate the week number footer in a calendar view (and in Day-At-A-Glance in the sidebar)</td>
<td>Click an option under Week Numbers to select the method used in the United States, the method used by the International Standards Organization, or a method you customize. Tip To hide the week number text, or to display the countdown in days or months instead of weeks, right-click the text and then click the option you want.</td>
</tr>
</tbody>
</table>

Lotus Notes

Upgrade folder design
When you replace the design of your mail file with the Mail (R8) template, you can also upgrade the design of folders you created prior to Notes 8.

Note Only folders based on these folder designs can be upgraded: Inbox, Calendar, Trash, All Documents, Alarms, and Rules

Use the following steps:
1. Make sure Advanced Menus are enabled (View > Advanced Menus).
2. From your mail file, click File > Application > Replace Design.
3. Select the option Upgrade Folder Design.
4. When the "Upgrade Folder Design" dialog box opens, click one of the following:
   - Automatic Upgrade - to upgrade all folders to the most current version of folder design
   - Manual Upgrade - to choose which folders to upgrade and which new folder design to apply
   - Cancel - to return to the Replace Design dialog box without updating folder designs

Lotus Notes, Domino Designer

Use Ctrl+F5 to lock out all clients
"Ctrl+F5" is the new key sequence to lock out all clients; "F5" is no longer supported.

Lotus Notes

Web query syntax: Plus(+) and minus (-) usage
The plus sign (+) is equivalent to the AND operator and the minus sign (-) is equivalent to the NOT operator.
Lotus Notes

"About This Application" and "Using This Application" documents
The "About This Application" and "Using This Application" documents for the Mail template (mail8.ntf) and the Contacts template (Pernames.ntf) have been updated for 8.0. For new applications created from one of these 8.0 templates, you can view the updated documents by opening the application and clicking Help > About This Application or Help > Using This Application.

However, the updated documents display only in applications created using 8.0 templates. For any existing mail or contacts applications created using templates prior to 8.0, updated versions of the "About This Application" and "Using This Application" documents do not display. For those templates, you can read the updated "About This Application" and "Using This Application" documents by opening the templates (mail8.ntf or pernames.ntf) and clicking Help > About This Application or Help > Using This Application.

For additional information about using Mail and Contacts in Notes 8, see the Help topics about those features (Help > Help Contents).

Lotus Notes

"IBM Lotus Productivity Tools" renamed "IBM Lotus Symphony"
The productivity tools that come with Lotus Notes are now called IBM Lotus Symphony. Lotus Symphony consists of a word processor, a spreadsheet, and a presentation program.

Domino Administration Help

Lotus Notes, Domino Server

Allowing diagnostic data to be sent to IBM
When the IBM Lotus Notes client (Basic configuration) or IBM Lotus Domino server is restarted after a server crash, diagnostic information about the crash is collected from the Notes System Diagnostics (NSD) and other files. This feature is enabled by default for the Notes client, and you can enable it on the Domino server. No attachments or confidential customer information are collected. The following information is collected:

- Client/Server Name
- Notes/Domino Version
- OS Version
- Start Time
- Crash Time
- Uptime
- User Comments (for clients)
- Error message
- Process
- Callstack
- Open Databases
Enabling the Send to IBM feature on the Domino server
To enable the Send to IBM feature on the Domino server, add the following setting to the Domino server's Notes.INI file:

```
CRASH_SENDTOIBM=1
```

When the Notes.INI setting `CRASH_SENDTOIBM=1` is set on the server, no additional configuration is required. When the server restarts after a server crash, diagnostic information is collected and an email is sent to IBM.

Send to IBM feature on the Notes client
When a Notes client end user restarts their client after a crash, one of the following behaviors occurs depending on whether the Send to IBM feature is enabled and Automatic Diagnostic Collection (ADC) prompting is enabled.

<table>
<thead>
<tr>
<th>Send to IBM feature</th>
<th>ADC prompting</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Enabled</td>
<td>The Notes client end user is prompted to specify whether to send a diagnostic report to their company administrator and to IBM. The Notes client end user also has the option of viewing the report.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Disabled</td>
<td>A dialog box displays information to the end user that a diagnostic report will be sent to their company administrator. The end user is also prompted as to whether they would like to send a diagnostic report to IBM.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Not configured</td>
<td>A diagnostic report is not sent to the company administrator but the Notes client end user is prompted to specify whether to send a diagnostic report to IBM.</td>
</tr>
<tr>
<td>Disabled</td>
<td>Disabled or enabled with no prompting</td>
<td>The Notes client end user sees no messages or prompts regarding diagnostic collection and reporting. A diagnostic report is sent to the administrator. The end user could be prompted for comments if the administrator configured the feature to do so.</td>
</tr>
</tbody>
</table>

To disable the Send to IBM feature on the Notes client, add this setting to the Notes.INI file on the Notes client:

```
DEBUG_CRASH_SENDTOIBM_DISABLE=1
```

Domino Server
Calculating user licenses - documentation correction
The Domino Administrator documentation contains the topic "Calculating the number of licenses in use." Step 3 of the procedure in that topic contained incorrect information. The corrected procedure is shown here:

Calculating the number of licenses in use
Use this procedure to recalculate the number of Notes and/or Domino Web Access users in your domain. A document is created for each server in your domain, listing the number of Notes and Domino Web Access users on each server.

1. From the Domino Administrator, click the "Files" tab.
2. Open the Domino User License Tracking database.
3. Choose 'Active Users - By Server', or choose 'All Users - By Server', and then click "Recalculate Licenses".
**Domino Server**

**Change to configuration setting for non-MIME Internet e-mail**
Enable the setting "Use character set auto-detection if message has no character set information" on the MIME - Conversion Options - Inbound tab of the Server Configuration document to allow IBM Lotus Notes Client e-mail users to receive correctly formatted MIME messages from non-MIME Internet e-mail clients. If this setting is not enabled, MIME e-mail messages sent from non-MIME e-mail clients will appear garbled when received by your Notes Client e-mail users.

**Domino Server**

**Clarification: Character limits for alternate names**
In the Domino Administration Help, two topics have been updated to clarify the character limit for alternate names.

The topic "Adding an alternate language and name to a user ID" now includes this note:

**Note**  When assigning an alternate name, do not exceed 79 characters for single-byte characters or 26 for double-byte characters. When alternate names are renamed, they are automatically truncated when the limitation is exceeded. Limiting the alternate name to within 79 (26) characters prevents the name from being truncated because it does not exceed its character limit.

In the topic "Table of Domino naming requirements," the row starting with 'Alternate user’ has been updated as follows:

| Alternate user | 79 characters for single-byte characters, 26 characters for double-byte characters | Can have only one alternate name |

**Lotus Notes, Domino Server**

**Clarification: Characters for use in Notes passwords**
The topic “Password protection for Notes and Domino IDs” in the Domino Administration Help has been updated to include the following information:

Notes passwords can include any keyboard character. This includes both standard ASCII characters and extended ASCII characters (for example, accented letters), as well as numbers and non-alphanumeric characters, such as the exclamation mark, percent sign, or parenthesis.

**Note:** Not all features that utilize Notes passwords may work if certain characters are used. For example, Windows single log-on will not work if the Notes password contains special characters.

**Domino Server**

**Commas not allowed in Agent Parameters for Event Handlers**
Do not use commas in the Agent Parameters field for Event Handlers. A series of parameters that includes commas between each parameter is invalid.
Correction for Extended Directory Catalog topic
The Domino Administration Help topic titled "Setting Up an Extended Directory Catalog" contains an error. Section 3 of the topic should read as follows:

**Step 3: Create the Extended Directory Catalog configuration document and run the Dircat task:**

1. Open the database you created in Step 2.
   
   **Note**: To integrate the Extended Directory Catalog into a primary Domino Directory, open that primary Domino Directory instead.

2. Select Configuration - Directory and open the Extended Directory Catalog view. In the view, click **Add Extended Directory Catalog**.

   **Note**: In order to use this toolbar function, make sure that all managers in the EDC ACL have all roles enabled.

Creating a server ID for the DB2 Access server
The Domino 8.0 Administrator documentation contains the topic "Creating a server ID for the DB2 Access server." The second paragraph in that topic has been modified. The first two paragraphs of the topic are shown here. The revision is in the second paragraph.

Creating a server ID for the DB2 Access server

**Note**: You only need to register a server and create a new server ID if you will be using the DB2 Access server. If you will be using DB2 Access Views (DAVs) and enabling the IBM(R) Lotus(R) Domino(TM) server to communicate with IBM(R) DB2 Universal Database(TM) Enterprise Server Edition, you need to perform this procedure and you also need to install and use the DB2 Access server.

Before installing a DB2 Access server on the DB2 server, you need a server ID saved to a file. Use this server ID when you install the DB2 Access server. When you are registering a new server, be sure to select the DB2 Server access check box to create a server ID specifically for the DB2 Access server. Be sure to make note of the server ID path and file name, because you are required to enter this information when installing the DB2 Access server. If you elect to install the DB2 Access server, you must create a new server ID file for it. Do not use the same server ID file for the Domino server and the DB2 Access server, as this will cause improper operation.

Creating criteria for mail archiving
The Domino 8 Administrator documentation contains the topic "Creating criteria for mail archiving." The topic has been updated to reflect minor changes to the user interface. The revised topic is as follows:

Creating criteria for mail archiving

You use an Archive Criteria policy settings document to define sets of criteria to use when archiving an IBM(R) Lotus(R) Notes(R) user's mail documents. You create an Archive Criteria policy settings document from within an Archive policy settings document. After you create archive criteria, you can use it in one or more archive policy settings documents.

When you specify archive criteria, you determine what to do with old documents in a user's mail file. Do you archive them (copy them to an archive database) or just delete them? If you archive them, you determine how to "clean up" the copies of the archived mail documents that remain the user's mail file. And finally, you define what an old document is.
Mail file criteria answers these questions:

- How should documents be archived? Archiving can be a combination of copying old documents to an archive database and then performing clean-up tasks on the user's mail file, or just deleting them.
- How should documents be cleaned up? Once documents have been copied to an archive database, you can either delete the copies that remain in the user's mail file, or reduce the size of the document.
- Which documents should be cleaned up? You provide a definition of an "old document" by specifying age criteria, and then applying that age criteria either to all documents or all documents in specified folders.

Specifying the name and location for the Archive database

By default, the archive mail database is stored in the directory archive, located in the data directory. Archive is the default name for the archive directory. The default name format for a user's archive database file is a_xxxx.nsf, where a_ is the prefix and xxxx is the name of the mail database. The name of the archive database is based on a specified number of characters (the default is 50) from the user's mail file name. For example, for the end user John Smith, whose mail file is jsmith.nsf, the archive database name is a_jsmith.nsf.

To create archive criteria policy settings

1. From the IBM(R) Lotus(R) Domino(TM) Administrator, select the People & Groups tab, and then open the Settings view.

2. Do one:
   - Select the Archive policy settings document for which you want to create archive criteria settings, and then click "Edit Settings."
   - Click "Add Settings" and then select Archiving to create a new Archive policy settings document.

3. Select the Selection Criteria tab, and then click "New Criteria."

4. Provide the following information on the Basics tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name that identifies the archive criteria. When you add criteria to an archive policy settings document, this is the name that appears in the selection box. This name also appears in the user's mail folder outline under Actions - Archive.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the criteria.</td>
</tr>
</tbody>
</table>
| Enable archive criteria | Do one:  
  Check to enable this archive criteria.  
  Uncheck if you are creating archive criteria to use later. |

5. For "How should documents be archived?", choose one:
   - Copy old documents into archive database; then clean up database -- to archive (copy) documents to the archive database and then clean up (delete or reduce those documents) from the user's mail database.
   - Clean up database without archiving -- to delete documents from the user's mail database without copying them into an archive database. Use this setting to enforce document-retention policies that delete all documents after a specified time.
6. If you chose to Copy old documents, for "How should documents be cleaned up?", choose one:
   - Delete older documents from the database -- to delete copies of archived documents that remain in the user's mail database.
   - Reduce the size of the documents in the database -- to truncate copies of the archived documents that remain in the user's mail database. Then choose one:
     - Remove attachment, leave summary -- to leave only the header information on the mail document.
     - Remove attachment, leave summary and 40KB -- to leave the header information and 40KB of the body of the mail document. This will truncate large documents and documents with attachments.

7. Under "Which documents should be cleaned up?" specify the criteria that defines an "old" document. This criteria determines which documents are candidates for archiving. Choose one:
   - Older than -- to specify the date the archive criteria settings document was created as the start date for the document retention period. Documents created prior to this date are eligible for archiving.
   - Not accessed in more than -- to specify documents not opened in the specified time frame. Do not use this option unless the database property Maintain Last Accessed is set. If this property is not set, the criteria will not locate any documents to archive. Specify a time period.
   - Not modified in more than -- to specify documents that have not been modified in the specified time frame (default). Then specify a time period. This is the recommended setting.
   - With expiration date older than -- to specify documents that have been marked expired. A document is eligible for archiving if it has an expiration date earlier than the specified cut-off date.

8. (Optional) If you use a custom mail template, complete these fields
   - Change template server -- select the name of the server on which your mail template is stored.
   - Choose template -- select the name of your custom mail template.

9. For "In views or folders" check this option to clean up all documents in the selected views and folders according to the criteria you established in the settings above.

10. (Optional) Click the Destination tab and change any of these fields if you want to change the location of the archive database.

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Archive Directory</td>
<td>The default is archive. Enter a new name if you want to change it.</td>
</tr>
<tr>
<td>Archive Prefix</td>
<td>The default is the letter a, followed by an underscore (_). Enter a new prefix if you want to change it.</td>
</tr>
<tr>
<td>Archive suffix</td>
<td>The default is .NSF. Enter a different suffix for the archive database name if you want to use a suffix other than NSF.</td>
</tr>
<tr>
<td>Number of characters from</td>
<td>The default is 50. To change this, enter the number of characters to use from the user's mail file name to create the archive database name.</td>
</tr>
<tr>
<td>original filename</td>
<td></td>
</tr>
</tbody>
</table>

11. Save the document.
Customizing Resource-Balancing Behavior

The IBM Lotus Domino 8 Administrator contains the topic "Customizing Resource-Balancing Behavior." The procedure in the topic was corrupted. The correct text is as shown:

Customizing resource-balancing behavior
Customizing resource-balancing behavior is an advanced feature. Therefore, unless you know how changes will affect the outcome of resource balancing, use the default settings.

To customize resource-balancing behavior
1. From the IBM(R) Lotus(R) Domino(TM) Administrator, click the Server - Performance tab, expand the Activity Trends section, and click Resource Balancing.
2. Choose Resource Balancing - Options to open the Server Profile Options dialog box.
3. Expand the Balancing section, and then click Advanced.
4. Under Resource Balancing Behavior, choose one:
   - Minimize Moves -- To minimize the number of moves made, even though the balance may not be as accurate when completed.
   - Balance Moves and Accuracy -- To allow more moves, in an effort to reach a higher level of accuracy.
   - Maximize Accuracy -- To allow as many moves as it takes to get the most accurate resource balance.
5. Under "When submitting a resource balancing plan" choose one of these:
   - Automatically Select Server -- to automatically locate the server in the domain that has the Domino Change Control database (DOMCHANGE.NSF). This is the default.
   - Use Local Database Replica -- and then enter the path to use a replica of the Domino Change Control database (DOMCHANGE.NSF) located on the local drive.
   - Use Remote Server -- and then enter the name of the server that has the Domino Change Control database (DOMCHANGE.NSF).
6. Under Bin Sizes, choose the percentage for each bin:
   - Light Bin -- Default is 30%
   - Middle Bin -- Default is 40%
   - Heavy Bin -- Default is 30%
7. For the field "Enter server resource capacities as relative values when editing server properties," do one:
   - Check Yes (default) to specify server resource capabilities relative to other servers in the list.
   - Uncheck Yes to specify actual values, such as the number of transactions per day or the total amount of available disk space.
8. For the field "Use server volume and file system information when resource balancing," do one:
   - Check Yes (default) to use the volume information, such as physical volumes and their sizes that comprise the space available to Domino.
   - Uncheck Yes to ignore volume information and use the total amount of space on the server, treating all space as flat.
9. For the field "Warning when data is older than n days," enter the number of days before a warning is generated. The default is 7 days. Then if you create a resource-balancing plan and the data is older than 7 days, you receive a warning that the resulting plan will be based on old data.
10. Choose one of the following options to set Resource Balancing behavior defaults:
    - Use Defaults -- To revert to previously saved custom defaults.
    - Save as Defaults -- To save a custom set of defaults and override the system defaults.
    - Reset Defaults -- To revert to the system defaults.
DB2 Access View and Query View usage notes

One of the chief benefits of using Domino on DB2 is to leverage the power of SQL to supply Domino views with data that can be both tailored with each open of the view using user context, or with any number of criteria to filter and format results. With SQL you can also access one Domino database while browsing a Query View in another. However, to change the default behavior opening a document, for example via mouse double-click or "Enter", some programming must be done to modify the database context.

With IBM Lotus Domino 8, new navigational columns are now available with DB2 Access Views. These are very important in the establishment of alternate database contexts. The method where that is controlled (invoked at double-click) is the QueryOpenDocument method in the Query View. This method is passed in a Notesuiview object, which is its link with the entry in the Query View being opened. Within the Notesuiview is the "CaretCategory" property. This corresponds to the first sortable column in the Query View. So while there are other ways to locate the current entry, it is currently a best practice to build a value in the Query View which allows for establishment of database and noteid context. In the Query View, for instance, one would construct a hidden key:

```
doctype || ';;;' || char(posteddate) || ';;;' ||
char(decimal(numwidgets,7,2) || ';;;' || #DBPATH || ';;;' ||
char(decimal(#NOTEID,8)) AS TYPE, <col 2>, <col 3> ....
```

which does double duty as first sort column and provider of database context.

If it is desired to display the collating values separately, other columns can follow the first one, where values are supplied from the same SQL columns or expressions but renamed for the view using the SQL "AS" clause (see below). Such additional columns can be used to sort or categorize entries as in traditional Domino view processing.

The Query View SQL must build values that enable CaretCategory values such as

```
SELECT doctype || ';;;' || char(posteddate) || ';;;' ||
char(decimal(numwidgets,7,2) || ';;;' || #DBPATH || ';;;' ||
char(decimal(#NOTEID,8)) AS TYPE, <col 2>, <col 3> ....
```

where the value must be a character value but which includes all data necessary for the Domino view to properly sort entries. When using either date or numeric values in the select clause, the SQL char() function serves as the method of transforming those values into characters yet preserving order. In the case of numeric values, the decimal() function is required to keep numeric values at a uniform length and precision. Alternately, the special #UNID column could be used in the SELECT clause above instead of #NOTEID as part of the CaretCategory value and that would support opening the document from any available replica.
For much more on date and time functions in DB2, see


or other related articles.

Once the CaretCategory values are in hand in the QueryOpenDocument method, those values can be parsed (using delimiters - like the ‘;;;’ above - or some other means) to get the database context in which to open the document.

**Domino Server, Domino Access for Outlook**

**Difference between Load convert and Replace design**

This release note explains the difference between Load convert and Replace design.

The Convert task was created specifically for converting mail files to a new design. As such, it does some mail-specific operations, like converting categories to folders. It is also a server task that can be run against many databases at one time.

Replace Design is a menu selection from the client, used to replace the design of any database. It simply replaces the current design elements with the ones from the template you select. It does not do any mail-specific actions, like Convert.

**Domino Server**

**Domino and Microsoft Cluster Server**

Domino can be run on a Microsoft Cluster Server as long as the recovery configuration for Domino (auto restart and the recovery configuration for Microsoft clusters), do not conflict.

**Domino Server**

**Enabling the Portal server for federated administration**

The IBM Lotus Domino 8 Administrator documentation contains the topic “Enabling the Portal server for federated administration.” The topic contains an error in Step 3.

**Incorrect information:**

3. Click the link for WP ConfigServer from the list of available resource environment providers.

**Correct information:**

3. Click the link for WP ConfigService from the list of available resource environment providers.

**Domino Server**

**Enhanced user activity detail available for applications**

IBM Lotus Domino 8 provides enhanced detail in the User Activity dialog box. You can use the detail information to determine who deleted documents from an application, who made design or ACL changes, and other related information pertaining to application reads, adds, updates and deletes. The changes to the user activity information allow greater troubleshooting of application problems and provide the ability to better perform usage analysis on an application. This is accomplished by detailing the application write information according to whether it is an application add, update or delete and also by listing the application reads.
If a note is added, updated, deleted or read, the logged statistics are updated accordingly, regardless of whether the update is done by a user/administrator or a server task. The enhanced detail in the User Activity dialog box is available with On-Disk Structure (ODS) 48 only.

Complete these steps to view the User Activity dialog box:

1. From the Domino Administrator client, choose File - Application - Properties.
2. On the Application Properties dialog box, click the Information (i) tab.
3. Click User Detail.

For more information about ODS 48, see the topic "Domino's On-Disk Structure" in the Domino 8 Administrator documentation.

---

**Domino Server**

**Event Handler notification methods**

The IBM Lotus Domino 8 Administrator documentation contains the topic "Event Handler Notification Methods." The Run an Agent description should be changed. The updated description is shown here:

<table>
<thead>
<tr>
<th>Run an agent</th>
<th>Runs a specified agent based on the configured Event Handler. Use this method to resolve an issue without user intervention. You specify the agent name, the server and database containing the agent, and any parameter to pass to the agent. Do not use commas in the Agent Parameters field; the field does not accept them.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note</strong></td>
<td>You must have the appropriate database access to run an agent from a database.</td>
</tr>
</tbody>
</table>

---

**Mail quota settings - desktop policy settings document**

The Mail tab on the desktop policy settings document contains settings that govern user mail quotas. The IBM Lotus Domino Administrator documentation contains this update to reflect these new settings:

24. Complete these fields on the Mail tab:

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format for messages to Internet addresses which cannot be found when message is sent:</td>
<td>Choose one:</td>
</tr>
<tr>
<td>Notes Rich Text Format -- Use Notes Rich Text format to send email messages whose internet address cannot be found.</td>
<td></td>
</tr>
<tr>
<td>MIME Format -- Use Mime Format to send email messages whose internet address cannot be found.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Action</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Mail Quota indicator on client</td>
<td>Choose one:</td>
</tr>
<tr>
<td></td>
<td>Enable -- Displays a mail quota indicator on the user's Notes client user interface. The mail quota indicator shows the user how much disk space their mail file consumes in relation to their mail quota.</td>
</tr>
<tr>
<td></td>
<td>Disable -- Prevents the display of a mail quota indicator on the user's Notes client. If mail quotas are not in use, set to Disable.</td>
</tr>
<tr>
<td>Auto update interval for mail quota in minutes</td>
<td>Specify the time interval in minutes between each refresh of the mail quota data that is displayed.</td>
</tr>
<tr>
<td>Allow refresh of mail Quota on hovering over quota indicator</td>
<td>Choose one:</td>
</tr>
<tr>
<td></td>
<td>Enable -- The mail quota usage information is updated when the user's cursor hovers over the mail quota indicator. The information that is displayed includes the name of the mail server and the disk space used by the mail documents on that server, the percentage of the quota that is used, and the mail quota limit.</td>
</tr>
<tr>
<td></td>
<td>Disable -- Prevents the updating of the mail quota usage information when the user's cursor hovers over the mail quota indicator.</td>
</tr>
</tbody>
</table>

Lotus Notes, Domino Server

**New Server.Load workloads for Notes 8**

In order to view the documentation for the N8 Mail, N7 Mail, and N8 Mail Initialization workloads within the Administration Help, perform a search for "N8 Mail", "N7 Mail", or "N8 Mail Initialization".

A Notes.INI variable has been added to the 8.0.1 Server.Load N8 Mail workload to enable the workload to provide transactions, like the 8.0.1 Notes client. Set `<NB_ENABLE_V801_TRANS=1>` in the Server.Load driver's Notes.INI file for the N8 Mail workload to act as a Notes 8.0.1 client when talking to the server. Remove this setting, or set to 0, when you want the N8 Mail workload to provide Notes 8.0 client transactions.

Lotus recommends setting this variable to 0, or removing it from the Notes.INI file, when it is not needed, though this should not affect other workloads.
Lotus Notes, Domino Server

**Storing roaming user ID in PAB during user registration**

Due to enhancements made to user registration for Roaming Users, you must now explicitly choose to store the roaming ID in the Personal Address Book by choosing the "In personal address book" option on the Register Person - ID Info panel (the Register Person - ID Info panel displays during the user registration process). Choosing this option causes Notes Client setup to attach the ID to the personal address book. Storing the ID in the Domino Directory is no longer required.

Domino Server

**Using mail journaling to determine intended message recipients**

The IBM Lotus Domino 8 Administrator documentation contains the topic "Using mail journaling to determine intended message recipients." The fourth paragraph in this topic contains the sentence fragment "To exclude this." That sentence fragment should be ignored. The correct paragraph is shown here:

**Correct paragraph**

$JournalRecipientsExpanded_n is a new set of items that is added to a message selected for journaling whenever router group expansion occurs for a recipient of that message. Multiple items are necessary for large group expansions. For example, $JournalRecipientsExpanded_1, and if necessary, $JournalRecipientsExpanded_2, and so forth. Forwarded messages are journaled just as they were in previous releases.

Domino Server

**WebSphere Services DDM probe not available for use**

The IBM Lotus Domino 8.0 Administrator documentation, and more recent releases, contains information pertaining to the WebSphere Services probe. The WebSphere Services probe is not being made available. Please disregard all references to that probe.

Composite Application Editor Help

Lotus Notes, Domino Designer

**Components can be associated with a portlet**

In this release, you can associate a component with an existing portlet. This can give you the ability to add an Eclipse view with the option to choose the portlet to be used.

When you add NSF or RCP (Eclipse) components to your palette when editing Portal-hosted applications, the Composite Application Editor creates a placeholder component on your Home Portal server so that you can add that component to the application on Portal. It also retrieves the WSDL file for the component and stores that in the new placeholder component on Portal so that any properties and actions in the component are available for wiring on Portal.

When you are using RCP components, the Composite Application Editor makes new placeholders based on a "CAEPlaceholder" portlet. By default, when you are using NSF components, the Composite Application Editor will create new placeholders based on the Domino Application Portlet. This allows you to display your NSF content if you plan to use/view your applications in a browser client.
However, if you have no plans to use your applications in a browser client, you do not need to use the Domino Application Portlet, and do not need the overhead of creating new placeholders based on that scenario.

In order to change this default behavior, you can set a preference so that the Composite Application Editor will always use the CAEPlaceholder portlet. The following procedures demonstrate how to manually set this preference depending on whether you want to associate a component with a placeholder portlet or a Domino Application Portlet (DAP).

**Associating a component with a placeholder portlet**

1. Edit the plugin_customization.ini file in a text editor (located in framework/rcp)
2. Add the following line to the bottom of the INI file:
   
   `com.ibm.rcp.aaf.portal/DontUseDAP=true`

3. Save the change.
4. Launch the Notes 8 client
5. Open a Portal Composite Application.
6. Select "Actions" from the menu bar
7. Select "Edit Application."
8. In the Composite Application Editor, right-click on your component palette.
9. Choose to add an NSF component to the palette.
10. View the Advanced Component Properties of this component by right-clicking on the component and choosing Advanced Component Properties. If the component is associated with the placeholder portlet, you will only see a few properties listed.
11. Drag this component onto the application in the Composite Application Editor.
12. Launch wiring and ensure you can wire up with this component. Make sure all wires also fire in the Composite Application Editor and in the client.
13. Open up the application in Portal and you should not see Domino Application Portlet (DAP) mentioned on the component.

**Associating a component with a Domino Application Portlet (DAP)**

1. Edit the plugin_customization.ini file in a text editor (located in framework/rcp)
2. Remove the following line to the bottom of the INI file:
   
   `com.ibm.rcp.aaf.portal/DontUseDAP=true`

3. Save the change.
4. Launch the Notes 8 client
5. Open a Portal Composite Application.
6. Select "Actions" from the menu bar
7. Select "Edit Application."
8. In the Composite Application Editor, right-click on your component palette.
9. Choose to add an NSF component to the palette.
10. View the Advanced Component Properties of this component by right-clicking on the component and choosing Advanced Component Properties. If the component is associated with the placeholder portlet, you should see a 100+ properties listed.
11. Drag this component onto the application in the Composite Application Editor.
12. Launch wiring and ensure you can wire up with this component. Make sure all wires also fire in the Composite Application Editor and in the client.
13. Open up the application in Portal and you should see Domino Application Portlet (DAP) mentioned on the component in the web browser.
Links to NSF components can be calculated at runtime

Two new Advanced Component Properties for composite application components have been added to assist you in calculating links (that is, NotesURLs) to NSF components in composite applications. The two properties are the following:

- ComputedNotesURL ("com.ibm.notes.ComputedNotesURL")
- ProcessOnlyOnUpdate ("com.ibm.notes.ProcessOnlyOnUpdate")

You may use these properties in application situations such as the following:

- When links (that is, NotesURLs) to NSF components in a composite application change between moving components from a development environment to a production environment. As a result, the composite application might not function correctly when it is deployed to your production environment.
- When a dynamic NotesURL is needed to customize a composite application at runtime based on the role or rights of the user.

The two properties are the following:

- ComputedNotesURL ("com.ibm.notes.ComputedNotesURL")
- ProcessOnlyOnUpdate ("com.ibm.notes.ProcessOnlyOnUpdate")

Using ComputedNotesURL ("com.ibm.notes.ComputedNotesURL")

Set this preference in the Advanced Component Properties page of the Composite Application Editor. as a value that is a macro of @functions that resolve to a Notes URL that will be added as a NotesURL preference to the cached CA.XML.

To access this property do the following:

1. Open a composite application for editing in the Composite Application Editor.
2. Right-click the component name in the CAE navigation pane and select Edit-Component-Component Properties from the context menu.
3. Click the Advanced... button on the Edit Component Properties dialog.
5. Click Edit to edit the property value as needed.
6. Enter one of the values described below as the property value.
7. Click OK to save the changes.

Entering @text("Notes://europa/85257299006C18B2/CompanyDetail?OpenFrameset") as the property value results in the addition of this preference to the cache:

```
<preference name="notesurl">
</preference>
```

Entering a value of @GetProfileField("URL Profile"; "NotesURL") demonstrates how to access a profile document.

This preference is also set in the Advanced Component Properties page of the Composite Application Editor as a value of true or false. A value of true (default) would indicate that the CA XML cache will be recomputed only when the CA XML design note is updated. A value of false would indicate that the CA.XML cache will be recomputed each time it is requested.

By default CA XML cache is only updated when the CA.XML design note is modified. It is worth noting that moving the Composite Application CA.XML to a new location (such as to deploy the composite application) will result in a new CA XML cache for the user.

The preference "page level access" will override the preference "com.ibm.notes.ProcessOnlyOnUpdate." For example if "pagelevel access" is turned on, the CA.XML is always returned even if the setting for "com.ibm.notes.ProcessOnlyOnUpdate" is set to true.

To access this property do the following:

1. While editing a composite application in the Composite Application Editor, right click the component you wish to associate this property with. You can do the same thing by selecting the component in the Composite Application Editor design pane and selecting Edit-Component-Component Properties from the context menu.
2. Click the Advanced... button on the Component Properties dialog.
4. Click Edit to edit the property value as needed.

This example would result in the cached application definition being refreshed each time the application is opened.

Domino Designer Help

Domino Designer

Agents property - usage and examples revised

Agents property
Read-only. All of the agents in a database.

Defined in
NotesDatabase

Data type
Array of NotesAgent objects

Syntax
To get: notesAgentArray = notesDatabase.Agents

Usage
Each element in the array is a NotesAgent object. If the script runs on the workstation, the array includes shared agents and private agents that belong to the current user. If the script runs on a server, the array includes only shared agents.
To set the value of an individual NotesAgent object, you need to access the array elements individually. For example, to get the first element in the array returned from the NotesDatabase object db, you could do the following:

```vbscript
Dim agent as NotesAgent
Set agent = db.Agents( 0 )
```

The database must be open to use this property.

To test whether the database contains agents, use IsEmpty or IsArray functions, as shown in the examples.

**Language cross-reference**

**Agents in Java Database class**

**Examples: Agents property**

1. This action script prints the name of each agent in the current database. Since the script runs on a workstation, it prints the name of shared agents, as well as the names of the current user's private agents, if any.

```vbscript
Sub Click(Source As Button)
    Dim session As New NotesSession
    Dim db As NotesDatabase
    Set db = session.CurrentDatabase
    If IsArray(db.Agents) Then
        Forall a In db.Agents
            Messagebox( a.Name )
        End Forall
    End If
End Sub
```

2. This script finds the agent in the current database named Periodic Archive and assigns it to the agent object. NOTE: See also GetAgent method.

```vbscript
Dim session As New NotesSession
Dim db As NotesDatabase
Dim agent As NotesAgent
Set db = session.CurrentDatabase
If Not IsEmpty(db.Agents) Then
    Forall a In db.Agents
        If ( a.Name = "Periodic Archive" ) Then
            Set agent = a
        End If
    End Forall
End If
End Forall
```
attachVCard method - new Document java method
attachVCard method
Attaches one or more documents in vCard format.

Note This method is new with Release 8.0.

Defined in Document

Syntax
public void attachVCard(lotus.domino.Base document)
    throws NotesException

Parameters
document
    Document, DocumentCollection, or NotesCollection. The Contact document or documents to be
    attached in vCard format. If a collection is specified, a single attachment will be made with the
    individual vCards lying end to end.

Usage
To keep the new attachment, call save after calling attachVCard.

If an empty collection is supplied, the error "No documents in collection" will be thrown.

If documents are not Contact documents, the documents will not be attached, and the error "Attach of
VCard failed" will be thrown.

The attachment will be in the UTF-8 character set.

Language cross-reference
AttachVCard method in LotusScript NotesDocument class

---

Domino Designer

AttachVCard method - new NotesDocument method
AttachVCard method
Attaches one or more documents in vCard format.

Note This method is new with Release 8.0.

Defined in NotesDocument

Syntax
Call notesDocument.AttachVCard( ClientADTOObject )

Parameters
ClientADTOObject
    Document, DocumentCollection, or NotesCollection. The Contact document or documents to be
    attached in vCard format. If a collection is specified, a single attachment will be made with the
    individual vCards lying end to end.
Usage
To keep the new attachment in the document, you must call the Save method after calling AttachVCard.
If an empty collection is supplied, the error "No documents in collection" will be thrown.
If documents are not Contact documents, the documents will not be attached, and the error "Attach of VCard failed" will be thrown.
The attachment will be in the UTF-8 character set.

Language cross-reference
attachVCard method in Java Document class

Domino Designer
CalendarFormat @Command - usage enhancement
CalendarFormat @Command
Changes the Calendar view to display one day, two days, one work week, one week, two work weeks, two weeks, one work month, one month, or one year.

Syntax
@Command( [CalendarFormat] ; format )

Parameters
format
Text. Optional. Specify one of the following:
- "1" specifies the one day display.
- "2" specifies the two day display.
- "5" specifies the one work week display.
- "7" specifies the one week display.
- "10" specifies the two work week display.
- "14" specifies the two week display.
- "20" specifies the one work month display.
- "30" specifies the one month display.
- "365" specifies the one year display. This option is only valid in Web applications.

Note Option "1" is new with Release 5.
Note Options "10" and "20" are new with Release 8.

Usage
With no parameters, CalendarFormat cycles to the next calendar display option, in this order: One Day, Two Days, One Work Week, One Week, Two Work Weeks, Two Weeks, One Work Month, One Month. With parameters, CalendarFormat changes to the designated display.
All options are supported for Web applications. Only options 1, 2, 5, 7, and 30 are supported for the standard environment. Only options 1, 2, 5, 7, 10, 14, 20, and 30 are supported for the basic environment.

Domino Designer
Caution when using CreateFromTemplate with large dbs
The NotesDatabase CreateFromTemplate method does not wait for the new database to be completely copied before finishing. Therefore, if you are copying a large database, use "Sleep" to ensure that sufficient time is given for the copy to complete before using the new database.
Changes to the "Instant Spell Check" feature
Instant (in-line) spell checking has been improved for 8.0.1. It is now possible to enable or disable instant spell checking on a per-field basis. Here are the steps to accomplish this in Domino Designer and the Notes Client.

In the Designer client

- In the Field properties dialog box, on the "Field Info" tab, there is an option "Enable instant spell check" for 'Text', 'Rich Text' and 'Rich Text Lite' fields. This will enable the instant spell checking feature for the selected field when the "Enable instant spell check" option is checked; it will disable the instant spell check for the selected field when "Enable instant spell check" is unchecked.

  or

- Open Domino Designer, and create a Form. Next, create a Text field, Rich Text field, or Rich Text Lite field, and open the Field Properties Dialog Box. Click the "Field Info" tab, and you will see an option to "Enable instant spell check". Check this option to enable instant spell checking for the field, or uncheck this box to disable instant spell checking.

In the Notes client

- When creating a document using a form that has Text, Rich Text, and Rich Text Lite fields, place a cursor in each field. Use "Tool -> Instant Spell Check" to enable the instant spell check separately for each field, or uncheck the "Tool -> Instant Spell Check" option to disable instant spell checking.

  or

- Open a database which contains a form with a Text, Rich Text, or Rich Text Lite field, and place the cursor in the field. Select "Tools -> Instant Spell Check" to enable Instant Spell Check in that Field. To verify it has been enabled, you can select the "Tools", and see the menu option for "Instant Spell Check" now has a checkmark on the left hand side.

  To disable instant spell check for this field, select "Tools -> Instant Spell Check" and uncheck the option.

DOMINO DESIGNER

Clear method

clear method

Purges the new or modified values of the property from the Notes backend where they are temporarily stored before publishing via the property broker.

Defined in
NotesProperty

Syntax
void clear()
    throws NotesException

Usage
If the NotesProperty is an input property, this method will have no effect.

Language cross-reference
Clear method in LotusScript NotesProperty class
clearProperty method

Purges the new or modified values of the specified property from the Notes backend where they are temporarily stored before publishing via the property broker.

Defined in

PropertyBroker

Syntax

void clearProperty(String propertyname)
    throws NotesException

Parameters

propertyname
    String. The name of the property which will be purged.

Usage

If the specified NotesProperty is an input property, this method will have no effect.

All PropertyBroker methods are inactive when called by applications running on the Domino server, or running on the Notes 8 basic configuration without Notes 8 standard configuration.

Language cross-reference

ClearProperty in LotusScript NotesPropertyBroker class

Composite Properties renamed Wiring Properties

The following Help documentation topics refer to a Composite Properties design element. The correct name of the design element is Wiring Properties.

Advanced options for columns
Examples: Description
Examples: Isinput
Examples: Name
Examples: NotesProperty class
NotesProperty class

Concurrent Web services require concurrent Web Agents

To allow Web services to run concurrently, the server on which they are running must have the ability to run concurrent Web Agents.

1. Open the Server document you want to edit.
2. Click the Internet Protocols - Domino Web Engine tab.
3. Enable "Run Web Agents concurrently".
Domino Designer

**ConvertToZone method - usage notes**
The following usage notes apply to the `ConvertToZone` method of both the Notes `DateTime` class and the Java `DateTime` class.

These changes also affect the `ZoneTime` property.

These changes do not affect the `GMTTime` and the `LocalTime` properties.

This method has no effect on an invalid `TimeZone` (because the `DateTime` object lacks the date or the time). `TimeZone` continues to return 0.

**Caution** This method uses the daylight saving time rules of the zone being converted from, not the zone being converted to.

Daylight saving time is a world-wide practice of decreasing energy consumption by adjusting clocks forward an hour, changing the offset from GMT. The `TimeZone` property indicates the base offset from GMT. For example, standard time in New York City is GMT -5, but when daylight savings is in effect, New York City is GMT -4.

---

Domino Designer

**CreateSession in NotesFactory - syntax revised**
When calling the `NotesFactory` `createSession` methods to create a `Session` object, nulls must be specified as `(String)null in order to avoid a "reference to createSession is ambiguous" error.

For applications making local calls based on the Notes user ID, create a `Session` object as follows. A Domino server or Notes client must be installed locally.

- `createSession()` -- No password verification occurs; the user is prompted for a password as required.
- `createSession((String)null, (String)null, (String)null)` -- Same as above.
- `createSession((String)null, (String)null, passwordString)` -- Access is granted if the password matches the Notes user ID password.

For applications making local calls based on the Domino Directory, create an Internet `Session` object as follows. A Domino Server must be installed locally.

- `createSession((String)null, "", ")` -- Anonymous Internet access is granted to the session if the server's `Server` record in the local Domino Directory permits anonymous access. Parameter two must be an empty string, not null.
- `createSession((String)null, userString, passwordString)` -- Internet access is granted to the session if the password matches the Internet password in the user's `Person` record in the Domino Directory.
Domino Designer

**Description property**

Read-only. Returns the description of the NotesProperty.

**Defined in**

NotesProperty

**Data type**

String

**Syntax**

```java
String getDescription() throws NotesException
```

**Language cross-reference**

Description property in LotusScript NotesProperty class

---

Domino Designer

**DesignImportOption property**

For both the NotesDXLImporter and Java DxlImporter class DesignImportOption properties:

If multiple elements share a name or alias, Replace_Else_Create and Replace_Else_Ignore will have unpredictable results. If there is at most one matching design element in the output database, whichever incoming element is the last one processed will replace all previously processed matching elements. If there are multiple matching design elements in the output database, there is no way to predict which one will be replaced. These options should only be used when there is at most one element with the same name or alias.

---

Domino Designer

**Designing forms - Changes do not effect existing forms**

Changing a form (for example, by adding a field) will not change documents previously created with that form until they have been edited and saved, either manually or programmatically by an agent. Removing a field from a form does not remove the value of that field from previously created documents. When adding a computed field or field with a default value, it may appear to have been added to the document, because opening the document will show a value in that field, but unless the document is edited and saved, the field will have no value, and no value is displayed in views referencing that field.
Domino Designer

**Disabling Passthru HTML - revised values**

When specifying how much HTML will be disabled, use the following values of the text field.

- To allow all passthru HTML, specify "DisablePassThruHTML=0".
- To disable only the [< and >] tags, specify "DisablePassThruHTML=1".
- To indicate passthru HTML with the Notes editor paragraph style html, specify "DisablePassThruHTML=2".
- To mark passthru HTML with the richtext passthru attribute, specify "DisablePassThruHTML=4".
- To disable all passthru HTML, indicate the passthru HTML with the Notes editor paragraph style html, and mark the passthru HTML with the richtext passthru attribute, specify "DisablePassThruHTML=7".

Domino Designer

**DiscoverFolders @Command title parameter and new example**

*DiscoverFolders @Command*

Displays the "Folders containing current document" dialog box.

**Note** This @command is new with Release 7.

**Syntax**

```plaintext
@Command( [DiscoverFolders] )
@Command( [DiscoverFolders];title )
```

**Parameters**

*title*

Text. Optional. If this argument is supplied, the text is appended to "Folders containing: " in the title of the dialog box. If this argument is not supplied, the title of the dialog box is "Folders containing current document".

**Usage**

This command does not work on the Web.

This command works only in a design element containing an embedded outline with the "Maintain folder unread information" property selected. Elsewhere in the design a document must be selected. Otherwise, the error "Cannot execute the specified command" occurs.

The dialog box displays the names of the folders containing the document. The user can open a folder or remove the document from a folder. The dialog box is replaced by the message box "Document does not exist in any of the folders" if that is the case.

**Examples: @Command([DiscoverFolders])**

This formula can be used to pass the subject field of a note in the mail database, which is then displayed in the title of the dialogue box. For example, if the current document has a subject of "Status of your project" then the following formula will title the dialogue box "Folders containing: Status of your project".

```plaintext
@Command([DiscoverFolders];subject);
```

Note that the formula displays the folders which contain the current document, not folders which contain documents having the same subject as the current document. The only thing changed by the optional title parameter is the title of the dialogue box, not the list of folders in the dialogue.
Domino Designer

**DontSendLocalSecurityUpdates takes effect immediately**
When the value of the NotesReplication `DontSendLocalSecurityUpdates` property is changed, the new value takes effect immediately.

Domino Designer

**Examples: Accessing the current database and view**
The text description of the second example has been corrected. The programming example itself remains unchanged.

**Examples: Accessing the current database and view**
1. This example displays the database title, its server and database name, its replica ID, and the names of users who have manager access.
   ```
   @Prompt([Ok]; "Title"; @DbTitle);
   @Prompt([Ok]; "Server and database"; @Trim(@Implode(@DbName))); 
   @Prompt([Ok]; "Replica ID"; @ReplicaID);
   @Prompt([Ok]; "Managers"; @Implode(@DbManager; ", "))
   ```
2. This window title formula displays "New Topic" for a new document; the Subject field if the view title is "AuthorView"; or the Subject field plus the number of response documents otherwise.
   ```
   StandardTitle := Subject + @DocDescendants(" (No Responses)"; " (1 Response)"; " (% Responses)")
   ```
   @If(@IsNewDoc; "New Topic"; @ViewTitle = "AuthorView"; Subject; StandardTitle)
3. This column formula displays the Subject field, the user name, and the number of response documents.
   ```
   Subject + " (" + @Name([CN]; From) + @DocDescendants("); ", % response)"; ", % responses")"
   ```

Domino Designer

**Examples: Clear method - revised**

**Examples: Clear method**
This script clears the previously published property "Track" from the selected NotesPropertyBroker.

```
Dim s As New NotesSession
Dim pb As NotesPropertyBroker
Set pb = s.GetPropertyBroker()
Dim prop As NotesProperty
prop = pb.setPropertyValue("Track","myvalue")
Call prop.Publish()
Call prop.Clear()```
Domino Designer

Examples: ClearProperty method - revised

Examples: ClearProperty method

This example demonstrates the use of the ClearProperty method to clear the value of a NotesProperty.

Dim s As New NotesSession
Dim pb As NotesPropertyBroker
Set pb = s.GetPropertyBroker()

dim PropName as string
PropName = "Subject"
Call pb.setPropertyValue(PropName,"My Subject")

Print "Property set to value " & pb.getPropertyValue(PropName)(0)
'value of "My Subject" will be printed

Call pb.ClearProperty(PropName)

Print "Property set to value " & pb.getPropertyValue(PropName)(0)
'value of blank will be printed

Domino Designer

Examples: Description property - revised

Examples: Description property

This script displays the name and description of the first input property for the Property Broker.

This script comes from a Notes form or view action. It executes because the Property Broker invokes it, on receiving a property change published by another component in a composite application. The script asks the Property Broker for the changed property, and displays the name and description of that property.

Note This script will always display the same message, because the input property, including its name and description, are associated with the WSDL action defined in the Wiring Properties design element in this application. The component that published the property may be using a different name and description, but there is no way to retrieve that information.

Dim s As New NotesSession
Dim pb As NotesPropertyBroker
Set pb = s.GetPropertyBroker()
Dim pbInputProperty As NotesProperty
Dim pbContext As Variant
pbContext = pb.InputPropertyContext
Dim InputPropertyName As String
Dim InputPropertyDesc As String
Set pbInputProperty = pbContext(0)
InputPropertyName = pbInputProperty.Name
InputPropertyDesc = pbInputProperty.Description
MessageBox "Property " + InputPropertyName + " is " + InputPropertyDesc, MB_OK, "Name"
Domino Designer

**Examples: GetMailInfo method - new examples**

Following are additional examples for the `GetMailInfo` method:

- The following example searches the directory on the server "server name" for the home server information of "Joe Smith", then displays that information.

```vbscript
Sub Initialize
    Dim session As New NotesSession
    Dim db As NotesDatabase
    Dim mynotesdir As NotesDirectory
    Set mynotesdir = session.getDirectory("server name")
    Dim homeserver As Variant
    homeserver = mynotesdir.GetMailInfo("Joe Smith", True)
    MsgBox "Mail Server: " + Cstr(homeserver(0))
    MsgBox "Build Number: " + Cstr(homeserver(1))
    MsgBox "Domino Version: " + Cstr(homeserver(2))
    MsgBox "Mailfile: " + Cstr(homeserver(3))
    MsgBox "Short Name: " + Cstr(homeserver(4))
    MsgBox "MailDomain: " + Cstr(homeserver(5))
    MsgBox "Username: " + Cstr(homeserver(6))
    MsgBox "internetMailAddress: " + Cstr(homeserver(7))
    MsgBox "Out of Office: " + Cstr(homeserver(8))
End Sub
```

- The following example uses the `getver` flag to get partial information about a user's mail file server if the first attempt to get mail information fails.

```vbscript
Function RetrieveMailInfo() As Integer
    On Error Goto ErrHandle
    RetrieveMailInfo = False
    Me.m_vOwnerMailInfo = Me.m_dirDirectory.GetMailInfo(Me.m_dbOwner, True)
    If IsEmpty(Me.m_vOwnerMailInfo) Then
        Me.m_vOwnerMailInfo = Me.m_dirDirectory.GetMailInfo(Me.m_dbOwner, False)
    End If
End Function
```

209
Examples: GetProperty method - revised

Examples: GetProperty method

This example illustrates a button in a composite application that would create a new response document. It checks for a PropertyBroker property, and if one is available, for the title of the Subject property, and uses the value to populate the Subject field in the new response document.

Sub Click(Source As Button)
    Dim s As New NotesSession
    Dim db As NotesDatabase
    Set db = s.CurrentDatabase
    Dim ws As New NotesUIWorkspace

    Dim pb As NotesPropertyBroker
    Dim prop As NotesProperty
    Set pb = s.GetPropertyBroker()
    If Not pb Is Nothing Then
        prop = pb.getProperty("Subject")
        title$ = prop.Title
    Else
        title$ = ""
    End If

    Dim uidoc As NotesUIDocument
    Set uidoc = ws.ComposeDocument("","","Response")
    Call uidoc.FieldSetText("Subject",title$)

End Sub

Examples: Isinput property - revised

Examples: Isinput property

This script checks whether the property named in the fieldname Propname is an input property.

This script comes from a Notes form or view action. It executes because the Property Broker invokes it, on receiving a property change published by another component in a composite application. The script asks the Property Broker for the changed property, and displays the name and description of that property.

Note This script will always display the same message, because the input property, including its name and description, are associated with the WSDL action defined in the Wiring Properties design element in this application. The component that published the property may be using a different name and description, but there is no way to retrieve that information.
Sub Click(Source As Button)
Dim s As New NotesSession
Dim workspace As New NotesUIWorkspace
If workspace.IsEmbeddedInsideWCT Then

    Dim pb As NotesPropertyBroker
    Set pb = s.GetPropertyBroker()
    Dim pbProperty As NotesProperty
    Dim PropertyName As String
    Dim PropertyIsInput As String
    Dim uidoc As NotesUIDocument
    Set uidoc = workspace.CurrentDocument
    PropertyName = uidoc.Propname(0)
    pbProperty = pb.GetPropertyValue(PropertyName)

    If pbProperty.Isinput Then
        PropertyIsInput = " is an input property"
    Else
        PropertyIsInput = " is NOT an input property"
    End If
    MessageBox PropertyName + PropertyIsInput, MB_OK, "Isinput"
Else
    MessageBox "Wrong Configuration", MB_OK, "Basic Configuration"
End If
End Sub

Examples: Name property - revised

Examples: Name property
This script displays the name of the input property to the action selected by the property broker.

This script comes from a Notes form or view action. It executes because the Property Broker invokes it, on receiving a property change published by another component in a composite application. The script asks the Property Broker for the changed property, and displays the name and description of that property.

Note This script will always display the same message, because the input property, including its name and description, are associated with the WSDL action defined in the Wiring Properties design element in this application. The component that published the property may be using a different name and description, but there is no way to retrieve that information.

Dim s As New NotesSession
Dim pb As NotesPropertyBroker
Set pb = s.GetPropertyBroker()
Dim pbInputProperty As NotesProperty
Dim pbContext As Variant
pbContext = pb.InputPropertyContext
Set pbInputProperty = pbContext(0)
Dim InputPropertyName As String
InputPropertyName = pbInputProperty.Name
MessageBox "Property Name is " + InputPropertyName, MB_OK, "Name"
Domino Designer

**Examples: NameSpace property - revised**

This script displays the namespace of the composite application selected by the property broker.

```vbscript
Dim s As New NotesSession
Dim pb As NotesPropertyBroker
Set pb = s.GetPropertyBroker()
Dim pbInputProperty As NotesProperty
Dim pbContext As Variant
pbContext = pb.InputPropertyContext
Set pbInputProperty = pbContext(0)
Dim PropNameSpace As String
PropNameSpace = pbInputProperty.NameSpace
Messagebox "Property NameSpace is " + PropNameSpace, MB_OK, "NameSpace"
```

---

Domino Designer

**Examples: NotesProperty class - revised**

This is the script for a form action. The action properties dialog has been used to associate this action with a "WSDL action" defined in a Wiring Properties design element, so that the form action executes when that form is open and the Property Broker triggers the WSDL action. It updates the value of propvalue on the form with the property value passed by the Property Broker.

```vbscript
Sub Click(Source As Button)
Dim s As New NotesSession
Dim workspace As New NotesUIWorkspace
If workspace.IsEmbeddedInsideWCT Then

    Dim pb As NotesPropertyBroker
    Set pb = s.GetPropertyBroker()
    Dim pbInputProperty As NotesProperty
    Dim pbContext As Variant

    'retrieves array of input NotesProperties
    'only first member of array is populated in this release
    pbContext = pb.InputPropertyContext
    Set pbInputProperty = pbContext(0)

    Dim InputPropertyName As String
    Dim NameSpace As String
    InputPropertyName = pbInputProperty.Name
    cName$ = InputPropertyName(0)

    Dim uidoc As NotesUIDocument
    Set uidoc = workspace.CurrentDocument
    Call uidoc.FieldSetText("propvalue", cName$)
    Call uidoc.Save
Else
    Messagebox "Wrong Configuration", MB_OK, "Basic Configuration"
End If
End Sub
```
Examples: Publish method
This script publishes the property value of "Track" to the NotesPropertyBroker.

```vbscript
Dim s As New NotesSession
Dim pb As NotesPropertyBroker
Set pb = s.GetPropertyBroker()
Dim prop As NotesProperty
prop = pb.setPropertyValue("Track",newCategory$)
Call prop.Publish()
```

Examples: Title property
This example illustrates a button in a composite application that would create a new response document. It checks for a PropertyBroker property, and if one is available, for the title of the Subject property, and uses the value to populate the Subject field in the new response document.

```vbscript
Sub Click(Source As Button)
    Dim s As New NotesSession
    Dim db As NotesDatabase
    Set db = s.CurrentDatabase
    Dim ws As New NotesUIWorkspace
    Dim pb As NotesPropertyBroker
    Dim prop As NotesProperty
    Set pb = s.GetPropertyBroker()
    If Not pb Is Nothing Then
        prop = pb.getProperty("Subject")
        title$ = prop.Title
    Else
        title$ = ""
    End If
    Print "The title of the Subject is: " & title$

    Dim uidoc As NotesUIDocument
    Set uidoc = ws.ComposeDocument("","","Response")
    Call uidoc.FieldSetText("Subject",title$)
End Sub
```
Domino Designer

Examples: **TypeName** property - revised

**Examples: TypeName property**

This example illustrates a button in a composite application that would create a new response document. It checks for a PropertyBroker property, and if one is available, for the name and typename of the Subject property, and uses the value to populate the Subject field in the new response document.

```vba
Sub Click(Source As Button)  
    Dim s As New NotesSession  
    Dim db As NotesDatabase  
    Set db = s.CurrentDatabase  
    Dim ws As New NotesUIWorkspace  
    Dim pb As NotesPropertyBroker  
    Dim prop As NotesProperty  
    Set pb = s.GetPropertyBroker()  
    If Not pb Is Nothing Then  
        prop = pb.getProperty("Subject")  
        name$ = prop.Name  
        type$ = prop.TypeName  
        title$ = "Property " & name$ & " of type " & type$  
    Else  
        title$ = ""  
    End If  
    Print "The title of the Subject is: " & title$  
    Dim uidoc As NotesUIDocument  
    Set uidoc = ws.ComposeDocument("","","Response")  
    Call uidoc.FieldSetText("Subject",title$)  
End Sub
```

Domino Designer

Examples: **Values** property - revised

**Examples: Values property**

This script displays the first value of the composite application selected by the property broker.

```vba
Dim s As New NotesSession  
Dim pb As NotesPropertyBroker  
Set pb = s.GetPropertyBroker()  
Dim pbInputProperty As NotesProperty  
Dim pbContext As Variant  
pbContext = pb.InputPropertyContext  
Set pbInputProperty = pbContext(0)  
Dim pbValueArray As Variant  
pbValueArray = pbInputProperty.Values  
FirstValue$ = pbValueArray(0)  
Messagebox "First Property value is " + FirstValue$, MB_OK, "Value"
```
Example: FTDomainSearch - new example
The following code, when placed in a button on a search form within a directory catalog database, searches the directory for the specified query string, and returns all results.

Sub Click(Source As Button)
    Dim s As New NotesSession
    Dim db As NotesDatabase
    Dim w As New NotesUIWorkspace
    Dim uidoc As NotesUIDocument
    Dim quer As String
    Dim srdoc as NotesDocument
    Dim doc as NotesDocument

    Set db=s.CurrentDatabase
    Set uidoc = w.currentdocument
    uidoc.refresh
    Set doc=uidoc.Document

    quer=doc.query(0)

    On Error Resume Next
    If db.isopen Then
        If Err <> 0 Then
            Messagebox STR_DBOPEN_ERROR, 0 , STR_ERROR
            Err = 0
            Exit Sub
        End If

        Set srdoc = db.ftdomainsearch(quer, 0)
        If Err <> 0 Then
            Messagebox STR_NDF, 0 , STR_LOTUS_NOTES
            Err=0
            Exit Sub
        End If

        srdoc.Form="SearchResults"
        Call w.EditDocument(False, srdoc, True)
    End If
End Sub

Lotus Notes, Domino Designer
Formulas that look for values in columns and views
Referring to columns in formulas
If you plan to use a lookup formula, such as @DbColumn or @DbLookup, to retrieve data from a view, include a sorted column that the formula can use as the lookup key.

Caution  If the column used as the lookup key can be resorted by clicking on the header, the formula will return unpredictable results, depending on the current sort.
GetComponentViewPreference method

GetComponentViewPreference method

Returns the value of the specified component view preference.

**Note**  
This property is new with Release 8.0.1.

**Defined in**

NotesUIWorkspace

**Syntax**

```vba
Set preferenceValue = notesUIWorkspace.GetComponentViewPreference(PreferenceID)
```

**Return value**

`preferenceValue`

Text list. Value(s) of the specified preference.

**Usage**

This method is only valid in the Notes client.

If the PreferenceID cannot be found, an error is returned. The Error string is "Specified view preference is unavailable".

The following are some common component view preference IDs.

- com.ibm.portal.app.input.file
- com.ibm.portal.app.input.name
- com.ibm.rcp.extensionType
- com.ibm.rcp.id
- com.ibm.rcp.moveable
- com.ibm.rcp.objectId
- com.ibm.rcp.ratio
- com.ibm.rcp.showTitle
- com.ibm.rcp.standalone
- com.ibm.rcp.title
- com.ibm.rcp.viewId
- com.ibm.rcp.visible
- notesurl
- portletname
- portletwindowid

**Language cross-reference**

@GetComponentViewPreference function in formula language

**Examples: GetComponentViewPreference method**

This example prompts the user for a view preference ID and then returns the value of that view preference ID for the current composite application component.

```vba
Dim ws As New NotesUIWorkspace
Dim prefid As Variant
prefid = ws.Prompt (PROMPT_OKCANCELEDIT, "PrefID?", "Enter PreferenceID."
If Not IsEmpty (prefid) Then
    MessageBox CStr(ws.GetComponentViewPreference(prefid))
End If
End Sub
```
Domino Designer

**getProperty method**

*getProperty method*

Returns a NotesProperty object for a specified property.

**Note** This method is new with Release 8.0.1.

**Defined in**

PropertyBroker

**Data type**

NotesProperty

**Syntax**

```java
lotus.domino.Property getProperty(String propertyname)
  throws NotesException
```

**Parameters**

- **propertyname**
  
  String. The name of the property which will be returned.

**Usage**

All PropertyBroker methods are inactive when called by applications running on the Domino server, or running on the Notes 8 basic configuration without Notes 8 standard configuration.

**Language cross-reference**

GetProperty in LotusScript NotesPropertyBroker class

---

Domino Designer

**getPropertyBroker method**

*getPropertyBroker method*

Retrieves the property broker for this session.

**Note** This method is new with Release 8.0.1.

**Defined in**

Session

**Syntax**

```java
lotus.domino.PropertyBroker getPropertyBroker()
  throws NotesException
```

**Return value**

```java
lotus.domino.PropertyBroker
```

The property broker associated with the current composite application.

**Usage**

This method is inactive when called by applications running on Domino servers, or running on clients with Notes 8 basic configuration without Notes 8 standard configuration.

**Language cross-reference**

GetPropertyBroker method in LotusScript NotesSession class
getPropertyValue

getPropertyValue method
Returns the value of a specified property.

Note This method is new with Release 8.0.1.

Defined in PropertyBroker

Data type Vector

Syntax java.util.Vector getPropertyValue(String propertyname)

Throws NotesException

Parameters

propertyname String. The name of the property whose value will be returned.

Note Since there can only be a single input property per action, the name passed in must match.

Usage
This method is only valid for input properties. Therefore, this method is only of use within the context of an executing action.
The vector must be homogenious.

All PropertyBroker methods are inactive when called by applications running on the Domino server, or running on the Notes 8 basic configuration without Notes 8 standard configuration.

Language cross-reference
GetPropertyValue in LotusScript NotesPropertyBroker class

getPropertyValueString

getPropertyValueString method
Returns the value of a specified property as a single text value.

Note This method is new with Release 8.0.1.

Defined in PropertyBroker

Data type String

Syntax String getPropertyValueString(String propertyname)

Parameters

propertyname String. The name of the property whose value will be returned.

Note Since there can only be a single input property per action, the name passed in must match.
**Usage**

If the property has no value or the value is numeric or date-time, this method returns an empty java string. To test for an empty java string, use the length property.

If no property with the specified name exists, this method returns an empty java string. It does not throw an exception. Use `hasProperty` to verify the existence of a property.

This method returns a rich text value rendered to plain text. Formatting and embedded objects are lost.

If the property has multiple values, this method returns the first value.

All PropertyBroker methods are inactive when called by applications running on the Domino server, or running on the Notes 8 basic configuration without Notes 8 standard configuration.

**Language cross-reference**

*GetPropertyValue* in LotusScript NotesPropertyBroker class

---

**Domino Designer**

**getValueString method**

*getValueString method*

Read-only. Returns the value of the current NotesProperty as a single text value.

**Note**

This method is new with Release 8.0.1.

**Defined in**

NotesProperty

**Data type**

String

**Syntax**

```java
String getValueString()
    throws NotesException
```

**Usage**

If the property has no value or the value is numeric or date-time, this method returns an empty java string. To test for an empty java string, use the length property.

This method returns a rich text value rendered to plain text. Formatting and embedded objects are lost.

If the property has multiple values, this method returns the first value.

All NotesProperty methods are inactive when called by applications running on the Domino server, or running on the Notes 8 basic configuration without Notes 8 standard configuration.

**Language cross-reference**

Values property in LotusScript NotesProperty class
hasProperty method

Indicates whether a specific named property is associated with a given property broker.

**Note** This method is new with Release 8.0.1.

**Defined in**

PropertyBroker

**Data type**

Boolean

**Syntax**

```java
boolean hasProperty(String propertyname)
```

**Parameters**

`propertyname`

String. The property name.

**Return value**

- True indicates that the property broker has a property named `propertyname`.
- False indicates that the property broker does not have a property named `propertyname`.

**Usage**

All PropertyBroker methods are inactive when called by applications running on the Domino server, or running on the Notes 8 basic configuration without Notes 8 standard configuration.

**Language cross-reference**

HasProperty in LotusScript NotesPropertyBroker class

---

InputPropertyBroker property - new Java PropertyBroker property

**InputPropertyContext property**

Read-Only. Returns vector of input NotesProperties.

**Defined in**

PropertyBroker

**Data type**

Vector

**Syntax**

```java
java.util.Vector getInputPropertyContext()
```

**Usage**

Since the current property broker only supports a single input property, only the first member of the vector is populated. The type is declared as a vector to allow for extensions to the property broker in the future.

**Language cross-reference**

InputPropertyContext in LotusScript PropertyBroker class
Domino Designer

**IsInCompositeApp property**

Read-only. Indicates whether the component is running within a composite application.

**Note** This function is new in release 8.0.1

**Defined in**
NotesUIWorkspace

**Data type**
Boolean

**Syntax**
To get: `flag = notesUIWorkspace.IsInCompositeApp`

**Return value**
`flag`
- True indicates that the component is running within a composite application.
- False indicates that the component is not running within a composite application.

**Usage**
The IsInCompositeApp property indicates if the current element is a component in a composite application, while the IsEmbeddedInsideWCT property indicates if composite applications are available, whether or not they are being used. If IsInCompositeApp is true, IsEmbeddedInsideWCT must be true. If IsEmbeddedInsideWCT is false, IsInCompositeApp must be false.

The IsInCompositeApp property indicates if the current element is a component in a composite application, while the IsUsingJavaElement property indicates if the current component in a composite application is Java-based view or outline. If IsUsingJavaElement is true, IsInCompositeApp must be true. If IsInCompositeApp is false, IsUsingJavaElement must be false.

**Language cross-reference**
@IsInCompositeApp function in formula language

**Examples: IsInCompositeApp property**
Clicking on this button will display a messagebox indicating if the component is part of a composite application.

```vba
Sub Click(Source As Button)
Dim uiws As New NotesUIWorkspace
If (uiws.IsInCompositeApp) Then
    MsgBox "This is a component in a composite application"
Else
    MsgBox "This is not a component in a composite application"
End If
End Sub
```
**IsInput property - new**

**IsInput property**
Read-only. Indicates whether this property is an input property.

**Defined in**
NotesProperty

**Data type**
Boolean

**Syntax**

```java
boolean isInput()
    throws NotesException
```

**Return value**
- True indicates that the property is an input property.
- False indicates that the property is an output property, created by the application or user activity.

**Usage**
All input properties are read-only, and can not be cleared. Output properties can be read-write, and can be cleared.

**Language cross-reference**
IsInput property in LotusScript NotesProperty class

---

**isTrustedSession in Session - new example**

**Examples: IsTrustedSession property**
The following code creates a trusted session, then verifies the session has been created.

```java
Session session = NotesFactory.createTrustedSession();
if (session.isTrustedSession()) {
    System.out.println("Trusted session created");
} else {
    System.out.println("Not a trusted session");
}
```

---

**isTrustedSession in Session - new Java property**

**IsTrustedSession property**
Read-only. Indicates whether the session is a trusted session.

**Note**
This property is new with Release 8.0.1.

**Defined in**
Session

**Data type**
boolean

**Syntax**

```java
public boolean isTrustedSession()
    throws NotesException
```
Legal values
- true if the session is a trusted session
- false (default) if the session is not a trusted session

Usage
This property is only True for Local Java language bindings.

This property can only be set to True by non-Agent applications resident on a server, using the NotesFactory createTrustedSession method. These applications include server addins, servlets, and freestanding Java applications. If the method is called from an Agent, an error will be thrown.

This property has no effect on databases residing on the local server.

Applications running on a server installation that need to access databases on a remote server must have either a Trusted Server relationship, or a Trusted Session. The userID authority that the application is running under must be accounted for in the ACL of the remote database. That userID is often the serverID.

Domino Designer

IsUsingJavaElement property
IsUsingJavaElement property
Read-only. Indicates whether the current component is a Java-based view or outline.

Note This @function is new in release 8.0.1

Defined in
NotesUIWorkspace

Data type
Boolean

Syntax
To get: flag = notesUIWorkspace.IsUsingJavaElement

Return value
flag
- True indicates that the component is a Java-based view or outline.
- False indicates that the component is not a Java-based view or outline.

Usage
The IsInCompositeApp property indicates if the current element is a component in a composite application, while the IsUsingJavaElement property indicates if the current component in a composite application is a Java-based view or outline. If IsUsingJavaElement is true, IsInCompositeApp must be true. If IsInCompositeApp is false, IsUsingJavaElement must be false.

Language cross-reference
@IsUsingJavaElement function in formula language
IBM Lotus Notes, Domino, Domino Designer 8.0.2

Examples: IsUsingJavaElement property
Clicking on this button will display a messagebox indicating if the current component is a Java-based view or outline.

Sub Click(Source As Button)
Dim uiws As New NotesUIWorkspace
If (uiws.IsInCompositeApp) Then
    If (uiws.IsUsingJavaElement) Then
        MsgBox "This is a Java-based component"
    Else
        MsgBox "This is not a Java-based component"
    End If
Else
    MsgBox "This is not a component in a composite application"
End If
End Sub

Domino Designer
Java versions of LotusScript methods
Domino Designer 8.0.1 includes Java versions of all LotusScript methods that were new with 8.0. This includes the methods clone, contains, intersect, merge, and subtract for both the documentCollection class and the viewEntryCollection class.

Domino Designer
Java View class - revised methods
The following is the correct list of Java View class methods. The methods getAllReadEntries and getAllUnreadEntries were not implemented in Notes 8.0.

Methods
clear
copyColumn
createColumn
createViewNav
createViewNavFrom
createViewNavFromAllRead
createViewNavFromAllUnread
createViewNavFromCategory
createViewNavFromChildren
createViewNavFromDescendants
createViewNavMaxLevel
FTSearch
getAllDocumentsByKey
getAllEntriesByKey
getChild
getColumn
getDocumentByKey
getEntryByKey
getFirstDocument
getLastDocument
getNextDocument
getNextSibling
getNthDocument
getParentDocument
getPrevDocument
getPrevSibling
getURL
lock
lockProvisional
markAllRead
markAllUnread
recycle
refresh
remove
removeColumn
setAliases
toString
unlock

Domino Designer

**Keyboard shortcuts for bi-directional language support**

If bi-directional language support is enabled, the following keyboard shortcuts change the horizontal progression:

<table>
<thead>
<tr>
<th>Keyboard shortcut</th>
<th>Horizontal progression</th>
</tr>
</thead>
<tbody>
<tr>
<td>LEFT CTRL + LEFT SHIFT</td>
<td>right-to-left</td>
</tr>
<tr>
<td>RIGHT CTRL + RIGHT SHIFT</td>
<td>left-to-right</td>
</tr>
</tbody>
</table>
Domino Designer

**markAllRead method - java ViewNavigator new method**

**markAllRead method**
Marks all of the documents in a view navigator as read.

**Defined in**
ViewNavigator

**Syntax**
```java
public void markAllRead()
    throws NotesException
public void markAllRead(String username)
    throws NotesException
```

**Parameters**
String username

Optional. If present, the method marks all of the documents in the navigator as read on behalf of the given name. If omitted, the method marks all of the documents in the navigator as read on behalf of the current user ID.

**Usage**
If the database does not track unread marks, all documents are considered read, and this method has no effect.

**Language cross-reference**
MarkAllRead method in LotusScript NotesViewNavigator class

---

Domino Designer

**markAllUnread method - java ViewNavigator new method**

**markAllUnread method**
Marks all of the documents in a view navigator as unread.

**Defined in**
ViewNavigator

**Syntax**
```java
public void markAllUnread()
    throws NotesException
public void markAllUnread(String username)
    throws NotesException
```

**Parameters**
String username

Optional. If present, the method marks all of the documents in the navigator as unread on behalf of the given name. If omitted, the method marks all of the documents in the navigator as unread on behalf of the current user ID.

**Usage**
If the database does not track unread marks, all documents are considered read, and this method has no effect.

**Language cross-reference**
MarkAllUnread method in LotusScript NotesViewNavigator class
Domino Designer

Memory management for Java objects

When Java is used to create an object, two objects are created: a Java object and Notes back-end (C++) object. If the Java object is set to "null", flagging it for garbage collection, the C++ object is not affected. To have both the Java object and the C++ object marked for garbage collection, you must use the recycle method.

If objects are created from within a Java agent, all created objects (both Java and C++) are destroyed when the agent ends. However, you should consider using the recycle method for long running agents or agents that create a large number of objects. When using servlets, JSPs or stand-alone Java applications, the recycle method must be used to remove the back-end objects.

Recycling a parent, such as a document, will recycle all of its children, such as items. Recycling the session will recycle every object that has been used from it.

Domino Designer

Name property

Name property

Read-only. Returns the name of the NotesProperty.

Defined in

NotesProperty

Data type

String

Syntax

String getName()

throws NotesException

Language cross-reference

Name property in LotusScript NotesProperty class

Domino Designer

Namespace property

Namespace property

Read-only. Returns the namespace of the datatype associated with the NotesProperty.

Defined in

NotesProperty

Data type

String

Syntax

String getNamespace()

throws NotesException

Usage

The Namespace within the PropertyBroker provides a default value for all additional calls to methods that have an optional Namespace argument.

Language cross-reference

Namespace property in LotusScript NotesProperty class
Creating a Domino session

For applications making local calls based on the Notes user ID, create a Session object as follows. A Domino server or Notes client must be installed locally.

- createSession() -- No password verification occurs; the user is prompted for a password as required.
- createSession((String)null, (String)null, (String)null) -- Same as above.
- createSession((String)null, (String)null, passwordString) -- Access is granted if the password matches the Notes user ID password.

Trusted sessions are created using the createTrustedSession method as follows. If this method is called from an agent, an error will be thrown.

- createTrustedSession() -- No password verification occurs; the user is prompted for a password as required.

Note The createTrustedSession method is new with Release 8.0.1.

NotesProperty class - new Java class

NotesProperty class

Represents a single property in the Composite Applications properties of a Domino application. Properties are data transmitted to or from the Property Broker, which routes your application's communication with other components in a composite application. Properties are defined in a Wiring Properties design element.

Note This class is new with Release 8.0.1.

Syntax

```java
public class NotesProperty extends Base
```

Containment

Contained by: PropertyBroker

Properties

Description through getDescription

IsInput through isInput

Name through getName

Namespace through getNameSpace

Title through getTitle

TypeName through getTypeName

Values through getValues and setValues

Methods

clear

publish

getValueString
**Usage**

All methods are inactive when called by applications running on the Domino server, or running on the client without Notes 8 standard configuration.

The Publish method is used to transmit the value of one of your application's output properties to the Property Broker, which then passes the value on to the actions of any other components that are wired to receive that property. In addition to using this method, property value changes can be automatically published by associating a property to a view or folder column.

**Domino Designer**

**NotesUIDocument Print method - syntax parameter revised**

**NotesUIDocument.Print()**
Prints the current document:

- If one or more parameters are specified, automatically prints the document.
- If no parameters are specified, or if the first parameter is omitted, displays the File Print dialog box.

**Defined in**

NotesUIDocument

**Syntax**

Call `notesUIDocument.Print`

or

Call `notesUIDocument.Print( [ numCopies%, [, fromPage%, [, toPage%, [,draft [,printerName]]]] ] )`

**Parameters**

- `numCopies%`
  Integer. Optional. The number of copies you want to print. If you omit this parameter, the method displays the File Print dialog box. If you specify 0, the method prints one copy.

- `fromPage%`
  Integer. Optional. The page number where you want to begin printing. If you omit this parameter or specify 0, the method begins printing on the first page of the document.

- `toPage%`
  Integer. Optional. The page number where you want to stop printing. If you omit this parameter or specify 0, the method stops printing on the last page of the document.

- `draft`
  Boolean. Optional. Specify True if you want to print the document in draft mode. Otherwise, specify False or omit this parameter.

- `printerName`
  String. Optional. The name of printer which you want to designate to print.
NotesUIView Print method - syntax parameter and examples revised

NotesUIView.Print()

Prints the selected document(s) or the current view.

- If no parameters are specified, or if the first parameter is omitted, displays the File Print dialog box.
- If the second form of the method is used, the document or view prints according to the specified parameters.

**Note** This method is new with Release 5.

**Defined in:** NotesUIView

**Syntax**

Call `notesUIView.Print`

Call `notesUIView.Print( numCopies%, [ fromPage% ] [ , toPage% ] [ , draft ] [ , pageSeparator% ] [ , formOverride$ ] [ , printview ] [ , dateRangeBegin ] [ , dateRangeEnd ] [ , printerName] )`

- `numCopies%` Integer. The number of copies you want to print. If you omit this parameter you get the first form of the method and all other parameters are ignored.
- `fromPage%` Integer. Optional. The page of the document selection where you want to start printing. If you omit this parameter or specify 0, the method begins printing on the first page of the document selection.
- `toPage%` Integer. Optional. The page of the document selection where you want to stop printing. If you omit this parameter or specify 0, the method stops printing on the last page of the document selection.
- `draft` Boolean. Optional. Specify True if you want to print the document in draft mode.
- `pageSeparator%` Integer. Optional. Determines the page separator.
  - 0 No page separator
  - 1 Line between documents
  - 2 Page break between documents
- `formOverride$` Text. Optional. The name of the form that you want to use to print the document.
- `printView` Boolean. Optional. Specify True to indicate that you want to print the current view instead of the contents of the document. Defaults to False.
- `dateRangeBegin` Variant of type DATE. Optional. Prints the beginning date if printing from a calendar view.
- `dateRangeEnd` Variant of type DATE. Optional. Prints the end date if printing from a calendar view.
**printerName**

String. Optional. The name of printer which you want to designate to print.

**Examples: Print method**

1. **This example opens the File Print dialog box.**
   ```vba
   Sub Click(Source As Button)
   Dim workspace As New NotesUIWorkspace
   Dim uiview As NotesUIView
   Set uiview = workspace.Currentview
   Call uiview.Print
   End Sub
   ```

2. **This example prints a line between documents.**
   ```vba
   Sub Click(Source As Button)
   Dim workspace As New NotesUIWorkspace
   Dim uiview As NotesUIView
   pageseparator = 1
   Set uiview = workspace.Currentview
   Call uiview.Print(1, , , , pageseparator, , , , ,)
   End Sub
   ```

3. **This example inserts a page break between documents.**
   ```vba
   Sub Click(Source As Button)
   Dim workspace As New NotesUIWorkspace
   Dim uiview As NotesUIView
   Set uiview = workspace.Currentview
   pageseparator = 2
   Call uiview.Print(1, 0, 0, False, pageseparator)
   End Sub
   ```

4. **This example prints the current view.**
   ```vba
   Sub Click(Source As Button)
   Dim workspace As New NotesUIWorkspace
   Dim uiview As NotesUIView
   Set uiview = workspace.Currentview
   Call uiview.Print(1, , , , , , True, , ,)
   End Sub
   ```

5. **This example prints page two of a document.**
   ```vba
   Sub Click(Source As Button)
   Dim workspace As New NotesUIWorkspace
   Dim uiview As NotesUIView
   Set uiview = workspace.Currentview
   Call uiview.Print(1, 2, 2)
   End Sub
   ```

6. **This example prints a range of documents from a calendar view.**
   ```vba
   Sub Click(Source As Button)
   Dim workspace As New NotesUIWorkspace
   Dim uiview As NotesUIView
   Dim drBegin, drEnd As Variant
   drBegin = Datenumber(2002, 01, 01)
   drEnd = Datenumber(2002, 12, 31)
   Set uiview = workspace.Currentview
   Call uiview.Print(1,,,,,, True, drBegin, drEnd,)
   End Sub
   ```
Oracle connectivity with Linux

Oracle Connectivity
This section provides information about setting up connectivity to an Oracle server.

Requirements for Oracle Connectivity
Connectivity software requirements depend on the operating system platform and the Oracle version you are using.

Oracle connectivity on Solaris relies on the Oracle client library found in ORACLE_HOME/lib or ORACLE_HOME/lib32.

If you are using LEI and an Oracle 9 or 10 client, you must create a symbolic link in ORACLE_HOME/lib32 using the following command:

```bash
ln -s libclntsh.so.9.0 libclntsh.so.8.0
ln -s libclntsh.so.10.0 libclntsh.so.8.0
```

**Note** For best result, Lotus Software recommends matching your Oracle client and server versions.

**Note** The Oracle 8 connector works with the Oracle 9 client on all platforms except Linux. To use the Oracle 8 connector with Oracle 9 servers in a Linux environment, install the Oracle 8.1.7.4 client, which can access Oracle 9 servers.

Prompt method: Clarification of PROMPT_CHOOSEDATABASE

Prompt method
Displays a dialog box and returns a value based on your actions in the dialog box.

**Note** This method is new with Release 5.

Defined in
NotesUIWorkspace

**Syntax**

```plaintext
variant = notesUIWorkspace.Prompt( type%, title$, prompt$, [ default ], [ values ] )
```

**Parameters**

**type%**
Constant. Indicates the type of dialog box that you want to display. May be any of the following:

- PROMPT_CHOOSEDATABASE (13)

**Note** The constant name PROMPT_CHOOSEDATABASE is not implemented but the literal value 13 can be used instead.

- PROMPT_OK (1)
- PROMPT_OKCANCELCOMBO (5)
- PROMPT_OKCANCELEDIT (3)
- PROMPT_OKCANCELEDITCOMBO (6)
- PROMPT_OKCANCELLIST (4)
- PROMPT_OKCANCELLISTMULT (7)
- PROMPT_PASSWORD (10)
- PROMPT_YESNO (2)
- PROMPT_YESNOCANCEL (11)
title$

String. The text that you want displayed in the dialog box title bar. Required for all type%s, although you can specify a null string with "". The maximum number of characters is 65.

prompt$

String. The text that you want displayed within the dialog box. Required for all type%s, although you can specify a null string with "". The maximum number of characters is 255.

default

The value that will be used as your default input value. The input section of the dialog box is primed with the value; you can accept it by selecting OK, replace it with another value, or Cancel.

Not applicable to dialog boxes of type% PROMPT_OK, PROMPT_YESNO, PROMPT_YESNOCANCEL, or PROMPT_PASSWORD Optional for all other type%s. However, for PROMPT_OKCANCELCOMBO and PROMPT_OKCANCELEDITCOMBO a default is recommended so that the input section is not blank.

The value listed as the default must be included in the values list; otherwise, it is ignored.

The default value(s) for PROMPT_OKCANCELEDIT, PROMPT_OKCANCELLIST, PROMPT_OKCANCELCOMBO, PROMPT_OKCANCELEDITCOMBO, and PROMPT_OKCANCELLISTMULT is a string, a string array, a variant of type string, or a variant array of strings.

values

The values that you want displayed in the dialog box list box. You can select one of these values as the input. Required only with type%s PROMPT_OKCANCELLIST, PROMPT_OKCANCELCOMBO, PROMPT_OKCANCELEDITCOMBO, and PROMPT_OKCANCELLISTMULT.

The values for PROMPT_OKCANCELLIST, PROMPT_OKCANCELCOMBO, PROMPT_OKCANCELEDITCOMBO, and PROMPT_OKCANCELLISTMULT are a string array, a variant of type string, or a variant array of strings.

Return value

<table>
<thead>
<tr>
<th>Variant of type integer</th>
<th>for PROMPT_OK, PROMPT_YESNO, PROMPT_YESNOCANCEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variant of type string</td>
<td>for PROMPT_OKCANCELEDIT, PROMPT_OKCANCELLIST, PROMPT_OKCANCELCOMBO, PROMPT_OKCANCELEDITCOMBO, and PROMPT_PASSWORD</td>
</tr>
<tr>
<td>Variant Array</td>
<td>for PROMPT_CHOOSEDATABASE and PROMPT_OKCANCELLISTMULT</td>
</tr>
</tbody>
</table>

Type% PROMPT_OK always returns 1. For type% PROMPT_YESNO, returns 1 if you select Yes. If you select No, returns 0. For type% PROMPT_YESNOCANCEL, returns 1 if you select Yes, 0 if you select No, and -1 if you select Cancel. For PROMPT_OKCANCELLISTMULT, the return value is a variant containing a string array if you select OK, and EMPTY if you select Cancel. For PROMPT_CHOOSEDATABASE, the return value is a three-element array of strings, containing the server, filepath, and title of the database, in that order; if you press cancel, the return value is EMPTY. For all other type%s the return value is a string if you press OK, and EMPTY if you press Cancel.

Language cross-reference

@Prompt function in formula language
Domino Designer

**PropertyBroker class - new Java class**

**PropertyBroker class**
Mediates communication between components of a composite application, allowing communication between multiple Java components, or between Notes and Java components.

**Note** This class is new with Release 8.0.1.

**Syntax**

```java
public class PropertyBroker extends Base
```

**Containment**

- Contained by: *Session*
- Contains: *NotesProperty*

**Properties**

- `InputPropertyContext` through `getInputPropertyContext`

**Methods**

- `clearProperty`
- `getProperty`
- `getPropertyValue`
- `getPropertyValueString`
- `hasProperty`
- `publish`
- `setPropertyValue`

**Creation and access**

Get an existing PropertyBroker object with `getPropertyBroker` in *Session*.

---

Domino Designer

**Publish method - NotesProperty**

**publish method**
Publishes new values for NotesProperty properties if modified.

**Defined in**

*NotesProperty*

**Syntax**

```java
void publish() throws NotesException
```

**Usage**

After setting the value of a NotesProperty property, you must call this method for the changes to take effect. If you do not call Publish, your changes are lost.

**Language cross-reference**

Publish method in LotusScript NotesProperty class
**Publish method - PropertyBroker**

*publish method*

Publishes new values for PropertyBroker properties if modified.

**Defined in**

*PropertyBroker*

**Syntax**

```java
void publish()
  throws NotesException
```

**Usage**

After setting the value of a PropertyBroker property, using the `setPropertyValue` method, you must call this method for the changes to take effect. If you do not call `Publish`, your changes are lost.

**Language cross-reference**

*Publish* in LotusScript NotesPropertyBroker class

---

**Read-restricted views not appearing in Domino Designer**

Database designers need access to views that are Read-restricted so that view design changes can be made in IBM Lotus Domino Designer. If a designer does not have Read access to a view, it will not be displayed in Designer.

---

**RemoveLinkage method - new method**

*RemoveLinkage method*

Removes the doclink link from the rich text item while keeping hotspot text and formatting.

**Note**

This method is new with Release 8.0.2.

**Defined in**

*NotesRichTextDocLink*

**Syntax**

Call `notesRichTextDocLink.RemoveLinkage`

**Usage**

This method operates on any doclink, with or without hotspot text. For a simple doclink, the link is removed. For a hotspot link, the link is removed, but the hotspot text remains. Any style attributes explicitly placed on the hotspot link text will remain untouched.
Domino Designer

**setPropertyValue method**

Returns a NotesProperty with the value of a specified property.

**Note** The property must be published after setting, or the new value will be lost.

**Defined in** PropertyBroker

**Data type**
NotesProperty

**Syntax**

```java
lotus.domino.Property setPropertyValue(String propertyName, String propertyValue)
  throws NotesException
```

**Parameters**

- `propertyName` (String) The name of the property whose value will be set.
- `propertyValue` (String) The new value of the property.

**Return Value**
NotesProperty

**Usage**

The property must be defined by WSDL. If it does not exist, it will be created. Otherwise, the existing value will be replaced. Input properties cannot be set.

All PropertyBroker methods are inactive when called by applications running on the Domino server, or running on the Notes 8 basic configuration without Notes 8 standard configuration.

**Language cross-reference**

SetPropertyValue in LotusScript NotesPropertyBroker class

Domino Designer

**StampAllMulti method - new method**

Replaces the values of specified items in all documents associated with the entries in a view collection.

**Note** This method is new with Release 8.0.2.

**Defined in** NotesViewEntryCollection

**Syntax**

```java
Call notesViewEntryCollection.StampAllMulti( document )
```

**Parameters**

- `document` (NotesDocument) The document contains multiple items, each with values appropriate for the item type.
**Usage**

If an item does not exist, it is created. If the item is of a different data type, the existing item will be deleted and a new item of the new data type created.

The item values are immediately written to the documents on the server. You do not have to use the Save method of NotesDocument after StampAllMulti. However, any documents modified by your script must be saved *before* calling StampAllMulti.

This method does not modify existing NotesDocument objects. Documents must be retrieved again to see the changes.

If you do not have the proper access to modify one or more of the documents in the view entry collection, this method will return ERR_NOTES_STAMP_FAILED. Only those documents you are able to modify will be stamped.

**Domino Designer**

`s.GetPropertyBroker("com.ibm.compositeapps.samples") has changed`

"s.GetPropertyBroker("com.ibm.compositeapps.samples")" is no longer supported. The proper usage should just be "s.GetPropertyBroker()."

**Domino Designer**

**Table of Column Icons - revised**

The following table illustrates the column icons in Notes 8. To find the value for an icon, add the values of the icon's column and line. For example, if a view column is set to display values as icons, the large red X will display when that column value equals 81, and the magnifying glass will display when that column value equals 8.

<table>
<thead>
<tr>
<th></th>
<th>0</th>
<th>10</th>
<th>20</th>
<th>30</th>
<th>40</th>
<th>50</th>
<th>60</th>
<th>70</th>
<th>80</th>
<th>90</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td><img src="image1" alt="Icon" /></td>
<td><img src="image2" alt="Icon" /></td>
<td><img src="image3" alt="Icon" /></td>
<td><img src="image4" alt="Icon" /></td>
<td><img src="image5" alt="Icon" /></td>
<td><img src="image6" alt="Icon" /></td>
<td><img src="image7" alt="Icon" /></td>
<td><img src="image8" alt="Icon" /></td>
<td><img src="image9" alt="Icon" /></td>
<td><img src="image10" alt="Icon" /></td>
<td><img src="image11" alt="Icon" /></td>
</tr>
<tr>
<td>2</td>
<td><img src="image12" alt="Icon" /></td>
<td><img src="image13" alt="Icon" /></td>
<td><img src="image14" alt="Icon" /></td>
<td><img src="image15" alt="Icon" /></td>
<td><img src="image16" alt="Icon" /></td>
<td><img src="image17" alt="Icon" /></td>
<td><img src="image18" alt="Icon" /></td>
<td><img src="image19" alt="Icon" /></td>
<td><img src="image20" alt="Icon" /></td>
<td><img src="image21" alt="Icon" /></td>
<td><img src="image22" alt="Icon" /></td>
</tr>
<tr>
<td>3</td>
<td><img src="image23" alt="Icon" /></td>
<td><img src="image24" alt="Icon" /></td>
<td><img src="image25" alt="Icon" /></td>
<td><img src="image26" alt="Icon" /></td>
<td><img src="image27" alt="Icon" /></td>
<td><img src="image28" alt="Icon" /></td>
<td><img src="image29" alt="Icon" /></td>
<td><img src="image30" alt="Icon" /></td>
<td><img src="image31" alt="Icon" /></td>
<td><img src="image32" alt="Icon" /></td>
<td><img src="image33" alt="Icon" /></td>
</tr>
<tr>
<td>4</td>
<td><img src="image34" alt="Icon" /></td>
<td><img src="image35" alt="Icon" /></td>
<td><img src="image36" alt="Icon" /></td>
<td><img src="image37" alt="Icon" /></td>
<td><img src="image38" alt="Icon" /></td>
<td><img src="image39" alt="Icon" /></td>
<td><img src="image40" alt="Icon" /></td>
<td><img src="image41" alt="Icon" /></td>
<td><img src="image42" alt="Icon" /></td>
<td><img src="image43" alt="Icon" /></td>
<td><img src="image44" alt="Icon" /></td>
</tr>
<tr>
<td>5</td>
<td><img src="image45" alt="Icon" /></td>
<td><img src="image46" alt="Icon" /></td>
<td><img src="image47" alt="Icon" /></td>
<td><img src="image48" alt="Icon" /></td>
<td><img src="image49" alt="Icon" /></td>
<td><img src="image50" alt="Icon" /></td>
<td><img src="image51" alt="Icon" /></td>
<td><img src="image52" alt="Icon" /></td>
<td><img src="image53" alt="Icon" /></td>
<td><img src="image54" alt="Icon" /></td>
<td><img src="image55" alt="Icon" /></td>
</tr>
<tr>
<td>6</td>
<td><img src="image56" alt="Icon" /></td>
<td><img src="image57" alt="Icon" /></td>
<td><img src="image58" alt="Icon" /></td>
<td><img src="image59" alt="Icon" /></td>
<td><img src="image60" alt="Icon" /></td>
<td><img src="image61" alt="Icon" /></td>
<td><img src="image62" alt="Icon" /></td>
<td><img src="image63" alt="Icon" /></td>
<td><img src="image64" alt="Icon" /></td>
<td><img src="image65" alt="Icon" /></td>
<td><img src="image66" alt="Icon" /></td>
</tr>
<tr>
<td>7</td>
<td><img src="image67" alt="Icon" /></td>
<td><img src="image68" alt="Icon" /></td>
<td><img src="image69" alt="Icon" /></td>
<td><img src="image70" alt="Icon" /></td>
<td><img src="image71" alt="Icon" /></td>
<td><img src="image72" alt="Icon" /></td>
<td><img src="image73" alt="Icon" /></td>
<td><img src="image74" alt="Icon" /></td>
<td><img src="image75" alt="Icon" /></td>
<td><img src="image76" alt="Icon" /></td>
<td><img src="image77" alt="Icon" /></td>
</tr>
<tr>
<td>8</td>
<td><img src="image78" alt="Icon" /></td>
<td><img src="image79" alt="Icon" /></td>
<td><img src="image80" alt="Icon" /></td>
<td><img src="image81" alt="Icon" /></td>
<td><img src="image82" alt="Icon" /></td>
<td><img src="image83" alt="Icon" /></td>
<td><img src="image84" alt="Icon" /></td>
<td><img src="image85" alt="Icon" /></td>
<td><img src="image86" alt="Icon" /></td>
<td><img src="image87" alt="Icon" /></td>
<td><img src="image88" alt="Icon" /></td>
</tr>
<tr>
<td>9</td>
<td><img src="image89" alt="Icon" /></td>
<td><img src="image90" alt="Icon" /></td>
<td><img src="image91" alt="Icon" /></td>
<td><img src="image92" alt="Icon" /></td>
<td><img src="image93" alt="Icon" /></td>
<td><img src="image94" alt="Icon" /></td>
<td><img src="image95" alt="Icon" /></td>
<td><img src="image96" alt="Icon" /></td>
<td><img src="image97" alt="Icon" /></td>
<td><img src="image98" alt="Icon" /></td>
<td><img src="image99" alt="Icon" /></td>
</tr>
</tbody>
</table>
IBM Lotus Notes, Domino, Domino Designer 8.0.2

Title property

Title property
Read-only. Returns the title of the NotesProperty.

Defined in
NotesProperty

Data type
String

Syntax
String getTitle()
    throws NotesException

Language cross-reference
Title property in LotusScript NotesProperty class

Troubleshooting DAVs - Data Exception error

If you insert the value -2.225E-308 in a Notes number field that is mapped to a double in a DAV, and you are using AIX, you will see the following DB2 Data Exception error on the Domino console:

    SQL0302N The value of a host variable in the EXECUTE or OPEN statement is too large for its corresponding use. SQLSTATE=22003

Inserting the same value to the same field from a DB2 CLP will not cause an error. This is a limitation of the double-precision floating-point number representation. To resolve this error, ensure that negative numbers fall into the range -1.79769E+308 to -2.225E-307, and positive numbers fall into the range 2.225E-308 to 1.79769E+308.
Troubleshooting DAVs - Inserting multiple value dates
Inserting multivalue date or date ranges in a DAV
When inserting or updating multivalue date or date range fields using a DAV, you must use the full DB2
timestamp, such as yyyy-mm-dd-hh.mm.ss.subsec or 2005-12-24-08.06.30.123456. Failure to do so will
result in the last valid timestamp being repeated in the place of the invalid timestamp. No error is
generated.

Troubleshooting DAVs - unknown form : Message
The Mail8 template renamed the Memo form, which is now the Message form. If a DAV is created based
on the Notes 8 mail template, using the Message form, and notes exist that have no forms associated with
them, an "Access View Definition references an unknown form : Message" error will result.

Note: This error will not occur if the DAV uses All Forms, or if all notes have a form associated with them.

To resolve the error, copy and save the DAV. Rerun Create/Update in DB2.

TypeName property
TypeName property
Read-only. Returns the type name of the NotesProperty.

Defined in
NotesProperty

Data type
String

Syntax
String getTypeName()
    throws NotesException

Usage
This property together with the Namespace property, gives the unique identifier of the NotesProperty type.
The typename alone is not necessarily unique.

Language cross-reference
Typename property in LotusScript NotesProperty class
Updates to Web services Java and LotusScript classes doc

The Domino and Domino Designer release of Web services includes an inventory of pre-defined LotusScript and Java classes used for mapping to WSDL XML Schema types.

The following are classes/properties/methods either added or updated that may not have been covered in the Domino Designer 8.0 documentation:

LotusScript Web services public classes

Note: WS_FAULT is the owning class for the first six "Fault"-related properties

SUB setFaultCode (value As STRING)

Sets the code value for the SOAP 1.1 <faultcode> subelement on the returned SOAP fault (the full SOAP 1.1 faultcode is always a qualified name, namespace "http://schemas.xmlsoap.org/soap/envelope"). The default faultcode value is "Server".

FUNCTION getFaultCode () As STRING

Gets the code value for the SOAP 1.1 <faultcode> subelement on the returned SOAP fault (local part, only, of the qualified name)

SUB setFaultActor (value As String)

Sets the value for the SOAP 1.1 <faultactor> subelement on the returned SOAP fault.

FUNCTION getFaultActor () As STRING

Gets the value for the SOAP 1.1 <faultactor> subelement on the returned SOAP fault.

SUB setFaultDetails (value() as NOTESDOMELEMENTNODE)

Adds the content of the NOTESDOMELEMENTNODE array argument to become the subelement(s) and value(s) for the SOAP 1.1 <detail> subelement on the returned SOAP fault. Clears any current details content for the Fault.

FUNCTION getFaultDetails () As NOTESDOMELEMENTNODEARRAY_HOLDER

Gets the subelement(s) and value(s) for the SOAP 1.1 <detail> subelement on the returned SOAP fault, as the NOTESDOMELEMENTNODE array value for the returned NOTESDOMELEMENTNODEARRAYHOLDER object.

SUB SetValueWithZoneFromNotesDateTime (value As NotesDateTime) -- new for Domino & Domino Designer 8.0

Note: XSD_DATETIME, XSD_DATE, and XSD_TIME are the owning classes for these methods

Sets the XML representation of the object from the NotesDateTime object, including any time zone information.
LotusScript Web services Helper classes
These are used internally by other LSXSD.LSS classes.

XSD_DATATYPE_CONVERTER

Methods:

Function notesStreamToBase64 (ns As NotesStream) As String
Returns the contents of the NotesStream as a string of base64-encoded characters.
Function notesStreamToBase64Ext (ns As NotesStream) As String -- new for Domino & Domino Designer 8.0
Same as notesStreamToBase64, but with Domino 8 performance enhancements.
Function base64ToNotesStream (b64String As String) As NotesStream
Decodes the string of base64-encoded characters into a byte array, and returns the byte array as a NotesStream
Function base64ToNotesStreamExt (b64String As String) As NotesStream -- new for Domino/Domino Designer 8.0
Same as base64ToNotesStream, but with Domino 8 performance enhancements.
Function notesStreamToHexBinary (ns As NotesStream) As String
Returns the contents of the NotesStream as a string of hexBinary-encoded characters.
Function hexBinaryToNotesStream (hexString As String) As NotesStream
Decodes the string of hexBinary-encoded characters into a byte array, and returns the byte array as a NotesStream
Sub setXSDDate (ndt As NotesDateTime, xsddate As String)
Sets the date part of a NotesDateTime From "CCYY-MM-DD ..."
Function getXSDDate (ndt As NotesDateTime) As String
Returns the date part of a NotesDateTime as "CCYY-MM-DD"
Function getXSDZoneDate (ndt As NotesDateTime) As String -- new for Domino & Domino Designer 8.0
Returns the date part of a NotesDateTime as "CCYY-MM-DD" + time zone part
Sub setXSDTime (ndt As NotesDateTime, xsdtime As String)
Sets the time part of a NotesDateTime From "HH:MM:SS ..."
Function getXSDTime (ndt As NotesDateTime) As String
Returns the time part of a NotesDateTime as "HH:MM:SS". Does not compute fractional seconds or time zone information.
Function getXSDZoneTime (ndt As NotesDateTime) As String -- new for Domino & Domino Designer 8.0
Returns the time part of a NotesDateTime as "HH:MM:SS", adjusted for time zone. Does not compute fractional seconds.
Function getXSDZone (ndt As NotesDateTime) As String -- new for Domino & Domino Designer 8.0
Returns the XSD zone part of a NotesDateTime as "Z" or "+HH:00" or "-HH:00"
Sub setXSDDateTime (ndt As NotesDateTime, source As String) -- new for Domino & Domino Designer 8.0
Sets the date, time & zone parts of a NotesDateTime from "CCYY-MM-DDT...Z..." If the zone offset is not supported by the NotesDateTime class, the NotesDateTime zone properties are converted to GMT.

Support routines for setXSDDateTime (new for Domino & Domino Designer 8.0):

Function isDigit(inp as String) As Boolean
Function getZone(zoneoffset As Long, zonemins As Long) As String
Function getMilliseconds(millisecondspart As String) As Long
Java Web Services classes
In particular for Java, the Java "UnsignedLong" class had the following recent additions:

New constructor:

```java
public UnsignedLong(BigInteger llValue) throws NumberFormatException
Validates the BigInteger argument as within the acceptable range defined by XML Schema, and if such,
stores it as the object value
```

New qualifications to "implemented methods:"

from java.lang.Number:

```java
public byte byteValue()
Returns the object value as a byte (returns 0, if object value is a BigInteger)
public short shortValue()
Returns the object value as a short  (returns 0, if object value is a BigInteger)
```

lotus.domino.types.URI and related classes

URI

Implementation of XML Schema type anyURI

constructors:

```java
public URI()
No-argument (default) constructor
```

```java
public URI(URI other)
All fields in the new URI are set to those of the URI argument.  A null URI argument will cause an exception.
```

```java
public URI(String uriSpec) throws MalformedURIException
Constructs a new URI from a URI specification string. If the specification argument follows the RFC 2396 "generic URI" syntax, (two slashes following the first colon), the specification will be parsed accordingly - setting the scheme, userinfo, host, port, path, query string and fragment fields as necessary. If the specification argument does not follow the "generic URI" syntax, the specification is parsed into a scheme and scheme-specific part (stored as the path) only.
A null uriSpec argument will cause an exception.
```

```java
public URI(URI base, String uriSpec) throws MalformedURIException
Constructs a new URI from a base URI and a URI specification string. The URI specification string may be a relative URI.
A null base argument will cause an exception if uriSpec is also null or empty.
```
public URI(String scheme, String schemeSpecificPart) throws
MalformedURLException

Constructs a new URI that does not follow the generic URI syntax. Only the scheme and
scheme-specific part (stored as the path) are initialized.

A null or empty argument(s) will cause an exception.

public URI(String scheme, String host, String path, String queryString,
String fragment) throws MalformedURLException

A new URI that follows the generic URI syntax is constructed from its component parts. Each
component is validated for syntax, including basic semantic checks (see setter methods for
details).

scheme -- the URI scheme (a null or empty scheme argument will cause an exception).
host -- the hostname or IPv4 address for the URI
path -- the URI path. If the argument contains '?' or '#', then the query string and/or fragment
will be set from the path; if the query and fragment are specified both in the path and as
separate parameters, an exception is thrown
queryString -- the URI query string (cannot be specified if path is null)
fragment -- the URI fragment (cannot be specified if path is null)

public URI(String scheme, String userinfo, String host, int port, String
path, String queryString, String fragment) throws MalformedURLException

A new URI that follows the generic URI syntax is constructed from its component parts. Each
component is validated for syntax, including basic semantic checks (see setter methods for
details).

scheme -- the URI scheme (a null or empty scheme argument will cause an exception).
userinfo -- the URI userinfo (cannot be specified if p_host is null)
host -- the hostname or IPv4 address for the URI
port -- the URI port (may be -1 for "unspecified"; cannot be specified if host is null)
path -- the URI path. If the argument contains '?' or '#', then the query string and/or fragment
will be set from the path; if the query and fragment are specified both in the path and as
separate parameters, an exception is thrown
queryString -- the URI query string (cannot be specified if path is null)
fragment -- the URI fragment (cannot be specified if path is null)

methods:

public String getFragment()

The returned value is null if no '#' is present in the URI value, or empty if a '#' is present but
there is no following fragment.

public String getHost()

public String getPath(boolean includeQueryString, boolean
includeFragment)

includeQueryString -- if true (and query string is not null), then a '?' followed by the query string
will be appended
includeFragment -- if true (and fragment is not null), then a '#' followed by the fragment will
be appended
public String getPath()

The returned value is the path only, and does not include the query string or fragment.

public String getPort()

public String getQueryString()

The returned value is null if no '?' is present in the URI value, or empty if a '?' is present but there is no following query string.

public String getScheme()

public String getSchemeSpecificPart()

Returns the current URI value following the scheme and first colon character.

public String getUserinfo()

public void setFragment(String fragment) throws MalformedURIException

An exception is thrown if the fragment argument is non-null and the URI object does not conform to the "generic URI" syntax or the URI path field is null, or if the fragment argument contains invalid characters.

public void setHost(String host) throws MalformedURIException

A null host argument also sets the userinfo field to null and the port field to -1; If host is an invalid IP address or DNS hostname, an exception is thrown.

public void setPath(String path) throws MalformedURIException

If the supplied path is null, then the query string and fragment are set to null as well. If the supplied path includes a query string and/or fragment, these fields will be parsed and set as well. Note that, for URIs following the "generic URI" syntax, the path specified should start with a slash. For URIs that do not follow the generic URI syntax, this method sets the scheme-specific part.

A null path argument is handled, but an invalid character(s) causes an exception.

public void setPort(int port) throws MalformedURIException

A -1 port argument indicates "not specified". For a valid port argument value (0 to 65535), an exception is thrown if the URI port field is null. If the port argument is not in the range of -1 to 65535, an exception is thrown.

public void setQueryString(String queryString) throws MalformedURIException

An exception is thrown if the queryString argument is non-null and the URI object does not conform to the "generic URI" syntax or the URI path field is null, or if the queryString argument contains invalid characters.

public void setScheme(String scheme) throws MalformedURIException

A null scheme argument causes an exception. The URI scheme field value is converted to lower case. A non-conformant scheme name causes an exception.
public void setUserinfo(String userinfo) throws MalformedURISyntaxException

A non-null userinfo argument causes an exception if the host value is null. A userinfo argument with invalid characters causes an exception.

public void appendPath(String addToPath) throws MalformedURISyntaxException

Appends to the end of the URI path. If the current path does not end in a slash character and the addToPath argument does not begin with a slash character, then a slash character will be appended first. Alternatively, if the current path ends in a slash character and the addToPath argument begins with a slash character, the extra slash character will be dropped.

Syntax errors in the addToPath argument causes an exception.

public boolean equals(Object obj)

Overridden java.lang.Object method, performs a comparison of the objects' states and values.

public int hashCode()

Overridden java.lang.Object method

public static boolean isConformantSchemeName(String scheme)

Returns true if the scheme argument is non-null, not empty, starts with an alphanumeric character, and contains only alphanumerics, '+', '-', and/or '.'.

public boolean isGenericURI()

Returns true if the URI host field value is not null.

public static boolean isWellFormedAddress(String address)

Returns true if the address argument is a syntactically valid IPv4 address or hostname.

public String toString()

Returns the object value in String representation.

from java.lang.Object:

class
notify
notifyAll
wait (3)
MalformedURIException

    nested URI class:

    public static class MalformedURIException extends IOException

    constructors:

    public MalformedURIException()

    public MalformedURIException(String msg)

URIHolder member of type lotus.domino.types.URI

For additional information, refer to the Domino Designer "Web services Java and LotusScript classes" topic.

Domino Designer

Using the Message programming model with a web service

The "Advanced" tab of the Web service design element properties dialog includes a "Programming model" option with two choices, "RPC" and "Message".

The default for a new or newly-imported Web service is always "RPC", which refers to the commonly-used service interface wherein one or more PortType class operations are defined with unique signatures of data input arguments and return type. The data type definitions are typically drawn either from a set of implementation language types mapped to the built-in WSDL XML Schema types, and/or from user-defined classes mapped to <types> constructs defined in the associated WSDL document.

However, the Web service designer may choose the alternative, "Message" programming model, instead, which affords greater flexibility in what data passes in and out of any service method, in exchange for potentially greater implementation effort to understand the incoming message and construct a response. This is because the message programming model requires fixed service method signatures comprised of a single DOM-tree input argument representing the incoming request message, and a returned response of like type. The DOM-tree data type can handily represent the XML content of any SOAP message body, in exchange for the program labor of working with the DOM-tree data type.

In order to enable a message-model LotusScript Web service, then, each public PortType method signature must conform to this prototype:

    Function myMethodName (doc As NotesDOMDocumentNode ) As NotesDOMDocumentNode

and for Java, to this prototype:

    public org.w3c.dom.Document myMethodName (org.w3c.dom.Document doc)

In addition, the "Message" choice for the Advanced properties "Programming model" option must be selected.
If more than one method is defined for the PortType class, then any Web service request will be routed to
the correct method provided that the incoming SOAP message supplies the method name as the element
name of the child element of the SOAP envelope "Body", e.g:

```xml
<SOAP-ENV:Body>
  <ns:myMethodName xmlns:ns="urn:myMethodNamespace">
    <![message payload here]>...
  </ns:myMethodName>
</SOAP-ENV:Body>
```

With this approach, LotusScript Web service methods can receive and send NotesDOMDocumentNode
backend class objects, and Java Web service methods can receive and send org.w3c.dom.Document
objects. Each class or interface has its defined set of methods for manipulating the DOM-tree content.

Note, too, that the WSDL document generated by Domino Designer for this type of service is valid WSDL,
although consumers of message-model Web services are not necessarily WSDL-driven.

---

**Domino Designer**

**Values property**

Values property

Read-write. Returns vector of NotesProperty values.

**Defined in**

NotesProperty

**Data type**

Vector

**Syntax**

```java
java.util.Vector getValues()
  throws NotesException

setValues(java.util.Vector v)
  throws NotesException
```

**Parameters**

`v`

Vector. The values of the property which will be set.

**Usage**

The vector must be homogenous. Input properties cannot be set. After setting this property, you must
call publish for the changes to take effect. If you do not call publish, your changes are lost.

**Language cross-reference**

Values property in LotusScript NotesProperty class
Domino Designer

**ViewHorizScrollBar @Command - not supported**

The `ViewHorizScrollBar @Command` toggles the display of the horizontal scroll bar in a view or folder.

*Note* ViewHorizScrollBar is not supported since Release 6. Since Release 6, the view automatically supplies a scrollbar when necessary. In pre-release 6 versions, ViewHorizScrollBar is not supported under OS/2 and on the Macintosh.

---

Domino Designer

**Web Service Consumer PortType class**

In the Web Service Provider feature, first available in Release 7.0, the PortType class is where the application developer enters their code that executes to process a web service request. In the Web Service Consumer feature, first available in Release 8.0, the PortType class is completely generated, based on the WSDL document. It contains methods for all the operations described in the imported WSDL document. The WSDL generated PortType class derives from this PortTypeBase class. The PortTypeBase class provides a set of common operations that are useful in writing client-side applications for web services. The PortTypeBase class in LotusScript provides the following functions:

```lotus
Public Class PortTypeBase
    Public Sub SetEndpoint(url as String)
    Public Sub SetTimeout(ms as Long)
    Public Sub SetCredentials(username As String, password As String)
    Public Function GetLastFault() As WS_FAULT
    Public Sub New()
    Private Service as NotesWebServiceEngine
End Class
```

Java provides the following functions through the `lotus.domino.types.PortTypeBase` interface:

```java
public interface PortTypeBase
{
    public void setTimeout(int ms);
    public int getTimeout();

    public final static int NOTES_SSL_LOCATION = 0;

    // SSL Options - To combine options add values
    public final static int NOTES_SSL_ACCEPT_SITE_CERTS = 1;
    public final static int NOTES_SSL_ACCEPT_EXPIRED_CERTS = 2;
    public final static int NOTES_SSL_SEND_CLIENT_CERT = 4;

    // SSL Version - Select one
    public final static int NOTES_SSL_V20_ONLY = 1 + 65536;
    public final static int NOTES_SSL_V30_HELLO = 2 + 65536;
    public final static int NOTES_SSL_V30_ONLY = 3 + 65536;
    public final static int NOTES_SSL_V30_WITH_V20_HELLO = 4 + 65536;
    public final static int NOTES_SSL_NEGOTIATED = 5 + 65536;
}
```
public void setSSLOptions(int opt);
public int getSSLOptions();

public void setEndpoint(String url) throws MalformedURLException;
public String getEndpoint();

public void setCredentials(String username, String password);

Example
Following is a WSDL document, and the sample code it generated using the PortTypeClass in LotusScript.

WSDL Document
<?xml version="1.0" encoding="UTF-8"?
<wsdl:definitions targetNamespace="urn:proto" xmlns="http://schemas.xmlsoap.org/wsdl/
xmlns:apachesoap="http://xml.apache.org/xml-soap" xmlns:impl="urn:proto" xmlns:intf="urn:proto"
xmlns:wsdlsoap="http://schemas.xmlsoap.org/wsdl/soap/"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">
<wsdl:types>
  <schema targetNamespace="urn:proto" xmlns="http://www.w3.org/2001/XMLSchema">
    <element name="ADDPERSON">
      <complexType>
        <sequence>
          <element name="P" type="impl:PERSON"/>
        </sequence>
      </complexType>
    </element>
    <element name="UPDATEPERSON">
      <complexType>
        <sequence>
          <element name="P" type="impl:PERSON"/>
        </sequence>
      </complexType>
    </element>
    <complexType name="PERSON">
      <sequence>
        <element name="NAME" type="xsd:string"/>
        <element name="ADDRESS" type="xsd:string"/>
        <element name="TELEPHONE" type="xsd:string"/>
      </sequence>
    </complexType>
    <element name="ADDPERSONResponse">
      <complexType>
        <sequence>
          <element name="ADDPERSONReturn" type="impl:RESPONSE"/>
        </sequence>
      </complexType>
    </element>
  </schema>
</wsdl:types>
<complexType name="RESPONSE">
  <sequence>
    <element name="CODE" type="xsd:short"/>
  </sequence>
</complexType>

<element name="ADDPART">
  <complexType>
    <sequence>
      <element name="P" type="impl:PART"/>
    </sequence>
  </complexType>
</element>

<element name="UPDATEPART">
  <complexType>
    <sequence>
      <element name="P" type="impl:PART"/>
    </sequence>
  </complexType>
</element>

<complexType name="PART">
  <sequence>
    <element name="IDENTIFIER" type="xsd:string"/>
    <element name="COUNT" type="xsd:short"/>
  </sequence>
</complexType>

<element name="ADDPARTResponse">
  <complexType>
    <sequence>
      <element name="ADDPARTReturn" type="impl:RESPONSE"/>
    </sequence>
  </complexType>
</element>

<element name="UPDATEPARTResponse">
  <complexType>
    <sequence>
      <element name="UPDATEPARTReturn" type="impl:PART"/>
    </sequence>
  </complexType>
</element>
<wsdl:message name="ADDPARTRequest">
  <wsdl:part element="impl:ADDPART" name="parameters"/>
</wsdl:message>
<wsdl:message name="ADDPERSONResponse">
  <wsdl:part element="impl:ADDPERSONResponse" name="parameters"/>
</wsdl:message>
<wsdl:message name="ADDPERSONRequest">
  <wsdl:part element="impl:ADDPERSON" name="parameters"/>
</wsdl:message>
<wsdl:message name="ADDPARTResponse">
  <wsdl:part element="impl:ADDPARTResponse" name="parameters"/>
</wsdl:message>
<wsdl:message name="UPDATEPERSONRequest">
  <wsdl:part element="impl:UPDATEPERSON" name="parameters"/>
</wsdl:message>
<wsdl:message name="UPDATEPERSONResponse">
  <wsdl:part element="impl:UPDATEPERSONResponse" name="parameters"/>
</wsdl:message>
<wsdl:message name="UPDATEPARTRequest">
  <wsdl:part element="impl:UPDATEPART" name="parameters"/>
</wsdl:message>
<wsdl:message name="UPDATEPERSONResponse">
  <wsdl:part element="impl:UPDATEPERSONResponse" name="parameters"/>
</wsdl:message>
<wsdl:message name="UPDATEPERSONRequest">
  <wsdl:part element="impl:UPDATEPERSON" name="parameters"/>
</wsdl:message>
<wsdl:message name="UPDATEPARTResponse">
  <wsdl:part element="impl:UPDATEPARTResponse" name="parameters"/>
</wsdl:message>
<wsdl:portType name="AddOperations">
  <wsdl:operation name="ADDPERSON">
    <wsdl:input message="impl:ADDPERSONRequest" name="ADDPERSONRequest"/>
    <wsdl:output message="impl:ADDPERSONResponse" name="ADDPERSONResponse"/>
  </wsdl:operation>
  <wsdl:operation name="ADDPART">
    <wsdl:input message="impl:ADDPARTRequest" name="ADDPARTRequest"/>
    <wsdl:output message="impl:ADDPARTResponse" name="ADDPARTResponse"/>
  </wsdl:operation>
</wsdl:portType>
<wsdl:portType name="UpdateOperations">
  <wsdl:operation name="UPDATEPERSON">
    <wsdl:input message="impl:UPDATEPERSONRequest" name="UPDATEPERSONRequest"/>
    <wsdl:output message="impl:UPDATEPERSONResponse" name="UPDATEPERSONResponse"/>
  </wsdl:operation>
  <wsdl:operation name="UPDATEPART">
    <wsdl:input message="impl:UPDATEPARTRequest" name="UPDATEPARTRequest"/>
    <wsdl:output message="impl:UPDATEPARTResponse" name="UPDATEPARTResponse"/>
  </wsdl:operation>
</wsdl:portType>
<wsdl:binding name="AddBinding" type="impl:AddOperations">
  <wsdl:operation name="ADDPERSON">
    <wsdlsoap:operation soapAction=""/>
    <wsdl:input name="ADDPERSONRequest">
      <wsdlsoap:body namespace="urn:proto" use="literal"/>
    </wsdl:input>
    <wsdl:output name="ADDPERSONResponse">
      <wsdlsoap:body namespace="urn:proto" use="literal"/>
    </wsdl:output>
  </wsdl:operation>
  <wsdl:operation name="ADDPART">
    <wsdlsoap:operation soapAction=""/>
    <wsdl:input name="ADDPARTRequest">
      <wsdlsoap:body namespace="urn:proto" use="literal"/>
    </wsdl:input>
    <wsdl:output name="ADDPARTResponse">
      <wsdlsoap:body namespace="urn:proto" use="literal"/>
    </wsdl:output>
  </wsdl:operation>
</wsdl:binding>

<wsdl:binding name="UpdateBinding" type="impl:UpdateOperations">
  <wsdl:operation name="UPDATEPERSON">
    <wsdlsoap:operation soapAction=""/>
    <wsdl:input name="UPDATEPERSONRequest">
      <wsdlsoap:body namespace="urn:proto" use="literal"/>
    </wsdl:input>
    <wsdl:output name="UPDATEPERSONResponse">
      <wsdlsoap:body namespace="urn:proto" use="literal"/>
    </wsdl:output>
  </wsdl:operation>
  <wsdl:operation name="UPDATEPART">
    <wsdlsoap:operation soapAction=""/>
    <wsdl:input name="UPDATEPARTRequest">
      <wsdlsoap:body namespace="urn:proto" use="literal"/>
    </wsdl:input>
    <wsdl:output name="UPDATEPARTResponse">
      <wsdlsoap:body namespace="urn:proto" use="literal"/>
    </wsdl:output>
  </wsdl:operation>
</wsdl:binding>

<wsdl:service name="Service1">
  <wsdl:port binding="impl:AddBinding" name="AddBindingService">
    <wsdlsoap:address location="http://localhost"/>
  </wsdl:port>
  <wsdl:port binding="impl:UpdateBinding" name="UpdateBindingService">
    <wsdlsoap:address location="http://localhost"/>
  </wsdl:port>
</wsdl:service>
Sample code generated by above WSDL document

Const n0 = "urn:proto"
Class AddOperations_n0 As PortTypeBase
    Sub NEW
            "AddOperations_n0")
    End Sub

    Function ADDPERSON(P As PERSON_n0) As RESPONSE_n0
        Set ADDPERSON = Service.Invoke("ADDPERSON", P)
    End Function

    Function ADDPART(P As PART_n0) As RESPONSE_n0
        Set ADDPART = Service.Invoke("ADDPART", P)
    End Function
End Class

This class can be used in an agent or wherever LotusScript code can execute in Notes and in Domino and it provides the mechanism for calling the web service that was defined by the WSDL document. It is not advisable to modify the generated code in the PortType class. Changing the generated code can cause failures.

For example, to make a call to the web service as shown above, you'd use the following LotusScript code:

    Dim port as new AddOperations_n0
    Dim p as new Person_n0
    Dim result as RESPONSE_n0
    ' update data in 'p'
    set result = call port.AddPerson(p)
    ' result is the response from the AddPerson web service request.

The same WSDL document generates the following interface that uses the PortTypeBase interface:

    package proto;
    public interface UpdateOperations extends lotus.domino.types.PortTypeBase,
        java.rmi.Remote {
        public proto.PERSON UPDATEPERSON(proto.PERSON p) throws
            java.rmi.RemoteException;
        public proto.PART UPDATEPART(proto.PART p) throws
            java.rmi.RemoteException;
    }

To use this generated code in a Java agent, you'd write this Java code:

    Service1Locator locator = new Service1Locator();
    AddOperations port = locator.getAddBindingService();

    PERSON p = new PERSON(); // and populate object
    RESPONSE result = port.ADDPERSON(p);
PortType class functions
This is a description of the methods provided by the PortTypeBase class. If there are any differences between the LotusScript and Java implementations they are noted.

Initialize
LotusScript only.
For stub use only.

GetLastFault
LotusScript only.
For stub use only.

Note: The GetLastFault Function can't be used in the dynamic programming model because it implies that the web services engine will need to handle some of the soap:body responses and not handle others.

SetEndpoint
Sets the remote web service's endpoint information. In this release, the HTTP: and HTTPS: protocols are supported.
Syntax:

```
Sub SetEndpoint(url as String)
public void setEndpoint(String url)
```

GetEndpoint
Provides the current endpoint value.
Syntax:

```
Function GetEndpoint() as String
public String getEndpoint();
```

SetCredentials
Sets the basic authentication credentials that will be sent with the web service request.
Syntax:

```
Sub SetCredentials(username As String, password as String)
public void setCredentials(String username, String password)
```

SetTimeout
Sets the maximum amount of time that the code will wait for each network operation to complete.
Syntax:

```
Sub SetTimeout(milliseconds as Long)
public void setTimeout(long milliseconds)
```

GetTimeout
Returns the current timeout value.
Syntax:

```
Function GetTimeout() as Long
public long getTimeout()
```
SetSSLOptions
Sets the outgoing SSL connection options. If the protocol specified for the endpoint is not HTTPS these options are ignored.

Syntax:

Sub SetSSLOptions(Options as Long)  
public void setSSLOptions(int Options)

Parameter Options uses the following values:

- NOTES_SSL_LOCATION (0) -- Indicates that SSL Options will be used as defined in the current location document. If this value is used, SSL version options cannot also be used. This is the default.
- Options for handling special cases -- Multiple values can be specified by adding their values, in which case they are treated as being combined using "OR". If the NOTES_SSL_LOCATION value is not used, these flag values can also be combined with an ssl version value.
  - NOTES_SSL_ACCEPT_SITE_CERTS (1)
  - NOTES_SSL_ACCEPT_EXPIRED_CERTS (2)
  - NOTES_SSL_SEND_CLIENT_CERT (4) -- Enables certificate authentication when the server requires client authentication.
- Version of SSL to negotiate with server -- Only one value can be specified. Cannot be used if NOTES_SSL_LOCATION is used. Can be combined with one or more special case flags by adding their values, in which case they are treated as being combined using "OR".
  - NOTES_SSL_V20_ONLY (65537)
  - NOTES_SSL_V30_HELLO (65538)
  - NOTES_SSL_V30_ONLY (65539)
  - NOTES_SSL_V30_WITH_V20_HELLO (65540)
  - NOTES_SSL_NEGOTIATED (65541)

GetSSLOptions
Gets the current value for the SSL Options.

Syntax:

Function GetSSLOptions() as Long  
public int getSSLOptions()

Domino Designer

@AbstractSimple - revised syntax and return value
@AbstractSimple

Creates a short abstract of a text or rich text field. Simpler and more efficient than using @Abstract.

Syntax

@AbstractSimple( bodyFields )

Parameters

bodyFields

Text or text list. Any number of fields containing the text to abstract. May be text or rich text fields. If Notes/Domino cannot locate a field by name, it uses the string literal instead. Enclose each field name in quotes and separate multiple names with colons: "Sales":"Figures".

Caution Rich text fields are not part of a document until saved. If you want @AbstractSimple to work on additions and changes to the current document, you must first save and then recalculate the document.

255
Return value

abstractedText

Text or text list. In the case of a single field being specified, a text value is returned. If the field has
less than 100 bytes, the entire field is returned. If the first two paragraphs in the field contain no
more than 100 bytes, the text value contains the first two paragraphs with newlines and tabs
converted to spaces. Otherwise, the text value contains no more than 124 bytes up to the first
completed word after the 99th byte with newlines and tabs converted to spaces. If no word is
completed between the 100th and 124th bytes, the first 100 bytes are returned. A paragraph is
defined by a terminating newline character. For rich text fields all formatting is removed. If a list of
field names is supplied, then a text list is returned, with each list element containing the abstracted
version of the corresponding field in the field list.

If a field is of an invalid type, or can't be found, the string returned is the name of the field that was
passed into @AbstractSimple.

Note If the behavior of @Abstract is desired, where the result is a single, space-separated, string of
abstracted results, apply @Implode to the result of @AbstractSimple

Language cross-reference

Abstract method in LotusScript NotesItem class

See also:

@Abstract

Examples: @AbstractSimple

1. If the field "Verse" contains the rich text:

   "One bright day

   in the middle of

   the night"

   Then @AbstractSimple("Verse") would return:

   "One bright day in the middle of"

2. If the field "Verse" contains the rich text:

   "One bright day

   in the middle of the night"

   Then @AbstractSimple("Verse") would return:

   "One bright day in the middle of the night"
3. If the following fields are on a document:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PersonName</td>
<td>Text</td>
<td>&quot;Sam Smith&quot;</td>
</tr>
<tr>
<td>Address</td>
<td>Text</td>
<td>&quot;123 Shady Lane&quot;</td>
</tr>
<tr>
<td>CityState</td>
<td>Text</td>
<td>&quot;Anytown, USA&quot;</td>
</tr>
<tr>
<td>ZIP</td>
<td>Numeric</td>
<td>&quot;12345&quot;</td>
</tr>
</tbody>
</table>

Then @AbstractSimple("PersonName" : "Address" : "CityState" : "ZIP") would return:
"Sam Smith" : "123 Shady Lane" : "Anytown, USA" : "ZIP"

Note: The last element is "ZIP" because the field is numeric which is invalid for @AbstractSimple.

4. If the field "Critics" contains the text:

"When asked to comment on the movie, the reviewer stated that it was one of the year's best, and certainly would find a place on many award lists."

Then @AbstractSimple("Critics") would return:
"When asked to comment on the movie, the reviewer stated that it was one of the year's best, and certainly"

5. If the field "Critics" contains the text:

"When asked to comment on the movie, the reviewer stated that it was one of the year's best, pure supercalifragilisticexpialidocious."

Then @AbstractSimple("Critics") would return:
"When asked to comment on the movie, the reviewer stated that it was one of the year's best, pure sup"

 Domino Designer

@Adjust usage note

@Adjust

Usage
The arguments are applied from right to left. For instance, @Adjust([2/2/2006]; 0; 2; 28; 0; 0; 0) returns [5/2/2006], not [4/30/2006] as you might expect. This is because @Adjust first adds 28 days, making [3/2/2006], then adds two months, making [5/2/2006]. To first add two months, then add 28 days, use @Adjust twice, for instance: @Adjust(@Adjust([02/02/2006]; 0; 2; 0; 0; 0); 0; 0; 28; 0; 0; 0)
@GetComponentViewPreference
@GetComponentViewPreference
Returns the value of the specified component view preference.

Note This @function is new with Release 8.0.1.

Syntax
@GetComponentViewPreference( PreferenceID )

Parameters
PreferenceID
Text. The name of the preference, set in the CAE Notes component Advanced properties tab, whose value you would like to read.

Return value
preferenceValue
Text list. Value(s) of the specified preference.

Usage
This @function is only valid in the Notes client.
If the PreferenceID cannot be found, @ERROR is returned. The Error string is "Specified view preference is unavailable".
The following are some common component view preference IDs.

com.ibm.portal.app.input.file
com.ibm.portal.app.input.name
com.ibm.rcp.extensionType
com.ibm.rcp.id
com.ibm.rcp.moveable
com.ibm.rcp.objectId
com.ibm.rcp.ratio
com.ibm.rcp.showTitle
com.ibm.rcp.standalone
com.ibm.rcp.title
com.ibm.rcp.viewId
com.ibm.rcp.visible
notesurl
portletname
portletwindowid

Language Cross-Reference
GetComponentViewPreference method of LotusScript NotesUIWorkspace class
Examples: @GetComponentViewPreference
The following examples reference a Notes Contacts View component, which is set to display contact information in a fixed location on half of the screen.

1. This code returns the value ALL_CONTACTS:
   @GetComponentViewPreference(com.ibm.rcp.csiviews.viewpart.folderalias)
2. This code returns the value false:
   @GetComponentViewPreference(com.ibm.rcp.closeable)
3. This code returns the value true:
   @GetComponentViewPreference(com.ibm.rcp.visible)
4. This code returns the value 0.5:
   @GetComponentViewPreference(com.ibm.rcp.ratio)

Domino Designer

@InheritedDocumentUniqueID usage - only works in Notes client
The @InheritedDocumentUniqueID @function only works in the Notes client.

Domino Designer

@IsEmbeddedInsideWCT and IsEmbeddedInsideWCT method - usage note
@IsEmbeddedInsideWCT and the IsEmbeddedInsideWCT method have the following new usage note.

Usage
The IsInCompositeApp property (or @IsInCompositeApp function) indicates if the current element is a component in a composite application, while the IsEmbeddedInsideWCT property (or @IsEmbeddedInsideWCT function) indicates if composite applications are available, whether or not they are being used. If IsInCompositeApp is true, IsEmbeddedInsideWCT must be true. If IsEmbeddedInsideWCT is false, IsInCompositeApp must be false.

Domino Designer

@IsInCompositeApp
@IsInComposite App
Indicates whether the component is running within a composite application.

Note This @function is new in release 8.0.1

Syntax
@IsInCompositeApp

Return value
flag

Boolean

- Returns 1 (True) if the current component is running within a composite application.
- Returns 0 (False) if the current component is not running within a composite application.
**Usage**
This function is only valid in the Notes client.

**Language Cross-Reference**
IsInCompositeApp property of the LotusScript NotesUIWorkspace class

**Examples: @IsInCompositeApp**
1. This example returns true if the current component is in a composite application.
   

```script
@IsInCompositeApp
```

---

**Domino Designer**

**@Version - Notes 8.0 is version 307, Notes 8.0.1 is version 322**

**@Version**

Returns the release number of the Notes/Domino software you're running.

**Syntax**

```
@Version
```

**Return value**

`versionNumber`

String. The release number.

**Usage**

In column, selection, mail agent, and scheduled agent formulas, @Version returns the release number of the Notes/Domino server or workstation containing the database. In all other formulas, @Version returns the release number of the Notes/Domino workstation running the formula.

The following table maps the numbers returned by @Version to each Notes/Domino version.

<table>
<thead>
<tr>
<th>Number Returned by @Version</th>
<th>Corresponding Lotus Notes/Domino version</th>
</tr>
</thead>
<tbody>
<tr>
<td>114</td>
<td>Notes 3.x</td>
</tr>
<tr>
<td>136</td>
<td>Notes 4.0, 4.0x</td>
</tr>
<tr>
<td>138</td>
<td>Notes 4.1, 4.1x</td>
</tr>
<tr>
<td>145</td>
<td>Notes 4.5, 4.5x</td>
</tr>
<tr>
<td>147</td>
<td>Notes 4.6</td>
</tr>
<tr>
<td>166</td>
<td>Notes 5.0, 5.0x</td>
</tr>
<tr>
<td>190</td>
<td>Notes 6.0, 6.0.1</td>
</tr>
<tr>
<td>Number Returned by @Version</td>
<td>Corresponding Lotus Notes/Domino version</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>191</td>
<td>Notes 6.0.2</td>
</tr>
<tr>
<td>194</td>
<td>Notes 6.0.3, 6.5</td>
</tr>
<tr>
<td>198</td>
<td>Notes 6.5.5</td>
</tr>
<tr>
<td>199</td>
<td>Notes 6.5.6</td>
</tr>
<tr>
<td>256</td>
<td>Notes 7.0</td>
</tr>
<tr>
<td>261</td>
<td>Notes 7.0.1</td>
</tr>
<tr>
<td>265</td>
<td>Notes 7.0.2</td>
</tr>
<tr>
<td>307</td>
<td>Notes 8.0</td>
</tr>
<tr>
<td>322</td>
<td>Notes 8.0.1</td>
</tr>
</tbody>
</table>

Note the following:
- @Version returns the same number for all releases of Notes 3.x.
- @Version does not distinguish between the maintenance releases of Notes 4.x.

**Language cross-reference**
- `NotesBuildVersion` property of LotusScript `NotesSession` class
- `NotesVersion` property of LotusScript `NotesSession` class
- `NotesVersion` property of Java `Session` class

**Additional information**
- "Accessing the user environment" topic in the Domino Designer 8 Help documentation
**Domino Web Access Help**

**Add a rich text signature to messages**
You can add a personal signature to the bottom of outgoing mail messages in rich text. This signature can include a name and other information, such as an address, phone number, web site. Note that this type of signature is different from a digital signature used for security.

1. Click **Preferences**.
2. Expand **Mail**, and then click **Signature**.
3. Under **Signature**, check **Automatically append a signature to the bottom of your outgoing mail messages** if you want this signature to be added to all messages. If you do not check this box, you can still add a signature manually when creating a message by clicking **More > Insert Signature**.
4. For type, click **Rich text**.
5. Enter the text for your signature in the text field, including any formatting such as bold or color.
6. Click **OK**.

**Configuration settings supported in Domino Web Access Lite mode**
Use the following list to determine which settings in the Configuration Settings document of the Domino application server are supported by the Lite mode of Domino Web Access. Settings listed as "not supported" are supported only in the Full mode of Domino Web Access.

**Welcome Page Setup**
Not supported

**Alarms**
Not supported

**Mail**
The following settings are supported:
- When sending mail set format to
- Maximum attachment size (kb)

**Mail Encryption**
All Mail Encryption settings are supported except "Allow untrusted Internet certificates to be used for S/MIME encryption."

**Instant Messaging**
Not supported

**Offline**
Not supported

**International**
All International settings are supported.

**Start Up View**
All Start Up View settings are supported,
Browser Cache Management  
Not supported

Other Settings  
The following settings are supported:
- Full-text indexing
- Modification of Internet password
- Compress HTTP response data

Disclaimer  
All Disclaimer settings are supported.

Domino Web Access

Create "confidential" contacts or mail groups  
When you create a new contact record or a new group entry in your Contacts, check Confidential to prevent the entry from being accessed by anyone to whom you delegate management of your Contacts.

Domino Web Access

Delegate access to Contacts  
You can delegate access to your contacts when you delegate access to your Mail, Calendar, To Do and Notebook. Use this topic to set delegation preferences instead of the one in the Domino Web Access Help.

Set Delegation Preferences  
Note  Delegation Preferences are not supported in the Lite mode of Domino Web Access.

You can let specified people open your mail file and read your messages, Calendar, Contacts and Notebook entries, and To Do items. You can also let them send, edit (including adding a follow-up flag) and delete messages, create and delete Calendar or Contacts entries, Notebook entries, and To Do items. If someone else manages your calendar, you can automatically forward your Calendar notices, whether or not that person or group has any access to your mail.

People who have access to your mail file cannot read encrypted mail that you receive, and cannot send signed or encrypted mail for you, even though the mail file contains your user ID. Additionally, you cannot read encrypted messages they create for you unless your user ID contains the encryption key used to encrypt the messages. By default, no one except the owner of the mail file has access.

Note  There may times when you cannot save your delegation preferences. This happens when an agent, scheduled to run every 60 minutes on the IBM Lotus Domino server, has not yet processed your request. After the process runs, the names to which you delegated access are saved in your Delegation Preferences.

To delegate access to your mail

1. Click Preferences.
2. Click Delegation, and then click Mail, Calendar.
3. Click Add Person or Group.
4. Select Access is for everyone or click the down arrow to choose a group or an individual from a list.
5. Choose how much of your mail file you want delegates to have access to:
   - All Mail, Calendar, To Do and Contacts
   - Calendar, To Do and Contacts
   - None (Use this option to prevent a specified person or group from having access to your mail file)
6. Choose the tasks you want the delegate to be able to do. For example, **Read, edit and create any
document, send mail on your behalf**. These options will change based on your selection in the
previous step.

7. Check one or more of the following forwarding options. When you forward a notice, the message
contains a document link to the original notice delivered to your mail file.
- **Forward notices where you are the invitee of the meeting** -- your delegate receives notification
each time you receive a meeting invitation or related notice.
- **Forward notices where you are the chair of the meeting** -- your delegate receives notification
each time you receive a response to a meeting invitation or related notice regarding a meeting
you chair.

8. Choose how to handle messages you receive that are marked private. For example, **Forward without
private details** lets your delegate see only the non-private details.

9. Click OK, and then OK again to close the preferences box.

---

**Domino Web Access**

**Displaying remote images in mail**
You can set a user preference so that remote images do not display automatically when reading mail. A
remote image is an image that is referenced, rather than embedded. Use the following steps to set the
Image Security preference:

1. Click Preferences
2. Click the plus sign next to Mail, and then click Display.
3. Under Image Security, select the option **Do not show remote images without permission**.

To view the image when reading a message that includes an embedded image, click **Show Images**.

---

**Domino Web Access**

**Domino Web Access Lite mode**
Domino Web Access 8.0.1 includes a lite mode that gives you access to your Mail and Contacts in a
streamlined user interface. The lite mode is ideal for reading and responding to mail quickly and
efficiently. It is optimized for performance in bandwidth-constrained environments.

Full Calendar features are not available in lite mode, but the Day-At-A-Glance calendar opens when you
click Sidebar. And if you need to complete tasks that are not supported in lite mode, you can easily switch
to the full mode by clicking Full. Tasks performed in either mode are reflected in both, so there is never a
time when the two modes are out of synch with one another. Although you cannot set preferences in lite
mode, many of the preferences you set in full mode are supported in the lite mode.

To view this window again in lite mode, click Help. For help with tasks, open the full mode and then click
Help > Help Topics.
Domino Web Access

**Errata: Using the To Do list**

The introduction and status icons in the topic "Using the To Do List" are incorrect. Use the information here instead.

The To Do List view shows all your current, completed, and overdue tasks by priority, date due, status, and category. Each personal To Do task shows the priority you assigned to it when you created it. Each instance of a repeating To Do task displays in the list. Group To Do assignments assigned to you display status using the icons shown in the following table.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>📌</td>
<td>Personal To Do - high priority</td>
</tr>
<tr>
<td>📌</td>
<td>Personal To Do - medium priority</td>
</tr>
<tr>
<td>📌</td>
<td>Personal To Do - low priority</td>
</tr>
<tr>
<td>✅</td>
<td>Group To Do assignment you accepted</td>
</tr>
<tr>
<td>🚫</td>
<td>Group To Do assignment you declined or delegated to someone else</td>
</tr>
<tr>
<td>🚫</td>
<td>Group To Do assignment you delegated was accepted by your delegate</td>
</tr>
<tr>
<td>✔</td>
<td>Completed To Do task</td>
</tr>
</tbody>
</table>

Domino Web Access

**iNotes_WA_EnableLiteMode**

New in release 8.0.1, Domino Web Access has two modes -- Full and Lite. The Lite mode offers only Mail and Contacts functionality, plus a Day-at-a-Glance calendar. Lite mode is also optimized for low-speed or bandwidth-constrained connections. You can use the `iNotes_WA_EnableLiteMode` setting to remove the Full and Lite buttons from the Full mode client as follows:

1 (or omitting this setting from the server's Notes.ini file; default) = **Full** and **Lite** buttons display in both the Full and Lite modes of Domino Web Access. Users can switch between the two modes.

0 = **Full** and **Lite** buttons do not display in the Full mode of Domino Web Access, but do display in the Lite mode. Users cannot switch from the Full mode to the Lite mode, however, users logged into Lite mode can switch to the Full mode regardless of this preference.

**Example:** `iNotes_WA_EnableLiteMode=value`

**UI Equivalent:** There is no UI equivalent.

For additional information about Lite mode, see the topic "Domino Web Access Lite mode" in these release notes.

Domino Web Access

**iNotes_WA_NoVertLineReplyForward**

Use the Notes.INI setting `iNotes_WA_NoVertLineReplyForward=1` to prevent a vertical line from being added to replies when history is included.
Domino Web Access

**iNotes_WA_PrintSSApplyTo**

**Syntax:** `iNotes_WA_PrintSSApplyTo=value`

**Description:** Use this setting in conjunction with the notes.ini setting `iNotes_WA_PrintUserStyleSheet`. The setting `iNotes_WA_PrintUserStyleSheet` is used to specify a special user-defined style sheet that controls font sizes when printing. However, in some cases you may want to restrict the application of a user style sheet to Mozilla Firefox only or to Internet Explorer only.

1 = User style sheet applied via `iNotes_WA_PrintUserStyleSheet` setting works on Mozilla Firefox only.
2 = User style sheet applied via `iNotes_WA_PrintUserStyleSheet` setting works on Internet Explorer only.

**Applies to:** Domino Web Access clients

**Default:** not set - `iNotes_WA_PrintUserStyleSheet` setting applies to all browsers

**UI equivalent:** none

---

Domino Web Access

**Logging in to Domino Web Access**

To log into Domino Web Access:

1. In your browser’s address box, type the URL for your Domino Web Access Mail.
2. Enter your user name and Internet password.
3. Depending on how the administrator sets up authentication, you may also have these options:
   - **Full mode** - Select to log in to the full set of features, including Mail, Contacts, Calendar, To Do, and Notebook.
   - **Lite mode** - Select to log in to a small set of features (Mail, Contacts, and a Day-at-a-Glance Calendar) optimized for faster performance.
   - **Shared or Public Computer** - Select this option if you are logging in on a public computer, such as a kiosk. Checking this box prevents viewing of attachments.
4. Click **Log In**.

**Note:** The options listed in step 3 are available only when session or multi-server authentication is in use.

---

Domino Web Access

**Notes.ini settings supported in Domino Web Access Lite mode**

Domino Web Access Lite mode supports the following Notes.ini settings:

- `iNotes_WA_Areas` (This setting is implemented differently in Lite mode than in Full mode. See the description at the end of this list for how to implement it in Lite mode.)
- `iNotes_WA_AutoUseWebmail`
- `iNotes_WA_DefaultDictionary`
- `iNotes_WA_DefaultFormatPlainText`
- `iNotes_WA_DisableActCntSecurity`
- `iNotes_WA_DisableRecodeMIMECharset`
- `iNotes_wa_GZIP_Content_Types_Excluded`
- `iNotes_wa_GZIP_Content_Types_Included`
- `iNotes_wa_GZIP_Disable`
- `iNotes_WA_LogoutRedirect`
Although this setting is supported, it is implemented differently than in the full mode of Domino Web Access. For the Lite mode, use this setting to disable any combination of the contacts or calendar area. **Mail is always on and cannot be turned off.**

The settings honored in Lite mode are:

- **C** = Calendar
- **E** = Contacts

The format is `iNotes_WA_Areas = 1111111`, where the order of the numbers corresponds to A,B,C,D,E,F.

---

**Domino Web Access**

**Preferences supported in Domino Web Access Lite mode**

The following user preferences are supported in the Lite mode of Domino Web Access. Any preference that is not listed here is supported in the Full mode of Domino Web Access only.

**Basic Preferences**

- Mail file ownership
- Display Options
  - Display this tab when starting
- Search
- Personal categories
- Spell check default dictionary
- Default mail client

**Mail Preferences**

**General**

- Sending
  - Save sent mail
  - Default editor
  - Send message in this format
- Composing Internet Style Replies
- View and Folder management
  - When I delete a calendar document from any view or folder
  - Delete documents in my Trash folder after $n$ hours
**Display**
- Sort options
- Unread mail indication

*Note:* Since the preference to mark documents read when opened in the preview pane is not supported in the Lite mode, only documents that have actually been opened (not just previewed) are marked as read.

**Signature**
The signature preference is supported.

**Follow Up**
- Follow up defaults
- Optional Follow Up Settings
  - Set default Follow Up date
  - Set default Follow Up time

*Note:* You can set a Follow Up alarm in Lite mode, however you will be alerted only in Full mode.

**Attention Indicator**
The Attention Indicator preference is supported.

**Calendar Preferences**

**General**
- Time Zone Settings
  - Option to use operating system settings or customize current
  - Time zone selection
- Import Holidays

**Display**
- Calendar Display
  - Month and year views start on
- Displaying Calendar Entries in Mail views

**Autoprocess**
Autoprocess preferences are supported.

**Work Hours**
Work Hours preferences are supported.

**International Preferences**
International preferences are supported.

**Delegation**
Delegation preferences *are not* supported. However, if you attempt to access a file to which you have been delegated access, you will be prompted to switch to the Full mode.

**Security**
Security preferences are supported.
Domino Web Access

Setting up Domino Web Access with Sametime - errata

stlinks.sav file not created

When you install Domino 8.0, the stlinks files that are installed in the stlinks directory (such as C:\st\domino\Data\domino\html\sametime\stlinks) are overwritten. The Configuration Notes in this topic incorrectly states that if you modified the stlinks files, they are backed up to a file called stlinks.sav. This is not the case. If you have modified the stlinks files, you must manually make a backup copy of them, and then replace the stlinks files installed during the upgrade.

Replace Part 5

Part 5 in the Domino Administrator help topic "Setting up Domino Web Access with Sametime" is incomplete. Use this information for Part 5 instead:

Part 5 - Set up the Instant Contact List in Domino Web Access

Domino Web Access 8.0 has its own Contact List client that replaces Sametime Connect for browsers, which was used in 7.0. Follow the steps below to set up the new Domino Web Access Contact List.

Configure Java servlet support

1. From the Domino Administrator client, open server document for the Domino Web Access server in edit mode.
2. Click the Internet Protocols - Domino Web Engine tab.
3. In the Java™ Servlets section, for the field Java servlet support, select "Domino Servlet Manager" from the list.
4. Save and close the document, and then restart the server.

Edit the Sametime Configuration file

5. Open the Sametime Configuration application (stconfig.nsf) on the Sametime server.
6. From the "By Form" view, open the CommunityConnectivity document.
7. Add the IP address of the Domino Web Access server to Community Trusted IPs field.
8. Save and close the document, and then restart the Sametime server.

Edit the servlet configuration file

9. Create a text file in the data directory on the Domino Web Access server called servlets.properties that includes the following line:
   servlet.DWABuddyList.code=com.lotus.dwa.stbuddy.DWABuddyList
10. (Optional) If you are using reverse proxy servers in your environment, you may need to add the following line with the fully-qualified domain name or IP address of the Sametime server in the servlet.properties file:
    servlet.DWABuddyList.initArgs=stserver=sametime.company.com

Enable the Domino Web Access Contact List client for Mozilla Firefox

11. Add the NOTES.INI setting iNotes_WA_DisableFirefoxAwareness=0 to the NOTES.INI file on the Domino Web Access server.
12. Add the signed version of the stlinks.jar file into the stlinks directory wherever you have an stlinks directory (on the Sametime server and on the Domino Web Access server).
Domino Web Access

**Using message recall in Domino Web Access**
The following information should be added to the Domino Web Access Help documentation:

**Preventing others from recalling messages sent to you**
By default, people who send messages to you can recall the messages. This is useful when others want to update or correct information that they sent in a message. However, you can set a Mail preference to prevent others from recalling any messages they have sent to you.

1. Click **Preferences**
2. Click the plus sign next to **Mail**, and then click **General**.
3. Under View and Folder Management, uncheck the option **Allow others to recall mail sent to you**.

**Recalling a message**
You can retract a message that you have already sent and saved in the Sent view. This is useful if you sent a message in error, or if you want to edit the content of a sent message and resend it.

*Note* You must have a copy of your Notes ID file stored in your mail file to use the recall message feature. If you do not have a copy of your Notes ID stored in your mail file, the Recall Message button does not display on the toolbar.

1. In your mail, open the Sent view.
2. Select the message.
3. Click **Recall Message**.
4. If the message was sent to more than one recipient, select the recipients to recall the message from.
5. *(Optional)* To recall the message from a recipient even if the recipient has already opened it, select **Recall the message even if it has been read**.
6. *(Optional)* To suppress recall status reports, clear **Send me a recall status report for each recipient**. Recall status reports confirm whether a message is recalled successfully or not.
7. Click **OK**.

*Note* Message recall is a Notes and Domino Release 8 feature. You can recall mail only if you are using the Release 8 mail application template (Mail8.ntf), and if both you and the message recipient have mail files on a Domino 8 server.

**Getting a "recall was not allowed" status message**
If you get "recall was not allowed" status when you attempt to recall a message, it could be for one of these reasons:

- The message recipient did not set a preference allowing mail to be recalled.
- The Domino administrator has not enabled this feature for the files on your mail server.
Domino for System i Documentation

Domino for System i

System i: C and C++ Application requirements

Any applications that use the Domino C or C++ API on i5/OS need to be reviewed to make sure they are properly enabled for use with Domino on i5/OS.

There are two important considerations:

- **Bind to QNOTES/LIBNOTES**
  Some applications incorrectly specify a library of *LIBL when binding to the LIBNOTES service program. This can result in incorrect operation in a multi-versioned Domino environment. Applications must specify library QNOTES when binding to the LIBNOTES service program in order to function correctly in a multi-versioned environment.

- **Enable for Teraspace**
  When 64-bit support for Domino becomes available, Domino for i5/OS will also change to use the i5/OS 64-bit pointer and teraspace support. To ensure proper operation, applications using the Domino C or C++ API must be teraspace-enabled. This can be accomplished by recompiling the application with the teraspace compiler option specified. This is expected to provide significant improvement in Domino i5/OS performance when 64-bit support is introduced.

For more details, see the following documents:

**Considerations when developing Domino C and C++ API applications for i5/OS:**

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21238494

**Domino 7 for i5/OS Application Development Guide (Chapter 2 - Application Development Considerations)**


For information on Domino 64-bit plans, see this document:


Domino Server, Domino for System i

**System i: CFGDOMSVR maximum length of DOM and ORG keywords**

When configuring a Domino server using the CFGDOMSVR CL command, the maximum length of the following keyword values are changed as follows:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Maximum length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization (ORG)</td>
<td>63</td>
</tr>
<tr>
<td>Domain (DOM)</td>
<td>31</td>
</tr>
</tbody>
</table>
Domino for System i

**System i: CFG/CHGDOMSVR TIMEZONE and DAYSAYTIME keywords**

The CL commands CFGDOMSVR and CHGDOMSVR that are used to configure Domino servers on System i are changed to incorporate support for the system value `QTIMZON` that was introduced in V5R3.

**CFGDOMSVR**

The Configure Domino Server (CFGDOMSVR) CL command is used to set up either a first Domino server or an additional Domino server. It is also used to remove an existing Domino server.

**CHGDOMSVR**

The Change Domino Server (CHGDOMSVR) CL command changes the configuration of an existing Domino server. You can use this command to change specific characteristics or to add features that were not included in the original server configuration.

The `TIMEZONE` keyword of the CFGDOMSVR command is modified to accept a new value `*SYSVAL` which is the new default value.

- **TIMEZONE**-Specifies the time zone to be used by the Domino server. The possible values are:
  - `*SYSVAL`
    - Specify the Timezone for this Domino Server based on QTIMZON system value.
  - `time-zone`
    - Specify a new value for the time zone (GMT, ZW1, et. al.).

The `DAYSAVETIME` keyword of the CFGDOMSVR command is modified to accept a new value `*TIMEZONE`.

- **DAYSAVETIME** Specifies whether the server time stamp should be adjusted for Daylight Savings Time. This value does not affect the actual system time. The possible values are:
  - `*YES`
    - Adjust the time stamp for Daylight Savings Time.
  - `*NO`
    - Do not adjust the time stamp for Daylight Savings Time.
  - `*TIMEZONE`
    - Adjust the time stamp for Daylight Savings Time according to the Timezone system value.

Note: `*TIMEZONE` cannot be specified here if `*SYSVAL` is not specified on the `TIMEZONE` parameter.

Similar values are accepted on the CHGDOMSVR CL command, along with the `*SAME` keyword.

Refer to each command's Help Text for additional information and usage details.
Domino for System i

**System i: Daylight Savings Time changes**
The United States and parts of Canada are extending the period of Daylight Savings Time (DST), beginning in 2007. From 2007 onward, DST will commence on the second Sunday in March (three weeks earlier than previously), and end on the first Sunday in November (a one week extension). For detailed information about these changes, and how they affect Notes and Domino, please see technote #21247972 at the following URL:

http://www.ibm.com/support/docview.wss?rs=899&uid=swg21247972

In addition, you can refer to the i5/OS Web page for additional information that pertains to DST on iSeries and System i.


Domino Server, Domino for System i

**System i: Generating an NSD**
A Domino enhancement as of release 8.0.1 to the RUNDOMCMD CL command allows an NSD to be generated that captures the typical NSD data. For example, your System i Domino server "Widget1" is unresponsive, and you want to generate an NSD for support to examine. Use the following i5 RUNDOMCMD CL command to generate the NSD:

RUNDOMCMD SERVER(Widget1) CMD(CALL QNOTES/NSD)

This command will generate a NSD under the IBM_TECHNICAL_SUPPORT subdirectory of the Domino data directory for server Widget1. Issuing this i5 command can be useful in hang or semaphore timeout conditions, where you want to be certain that an NSD is created.

This capability is only supported for Domino 8.0.1 (and later) servers.

Domino Server, Domino for System i

**System i: How to obtain additional spell-check dictionaries**
Lotus Domino 8 for System i installs four of the most common spell-check dictionary files for use with Domino:

- canadien.dic
- uk.dic
- us.dic
- wpdic.dic

Additional dictionary files may be obtained from the *dictions.exe* file of the Domino 8 for System i physical CD or Web kit. For more information, including instructions on how to install, refer to Chapter 20 of the Installing and Managing Domino 8 for System i Help documentation, in the topic "Language Dictionary Files".

In prior releases, customers were directed to obtain the additional dictionaries from the Notes client CD. However, with Domino 8, the server dictionary support has been upgraded, and is no longer consistent with the client dictionary versions.
Domino for System i

**System i: Parallel save capability with BRMS and i5/OS V5R4**

BRMS has extended the parallel save and restore capability to the Integrated File System (IFS) with i5/OS V5R4. Domino users of BRMS may want to investigate whether this new capability will help to minimize their Domino backup window.

Use the Work with Backup Control Groups (WRKCTLGBRM) CL command and specify option 8 (Change Attributes) for the QLTSSVR (or your own) control group to change the Parallel device resources from "*NONE*" to '2', or more, parallel devices.

If parallel backup is selected, then BRMS is required on the restore operation.

Customers who run concurrent backups with Domino servers may already be minimizing the save time, if the servers consume approximately the same storage.

For more information on this feature, refer to the BRMS Web page at the following URL:

http://www-03.ibm.com/servers/eserver/iseries/service/brms/domino.html

---

Domino for System i

**System i: Retrieve Domino Server Attributes API**

The Retrieve Domino Server Attributes (QnninRtvDominoServerAttr) API is used to retrieve specific information about each Domino server. This API program retrieves all of the information provided by QnninRtvDominoServerI, plus additional information based on the format name. It is modified in Domino 8 to additionally retrieve IPv6 information.

**Retrieve Domino Server Attributes (QnninRtvDominoServerAttr):**

**Required Parameter Group:**

<table>
<thead>
<tr>
<th></th>
<th>Data buffer for Domino server information</th>
<th>O</th>
<th>Char(*)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Data buffer length</td>
<td>I</td>
<td>Binary(4)</td>
</tr>
<tr>
<td>3</td>
<td>Server name</td>
<td>I</td>
<td>Char(255)</td>
</tr>
<tr>
<td>4</td>
<td>Server name length</td>
<td>I</td>
<td>Binary(4)</td>
</tr>
<tr>
<td>5</td>
<td>Format name</td>
<td>I</td>
<td>Char(8)</td>
</tr>
<tr>
<td>6</td>
<td>Error Code</td>
<td>I/O</td>
<td>Char(*)</td>
</tr>
</tbody>
</table>

Service Program Name: QNNINLDS

Similar Commands: None

**Authorities and Locks**

Default public authority

*USE

**Required Parameter Group**

Data buffer for Domino server information

OUTPUT; CHAR(*)

This returns the information about a specific Domino server. For the format, see "Data Buffer".

Data buffer length

INPUT; BINARY(4)

The length of the data buffer. The length must be at least big enough to hold the Bytes returned field and Bytes available field. Failure to provide enough room for the data will result in errors or incomplete data being returned.
Server name
  INPUT; CHARACTER(255)
  The name of the Domino server to retrieve information. This is a blank padded field. If the server
name was 10 characters long, then there would be 245 blanks following the server name.

Server name length
  INPUT; BINARY(4)
  The length of the server name including the blanks. It should always be 255.

Format name
  INPUT; CHARACTER(8)
  The name of the format used to retrieve different Domino server attributes. You can use the following
format names:
  DATR0100, DATR0200

Error code
  I/O; CHAR(*)
  The structure in which to return error information. For the format of the structure, see Error Code
Parameter. If this parameter is omitted, diagnostic and escape messages are issued to the
application.

Data Buffer
For detailed descriptions of the fields in these tables, see Field Descriptions.

DATR0100 Attribute Buffer

<table>
<thead>
<tr>
<th>Offset Dec</th>
<th>Offset Hex</th>
<th>Type</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Binary(4)</td>
<td>Bytes returned</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>Binary(4)</td>
<td>Bytes available</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>Binary(4)</td>
<td>Primary type of Domino server</td>
</tr>
<tr>
<td>12</td>
<td>C</td>
<td>Binary(4)</td>
<td>Secondary type of Domino server</td>
</tr>
<tr>
<td>16</td>
<td>10</td>
<td>Binary(4)</td>
<td>Number of active jobs in the subsystem</td>
</tr>
<tr>
<td>20</td>
<td>14</td>
<td>Binary(4)</td>
<td>Offset to data directory path</td>
</tr>
<tr>
<td>24</td>
<td>18</td>
<td>Binary(4)</td>
<td>Length of data directory path</td>
</tr>
<tr>
<td>28</td>
<td>1C</td>
<td>Binary(4)</td>
<td>Offset to executable directory path</td>
</tr>
<tr>
<td>32</td>
<td>20</td>
<td>Binary(4)</td>
<td>Length of executable directory path</td>
</tr>
<tr>
<td>36</td>
<td>24</td>
<td>Character(20)</td>
<td>Subsystem description</td>
</tr>
<tr>
<td>56</td>
<td>38</td>
<td>Character(10)</td>
<td>Library name</td>
</tr>
<tr>
<td>66</td>
<td>42</td>
<td>Binary(1)</td>
<td>Server status</td>
</tr>
<tr>
<td>67</td>
<td>43</td>
<td>Binary(1)</td>
<td>Auto-Start with TCP/IP Servers</td>
</tr>
<tr>
<td>68</td>
<td>44</td>
<td>Binary(4)</td>
<td>Partition Number</td>
</tr>
<tr>
<td>72</td>
<td>48</td>
<td>Binary(4)</td>
<td>Offset to generic information</td>
</tr>
<tr>
<td>76</td>
<td>4C</td>
<td>Binary(4)</td>
<td>Length of generic information</td>
</tr>
<tr>
<td>80</td>
<td>50</td>
<td>Character(16)</td>
<td>Server release</td>
</tr>
<tr>
<td>*</td>
<td>*</td>
<td>Character(*)</td>
<td>Variable data</td>
</tr>
</tbody>
</table>
### DATR0200 Attribute Buffer

<table>
<thead>
<tr>
<th>Offset Dec</th>
<th>Offset Hex</th>
<th>Type</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Binary(4)</td>
<td>Bytes returned</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>Binary(4)</td>
<td>Bytes available</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>Binary(4)</td>
<td>Primary type of Domino server</td>
</tr>
<tr>
<td>12</td>
<td>C</td>
<td>Binary(4)</td>
<td>Secondary type of Domino server</td>
</tr>
<tr>
<td>16</td>
<td>10</td>
<td>Binary(4)</td>
<td>Number of active jobs in the subsystem</td>
</tr>
<tr>
<td>20</td>
<td>14</td>
<td>Binary(4)</td>
<td>Offset to data directory path</td>
</tr>
<tr>
<td>24</td>
<td>18</td>
<td>Binary(4)</td>
<td>Length of data directory path</td>
</tr>
<tr>
<td>28</td>
<td>1C</td>
<td>Binary(4)</td>
<td>Offset to executable directory path</td>
</tr>
<tr>
<td>32</td>
<td>20</td>
<td>Binary(4)</td>
<td>Length of executable directory path</td>
</tr>
<tr>
<td>36</td>
<td>24</td>
<td>Character(20)</td>
<td>Subsystem description</td>
</tr>
<tr>
<td>36</td>
<td>38</td>
<td>Character(10)</td>
<td>Library name</td>
</tr>
<tr>
<td>42</td>
<td>43</td>
<td>Binary(1)</td>
<td>Server status</td>
</tr>
<tr>
<td>48</td>
<td>44</td>
<td>Binary(1)</td>
<td>Auto-Start with TCP/IP Servers</td>
</tr>
<tr>
<td>48</td>
<td>49</td>
<td>Binary(4)</td>
<td>Partition Number</td>
</tr>
<tr>
<td>50</td>
<td>52</td>
<td>Character(1)</td>
<td>Log replication events</td>
</tr>
<tr>
<td>50</td>
<td>51</td>
<td>Character(1)</td>
<td>Log client session events</td>
</tr>
<tr>
<td>52</td>
<td>53</td>
<td>Character(1)</td>
<td>Day light savings time enabled</td>
</tr>
<tr>
<td>54</td>
<td>54</td>
<td>Character(6)</td>
<td>Time zone</td>
</tr>
<tr>
<td>5A</td>
<td>55</td>
<td>Character(10)</td>
<td>Collation sort order</td>
</tr>
<tr>
<td>64</td>
<td>65</td>
<td>Character(11)</td>
<td>SMTP type</td>
</tr>
<tr>
<td>6F</td>
<td>70</td>
<td>Character(1)</td>
<td>Directory type</td>
</tr>
<tr>
<td>71</td>
<td>71</td>
<td>Character(3)</td>
<td>Service provider configuration</td>
</tr>
<tr>
<td>71</td>
<td>74</td>
<td>Binary(4)</td>
<td>Offset to organization name</td>
</tr>
<tr>
<td>78</td>
<td>78</td>
<td>Binary(4)</td>
<td>Length of organization name</td>
</tr>
<tr>
<td>7C</td>
<td>7C</td>
<td>Binary(4)</td>
<td>Offset to web browser list, List Type 1</td>
</tr>
<tr>
<td>80</td>
<td>80</td>
<td>Binary(4)</td>
<td>Offset to News Readers List, List Type 1</td>
</tr>
<tr>
<td>84</td>
<td>84</td>
<td>Binary(4)</td>
<td>Offset to Mail services List, List Type 1</td>
</tr>
<tr>
<td>88</td>
<td>88</td>
<td>Binary(4)</td>
<td>Offset to Advanced services List, List Type 1</td>
</tr>
<tr>
<td>8C</td>
<td>8C</td>
<td>Binary(4)</td>
<td>Offset to Connection Services List, List Type 1</td>
</tr>
<tr>
<td>90</td>
<td>90</td>
<td>Binary(4)</td>
<td>Offset to Directory Services List, List Type 1</td>
</tr>
<tr>
<td>94</td>
<td>94</td>
<td>Binary(4)</td>
<td>Offset to Additional Services List, List Type 1</td>
</tr>
<tr>
<td>98</td>
<td>98</td>
<td>Binary(4)</td>
<td>Offset to TCP Info List, List Type 2</td>
</tr>
<tr>
<td>9C</td>
<td>9C</td>
<td>Binary(4)</td>
<td>Offset to canonical name</td>
</tr>
<tr>
<td>A0</td>
<td>A0</td>
<td>Binary(4)</td>
<td>Length of canonical name</td>
</tr>
<tr>
<td>A4</td>
<td>A4</td>
<td>Binary(4)</td>
<td>Offset to server title</td>
</tr>
<tr>
<td>A8</td>
<td>A8</td>
<td>Binary(4)</td>
<td>Length of server title</td>
</tr>
</tbody>
</table>
Field Descriptions

**Auto - Start with TCP/IP servers**: This is a flag that indicates if the server will be started automatically when TCP/IP is started on the system.

- 0 - The server will not be started with TCP/IP
- 1 - The server will be started with TCP/IP

**Bytes available**: The length of data that could be returned by this API. This value is greater than "Bytes returned" when the length of the receiving variable is too small, causing truncation of data.

**Bytes returned**: The length of data returned in this structure. This value includes this and all following fields. If the data is truncated because the receiver variable is not large enough to hold all of the data available, this value will be less than the bytes available value.

**Collation sort order**: This field indicates which way the Domino server will sort characters. The possible values are:

```
*SAME
*STD
CS Czech
DA-DK-AA Nordic 2to1
DE German
E2-ES Spanish - Modern
EL Greek
EN Latin1
ES Spanish - Traditional
ET-EE Estonian collation
FI Finnish
FR French
HR Croatian
HU Hungarian
IS Icelandic
IT Italian
KO Korean
LT Lithuanian
LV Baltic
NL Dutch
NO Nordic
PL Latin2
PL-PL Polish
PT Portuguese
RU Cyrillic
SK Slovak
SL-SI Slovenian
SQ-AL Albanian
SV Swedish
TH Thai
TR Turkish
ZH-CN Simplified Chinese
ZH-TW Traditional Chinese
```

**Directory Type**: This is a flag that indicates if the server is configured as a central directory or a config-only directory. The possible values are:

- ‘1’ - Central Directory
- ‘2’ - Config-Only Directory

**DOLS enabled**: This is a flag that indicates if the server is enabled for Domino Offline Support (DOLS). The possible values are:

- ‘0’ - Not enabled for DOLS
- ‘1’ - Enabled for DOLS
DST: This is a flag that indicates if the server is configured for Daylight Savings Time (DST). The possible values are:
  - '0' - Not configured for DST
  - '1' - Configured for DST

Length of administrator name: This is the length of the data in the administrator name.

Length of canonical name: This is the length of the data in the canonical name. If length is equal to 0 (zero) then no canonical server name is available. Example of canonical server name:
CN=MYSERVER/OU=SALES/O=ORG1/C=US

Length of data directory path: This is the length of the data in the data directory path.

Length of domain name: This is the length of the data in the domain name (1-32).

Length of executable directory path: This is the length of the data in the executable directory path.

Length of generic information: This is the length of the data in the generic information.

Length of organization name: This is the length of the data in the organization name (1-64).

Length of server host name: This is the length of the data in the server host name (0-255). If length is equal to 0 (zero) then no server host name is available.

Length of server title: This is the length of the data in the server title (0-60). If length is equal to 0 (zero) then no server title is available.

Library name: This is the library name of the run time programs.

Log client session events: This is a flag that indicates if client session events should be logged. The possible values are:
  - '0' - Do not log client session events
  - '1' - Log client session events.

Log replication events: This is a flag that indicates if replication events should be logged. The possible values are:
  - '0' - Do not log replication events
  - '1' - Log replication events.

Number of active jobs in the subsystem: This is the number of active jobs in the subsystem associated with this Domino server. If the Domino server is currently not running this value will be 0. If a -1 is returned then the number of active jobs running in the subsystem could not be determined. If a -1 is returned there is a diagnostic message written that gives some more information on why this information could not be retrieved.

Offset to administrator name: This is the offset, from the start of the returned data, to where the administrator name can be found. It will be somewhere within the variable data portion of the returned data.

Offset to advanced services list: This is the offset, from the start of the returned data, to the list of advanced services of the server. This list is in List Type 1 format. See below for the description of the List Type 1 format;
Offset to canonical name: This is the offset, from the start of the returned data, to where the canonical name can be found. It will be somewhere within the variable data portion of the returned data.

Offset to connection services list: This is the offset, from the start of the returned data, to the list of connection services of the server. This list is in List Type 1 format. See below for the description of the List Type 1 format;

Offset to data directory path: This is the offset, from the start of the returned data, to where the data directory path can be found. It will be somewhere within the variable data portion of the returned data.

Offset to directory services list: This is the offset, from the start of the returned data, to the list of directory services of the server. This list is in List Type 1 format. See below for the description of the List Type 1 format;

Offset to domain name: This is the offset, from the start of the returned data, to where the domain name can be found. It will be somewhere within the variable data portion of the returned data.

Offset to executable directory path: This is the offset, from the start of the returned data, to where the executable directory path can be found. It will be somewhere within the variable data portion of the returned data.

Offset to generic information: This is the offset, from the start of the returned data, to where the generic configuration information can be found. It will be somewhere within the variable data portion of the returned data.

Offset to mail services list: This is the offset, from the start of the returned data, to the list of internet mail packages of the server. This list is in List Type 1 format. See below for the description of the List Type 1 format;

Offset to news readers list: This is the offset, from the start of the returned data, to the list of news readers of the server. This list is in List Type 1 format. See below for the description of the List Type 1 format;

Offset to organization name: This is the offset, from the start of the returned data, to where the organization name can be found. It will be somewhere within the variable data portion of the returned data.

Offset to server host name: This is the offset, from the start of the returned data, to where the server host name can be found. It will be somewhere within the variable data portion of the returned data.

Offset to server title: This is the offset, from the start of the returned data, to where the server title can be found. It will be somewhere within the variable data portion of the returned data.

Offset to TCP/IP information list: This is the offset, from the start of the returned data, to the list of TCP/IP port information of the server. This list is in List Type 2 format. See below for the description of the List Type 2 format;

Offset to web browsers list: This is the offset, from the start of the returned data, to the list of web browser features of the server. This list is in List Type 1 format. See below for the description of the List Type 1 format;

Partition Number: The internal partition number used by the Domino server to identify itself within a partitioned server environment.
Primary type of Domino server: This is the type of Domino server. The possible values are:

- 0 - Unknown Domino server type
- 1 - Domino server
- 2 - Stand alone QuickPlace server
- 3 - Stand alone SameTime server

If the server type is a Domino server, you may need to check the Secondary type of Domino server field to see if there are other capabilities of the server.

Secondary type of Domino server: This Domino server also has these additional capabilities. The possible values are:

- 0 - No additional capabilities.
- 1 - Also a QuickPlace server
- 2 - Also a SameTime server
- 3 - Also a QuickPlace AND SameTime server

This field is only valid if the Primary type of Domino server field indicates a Domino server.

Service provider configuration: This is a flag that indicates if the Service Provider Configuration (XSP) is enabled in the server. The possible values are:

- '0' - XSP not enabled
- '1' - XSP Enabled

Server release: This is the release of the server in the format VRM. Example of a server release: 8.0.0

Server status: This is the current status of the server. The possible values are:

- 1 - Server ended
- 2 - Server started
- 3 - Server starting
- 4 - Server ending
- 5 - Server in standby mode
- 99 - Server in unknown status

SMTP Type: This field indicates how the Domino server supports SMTP mail. The possible values are:

*MSF  AS/400 SMTP server in combination with the AnyMail/400 Mail Server Framework (value is obsolete)
*DOMINO  Built-in Domino SMTP
*QUICKPLACE  Built-in QuickPlace SMTP (QuickPlace servers only)

Subsystem description: This is the name of the subsystem description used for this Domino server. The first 10 bytes of the data will be the subsystem description name and the next 10 bytes will be the library name where the subsystem description can be found.
**Time Zone:** This field indicates what time zone the server is configured for. The possible values are:

- **GMT**  Greenwich Mean Time
- **BST**  Bering Standard Time
- **HST**  Alaska-Hawaii
- **ZW1**  1 hour West of GMT
- **ZW2**  2 hours West of GMT
- **ZW3**  3 hours West of GMT
- **NST**  Newfoundland Standard Time
- **AST**  Atlantic Standard Time
- **EST**  Eastern Standard Time
- **CST**  Central Standard Time
- **MST**  Mountain Standard Time
- **PST**  Pacific Standard Time
- **YST**  Yukon Standard Time
- **ZW9B**  9 1/2 hours West of GMT

**Variable Data:** This is the start of the variable data field. Use the offset and length fields to actually find and retrieve data from this area.

**List Formats**

**List Type 1**

<table>
<thead>
<tr>
<th>Offset Dec</th>
<th>Offset Hex</th>
<th>Type</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Binary(4)</td>
<td>Number of Items in List</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>Binary(4)</td>
<td>Length of each item</td>
</tr>
<tr>
<td>*</td>
<td>*</td>
<td>Character(*)</td>
<td>Items in the list</td>
</tr>
</tbody>
</table>

**List Type 2**

<table>
<thead>
<tr>
<th>Offset Dec</th>
<th>Offset Hex</th>
<th>Type</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Binary(4)</td>
<td>Number of Items in List</td>
</tr>
<tr>
<td>*</td>
<td>*</td>
<td>Character(*)</td>
<td>TCP/IP list items in TCP List Format</td>
</tr>
</tbody>
</table>

**TCP List Format**

<table>
<thead>
<tr>
<th>Offset Dec</th>
<th>Offset Hex</th>
<th>Type</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Binary(4)</td>
<td>OffsetToNext Item</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>Character(17)</td>
<td>Pv4 Address</td>
</tr>
<tr>
<td>21</td>
<td>15</td>
<td>Character(1)</td>
<td>Port Enabled</td>
</tr>
<tr>
<td>22</td>
<td>16</td>
<td>Character(10)</td>
<td>Port Encrypted</td>
</tr>
<tr>
<td>32</td>
<td>20</td>
<td>Binary(4)</td>
<td>Offset To Port Name</td>
</tr>
<tr>
<td>Offset Dec</td>
<td>Offset Hex</td>
<td>Type</td>
<td>Field</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------</td>
<td>-----------------</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>36</td>
<td>24</td>
<td>Binary(4)</td>
<td>Length of Port Name</td>
</tr>
<tr>
<td>40</td>
<td>28</td>
<td>Binary(4)</td>
<td>Offset To Network Name</td>
</tr>
<tr>
<td>44</td>
<td>2C</td>
<td>Binary(4)</td>
<td>Length of Network Name</td>
</tr>
<tr>
<td>48</td>
<td>30</td>
<td>Character(1)</td>
<td>Port Compression</td>
</tr>
<tr>
<td>49</td>
<td>31</td>
<td>Character(1)</td>
<td>Type of Remote system information</td>
</tr>
<tr>
<td>50</td>
<td>32</td>
<td>Character(2)</td>
<td>Reserved</td>
</tr>
<tr>
<td>52</td>
<td>34</td>
<td>Binary(4)</td>
<td>Offset To Remote system information</td>
</tr>
<tr>
<td>56</td>
<td>38</td>
<td>Binary(4)</td>
<td>Length of Remote system information</td>
</tr>
<tr>
<td>*</td>
<td>*</td>
<td>Character(*)</td>
<td>Variable data</td>
</tr>
</tbody>
</table>

TCP List Format Field Descriptions:

IPv4 address: This is the IPv4 address for this Domino Server Port. It is blank if an IP host name or IPv6 address is available.

Length of Network Name: This is the length of the Network Name data.

Length of Port Name: This is the length of the port name data.

Length of Remote system information: This is the length of the IP host name data, IPv4 address, or IPv6 address.

Offset to Network Name: This is the offset, from the start of this list element, to where the network name can be found.

Offset to next item: This is the offset, from the start of the first element in the list, to where the next element can be found.

Offset to Port Name: This is the offset, from the start of this list element, to where the port name can be found.

Offset to Remote system information: This is the offset, from the start of this list element, to where the IP host name, IPv4 address, or IPv6 address can be found.

Port Compression: This indicates if the data sent through the port is compressed. Possible values are;
- ‘0’ - Data is not compressed.
- ‘1’ - Data is compressed.

Port Enabled: This is a flag that indicates if this Domino Server Port is enabled. Possible values are;
- ‘0’ - Server port not enabled.
- ‘1’ - Server port is enabled.

Port Encrypted: This indicates if the data sent through the port is encrypted. Possible values are;
- *ENCRYPT
- *NOENCRYPT

Reserved: This is a reserved field.
Type of Remote system information: This indicates the type of address the Remote system information variable field contains for this Domino Server Port. Possible values are:

- ‘1’ - "Remote system information" field contains an IPv4 address.
- ‘2’ - "Remote system information" field contains an IPv6 address.
- ‘3’ - "Remote system information" field contains the host name for this port.

Variable Data: This is the start of the variable data field. Use the offset and length fields to actually find and retrieve data from this area.

Error Messages
CPF24B4: Severe error while addressing parameter list.
CPF3CF1: Error code parameter not valid
CPF3CF2: Error(s) occurred during running of &1 API.
CPF3C1E: Required parameter &1 omitted.
CPF3C21: Format name &1 is not valid.
CPF3C24: Length of the receiver variable is not valid.
LNT0907: The server name specified, &1, is not valid.

Domino for System i
System i: System Value QLOGOUTPUT
V5R4 introduced a new system value - QLOGOUTPUT (Job Log output). This affects Domino servers / jobs as follows:

- Each Domino server runs in a separate subsystem. The subsystem name is specified on the CFGDOMSVR command; the default is DOMINOxx, where xx is a number. The WRKDOMSVR command shows the subsystem name.
- Information for Subsystem is stored in the library QUSRNOTES
- Each subsystem has a Job Description (JOBD) used when submitting jobs to a system
  - To view JOBD: Enter the command WRKJOBD JOB(QUSRNOTES/*ALL)
  - One of the parameter of JOBD is Job log output, Keyword LOGOUTPUT:
    - When a job completes, one of three actions occur that affects how the job log is created. The following are values of the LOGOUTPUT parameter:
      - The job log server produces the job log: (*JOBLOGSVR)
      - The job itself produces the job log; if the job cannot produce its own job log, the job log will be produced by a job log server. (*JOBEND)
      - The job log is not produced; the job log remains in pending until it is removed. (*PND)
    - If LOGOUTPUT is set to *SYSVAL, the job uses the job log output value that is specified in the Job log output (QLOGOUTPUT) system value.
    - The shipped value for the Job log output (QLOGOUTPUT) system value is *JOBEND; the recommended value is *JOBLOGSVR.

Additional information on JOBD and the QLOGOUTPUT can be found at:
http://publib.boulder.ibm.com/iseries/
  - Select V5R4
  - Search on qlogoutput
Domino for System i

**System i: Use of the forward slash "/" character**

When issuing Domino console commands on System i, be aware of the command syntax and use of the forward vs. backward slash. For example, you may see the backward slash character "," used to delimit directory and file names in general use examples. On System i, use the forward slash "/" character.

---

Domino for System i

**System i: Using iSeries Navigator tasks on the Web**

**Overview**

System i Navigator is the user interface of choice for many System i administrators, system operators, and end users. This Windows-based GUI, which is a part of the System i Access for Windows product, gives administrators an easy-to-use, Windows-based interface for managing key System i resources.

However, in order to use System i Navigator, you must have the System i Access for Windows product installed, both on the System i and your PC. What if you are home or away from your primary PC at work, and you would like to perform some quick System i Navigator task. Maybe you need to check the system operator's message queue to make sure there are no messages needing a response before work can continue. Or you might need to check the status of a particular job that is currently running, or make sure a key piece of printer output is moved to the top of its print queue so it can be printed immediately. Well, with Domino 8 and i5/OS V5R4 or a later release, you can perform these and many other tasks, even though you are away from your main work PC! All you need is a browser and access to the desired System i system.

This browser support is provided with a feature called System i Navigator tasks on the Web. System i Navigator tasks on the Web allows you to perform a subset of System i Navigator tasks through an Internet Web browser. The interface may look slightly different, but the tasks you can perform are the same as when using System i Navigator Windows interface.

Administration of Domino servers from System i Navigator tasks on the Web is supported with i5/OS V5R4 or V6R1. This feature, allows you to perform most of the same tasks that you can perform when using the Domino plug-in for System i Navigator Windows interface, but from a browser.

The System i Navigator Web interface for Domino differs from the System i Navigator Windows interface for Domino in that it is shipped with i5/OS, whereas the System i Navigator Windows interface for Domino is shipped as a System i Navigator plug-in as part of the Domino for System i product. Therefore, there is no need for any update operation to run on the client in order to get a newer version of the System i Navigator Web interface for Domino. Whenever you update to a new i5/OS level, you get the latest version of the System i Navigator Web interface for Domino.

The Domino Plugin version that is provided with i5/OS V5R4 and V6R1 is Domino release 8.0.

**Domino releases supported with i5/OS V5R4 and V6R1**

- Domino 6.5.x
- Domino 7.0.x
- Domino 8.0.x

**Languages supported**

- English

**Browsers supported**

- Microsoft Internet Explorer 6.0
- Mozilla 1.7
- Firefox 1.0.2
Initial setup steps
To administer Domino servers using System i Navigator tasks on the Web, you need at least one system at either i5/OS V5R4 with SP3 (or later) or i5/OS V6R1, that has the following products installed:

<table>
<thead>
<tr>
<th>i5/OS V5R4</th>
<th>i5/OS V6R1</th>
</tr>
</thead>
<tbody>
<tr>
<td>5722SS1 Option 3</td>
<td>Extended Base Directory Support</td>
</tr>
<tr>
<td>5722SS1 Option 12</td>
<td>Host Servers</td>
</tr>
<tr>
<td>5722SS1 Option 30</td>
<td>Qshell</td>
</tr>
<tr>
<td>5722DG1</td>
<td>IBM HTTP Server for Series</td>
</tr>
<tr>
<td>5722JV1</td>
<td>IBM Developer Kit for Java</td>
</tr>
<tr>
<td>5722JV1 Option 6</td>
<td>Java Developer Kit for 1.4 for Domino 6 and 7</td>
</tr>
<tr>
<td>5722JV1 Option 8</td>
<td>J2SE 5.0 32 bit for Domino 8</td>
</tr>
<tr>
<td>5761SS1 Option 3</td>
<td>Extended Base Directory Support</td>
</tr>
<tr>
<td>5761SS1 Option 12</td>
<td>Host Servers</td>
</tr>
<tr>
<td>5761SS1 Option 30</td>
<td>Qshell</td>
</tr>
<tr>
<td>5761DG1</td>
<td>IBM HTTP Server for i5/OS</td>
</tr>
<tr>
<td>5761JV1</td>
<td>IBM Developer Kit for Java</td>
</tr>
<tr>
<td>5761JV1 Option 6</td>
<td>Java Developer Kit for 1.4 for Domino 6 and 7</td>
</tr>
<tr>
<td>5761JV1 Option 8</td>
<td>J2SE 5.0 32 bit for Domino 8</td>
</tr>
</tbody>
</table>

Required V5R4 PTFs:
- 5722SS1 Option 3 PTF SI24255
- 5722DG1 Group PTF SF99114 Level 6 or later

Prior to applying the V5R4 5722DG1 SF99114 Level 6 PTF(s), end the following servers:

- IBM Help Server ENDTCPSVR "IBMHELP"
- ADMIN HTTP Server ENDTCPSVR "HTTP HTTPSVR("ADMIN")
- DDM Server ENDTCPSVR "DDM"
- LDAP Server ENDTCPSVR "DIRSVR"

Note: You do not need the Domino product installed on the same i5 system that has the System i Navigator tasks for the Web support installed. From any i5 system that has the Web support installed, Domino servers on any i5 system in the network can be managed. Also, any supported release of Domino for i5/OS or System i can be administered using this Web interface.

Before users can access System i Navigator tasks on the Web, the system administrator needs to modify the HTTP Administration server configuration to automatically start the system application server instance. This special "system instance" must be configured and started before the System i Navigator Web application can function. To do this, the system administrator needs to perform these tasks:

1. Start the HTTP Administration server if it is not already started
   > STRTCPSVR SERVER("HTTP HTTPSVR("ADMIN))
2. Go to the HTTP Administration Web page: http://<system>:2001/HTTPAdmin (where <system> is the System i host name).
3. Click on the "Manage" tab
4. Click on the "HTTP Servers" tab, then select "ADMIN - Apache" from the Server list
5. Click on "General Server Configuration" in the left pane of the current page
6. Specify "Yes" for "Start the system application server instance when the 'Admin' server is started"
7. Specify "Yes" for "Stop the system application server instance when the 'Admin' server is stopped"
8. Click the "Apply" button
9. Stop, then start the HTTP Administration server so these configuration changes take effect
Once this "one time" configuration change is made to the HTTP Administration server, and the server is restarted, users will be able to access System i Navigator tasks on the Web.

**Note:** For V6R1 systems you do not need to modify the HTTP Administration server configuration manually because the system application server instance would be started automatically when the 'Admin' server is started.

**Note:** For more information on how to set up this Web environment on your system, see the IBM iSeries V5R4 Information Center:


or the System i V6R1 Information Center:

http://publib.boulder.ibm.com/iseries/ (available after i5/OS V6R1 is generally available).

After you have set up System i Navigator tasks on the Web, all you need on your PC is a Web browser that connects to the Internet and you can begin working with the Domino tasks by clicking **View All Tasks** and selecting the Network tab.

Also, you do not need to worry about learning a new interface for these Web tasks. The exact same code and user interface that are used within System i Navigator on the client are also used on the Web. So, for example, if you're already familiar with the System i Navigator for Windows panel that appears when you select the "properties" action of a Domino server, you will see the exact same interface when you select "properties" of a Domino server on the Web.

You can also create your own URL that points to the Domino tasks on the Web, as well as other System i Navigator tasks on the Web, by using the URL Advisor. To use the URL Advisor, visit the following URL from a Web browser:

http://<hostA>:<port>/webnav/WnServlet?task=home

where:

<hostA> is the System i host name.

<port> is the HTTP port number set up with System i Navigator Web interface.

Click **Create a URL...** to create the URL for the Domino tasks on the Web.

**Working with the Domino tasks on the Web**

Not all Domino operations that are available with the System i Navigator Windows interface are allowed in the Web interface. The following table shows the Domino operations that can be performed using the Web interface to Domino servers that reside in the network, and the special authorities needed for the user profile performing them:

<table>
<thead>
<tr>
<th>Operations</th>
<th>Special Authorities needed</th>
<th>Steps to follow</th>
</tr>
</thead>
</table>
| Change the properties of a Domino server | *ALLOBJ  
*JOBCTL  
*SECADM  
*IOSYSCFG | To change the properties of a Domino server:  
1. Locate the system where the Domino server resides.  
2. Select **Network**.  
3. Select **Domino Servers**.  
4. Click the **pop menu** from a Domino server in the server list and select **Properties**.  
5. Change any of the properties of the Domino server and click **OK**. |
<table>
<thead>
<tr>
<th>Operations</th>
<th>Special Authorities needed</th>
<th>Steps to follow</th>
</tr>
</thead>
</table>
| Delete a Domino server | *ALLOBJ
*JOBCTL
*SECADM
*IOSYSCFG | To delete a Domino server from a system:  
1. Locate the system where the Domino server resides.  
2. Select Network.  
4. Click the pop menu from a Domino server in the server list and select Delete. |

| Start Domino servers or controllers | *JOBCTL | To start a Domino server, controller, or both on a system:  
1. Locate the system where the Domino server resides.  
2. Select Network.  
4. Click the pop menu from a Domino server in the server list.  
5. Click Start and select one of the following: Server, Controller or Server and Controller.  
To start all existing Domino servers, controllers, or both on a system:  
1. Locate the system where the Domino servers reside.  
2. Select Network.  
4. In Select Action, select one of the following: Start > All Servers, Start > All Controllers or Start > All Servers and Controllers. |

| Stop Domino servers or controllers | *JOBCTL | To stop a Domino server, controller, or both on a system:  
1. Locate the system where the Domino server resides.  
2. Select Network.  
4. Click the pop menu from a Domino server in the server list.  
5. Select Stop and click one of the following: Server, Server Immediately, Server and Controller or Server and Controller Immediately.  
To stop all existing Domino servers, controllers, or both on a system:  
1. Locate the system where the Domino servers reside.  
2. Select Network.  
4. In Select Action, select one of the following: Stop > All Servers, Stop > All Servers and Controllers, Stop > All Servers Immediately or Stop > All Servers and Controllers Immediately. |

| Launch WebAdmin.nsf | *JOBCTL | To launch WebAdmin.nsf:  
1. Locate the system where the Domino server resides.  
2. Select Network.  
4. Click the pop menu from a Domino server in the server list and select Server Administration.  
5. Specify the HTTP port and click OK. |
<table>
<thead>
<tr>
<th>Operations</th>
<th>Special Authorities needed</th>
<th>Steps to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a Domino Application</td>
<td>*ALLOBJ *SECADM *IOSYSCFG</td>
<td>To add a Domino Application to a Domino server:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Locate the system where the Domino server resides.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Select <strong>Network</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Select <strong>Domino Servers</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Click the pop menu from a Domino server in the server list and select Add Application.</td>
</tr>
<tr>
<td><strong>Usage notes:</strong></td>
<td></td>
<td>• The Domino server must already be set up on the system.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The licensed program and option being added must be installed on the system.</td>
</tr>
<tr>
<td>Add QuickPlace or Sametime to a Domino server</td>
<td>*ALLOBJ *JOBCTL *SECADM *IOSYSCFG</td>
<td>To add QuickPlace or Sametime to a Domino server:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Locate the system where the Domino server resides.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Select <strong>Network</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Select <strong>Domino Servers</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Click the pop menu from a Domino server in the server list and select either of the following: Add QuickPlace or Add Sametime.</td>
</tr>
<tr>
<td>Remove QuickPlace or Sametime from a Domino server</td>
<td>*ALLOBJ *JOBCTL *SECADM *IOSYSCFG</td>
<td>To remove QuickPlace or Sametime from a Domino server:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Locate the system where the Domino server resides.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Select <strong>Network</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Select <strong>Domino Servers</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Click the pop menu from a Domino server in the server list and select either of the following: Remove QuickPlace or Remove Sametime.</td>
</tr>
<tr>
<td>View the active jobs related to the Domino servers</td>
<td>*NONE</td>
<td>To view the active jobs related to the Domino servers on a system:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Locate the system where the Domino servers reside.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Select <strong>Network</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Select <strong>Domino Servers</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. In Select Action, select <strong>Domino Jobs</strong>. The jobs are displayed in a new window, sorted by subsystem.</td>
</tr>
<tr>
<td>Display the Domino plug-in version</td>
<td>*NONE</td>
<td>To see the version of the Domino plug-in that you are using:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Locate the system where the Domino server resides.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Select <strong>Network</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Select <strong>Domino Servers</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. In Select Action, select <strong>Display Plugin Version</strong>.</td>
</tr>
</tbody>
</table>
### Operations needed

**Steps to follow**

1. Locate the system where the Domino servers reside.
2. Select Network.
4. The Domino servers list appears in a new window.
5. Click the pop menu from a Domino server of your choice to bring up a context menu where you can select different operations to apply to the Domino server. Ability to run an operation depends on the special authorities it requires, as described in this table.

<table>
<thead>
<tr>
<th>Operations</th>
<th>Special Authorities needed</th>
<th>Steps to follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Domino servers</td>
<td>*ALLOBJ, *JOBCTL, *SECADM, *IOSYSCFG</td>
<td>To work with existing Domino servers on a system:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Locate the system where the Domino servers reside.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Select Network.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. The Domino servers list appears in a new window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. Click the pop menu from a Domino server of your choice to bring up a context menu where you can select different operations to apply to the Domino server. Ability to run an operation depends on the special authorities it requires, as described in this table.</td>
</tr>
</tbody>
</table>

**Usage notes:**

- You can sort the Domino servers by name or by creation date in the new window. To sort the servers by name, click **Server Name** at the top of that column. To sort the Domino servers by creation date, click **Server Name** again.
- To view the Domino server status the user profile must have *USE object authority* to the QUSRNOTES library.

### Other operations over Domino tasks on the Web

- **FIND TOOLBAR** only searches for the first satisfied result, next search begins from previous search result.
- On **TABLE ACTIONS TOOLBAR**, Select All only takes effect on current page, this functionality isn't supported by the Domino tasks on the Web, it uses the "Start All Domino servers or controllers" and "Stop All Domino servers or controllers" operations to work with all servers.
- On **TABLE ACTIONS TOOLBAR**, when Edit Sort is used with Server Name, by descending the list appears by the date created in default and by ascending the list is shown alphabetically, sorting list by "Status" or "Version" are not enabled.
- Launch WebAdmin.nsf is used as instance of "Start Domino console" and "Server Administration" options used on Domino plug-in for System i Navigator.

### Operations not supported

- Configure a new Domino server.
- Work with Domino console.

### Domino for System i

**System i: WRKDOMSVR new options - 14, 15, 16 and F23**

The following options were added to the CL command WRKDOMSVR:

**F23=More options**

Displays more options that you can use to perform operations on the Domino Servers in the list.

**14=Work with support files**

Use this option to work with support files in `<data directory>/IBM_TECHNICAL_SUPPORT` IFS directory that is used by the Domino server. This option runs the Work with Object Links (WRKLNK) command. To perform operations using the WRKLNK command, you must have the following authorities:
Activities Help

Lotus Notes

Activities sidebar enhancements
No new features or enhancements have been introduced in the Activities sidebar with version 8.0.2. This release note describes the new or enhanced features, and documentation corrections made with Lotus Notes 8.0.1 that also apply to Lotus Notes 8.0.2.

Note: The Activities sidebar for Notes 8.0.2 requires a Lotus Connections Server, version 1.0.1 or 1.0.2. You can use a version 2.0 server as well, but some of the new features of Lotus Connections 2.0, such as custom fields, will not be available.

New features that were introduced in Lotus Notes 8.0.1

Creating an activity from a template
A template is a prototype of an activity. You can use a template to capture the required steps, contacts, resources, and tools used to complete a common process. You must use the Web client version of Activities to create a template. But after a template is created, you can specify that you would like to create an activity from the template when you create an activity from the Notes sidebar. This capability is useful if you are creating an activity for a project that uses a process that has already been captured in a template.

To specify that you would like to create an activity from an existing template, complete the following steps:
1. From the Activities sidebar toolbar, click New to start an activity.
2. Name the activity.
3. Click the Display button, and then select Template Options.
4. Select a template from the list of templates.

Note: There will be no templates available in this list until they are created. Use the Web client version of Activities to create templates.
5. Optional: If you want to use the tags set up in the template, select the **Use tags from this template** check box.

6. Optional: If you want to add the same people listed as members of the template to this activity, select the **Use members from this template** check box.

7. Fill out the remaining fields as desired, and then click **Save** to create the activity from the selected template.

**Configuring the type of authentication used to access the Activities server**

The Activities preferences page has a new Advanced button that you can click to configure advanced server settings. You can use the Advanced Server Settings dialog box to select the authentication type to use when communicating with the Activities server. By default, Lotus Notes authenticates with the Activities server using form based authentication, which means it establishes trust by sending a Lightweight Third-Party Authentication (LTPA) token to identify itself. If your administrator has implemented an alternate authentication mechanism in the Lotus Connections environment in which the Activities server is running, you may be instructed to edit the advanced server settings. The authentication type options are as follows:

- **Java Form (default)** -- Communicates using form based authentication. This option is implemented by default.
- **Tivoli Access Manager Form** -- Communicates using form based authentication on Tivoli Access Manager. Do not select this option unless you are advised to do so by your administrator.
- **Basic Authentication** -- Communicates using basic authentication, which establishes trust by sending a user name and password. Do not select this option unless you are advised to do so by your administrator.

To change the authentication type used to communicate with the Activities server, complete the following steps:

1. From the Notes menu, select **File > Preferences**.
2. Click **Activities** to open the Activities Settings page.
3. Click the **Advanced** button.
4. Select an authentication type option, and then click **OK**.
5. Click **OK** to save your changes and close the Preferences window.

**Enhancements that were introduced in Lotus Notes 8.0.1**

**Using arrow keys to open and close the slideout preview box**

To quickly learn about an activity or an entry, you can display its slideout preview box. The preview box contains the activity or entry name, purpose, and other basic information. Previously, to open the slideout preview box, you clicked the activity or entry once, and after reading it, closed it by clicking the ESC key. You can now click the LEFT arrow to open the slideout preview box, and click the RIGHT arrow key to close it. Using the arrow keys allows you to navigate the sidebar more quickly.

**Formatting entries**

You can use the toolbar to format the text in any type of activity entry, from messages to ToDo items, and you can run the spell checking tool on the entry before saving it.

**Forwarding activities or entries to colleagues**

If you see an activity or a new entry in an activity that you think may be of interest to a colleague, you can send a link to the activity or entry in an e-mail message to that colleague. The menu item you click to send the link has changed from **Send Notification** to **Forward a Link**. To send a link to a colleague in 8.0.1, complete the following step:

- Right-click the activity or entry, and then select **Forward a Link**. This opens a new memo with ahypertext link to the activity or entry. You can then address the e-mail to your colleague and then send it.
Documentation changes that were made in Lotus Notes 8.0.1

- When you create an activity, you must provide a name for it. This excerpt from the Help topic Creating an activity should read as follows:

  Creating an activity is easy: just click a button and fill out a form. You can edit the activity later to add or change information.
  
  1. From the Activities sidebar panel, click New.
  2. In the Activity field, type a short name that describes the purpose of the activity, for example, a project name.

- You now can create a tag that contains spaces. This excerpt from the Help topic What is a tag? should read as follows:

  A tag can contain characters, such as an underscore or @ (at-sign), and can contain spaces. For example, you can use follow_up, follow-up, and follow up.

Sametime Help

Lotus Notes

Sametime Contacts Help

You can find Help for the Sametime instant messaging features by choosing Help -> Help Contents and then selecting Sametime Contacts in the navigator. Please note that some of the features described in the Help may not be available to you.
Lotus Notes

**Sametime Show Online Settings**
There are two settings to Show Online Users only for Instant Messaging. One is persistent, meaning that the setting is stored after the client session has ended, the other is not. Please see the graphics below for more information.

<table>
<thead>
<tr>
<th>Persistent</th>
<th>Not Persistent</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Persistent Settings" /></td>
<td><img src="image2.png" alt="Non-Persistent Settings" /></td>
</tr>
</tbody>
</table>

**Lotus Symphony Help**

Lotus Notes

**Symphony keyboard shortcuts corrections and updates**

**Keyboard Navigation for IBM Lotus Symphony**

**Practical Text input fields**
- Shift+Ctrl+S opens the Save as dialog box rather than the Special Characters dialog box.

**List of General Shortcut Keys in Symphony**
- Alt+O opens the the Options dialog box rather than the Spelling dialog box behavior described.

**Shortcut Keys Using the Function Keys**
- Ctrl+F11 does not work.

**Shortcut Keys for Drawing Objects**
- Ctrl+Tab and Ctrl+Shift+Tab do not work.

**Window Shortcut Keys**

293
- F4+modifier key does not work.

**Shortcut keys in the file open dialog**
- Ctrl+arrow, Alt+Up arrow, and Alt+Down arrow do not work.

**Using shortcuts**
- F6 switches between the document and sidebar, but does not switch to the menus or toolbars.

### Keyboard navigation for Lotus Symphony Documents

**Function keys for Lotus Symphony Documents**
- F1 activates context help rather than Shift+F1.
- Alt+F7, F8, Shift+F8, F9, Ctrl+Shift+F9, and Ctrl+Shift+F11 do not work.

**Shortcut keys for Lotus Symphony Documents**
- Alt+Enter, Ctrl+Plus(+), Ctrl+Shift+Enter and do not work.

**Keyboard shortcuts for navigating and selecting**
- Alt+Tab and Ctrl+Tab do not work.

**Shortcut keys for tables**
- Ctrl+Tab removes cursor from table rather than inserting a tab stop.
- Alt+Delete does not work.

**Shortcut keys for moving and resizing frames, graphics, and objects**
- Alt+Ctrl+arrow keys, Alt+Ctrl+Shift+arrow keys, and Ctrl+Tab do not work.

### Keyboard Navigation for Lotus Symphony Presentations

**Function Keys for Lotus Symphony Presentations**
- Ctrl+Shift+S opens the Save as dialog box rather than Ctrl+S.
- Ctrl+Tab switches between toolbar, sidebar and status bar.
- Shift+F1, Ctrl+T, and Ctrl+Shift+K do not work.

**Shortcut Keys in Page Shows**
- Spacebar goes to next page rather than next animation.
- P does not go to previous page.

**Shortcut Keys in the Drawing View**
- Alt, Alt key combinations, Ctrl+F1, Ctrl+click, and Shift+Ctrl+Alt+A do not work.

### Keyboard Navigation for Lotus Symphony Spreadsheets

**Function keys for Lotus Symphony Spreadsheets**
- Ctrl+Shift+S opens the Save as dialog box rather than Ctrl+S.
- Ctrl+F5, Ctrl+Shift+X, and Ctrl+T do not work.

**Using the Data Pilot**
- Ctrl+Tab switches between toolbar, sidebar, and status bar.
Notices and Trademarks

Notices

Lotus Notes, Domino Designer, Domino Server, Domino Web Access, Domino Access for Outlook, Domino Offline Services (DOLS), Domino for System i, Domino for System z

License agreement
Any information or reference related to license terms in this document is provided to you for your information. However, your use of Notes and Domino, and any other IBM program referenced in this document, is solely subject to the terms and conditions of the IBM International Program License Agreement (IPLA) and related License Information (LI) document accompanying each such program. You may not rely on this document should there be any questions concerning your right to use Notes and Domino.

IBM Product Licenses are available for reference at: http://www.ibm.com/software/sla/sladb.nsf

Notices
This information was developed for products and services offered in the USA. IBM may not offer the products, services, or features discussed in this document in all countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country/region or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan
The following paragraph does not apply to the United Kingdom or any other country/region where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions; therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

References in this publication to IBM products, programs, or services do not imply that they will be available in all countries in which IBM operates. Product release dates and/or capabilities referenced in this publication may change at any time at IBM’s sole discretion based on market opportunities or other factors, and are not intended to be a commitment to future product or feature availability in any way.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information that has been exchanged, should contact:

Lotus Software
IBM Software Group
One Rogers Street
Cambridge, MA 02142
USA

Such information may be available, subject to appropriate terms and conditions, including in some cases payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or by any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems, and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements, or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility, or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

**Trademarks**

IBM, the IBM logo, AIX, DB2, DB2 Universal Database, developerWorks, Domino, i5/OS, iSeries, Lotus, Lotus Notes, LotusScript, Notes, Passport Advantage, QuickPlace, Quickr, Redbooks, Sametime, Symphony, System i, System i5, System z, Tivoli, WebSphere, xSeries, z/OS, and zSeries are trademarks or registered trademarks of IBM Corporation in the United States, other countries, or both.


This product is Built on Eclipse™ ([http://www.eclipse.org](http://www.eclipse.org)).

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Microsoft, Windows, Windows Vista, Aero, and the Windows logo are trademarks or registered trademarks of Microsoft Corporation in the United States, other countries, or both.

Apple, the Apple logo, Mac, Macintosh, Mac OS, and Safari are trademarks of Apple Inc., registered in the U.S. and other countries.

Intel and Pentium are trademarks of Intel Corporation in the United States, other countries, or both.

Macrovision and InstallShield are registered trademarks of Macrovision Corporation.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

Google and Google Desktop are trademarks of Google Inc.

Yahoo! is a trademark of Yahoo! Inc.

The Graphics Interchange Format© is the Copyright property of CompuServe Incorporated. GIF(sm) is a Service Mark property of CompuServe Incorporated.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product and service names may be trademarks or service marks of others.